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Using Session Commands

Alphabetical list of session commands

A

AASA: Session command for acceptance sampling by attributes on page 688

ACF: Session command for calculating autocorrelation on page 862

ADD: Session command for addition on page 63

ALTTESTPLAN: Session command for creating an accelerated life test plan on page 699

ANOM: Session command for creating an analysis of means chart on page 223

ANOVA: Session command for performing a balanced ANOVA on page 224

ARDECISION: Session command for accepting or rejecting an entire lot on page 694

AREA: The session subcommand for shading the area below the data values to the base on page 999
ARGRAPH: Session command for creating an area graph on page 990

ARIMA: Session command for modeling time series behavior and generating forecasts on page 864

AXLABEL: Session subcommand for customizing graph axis labels on page 1001

BAR: Session subcommand for representing data values with bars on page 1003

BASE: Session command for fixing a starting number for the random number generator on page 86
BBDESIGN: Session command for creating a Box-Behnken design on page 342

BCAPA: Session command for performing binomial capability analysis on page 656

BFFACTORIAL: Session command for analyzing a full or fractional factorial design with a binary response on page
296

BFIT: Session command for creating a binary fitted line plot on page 210

BGFACTORIAL: Session command for analyzing a general full factorial design with a binary response. on page 312
BOXCOX: Session command for performing a Box-Cox transformation on page 432

BOXPLOT: Session command for creating a boxplot on page 975

BTFT: Session command for calculating a 1-sample bootstrap confidence interval of a function on page 96

BTPR: Session command for calculating a 1-sample bootstrap confidence interval of a proportion on page 97

BTTM: Session command for calculating a 2-sample bootstrap confidence interval for the difference of means on
page 99

BREAK: Session command for transferring control from a DO- or WHILE-loop on page 1118

BREG: Session command for performing best subsets regression on page 178
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BRIEF: Session command for controlling the amount of output on page 1125

BUBBLEPLOT: Session command for creating a bubble plot on page 955

BRSREG: Session command for analyzing a response surface design with a binary response on page 353
BSCREEN: Session command for analyzing a screening design with a binary response on page 268
BWCAPA: Session command for performing between/within capability analysis on page 596

BWCHART: Session command for creating an I-MR-R/S chart on page 446

BWSIXPAC: Session command for Between/Within Capability Sixpack on page 641

CA: Session command for performing simple correspondence analysis on page 855

CALL and RETURN: Session commands for passing control to another macro on page 1119
CAPA: Session command for performing a normal capability analysis on page 604
CCDESIGN: Session command for creating a central composite design on page 343

CCF: Session command for calculating cross correlation between two time series on page 871
CCHART: Session command for creating a C chart on page 531

CD: Session command for displaying or changing the current directory on page 1121

CDF: Session command for calculating the cumulative probability of an x-value on page 91
CENTER: Session command for centering data on page 80

CFAUTOMATICALLY: Session command for automatically recalculating values on page 135
CFMANUALLY: Session command for manually recalculating values on page 136

CFNOW: Session command for recalculating values now on page 136

CFORMAT: Session command for conditional formatting of worksheet cells on page 132
CHART: Session command for creating a bar chart on page 942

CIBOX: The session subcommand for displaying a median confidence interval box on a boxplot on page 1005
CLIMITS: Session command for specifying attributes for control limit lines on page 1006
CLINE: Session command for specifying attributes for a center line on page 1008

CLUOBS: Session command for clustering observations on page 845

CLUVARS: Session command for clustering variables on page 849

CMEAN: Session subcommand for connecting means with lines on a boxplot on page 1010
CMEDIAN: Session subcommand for connecting means with lines on a boxplot on page 1011
CODE: Session command for changing values in columns to new values on page 119
COFFSET and GAPWIDTH: Session subcommands for the space between clusters and items in a cluster on page 1028
COMPARE: Session command for performing multiple comparisons of means on page 241
CONCATENATE: Session command for combining text columns on page 119

CONNECT: Session subcommand for connecting points with lines on page 1012
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CONTOURPLOT: Session command for creating a contour plot on page 992

%CONTPROC: Session command for creating a contour plot

CONVERT: Session command for converting text data to numeric data, and numeric data to text data on page 121
COPY: Session command for copying data on page 130

CORRELATION: Session command for measuring the strength and direction of the association between two variables
on page 160

COUNT: Session command for counting the number of values in a column on page 76

COVARIANCE: Session command for calculating the covariance between pairs of columns on page 162
CTPREDICT: Session command for predicting responses for new observations for a classification tree on page 771
CTREE: Session command for creating a classification tree on page 765

CUSUM: Session command for creating a CUSUM chart on page 550

CUTPOINT, MIDPOINT, and NINTERVAL: Session subcommands for specifying cutpoints and midpoints on page
1014

DATA: Session subcommand for controlling the data region within the figure region on page 1015
DATE: Session command for changing data type to date/time on page 113

DATLAB: Session command for labeling data values on page 1016

DCAPA: Session command for performing individual distribution identification on page 593
DEBUG and NODEBUG: Session commands for finding problems in macros on page 1124
DECOMP: Session command for performing decomposition on a time series on page 872
DEFAULT: Session command for assigning default values to subcommand arguments on page 1112
DEFINE: Session command for defining a constant matrix on page 104

DEFTEST: Session command for defining the sensitivity of the tests for special causes on page 592
DELETE: Session command for deleting rows of data on page 111

DES: Session command for performing double exponential smoothing on page 876

DESCRIBE: Session command for summarizing numeric data with statistics on page 139
DIAGONAL: Session command for creating a matrix from a column on page 104

DIFFERENCES: Session command for calculating differences on page 880

DISCRIMINANT: Session command for performing discriminant analysis on page 852
DISTRIBUTION: Session command for fitting a distribution on page 1018

DQT: Session subcommand for displaying a symbol for each data value on page 1021

DOTPLOT: Session command for creating a dotplot on page 961

DPLOT: Session command for creating a probability distribution plot on page 970

DSDESIGN: Session command for creating a definitive screening design on page 257
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DROUND: Session command for rounding date/time values on page 122
DSET: Session command for making patterned data on page 82
DTESTPLAN: Session command for creating a demonstration test plan on page 695

DTYPE: Session command for determining the data type of a column or a constant on page 1114

ECDF: Session command for creating an empirical CDF plot on page 968

EIGEN: Session command for calculating eigenvalues on page 63

ELLIPSE: Session subcommand for constructing an ellipse from points on a graph on page 1022

ELSE, ELSEIF, IF, ENDIF: Session commands for executing code depending on a logical condition on page 1115
END: Session command for ending data input on page 38

ENDLAYOUT and LAYOUT: Session subcommands for specifying where a graph appears on a page on page 1043

ENDMACRO, GMACRO, and MACRO: Session commands for marking the beginning and ending of a macro on
page 1109

ENDWHILE and WHILE: Session commands for repeating a block of commands depending on a logical expression
on page 1116

ERASE: Session command for erasing variables on page 113

ETESTPLAN: Session command for creating an estimation test plan on page 697

EVDESIGN: Session command for creating an extreme vertices design on page 365

EWMACHART: Session command for creating an EWMA chart on page 543

EXCLUDE and INCLUDE: Session subcommands for including or excluding rows on a graph on page 1036
EXECUTE: Session command for running an Exec file on page 1130

EXIT: Session command for transferring control back to Minitab or for closing Minitab on page 1120

FACPLOT: Session command for creating a factorial plot on page 276

FACTOR: Session command for performing a factor analysis on page 842

FDATE/TIME: Session command for changing the format of date/time columns on page 136

FDESIGN: Session command for creating a general full factorial design on page 277

FDESIGN: Session subcommand for power and sample size for a general full factorial design on page 919
FFACTORIAL: Session command for analyzing a full or fractional factorial design on page 288

FFCUBE: Session command for creating a cube plot on page 340

FFDESIGN: Session command for creating a full or fractional factorial design on page 279

FFDESIGN: Session subcommand for power and sample size for a 2-level factorial design on page 920
FFINT: Superseded by FACPLOT except for mixture designs on page 336

FFMAIN: Superseded by FACPLOT except for mixture designs on page 338
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FIGURE: Session subcommand for controlling the figure region within the graph region on page 1023
FISHBONE: Session command for creating a cause-and-effect diagram on page 425

FITD: Session command for fitting a distribution to the data on a probability plot on page 1024
FITLINE: Session command for creating a fitted line plot on page 179

FNUMERIC: Session command for changing columns to numeric format on page 136

FOOTNOTE: Session subcommand for adding a footnote to a graph on page 1025

%FORM: Session command for creating a data collection form for a 3-factor design

FORMULA: Session command for assigning a formula to a column on page 137

FREQUENCY: Session subcommand for using a frequency column for a graph on page 1027
FRIEDMAN: Session command for performing a Friedman test on page 910

FTEXT: Session command for changing the format of text columns on page 137

G
GAGERR: Session command for performing a crossed gage R&R study on page 675
GAPS: Session subcommand for displaying a gap in time on a graph on page 1027
GAPWIDTH and COFFSET: Session subcommands for the space between clusters and items in a cluster on page 1028
GAWORKSHEET: Session command for creating a gage R&R study worksheet on page 667
GCHART: Session command for creating a G chart on page 582
GENVAR: Session command for creating a generalized variance chart on page 572
GFACTORIAL: Session command for fitting a general full factorial design on page 305
GLM: Session command for fitting the general linear model on page 227
GMACRO, MACRO, and ENDMACRO: Session commands for marking the beginning and ending of a macro on
page 1109
GOTO and MLABEL: Session commands for branching to any line in a macro on page 1118
GRAPH: Session subcommand for controlling the graph region fill and border line on page 1028
MGRID, NOGRID, and NOMGRID: Session subcommands for controlling the grid on a graph on page 1029
GROUP: Session subcommand for specifying categorical variables for grouping on page 1029
GSAVE: Session subcommand for saving a graph in a file on page 38
GSCALE: Session command to determine appropriate scaling for a graph on page 1127
GSUMMARY: Session command for displaying a graphical summary of each variable on page 146
GZLM: Session command for fitting a binary logistic model or a Poisson model on page 199
H

HISTOGRAM: Session command for creating a histogram on page 958

HLABEL: Session subcommand for labeling histogram bars on a marginal plot with y-axis values on page 1030
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HLINE: Session subcommand for specifying attributes for historical stage lines on page 1032

ICHART: Session command for creating an | chart on page 490

IDIDENTIFICATION: Session command for creating probability plots of arbitrarily-censored, failure (or survival) data
on page 718

IDOVIEW: Session command for creating a layout of distribution plots on page 720

IF, ELSEIF, ELSE, ENDIF: Session commands for executing code depending on a logical condition on page 1115
ILABEL: Session subcommand for labeling individual values on a boxplot or interval plot on page 1033
IMRCHART: Session command for creating an I-MR chart on page 479

INCLUDE and EXCLUDE: Session subcommands for including or excluding rows on a graph on page 1036
INDICATOR: Session command for creating indicator variables on page 85

INDIVIDUAL: Session subcommand for displaying a symbol for each individual data value on a boxplot or an
individual value plot on page 1036

INDPLOT: Session command for creating an individual value plot on page 980
INFO: Session command for summarizing the current worksheet on page 106

INTBAR: Session subcommand for displaying a vertical line with horizontal lines at the endpoints of the confidence
interval for the mean on page 1037

INTERACT: Session command for creating an interactions plot on page 254

INTLAB: Session subcommand for labeling interval bar endpoints on an interval plot on page 1039
INTPLOT: Session command for creating an interval plot on page 250

INVCDF: Session command for calculating the variable for a cumulative probability on page 94
INVERT: Session command for replacing a matrix value with its inverse on page 105

IQRBOX: Session subcommand for displaying an interquartile range box on a boxplot on page 1041

ITEMANALYSIS: Session command for performing item analysis on page 854

J
JITTER and NOJITTER: Session subcommands for randomly offsetting data points to reveal overlapping points on
page 1043
JOHNSON: Session command for applying the Johnson transformation on page 596

K

KKCAT, KKNAME, and KKSET: Session commands for using text on page 1112
KMEANS: Session command for non-hierarchical clustering of observations on page 851

KRUSKAL-WALLIS: Session command for performing a Kruskal-Wallis test on page 911
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LAG: Session command for calculating the lags of a column on page 63
LAYOUT and ENDLAYOUT: Session subcommands for specifying where a graph appears on a page on page 1043

LBRIGHT: Session subcommand for specifying the brightness of the lights that illuminate a surface plot on page
1044

LEGEND and NOLEGEND: Session subcommands for controlling the legend on a graph on page 1045
LET: Session command for correcting a number in a worksheet or performing arithmetic on page 63

LIGHT: Session subcommand for specifying the position, color, and visibility of the lights that illuminate a surface
plot on page 1047

LINE: The session subcommand for constructing a line from points on a graph on page 1048
LNGAGE: Session command for performing a gage linearity and bias study on page 673
LONGMETHOD: Session command for performing an attribute gage study (analytic method) on page 684

LOWESS: Session subcommand for fitting a LOWESS smoother to a scatterplot, a matrix plot, a histogram, or a time
series plot on page 1049

LPLOT: Session command for creating a line plot on page 983

LREGRESSION: Session command for performing a regression analysis when the error distribution is Weibull, smallest
extreme value, exponential, log-normal, normal, logistic, or log-logistic on page 735

LTABLE: Session command for fitting a distribution to arbitrarily-censored data on page 722

LTEST: Session command for parametric or nonparametric distribution analysis on page 709

MA: Session command for calculating a moving average on page 882
MACHART: Session command for creating a moving average chart on page 536

MACRO, ENDMACRO, and GMACRO: Session commands for marking the beginning and ending of a macro on
page 1109

MAIN: Session command for creating a main effects plot on page 253

MANN-WHITNEY: Session command for performing a Mann-Whitney test on page 910

MANOVA: Session command for performing a general MANOVA on page 244

MARGPLOT: Session command for creating a marginal plot on page 957

MARKER: Session subcommand for displaying a symbol at specified points on a graph on page 1050
MATRIXPLOT: Session command for creating a matrix of plots on page 952

MCA: Session command for performing a multiple correspondence analysis on page 859

MCAPA: Session command for performing a normal capability analysis for multiple variables on page 626
MCONSTANT, MCOLUMN, MMATRIX, and MTYPE: Session commands for declaring variables on page 1109
MDESIGN: Session command to modify the design properties or display of a design in the worksheet on page 420
MEALAB: Session subcommand for labeling means on a boxplot or an interval plot on page 1051

MEAN: Session command for calculating the arithmetic mean of a column on page 76
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MEAN: Session subcommand for displaying symbol for each mean on a boxplot, interval plot, or individual value
plot on page 1053

MEDIAN: Session command for identifying the median of a column on page 76

MEDIAN: Session subcommand for displaying a symbol for each median on a boxplot, interval plot, or individual
value plot on page 1054

MEDLAB: Session subcommand for labeling medians on a boxplot on page 1055

MERGE: Session command for merging two worksheets into one worksheet on page 106

MESH: Session command for making mesh data on page 84

MEWMA: Session command for creating a multivariate EWMA chart on page 577

MFFCUBE: Session command for creating a cube plot for fitted means on page 335

MFREE: Session command for declaring a free variable on page 1110

MGAGE: Session command for performing an expanded gage R&R study on page 670

MGRID, GRID, NOGRID, and NOMGRID: Session subcommands for controlling the grid on a graph on page 1029

MIDPOINT, CUTPOINT, and NINTERVAL: Session subcommands for specifying cutpoints and midpoints on page
1014

MIXCONTOUR: Session command for creating a contour plot on page 391

MIXOVER: Session command for creating an overlaid contour plot on page 399

MIXREG: Session command for analyzing a mixture design on page 375

MIXSURFACE: Session command for creating a surface plot on page 397

MLABEL and GOTO: Session commands for branching to any line in a macro on page 1118

MLAG: Session command to calculate lags of one or more columns on page 881

MMATRIX, MCONSTANT, MCOLUMN, and MTYPE: Session commands for declaring variables on page 1109
MMOPT: Session command for the Response Optimizer on page 1095

MNCAPA: Session command for performing nonnormal capability analysis for multiple variables on page 636
MOOD: Session command for performing a Mood's median test on page 911

MOVERCONT: Session command for creating an overlaid contour plot on page 1098

MRCHART: Session command for creating an MR chart on page 497

MROPT: Session command for the Response Optimizer on page 409

MSURFACE: Session command for creating a surface plot on page 1099

MTITLE: Session command for adding a title above output on page 1121

MTYPE, MMATRIX, MCONSTANT, and MCOLUMN: Session commands for declaring variables on page 1109
MULTIPLY: Session command for multiplication on page 75

MVARCHART: Session command for creating a multi-vari chart on page 427

N: Session command for counting the nonmissing values in a column on page 76
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NESTED: Session command for performing a fully-nested ANOVA on page 248
NEXT: Session command for transferring control from a loop to the beginning of the block on page 1117

NGROWTH: Session command for performing a nonparametric analysis using a nonparametric growth curve on
page 732

NINTERVAL, CUTPOINT, and MIDPOINT: Session subcommands for specifying cutpoints and midpoints on page
1014

NLINEAR: Session command for performing nonlinear regression on page 188

NLOGISTIC: Session command for performing nominal logistic regression on page 216

NMISS: Session command for counting the missing values in a column on page 76
NMVARCHART: Session command for creating variability charts on page 427

NNCAPA: Session command for performing a nonnormal capability analysis on page 612
NNSIXPACK: Session command for Nonnormal Capability Sixpack on page 651

NNTINTERVALS: Session command for calculating tolerance intervals on page 664

NOBRUSH: Session subcommand for disabling brushing on a graph on page 1128

NODEBUG and DEBUG: Session commands for finding problems in macros on page 1124
NODOTFOOTNOTE: Session subcommand for suppressing footnotes on a dotplot on page 1057

NODTITLE, NODSUBTITLE, and NODFOOTNOTE: Session subcommands for suppressing titles, subtitles, and footnotes
on a graph on page 1057

NOECHO and ECHO: Session commands for displaying Minitab commands in the output on page 1123
NOEMPTY and NOMISS: Session subcommands for excluding missing data from graphs on page 1057
NOFRAME: Session subcommand for suppressing lines and labels on a graph on page 1057

NOGRID, GRID, MGRID, and NOMGRID: Session subcommands for controlling the grid on a graph on page 1029
NOHLEGEND: Session subcommand for suppressing the legend of hold values on a graph on page 1058

NOJITTER and JITTER: Session subcommands for randomly offsetting data points to reveal overlapping points on
page 1043

NOLEGEND and LEGEND Session subcommands for controlling the legend on a graph on page 1045

NOMGRID GRID, MGRID, and NOGRID, and: Session subcommands for controlling the grid on a graph on page
1029

NOMISS and NOEMPTY: Session subcommands for excluding missing data from graphs on page 1057
NOOUTFILE and OUTFILE: Session commands for saving a Minitab session in a text file on page 40
NOPERFOOTNOTE: Session subcommand for suppressing My Footnote on page 1058

NOPROPORTIONAL and PROPORTIONAL: Session subcommands for making the boxes on a boxplot proportional
to the square root of the number of observations in the boxes on page 1066

NORMTEST: Session command for performing a normality test on page 163
NOSEPSUBTITLE: Session subcommand for subtitles on separate graphs on page 1058
NOTABLE and TABLE: Session subcommand for controlling the table within the figure region on page 1085

NOTE: Session command for adding comments that are displayed in the output on page 1129
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NOTRANSPOSE and TRANSPOSE: Session subcommands for transposing the x- and y-axis on a graph on page 1091
NPCHART: Session command for creating a chart for the number of defectives on page 514
NTGAGE: Session command for performing a nested gage R&R study on page 680

NUMERIC: Session command for changing the data format of a date/time column or extracting date/time components
on page 123

OADESIGN: Session command for creating a Taguchi orthogonal array design on page 412
OAPREDICT: Session command for calculating predicted response values on page 418

ODBC: Session command for importing data from a database file on page 39

OLAB: Session subcommand for labeling outliers on a boxplot on page 1058

OLOGISTIC: Session command for performing ordinal logistic regression on page 213

ONERATE: Session command for performing a 1-sample Poisson rate test on page 155

ONERATE: Session subcommand for power and sample size for a 1-sample Poisson rate test on page 921
ONET: Session command for performing a 1-sample t-test on page 148

ONEV: Session command for performing a 1 variance test on page 157

ONEVARIANCE: Session command for power and sample size for a 1 variance test on page 923
ONEWAY: Session command for power and sample size for one-way ANOVA on page 924
ONEWAY: Session command for power and sample size for one-way ANOVA on page 924

ONEZ: Session command for performing a 1-sample Z-test on page 147

OPTDES: Session command for selecting an optimal design on page 361

OREG: Session command for performing orthogonal regression on page 192

OUTFILE and NOOUTFILE: Session commands for saving a Minitab session in a text file on page 40
OUTLIER: Session command for performing an outlier test on page 165

OUTLIER: Session subcommand for displaying a symbol for each outlier on a boxplot on page 1060

OVERLAY: Session subcommand for combining graphs specified in a multiple graph command into a single graph
on page 1061

PACF: Session command for calculating partial autocorrelation on page 886

PAIR: Session command for performing a paired t-test on page 151

PANEL: Session subcommand for paneling graphs on page 1061

PARETO: Session command for creating a Pareto chart on page 428

PAUSE and RESUME: Session commands for pausing and resuming a macro on page 1121
PBDESIGN: Session command for creating a Plackett-Burman design on page 258

PBDESIGN: Session subcommand for power and sample size for Plackett-Burman design on page 925
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PCA: Session command for performing principal components analysis on page 841

PCAPA: Session command for performing a Poisson capability analysis on page 659

PCHART: Session command for creating a P chart on page 503

PDF: Session command for calculating the probability distribution of a continuous random variable on page 89
PDIAGNOSTIC: Session command for determining whether to use a P chart or a Laney P' chart on page 502

PGOODNESS: Session command for performing a chi-square goodness-of-fit test for Poisson distribution on page
166

PGROWTH: Session command for performing a parametric analysis using a parametric growth curve on page 729
PIECHART: Session command for creating a pie chart on page 985

PLOT: Session command for creating a scatterplot on page 947

PLS: Session command for performing partial least squares regression on page 194

PLTX: Session command for creating a 3D scatterplot on page 995

POLYGON: Session subcommand for constructing a polygon from points on a graph on page 1063

PONE: Session command for performing a hypothesis test of the proportion on page 152

PONE: Session subcommand for power and sample size for a 1 proportion test on page 926

POWER: Session command for power and sample size on page 927

PPLOT: Session command for creating a probability plot on page 963

PPRIMECHART: Session command for creating a Laney P' chart on page 509

PREDICT: Session command for predicting response values on page 1101

PRINT: Session command for displaying columns, constants, or matrices in the output pane on page 40
PROBIT: Session command for performing probit analysis on page 750

PROJECT: Session subcommand for extending projection lines from each point to the x-axis on page 1064

PROPORTIONAL and NOPROPORTIONAL: Session subcommands for making the boxes on a boxplot proportional
to the square root of the number of observations in the boxes on page 1066

PTILES: Session subcommand for specifying the location of the percentile lines on a graph on page 1066
PTWO: Session command for performing a hypothesis test of the difference between two proportions on page 154
PTWO: Session subcommand for power and sample size for a 2 proportion test on page 929

PYSC: Session command for running a Python script on page 54

RANDOM: Session command for generating random data on page 87
RANGE: Session command for calculating a range of values in a column on page 77
RANK: Session command for ranking values in a column on page 110
RBOX: Session subcommand for displaying a range box on a boxplot on page 1070

RCHART: Session command for creating an R chart on page 461
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RCOUNT: Session command for counting missing and nonmissing values in a row on page 77
RDIDENTIFICATION: Session command for creating a distribution ID plot on page 703

RDOVIEW: Session command for creating a layout of distribution plots on page 706

READ data into columns on page 41

READ data into a matrix on page 43

READ, TSET, and SET: Session command for asking users questions and using the answers in a macro on page 1128
RECTANGLE: Session subcommand for constructing a rectangle from points on a graph on page 1072
REFERENCE: Session subcommand for specifying the axis and location of reference lines on a graph on page 1073
REGRESS: Session command for performing a regression analysis on page 169

REGRESS: Session subcommand for fitting a regression line to data on a graph on page 1075
RESTART: Session command for restarting on page 43

RESUME and PAUSE: Session commands for pausing and resuming a macro on page 1121

RETRIEVE: Session command for retrieving a saved worksheet or project on page 44

RETURN and CALL: Session commands for passing control to another macro on page 1119
RFORMULA: Session command for removing formulas on page 137

RMAXIMUM: Session command for identifying the maximum value in each row on page 77
RMCONTOUR: Session command for creating a contour plot on page 1107

RMEAN: Session command for calculating the arithmetic mean in each row on page 78

RMEDIAN: Session command for identifying the median in each row on page 78

RMERGE: Session command for merging worksheets on page 131

RMINIMUM: Session command for identifying the minimum value in each row on page 78

RN: The session command for counting the nonmissing values in a row on page 78

RNGAGE: Session command for creating gage run chart on page 669

RNMISS: Session command for counting the missing values in a row on page 78

RNMN: Session command for performing a 1-sample randomization test of a mean on page 100
RNPR: Session command for performing a 1-sample randomization test of a proportion on page 101
RNTM: Session command for performing a 2-sample randomization test of means on page 102
ROBUST: Session command for analyzing a Taguchi design on page 414

ROWTOC: Session command for stacking multiple columns into one column on page 113

RRANGE: Session command for calculating the range in each row on page 79

RSCR: Session command for running a R script on page 54

RSREG: Session command for analyzing a response surface design with least squares regression on page 346
RSSQ: Session command for calculating the uncorrected sum of squares on page 79

RSTDEV: Session command for calculating the standard deviation in each row on page 79
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RSUM: Session command for adding the values in each row on page 79

RTPREDICT: Session command for predicting responses for new observations for a regression tree on page 763
RTREE: Session command for creating a regression tree on page 758

RUNCHART: Session command for creating a run chart on page 430

RUNS: Session command for performing a runs test on page 911

SAME: Session subcommand for specifying that one or more axes are the same for multiple graphs on page 1076
SAMPLE: Session command for generating rows of random data from specified columns on page 89

SAVE: Session command for saving a worksheet or project on page 44

SCALE: Session subcommand for customizing the axes and ticks of a graph on page 1076

SCDESIGN: Session command for creating a simplex centroid design on page 369

SCHART: Session command for creating an S chart on page 467

SCREEN: Session command for analyzing a screening design on page 260

SEPARATE: Session subcommand for placing groups in separate graphs when you use a paneling variable on page
1079

SES: Session command for performing single exponential smoothing on page 887

SET: Session command for entering data into a column on page 80

SFIT: Session subcommand for specifying the attributes of the surface on a 3D surface plot on page 1079
SHELFLIFE: Session command for performing a stability study on page 183

SIMPLEX: Session command for creating a simplex design plot on page 383

%SIMPROC: Session command for creating a simplex plot on page 388

SINTERVAL: Session command for calculating a sign confidence interval on page 909
SIXPACK: Session command for Normal Capability Sixpack on page 646

SLABEL: Session subcommand for labeling the slices on a pie chart on page 1080

SLDESIGN: Session command for creating a mixture design on page 372

SLICE: Session subcommand for specifying the attributes of slices on a pie chart on page 1081
SOFFSET: Session subcommand for offsetting points from the center on page 1082

SORT: Session command for sorting columns on page 108

SPCONT: Session command for creating a contour design plot on page 394

SPDESIGN: Session command for creating a 2-level split-plot design on page 284
SPFACTORIAL: Session command for analyzing a 2-level split-plot design on page 321

SPLIT: Session command for splitting a worksheet into multiple worksheets on page 112
SPSIMP: Session command for creating a simplex design plot on page 385

SSCI: Session command for estimating sample size on page 930
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SSQ: Session command for calculating the uncorrected sum of squares on page 77

SSTI: Session command for sample size for tolerance intervals on page 931

SSWORKSHEET: Session command for creating a stability study worksheet on page 182

STACK: Session command for stacking blocks of columns and constants on top of each other on page 126
STAMP: Session subcommand for specifying columns that contain time values for observations on page 1083
STATS: Session command for storing descriptive statistics on page 143

STDEV: Session command for calculating the standard deviation of all the values in a column on page 77
STEM-AND-LEAF: Session command for creating a stem-and-leaf plot on page 963

STEST: Session command for performing a 1-sample sign test on page 909

STOP: Session command for closing Minitab on page 45

SUBSET: Session command for copying specified rows to a new worksheet on page 114

SUBTITLE: Session subcommand for adding a subtitle to a graph on page 1083

SUM: Session command for adding the values in a column on page 77

SURFACEPLOT: Session command for creating a surface plot on page 996

SYMBOL: Session subcommand for displaying a symbol for each data value on page 1084

SYMPLOT: Session command for creating a symmetry plot on page 432

TABLE and NOTABLE: Session subcommand for controlling the table within the figure region on page 1085

TABLE: Session command for creating one-way, two-way, and multi-way tables using categorical variables on page
901

TALLY: Session command for displaying a one-way table for each column on page 903
TCHART: Session command for creating a T chart on page 587

TCHISQUARE: Session command for performing a chi-square goodness-of-fit test on page 904
TEXT: Session command for changing the data type of a column to text on page 124
TEXT: Session subcommand for displaying text on a graph on page 1088

TITLE: Session subcommand for adding a title to a graph on page 1089

TOGAGE: Session command for performing a Type 1 gage study on page 666
TOLINTERVALS: Session command for calculating tolerance intervals on page 662

TONE: Session command for power and sample size for a 1-sample t-test on page 933
TOST: Session command for performing an equivalence test on page 914

TOST: Session command for power and sample size for an equivalence test on page 934
TPAIRED: Session subcommand for power and sample size for a paired t-test on page 935
TRACE: Session command for creating a response trace plot on page 389

TRANSPOSE and NOTRANSPOSE: Session subcommands for transposing the x- and y-axis on a graph on page 1091
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TRANSPOSE: Session command for changing rows to columns, and columns to rows on page 105
TREND: Session command for performing a trend analysis on page 892

TSET: Session command for creating data that follow complicated patterns on page 81

TSGV: Session command for creating a Tsquared-generalized variance chart on page 562

TSHOW: Session subcommand for specifying the level of tick labels that are displayed on page 1091
TSPLOT: Session command for creating a time series plot on page 987

TSQUARED: Session command for creating a Tsquared chart on page 567

TSWINT: Session command for performing Holt-Winters seasonal exponential smoothing on page 896
TTWO: Session subcommand for power and sample size for a 2-sample t-test on page 936

TWORATE: Session command for performing a 2-sample Poisson rate test on page 156

TWORATE: Session subcommand for power and sample size for a 2-sample Poisson rate test on page 938

TWOSAMPLE: Session command for performing a 2-sample t-test when the samples are in different columns on
page 150

TWOT: Session command for performing a 2-sample t-test when samples are in one column on page 149

TWOVARIANCES: Session command for determining whether the variances or standard deviations of two groups
differ on page 158

TWOVARIANCE: Session subcommand for power and sample size for a 2 variances test on page 939

U
UCHART: Session command for creating a U chart on page 525
UDIAGNOSTIC: Session command for determining whether to use a U chart or a Laney U' chart on page 530
UNSTACK: Session command for separating a column into multiple columns on page 127
UPRIMECHART: Session command for creating a Laney U' chart on page 519
V

VARTEST: Session command for performing an equal variances test on page 249

VASAMPLING: Session command for creating or comparing variables acceptance plans on page 691

VASPECT: Session subcommand for specifying the aspect ratio of the data box on page 1091

VBOX: Session subcommand for specifying the display of the box that surrounds the data on a graph on page 1092
VFACTORIAL: Session command for analyzing variability in a 2-level factorial design on page 327

VFIELD: Session subcommand for specifying the dimensions of the field of view in object units on page 1092
VMASK: Session command for creating a two-sided CUSUM chart on page 556

VORDER: Session command for controlling the order for text categories to be processed by Minitab commands
on page 137

VPOSITION: Session subcommand for specifying the view position as a ratio on page 1092

VPREPROCESS: Session command to preprocess responses for analyze variability on page 326
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VUP: Session subcommand for specifying which direction is up in relation to the data box on page 1092

W
WALSH: Session command for calculating pairwise averages on page 912
WODIFF: Session command for calculating pairwise differences on page 912

WHILE and ENDWHILE: Session commands for repeating a block of commands depending on a logical expression
on page 1116

WHISKER: Session subcommand for controlling the display of whiskers on a boxplot on page 1093
WINTERVAL: Session command for calculating a Wilcoxon confidence interval on page 910
WOPEN: Session command for opening a worksheet on page 45

WORKSHEET: Session command for making a worksheet active, for closing a worksheet, or for renaming a worksheet
on page 48

WPREDICTIONS: Session command for performing warranty predictions on page 755
WRITE: Session command for writing data to the screen or a data file on page 49
WSAVE: Session command for saving a worksheet file on page 51

WSLOPE: Session command for calculating pairwise slopes on page 912

WSTACK: Session command for stacking worksheets on page 128

WTEST: Session command for performing a 1-sample Wilcoxon test on page 909

WTITLE: Session subcommand for specifying the title of the output pane on page 1093

XBARCHART: Session command for creating an Xbar chart on page 454

XDACTIVATE: Session command for activating a link on page 57

XDADD: Session command for adding a new link on page 57

XDDEACTIVATE: Session command for deactivating a client link on page 59

XDEXEC: Session command for executing a command in a remote application on page 60
XDGET: Session command for performing a one-time data transfer on page 60
XDREMOVE: Session command for deleting an established link on page 61

XPPOINT: Session command for sending output to Microsoft PowerPoint on page 53
XRCHART: Session command for creating an Xbar-R chart on page 433

XSCHART: Session command for creating an Xbar-S chart on page 439

XTABS: Session command for displaying one-way, two-way, and multi-way tables for categorical variables on page
905

XWORD: Session command for sending output to Microsoft Word on page 53

ZMRCHART: Session command for creating a Z-MR chart on page 485
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ZONE: Session command for creating a zone chart on page 473

ZONE: Session subcommand for power and sample size for a 1-sample Z-test on page 940

What are session commands?

Session commands are a command language that you use, instead of the menus and interface, to access most functions
in Minitab. Session commands are especially useful in macros.

You can type session commands in the Command Line pane.

Session command syntax notation

Generally, the syntax of a command includes the command name, and then one or more arguments upon which the
command operates.

Usually a command operates on one or more arguments (also called parameters) that you specify; they can be columns,
constants, matrices, numbers, file names, or text strings. For example, "C1" is the argument in the following command,
which tells Minitab to draw a histogram of the data in column C1:

HISTOGRAM C1

Minitab Help uses the following typographical conventions for describing the syntax of individual commands.

K
Denotes a constant such as 8.3 or K14.
C
Denotes a column such as C13 or 'Height'.
C..C
Denotes a list of one or more columns separated by spaces.
M
Denotes a matrix such as M5.
E

Denotes either a constant or column, and sometimes a matrix.

[1

Denotes an optional argument, for example [K1].

Symbols to use with session commands

Use the following symbols with any session commands or subcommands.

Comment symbol (#)
Place the comment symbol # anywhere on the line to tell Minitab to ignore the rest of the line. For example:
DESCRIBE Cl1 #This is a comment
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Missing value symbol (*)
Place the missing values symbol * anywhere a number would normally interact, to represent values that could be
missing. The asterisk should be enclosed in single quotation marks ('**'). You could use the following command
to copy data from one column to another, omitting rows that have missing values:

COPY C1 C2;
OMIT Cl1 = '*',

Using a subcommand

Many session commands have subcommands. To use a subcommand, complete the following steps.
Note When you use a command with no subcommands, you do not have to type any punctuation mark after the command line.

1. Type the main command and end the main command line with a semicolon (;).
2. Press Enter to move to the next line.
3. Type as many subcommands as you need, ending each with a semicolon (;) and pressing Enter after each.
4. End the last subcommand with a period (.).
If you forget to end the last subcommand with a period, you can type the period all by itself on the next line.

Using session commands in the Command Line
pane and the History pane

Sometimes, it is convenient to copy a previously executed session command (or sequence of session commands) from
the Command Line pane or the History pane, make minor changes if necessary, then execute the changed command(s).

Use the Command Line pane to type, edit, and enter commands.

The Command Line pane and the History pane can be viewed together, docked on the right side of the application
frame. If the Command Line pane and the History pane are not visible, then do one of the following:

e Choose View > Command Line/History.

e Use Ctrl+K shortcut to open the Command Line/History panes.
Note If the panes are already in view, Ctrl+K puts focus into the Command Line pane, but will not toggle the pane closed.

Executing session commands in the Command Line pane

There are several ways to enter command language into the Command Line pane. For instance, you can:

e Type the commands and subcommands directly into the pane. Use the Enter key to go to the next line. For
information on arguments, go to Session command syntax notation on page 27 or Using a subcommand on page
28.

e Highlight the commands in the History pane and either copy and paste to the Command Line pane, or click Copy
to Command Line.

e Paste text from other applications.

Press Run to execute the command language.
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Using the History pane

The History pane provides a convenient list of the commands that you have used in your project.

You can select commands and subcommands as list items and can multi select both contiguous and non-contiguous
items in the list. Selected items can be copied to clipboard or dragged to the Command Line pane. When pasted into
the Command Line pane, you can edit the command language before running it.

You can also create a Minitab macro file for a routine analysis by first working through the steps using the menus,
highlighting portions of session commands, and saving them as a macro or text file type.

Print the contents of the History pane

You can print the contents of the History pane. Right-click the selected text, then choose Print History.

Save the contents of the History pane

You can save the contents of the History pane in a text file. Right-click the selected text, then choose Save History
As. Choose your file name and file type.

Rules for entering session command arguments

Arguments specify data characteristics, such as location or titles. They can be variables (columns, constants, matrices)
as well as text strings or numbers. For information on argument notation, go to Session command syntax notation on
page 27.

Variables

e Enclose variable names in single quotation marks (for example, HISTOGRAM 'Salary'). Certain commands, such as
ANOVA, GLM, and the high-resolution graphics commands do not require quotation marks, but all commands
work properly when quotes are used.

e |n arguments, variable names and variable numbers can be used interchangeably. For example, the two following
commands do the same thing (if C1 is named 'Sales'):

DESCRIBE C1 C2
DESCRIBE 'Sales' C2

e You can abbreviate a consecutive range of columns, stored constants, or matrices with a dash. For example, PRINT
C2-C5 is equivalent to PRINT C2 C3 C4 C5.

e You can use a stored constant (such as K20) in place of any constant. You can even use stored constants to form
a range such as K20:15, which represents all integers from the value of K20 to 15.

Text strings

Enclose text strings, such as labels or file names, in double quotes (for example, TITLE "This is My Title"). In earlier
versions of Minitab, text was enclosed in single quotes. Although this still works, it is no longer recommended, and
can cause a conflict with column and constant names.

Numbers

e Do not enclose numbers in quotes unless you want the numbers to appear as text.
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e To specify a range of numbers, abbreviate the sequence using these conventions:
1:4 expandsto 1234

4:1 expandsto 4321
1:3/.5 expands to 1.0 1.52.0 2.5 3.0

The session command SET on page 80 includes additional abbreviation conventions.

Rules for entering session commands

A session command consists of one main command, and may have one or more subcommands. Arguments and
symbols may also be included in the command.

e Subcommands, which further define how the main command should be carried out, are optional unless otherwise
specified.

e Arguments, which specify data characteristics, may be included one or more times for both the main command
and subcommands.

e Symbols, which assist in controlling the session language, can also be included in session commands.

e Commands and column names are not case-sensitive. You can type them in lowercase, uppercase, or any combination.

e You can abbreviate any session command or subcommand by using the first four letters.

e Enter only one command or subcommand per line.

e Close all but the last line of a command with semicolons. Close the last line with a period.

® Some subcommands have their own subcommands. The order in which you give these subcommands determines
what subcommand or command they modify. You can use many subcommands more than once in a command.

Note Some commands, called %macros, are macros that are invoked by typing % followed by the full macro name (you cannot abbreviate
macro names).

Interrupting session command execution

To interrupt the display of data from a command or the execution of a macro, type Ctrl+Break. In a macro, Minitab
finishes executing the current command, then exits the macro. Display of data is halted as soon as possible.

Updates for release 19.1

The following section includes the session commands that are new, changed or obsolete for Minitab 19.

Input and history

In Minitab 19.1, choose View > Command Line/History to open the Command Line pane and the History pane. In
the Command Line pane, enter session commands and run macros. Use the History pane to see session commands
that ran and to copy those session commands.
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Obsolete continuation character (&)

In previous versions the & symbol indicated that a command continued on the next line, for example:

PLS C18 = C1-C17 cl*c2 cl*c3 cl*cd cl*c5 cl*c6 cl*c7 cl*c8 cl*c9 cl*cl0 cl*cllé&
cl*cl2 cl*cl3 cl*cld cl*cl5 cl*cle cl*cl7;

In Minitab 19.1, session commands with an & symbol create errors. Instead, type everything on 1 line.

PLS C18 = C1-C17 cl*c2 cl*c3 cl*cd4 cl*c5 cl*c6 cl*c7 cl*c8 cl*c9 cl*cl0 cl*cll cl*cl2
cl*cl3 cl*cld4 cl*cl5 cl*cl6e cl*cl7;

Adding comments and notes

In Minitab 19.1, each instance of the NOTE command creates a new output tab. To keep different notes together,
surround all of the notes and output that you want on one output tab with MTITLE and ENDMTITLE.

New commands

Resampling commands

BTFT
Bootstrapping for 1-sample function

BTPR
Bootstrapping for 1 proportion

BTTM
Bootstrapping for 2-sample means

RNMN
Randomization test for 1-sample mean

RNPR
Randomization test for 1-sample proportion

RNTM
Randomization test for 2-sample means

Design of experiments

BFFA
Analyze a binary response variable for a 2-level factorial design.

BGFA
Analyze a binary response variable for a general full factorial design.

BRSREG
Analyze a binary response variable for a response surface design.

BSCREEN
Analyze a binary response variable for a screening design.
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MDESIGN
Modify a design that is in the worksheet.

VPREPROCESS
Pre-process responses for analyzing the variability of repeat or replicate measurements for a factorial design.

Obsolete commands

CONSTANT/NOCONSTANT
Use subcommands to for an individual analysis to control the estimation of the constant term.

DIR
List the names of files in a directory.

GPAUSE
Specify the number of graphs to display before you are prompted to save or discard open graphs. In Minitab
19.1, the number of graphs does not have a fixed limit.

GPRINT
Print a graph window. In Minitab 19.1, all output is in tabs instead of windows.

GVIEW
Open a .MGF format image. Minitab does not save images in this format anymore.

INSERT
Insert rows of data into the worksheet. Consider WOPEN and READ.

Iw
Set the maximum width for input to the session window. Minitab 19.1 does not limit the input width in the
Command pane.

JOURNAL/NOJOURNAL
Save session window lines to a text file. In Minitab 19.1, save the History pane.

MRESET
Restore environment settings to pre-macro conditions. In Minitab 19.1, restoration occurs at the end of every
macro.

oW
Set the width of output in the session window. In Minitab 19.1, the output pane does not have a fixed width by
number of characters.

PLUG/NOPLUG
Respond to errors from the macro processor. In Minitab 19.1, the macro processor stops when it encounters an
error.

TITLE/NOTITLE
Display a title above session window output. In Minitab 19.1, use MTITLE/ENDMTITLE to add a title for an output
tab and to group output on a single output tab.
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Changes to subcommands

Opening and saving files

READ
The FORMAT subcommand does not use the T format.

RETRIEVE
The PORTABLE subcommand is obsolete. MTP format files are not compatible with Minitab 19.1.

The REPLACE/NOREPLACE subcommands are obsolete. If you save a file with the same filename, Minitab overwrites
the file.

The GRAPH does not support the parameter MGF. Minitab no longer saves images in this format.
The PROJECT subcommand saves the project in the MPX format. The subsubcommand PASSWORD specifies a
password that protects the file.

SAVE

The RELEASE subcommand accepts only 19 as a value. The tabbed output and other changes cannot be saved
to an earlier version of Minitab.

The REPLACE/NOREPLACE subcommands are obsolete. If you save a file with the same filename, Minitab overwrites
the file.

The GRAPH does not support the parameter MGF. Minitab does not save images in this format anymore.

The PROJECT subcommand saves the project in the MPX format. The subsubcommand PASSWORD specifies a
password that protects the file.

Analysis of linear models

NLOG

OLOG
The TOLERANCE subcommand uses 1 parameter. Minitab uses the same value for all tolerances.

REGRESSION
The GPARETO subcommand makes a Pareto chart of the effects.

Changes to correlation

CORRELATION
The NOPVALUES subcommand is obsolete. P-values are in the new pairwise correlation table.

The following subcommands control the amount of output:
e TMETHOD

¢ TCORRELATION

® TPCORRELATION

e NODEFAULT

® GMPLOT

The following subcommands are for storage:
® SCORRELATION
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® SCIS

The CONFIDENCE subcommand sets the confidence level for confidence intervals.

New subcommands

Creation of designed experiments

BBDESIGN
CCDESIGN
EVDESIGN
FDESIGN
FFDESIGN
MIXREG
OADESIGN
OPTDES
PBDESIGN
SCDESIGN
SLDESIGN

SPDESIGN

The DESIGN subcommand stores the design columns in the worksheet. The new subcommand replaces
subcommands that required individual specification.

OPTDES

The COPY subcommand moves columns that are not part of the design, such as COVARIATES, to the new worksheet
where you store rows for an optimal design.

ROBUST
The DOE subcommand stores the model information in a Minitab design object.
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Analysis of linear models

FFAC

GFAC

GLM

GZLM
REGRESS
RSREGRESS
SCREEN

VFAC
The FINFORMATION subcommand specifies forward stepwise selection with information criterion.

Capability analysis

BWCAPA
CAPA

MCAPA
The UCPM and LCPM subcommands store one-sided confidence limits of the Cpm statistic.

The ONECI sub-subcommand to the CONFIDENCE subcommand specifies one-sided confidence intervals for the
capability metrics.

The PPM subcommand replaces the percentage calculations with parts per million (PPM).

Changes to subcommands

FORMAT
The FORMAT subcommand, for commands such as READ, does not use the T format.

GSAVE
e REPLACE is obsolete.

e NOREPLACE is obsolete.

RELEASE
The RELEASE subcommand to SAVE accepts values of 19 or higher.

WOPEN
Changes to the subsubcommands of the subcommand FTYPE:

e XILSXis new.
e REPLACE is obsolete.

e NOREPLACE is obsolete.
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WSAVE

Changes to the subsubcommands of the subcommand FTPYE:

e MINITAB accepts values of 19 or higher.

e XILSXis new.

e USTEXT is new.

e [BCSVis new.

e REPLACE is obsolete.

e NOREPLACE is obsolete.

e WEBPAGE is obsolete.

Obsolete subcommands

FNUMERIC

The subsubcommand CULTURE to the subcommand CURRENCY is obsolete.

READ

The subcommand TAB is obsolete. Use WOPEN instead of READ to open tab-delimited data.

WSAVE

REPLACE and NOREPLACE are obsolete. If you save with the same filename, Minitab overwrites the file.

Commands that are unavailable in the web app

The following commands are not currently supported in exec or macro files in the Minitab web app:

Command
CcDh
EXEC
EXIT
GSAVE
MYME
NEW
NOOU
ODBC
OUTF
ow
PAUS
PROF
PYSC
QUIT

Minitab B’

Description

Display current directory or change current directory to another path
Run a MTB file

In macros, transfer control back to interactive Minitab; in execs, exit Minitab
Save a graph file

Invoke commands specified on customized My Menu

Create new project

Stop writing output to an open/active text file

Import data from a database file

Save output to a text file

Set character width of output

Shift control to keyboard for interactive user input

Change profile

Python script command

Exit Minitab

Using Session Commands
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Command
READ; FILE
REST

RESU
RETR
TSET; FILE
SAVE

SET; FILE
STOP
WOPE
WSAV
WRITE; FILE
XPPO
XWOR

Minitab B’

Description

Import data from a text file into a worksheet (READ is allowed without FILE)
Restart Minitab

Resume macro execution from interactive keyboard entry

Retrieve a project file in local macros

Import data from a text file (TSET is allowed without FILE)

Save a project file in local macros

Import data from an ASCII file (SET is allowed without FILE)

Exit Minitab

Open worksheet

Save worksheet

Writes data in the specified columns or constants to a data file (WRITE is allowed without FILE)
Send output to Microsoft® PowerPoint

Send output to Microsoft® Word
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Opening, Saving, and Printing Files

END: Session command for ending data input

END
Ends data input.

Type END following the last data line typed after READ (for information, go to READ data into a matrix on page
43 or READ data into columns on page 41), or SET on page 80. This ensures that any diagnostic messages
concerning data lines will be printed before the next operation is carried out.

GSAVE: Session subcommand for saving a graph in
a file

GSAVE "file name"

GSAVE K
Saves the graph in a file.

The default file name is Minitab.PNG. You can specify a custom file name in double quotation marks ("file_name"),
or as a stored text constant (K). You can also use any of the following subcommands to save the graph in a different
graphics format.

Some graph commands—for example, HISTOGRAM C1 C2 C3—generate more than one graph. If you include
the GSAVE subcommand with such a command, Minitab saves multiple files. Minitab gives each file a different
file name. Minitab uses the first five characters of the name you specify, then appends a number (001, 002, and
so on), for up to 300 files.

JPEG
JPEG color

PNGB
PNG grayscale

PNGC
PNG color

TIFB
TIF grayscale

TIF
TIF color

BMPB
BMP grayscale
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BMPC
BMP color

GIF
GIF

EMF
EMF

RESOLUTION K
Saves the graph at a resolution of K dots per inch.

ODBC: Session command for importing data from
a database file

ODBC
Imports data from a database file, such as one saved by Microsoft Access, Oracle, dBASE, Sybase, or SAS, into the
Minitab worksheet.

With ODBC (open database connectivity), you can import a subset of data, such as data collected during a certain
month, into the Minitab worksheet. ODBC adds data to the worksheet to the right of existing columns.

To use the ODBC session commands (for example, in a macro) use this method to identify the correct syntax:
1. Choose File > Query Database (ODBC) to query data.

2. When you have successfully retrieved the data you want, copy the corresponding command language from
the History pane. (Open the History pane by pressing Ctrl+K.)

3. The COLUMNS subcommand is not created when you use the ODBC dialog boxes. If you are creating a local
macro, add this subcommand yourself. Remember that in a local macro, columns must be declared before
they are used as arguments in any commands. The ODBC session command can also query more than one
table at a time.

CONNECT "connection string"
CONNECT specifies complete information pointing to the data source you want to query on your network.
The text string argument can be very long.

SQLSTRING "sglstring”
SQL specifies the query that selects a subset of the data. The text string can be up to 16384 characters in
length.

COLUMNS k.. .k
COLUMNS specifies which columns of the Minitab worksheet should hold the data. k can be an integer from
1 to 4000.
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The COLUMNS subcommand is required in local macros. In global macros or Execs, or when using Minitab
interactively, executing the ODBC command without the COLUMNS subcommand places new data at the
end of the global worksheet.

Note You can specify a range of columns with a colon, for example: 1 : 5. Within Minitab or in a global macro you can also
use stored constants that contain integers, for example 1 : k1 where k1=5.

OUTFILE and NOOUTFILE: Session commands for
saving a Minitab session in a text file

OUTFILE "filename"

OUTFILE K
OUTFILE saves your Minitab output in a text file. You can specify the filename as either the name of the file in
double quotation marks, or as a stored text constant.

After OUTFILE is typed, Minitab sends a copy of the commands and output that you see in the History pane to
a text file. OUTFILE is in effect until you type NOOUTFILE or you exit Minitab. If you type OUTFILE again, with the
same file name, output is appended to the end of this file.

The file is a standard text file, which can be printed and edited by any editor or word processor. Unless you specify
a different file extension, Minitab adds the extension LIS to the file name.

You can use OUTFILE to get a printout of your worksheet. Suppose your current worksheet contains data in the
first 10 columns. For example, the following commands save a copy of your worksheet is to a file named Sales.LIS
in your default directory.

OUTFILE "Sales"
PRINT C1-C10
NOOUTFILE

Closing the outfile

NOOUTFILE
NOOUTFILE closes an open outfile. If you type OUTFILE again with the same file name, input lines are appended
to the same file.

PRINT: Session command for displaying columns,
constants, or matrices in the output pane

PRINT E...E
Displays data in the output pane. You can display one or more (or any mixture of) columns, stored constants, or
matrices.
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If you mix columns, constants, and matrices in one PRINT command, they are listed in the following order: first
all matrices and constants (in the order you specified), then all columns (in the order you specified). For example,
the following command prints M1, K2, K1, and M2, then C1, C4, and C3.

PRINT Cl1 C4 M1 K2 C3 K1 M2

If a number is too large to fit in the space allowed (and FORMAT is not used), the number is displayed in exponential
format.

FORMAT (format statement)

The FORMAT subcommand specifies where and how to print data on the output line. If you PRINT columns
using FORMAT, only the data in columns is displayed, not column names. For more information, go to Valid
format items on page 1186.

Minitab chooses the output format (i.e., number of decimal digits printed). If you want to control this yourself,
use the FORMAT subcommand, or you can right-click on the output and select Decimal Places.

The following command prints numbers single-spaced, five numbers on each line, each number in a field of
ten spaces.

PRINT C1l1-C15;
FORMAT (5F10) .

READ data into columns

READ C...C
Reads in data, row by row, that you type from the keyboard, or that you import from a text file. You cannot type
comments on a data line when the FORMAT subcommand is used.

READ enters new data into columns, replacing any data already in those columns, if it exists. For information on
entering data into a matrix, go to READ data into a matrix on page 43.

When you enter data manually, type END. after you enter your final value.

When you use READ, you can use a space or a comma to separate data entries. For example:

READ C1 C5.
12
3,4
END.

For details on using this command without subcommands to select data entry options, go to Using READ without
subcommands on page 1183.

FILE "filename"
Inserts data from the specified text file. You may specify the filename as either the name of the file in double
quotes, or a stored text constant. If the file has an extension other than DAT and/or if it is not in your current
directory, include the file extension and the path within the single quotation marks. For example, use the
following command to read a copy of the file SALES.ASC stored in the subdirectory JANUARY underneath
the directory SMITH on the C drive.

READ C1-C5;
FILE "C:\SMITH\JANUARY\SALES.ASC".

FORMAT (format statement)
Include a format statement, within parentheses to specify precisely how to enter data into the worksheet.
The entire expression within the parentheses is repeated once for each record. For more information, go to
Using READ with FORMAT on page 1183.
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The FORMAT subcommand is useful when you want to skip over spaces, read data that have no spaces
between them, insert decimal points in numbers, or read in text data, date/time data, or currency data.

Format items may be combined together. For example, the following command reads the name in the first
20 spaces of each data line into Name (C12), skips the next 10 spaces (spaces 21 through 30), then reads the
number in space 31 into C1, the number in space 32 into C2, ..., the number in space 40 into C10.

NAME C12 'Name'

READ 'Name' C1-C10;

FILE "MYDATA";
FORMAT (A20, 10X, 10F1).

Minitab has a special date/time (DT) format which works as shown below. This says to read the date/time
value in the first 8 spaces in the file into C1, and that the format of the date/time data in the file is m/d/yy.
READ C1;

FILE "DATEDATA";
FORMAT (DT8m/d/vyy) .

The following example shows the use of a decimal indicator, repeat factor in front of parentheses, and the
slash.

READ C11-C15;
FILE "EMPLOYEEDATA"™;
FORMAT (F2.1, 2(1X,F3), F4/F2).

This example uses two data lines for every row read. From the first line, the value of C11 is in spaces 1 and
2. The first value is a whole number and the second value is in the tenths place. The format skips space 3.
Then, C12 is read from spaces 4 to 6. The format skips space 7. Then, C13 is read from spaces 8 to 10, which
repeats the pattern inside of the parentheses. C14 is read from spaces 11 to 14. In response to the /, reading
moves to the second data line, and C15 is read from spaces 1 and 2. For more information, go to Valid format
items on page 1186.

NOBS K

The NOBS subcommand specifies the number of observations (rows) to be inserted. If an END on page 38
subcommand or end-of-file is encountered before K observations are inserted, NOBS is ignored. NOBS is
useful when you want to insert just the first portion of a file. It is also useful for Prompting a user for
information on page 1177.

SKIP K

Tells Minitab to skip K lines at the top of the data file before beginning to add data into the file. This is most
useful when you have one or more lines of text, such as column names and titles, at the top of a data file
that you want to import into Minitab.

With READ; FILE only
DECIMAL works with READ when only when reading a file. DECIMAL does not work with READ if you type data.

DECIMAL ", "

DECIMAL "."
Specifies a comma or period as a decimal separator.
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READ data into a matrix

READ K K M

Puts numbers into a matrix. To input data to columns, go to READ data into columns on page 41. You can specify
the filename as either the name of the file in double quotes, or a stored text constant. If the file has an extension
other than DAT and/or if it is not in your current directory, include the file name extension and the path within
guotation marks.

You can use either spaces or commas to separate the data in the matrix.

You must specify the dimension of the matrix in the READ command. The first K gives the number of rows, the
second K the number of columns. The M is the matrix identifier for storage. If a file name is not used, READ is
followed by data lines, each containing one row of the matrix. The following command creates the following

matrix.

Command
READ 3 4 M2
1 2 3 4

5 6 7 8

9 10 11 12
END

Matrix

1 2 3 4

5 6 7 8

9 10 11 12

FILE "filename"

FILE K
Reads or inserts data from the specified text file.

RESTART: Session command for restarting

RESTART

Note You cannot use RESTART in a global macro. For more information, go to Session commands that are not allowed in macros
on page 1179.

Allows you to start over again.

RESTART erases the worksheet, cancels any controls in effect. RESTART also closes all open files such as OUTFILE.
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RETRIEVE: Session command for retrieving a saved
worksheet or project

RETRIEVE "filename"

RETRIEVE K

Note The menu command File > Open and the session command WOPEN on page 45 also open Minitab saved worksheets and
Excel files (and many other types of files). They provide several useful options that are not available with RETRIEVE.

Use the main command by itself to retrieve a saved worksheet and add the file to the current project. With
subcommands you can open a project or add one or more worksheets from a project to the current project. You
can specify the filename as either the name of the file in double quotes or as a stored text constant.

If you omit the file name and the current folder contains a file named Minitab.MWX or Minitab.MTW, then Minitab
opens that file.

Note You cannot use RETRIEVE in a local macro. For more information, go to Session commands that are not allowed in macros on

page 1179.

PROJECT

Note You cannot use PROJECT in a global macro. For more information, go to Session commands that are not allowed in
macros on page 1179.

Specifies that the file after RETRIEVE is a Minitab project file (MPX, MPJ). If you do not want the prompt,
use the SAVE command with the PROJECT subcommand before you use the RETRIEVE command.

PASS "password"
To retrieve a password-protected file, specify the password.

SAVE: Session command for saving a worksheet or
project

SAVE [K]

Note You cannot use SAVE in a local macro. For more information, go to Session commands that are not allowed in macros on page
1179.

Saves a worksheet or project. You can specify the filename as either the name of the file in double quotation
marks, or a stored text constant. When no subcommands are specified, worksheet (MWX) is the default file type
for SAVE.

A saved worksheet file contains all data, stored constants, matrices, column names, and missing value information.
Minitab automatically replaces an existing file if you save with the same filename.

You can open saved worksheets with RETRIEVE on page 44 or WOPEN on page 45.

PROJECT
Specifies to save as a Minitab Project file (MPX).
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WSONLY
Use the subcommand WSONLY to save only worksheets with the saved project.

PASSWORD "password"
Specify a password to use to open the file. Enter the password within double quotation marks. To remove

password protection, use the argument "".

RELEASE K
Specifies the earliest version of Minitab that can open the file. For Minitab 19 and higher, 19 is the earliest
valid argument. You cannot specify a version newer than the version of Minitab that you have.

STOP: Session command for closing Minitab

STOP
Closes Minitab.

WOPEN: Session command for opening a worksheet

WOPEN K

Note You cannot use WOPEN in a local macro. For more information, go to Session commands that are not allowed in macros on
page 1179.

Opens a worksheet. For example, to open a data set named PULSE, enter the following command.

WOPEN "PULSE"

When you open a file, you copy the contents of the file into the current Minitab project. Any changes that you
make to the worksheet while in the project do not affect the original file.

FTYPE
Specifies the type of the file to open. Use one of the following subcommands for FTYPE:
MINITAB

XLSX (For Excel files with a .xIsx extension)
EXCEL (For Excel files with a .xIs extension)
XMLEXCEL

TEXT

csv

You must specify the file type, such as EXCEL, to use some of the other subcommands, such as VNAMES. If
you do not specify the file type, then Minitab considers the file extension. For example, if you enter WOPEN
"Mywork.x1s" but do not specify a file type, then Minitab opens the file as an Excel file. However, if that
Excel file were saved with the name Mywork.abc, Minitab would not recognize the file as an Excel file, and

would display an error message or open the file incorrectly.

When you open a Minitab worksheet (with FTYPE; MINITAB), you do not need to specify a release number.
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FIELD
FIELD allows you to specify how fields are delimited.

Use one of the following subcommands to specify what character denotes the sections of data to be placed
into each field. If FIELD is not specified, Minitab uses the default the default delimiter for the file type.
TAB

COMMA
SEMICOLON
SPACE
PERIOD
CUSTOM "K"

TDELIMITER
Specifies how text fields are delimited.

DOUBLEQUOTE
Use when the columns of data are separated by a double quotation mark.

SINGLEQUOTE
Use when the columns of data are separated by a single quotation mark.

NONE
Use to have text that is separated by a blank entered into its own column.

CUSTOM K

Use if the columns are separated by a character other than those listed above and enter the character
as K.

DECSEP
Specifies how decimals are separated.

COMMA
Specifies that decimals are separated by a comma.

PERIOD
Specifies that decimals are separated by a period.

MISSING
Specifies how to write out a missing value.

TEXT K K

Denotes text columns, with the first K as the "missing" marker in the file's original form, and the second
K as the one or more words, characters, or spaces that you want Minitab to replace these markers with.
The default Minitab marker for missing text is a space.

NUMERIC 'K' K
Denotes numeric columns, with the first K as the missing marker in the file's original form, and the
second K as the digits, characters, or spaces that you want Minitab to replace these markers with. The
default Minitab marker for missing numeric data is an asterisk (*). The missing value symbol (first K)
must be enclosed in single quotation marks.
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DATA
Specifies where to begin reading data in the file to be opened.

IGNOREBLANKROWS
Skips over blank data rows. If you don't use this command, Minitab reads blank data rows as missing
values.

EQUALCOLUMNS
Adds missing values (*) to shorter columns to so that all columns have the same number of rows.

CLEAN
Removes nonprintable characters and extra spaces from text columns.

CASE
Corrects case mismatches in text columns by applying the capitalization of the first occurrence of a text
value to all matching values in the column.

SHEET K

Controls the way the K™ worksheet in the file is read. SHEET can be used one time for each worksheet in the
file.

EXCLUDE
Stops the worksheet from being imported.

VNAMES K
Specifies the row number K that contains the variable names. -1 indicates no variable names. 0 indicates
that the first row that is being imported is the variable names row.

FIRST K
Specifies the row number K to begin reading the data. If you do not choose a variable names row,
Minitab begins reading data from the first available row in the file.

NROWS K

Specifies the number of data rows. Enter a number to read a portion of the file. For example, if you enter
50, Minitab reads only the first 50 rows beginning with the first row of data. By default, Minitab reads
all rows from the file into the current worksheet.

VARIABLE K
Controls the way the K" variable in the worksheet is read. It can be used once for each variable in the
worksheet.

EXCLUDE
Do not import this variable.

NAME K
Assigns a name to the variable. Names can be up to 31 characters long, and can include any letters
and numbers except the symbol ' (single quotation mark) or # (pound sign). Names cannot begin
or end with a blank or consist entirely of the symbol * (asterisk). You also can name your variables
directly after the worksheet is open.

TEXT
Specifies that the data type is text.

NUMERIC
Specifies that the data type is numeric.
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DATETIME
Specifies that the data type is date/time.

COLUMN C
Specifies which column of the worksheet (C) the variable is placed in.

WORKSHEET: Session command for making a
worksheet active, for closing a worksheet, or for
renaming a worksheet

WORKSHEET K
You cannot use WORKSHEET in a local macro. For more information, go to Session commands that are not allowed
in macros on page 1179.

Specifies K as the active worksheet. If no worksheet is specified, then session commands work on the active
worksheet.

When you are working in Minitab, any session command you use works on the active worksheet. The active
worksheet is the worksheet associated with the active Data tab.

You can also click a worksheet to activate it. If no worksheet is active, the session command acts on the worksheet
that was most recently active.

Note A worksheet can contain up to 4000 columns, 1000 constants, and up to 10,000,000 rows depending on how much memory
your computer has.

If you run subcommands, only the last subcommand works. To rename and close a worksheet, you must use more
than one instance of the main session command.

CLOSE
Closes the worksheet.

NOPROMPT
Specifies not to prompt to save when saving the worksheet.

CURRENT
Specifies to make the named worksheet active.

RENAME K

RENAME "text"”
Renames the worksheet.
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WRITE: Session command for writing data to the
screen or a data file

WRITE E...E

Writes data in the specified columns or constants to the screen or to a data file (also called text or ASClII file). You
can specify the filename as either the name of the file in double quotes, or a stored text constant.

WRITE exports your data to a data file which you can import into other applications, print on your printer, or enter
into Minitab with READ (for more information, go to READ data into columns on page 41 or READ data into a
matrix on page 43) or SET on page 80. WRITE prints the columns vertically, very close together, with no column
names or row numbers and prints constants horizontally, whether they are stored numeric or text constants.

If you omit the file name, WRITE displays the columns or constants on your screen. If you specify a file name but
omit the extension, WRITE adds the default extension DAT.

Use the FORMAT subcommand to write data with a fixed format, for example, columns not separated by spaces.

By default, if you WRITE to a file that already exists, Minitab asks you whether or not you want to replace the file
before proceeding. You can use the subcommands REPLACE and NOREPLACE to override Minitab's default
behavior.

WRITE normally creates a data file. It can also be used to print columns or constants on your screen or on paper.
The output is very compact. With columns, there is no header giving the column name, and there are no row
numbers on the left. Columns are always output vertically. Constants are output horizontally, whether they are
stored numeric or text constants.

A data file created with the WRITE command can be transferred to different computer types and read by other
programs. On most computers, the default file name extension is DAT.

e The format of the output is adjusted to make the data as compact as possible. Thus, the number of columns
that can be put on one line varies with the data.

e |f aformat is not specified, and if very wide text items are to be printed (e.g., 80 wide), and if the output width
is not wide enough to print the entire item, the items will be truncated on the right.

e When writing columns of unequal length to a file, Minitab makes them equal by adding missing value symbols
(*) to the short columns.

Note The menu command File > Save Worksheet As and the session command WSAVE on page 51 can also save the current
Minitab worksheet as a text file, and many other file types as well. It also provides several useful options not available with WRITE.

FILE "filename"

Specify to write to a data file (also called text or ASCII file). You may specify the filename as either the name
of the file in double quotes, or a stored text constant. If you specify a file name but omit the extension, WRITE
adds the default extension DAT. Use the subcommands UTEXT and TEXT to specify Unicode or ANSI text for
the file.

UTEXT
Saves the file in Unicode format.

TEXT
Saves the file in text format.

FORMAT

A format specification, similar to a Fortran format, may be given on this subcommand. For more information,
go to Valid format items on page 1186.
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The format specifies where the data will appear on the output lines, and the number of decimal places printed.
FORMAT works the same way with WRITE as it does with READ (with the exception of the currency format,
which works with READ but not WRITE). For more information, go to READ data into columns on page 41
or READ data into a matrix on page 43.

The following table shows how 123.456 is output with different formats.

Format Output

F7.3 123.456

F7.2 123.46

17 123

E11.6 1.23456E+02
G7 123.456

If you create a file with WRITE, using a FORMAT, then the READ command (for more information, go to READ
data into columns on page 41 or READ data into a matrix on page 43) can read the file with the same format.

To create a file that READ can read without a format (or other programs can read without a format), make
sure that there is at least one space between numbers. One way to do this is with the X format item. For
example, the following command creates a file which can be read without a format.

WRITE C1-C5;
FILE "FileA";
FORMAT ( 5(1x, F11) ).

Missing numeric data are output as * in the right-most space of the field. Missing text data are output as
blanks.

You must WRITE columns of equal length.

You can write columns that contain text data with or without using a FORMAT subcommand. You must,
however, use a FORMAT subcommand to READ the file.

Column format

TAB
TAB saves the specified columns, separated by tabs, in a data (also called text or ASCII) file. Do not use FORMAT
with tab-delimited data.

NONAMES

If you do not want to include the column names in the file, use the NONAMES subcommand in addition to
TAB.

File instructions
REPLACE and NOREPLACE allow you to bypass the "REPLACE?" prompt and are most useful in macros.

REPLACE
When you specify REPLACE, Minitab always overwrites the file.

NOREPLACE
When you specify NOREPLACE and you have an existing file with the same name, Minitab generates an error
message and aborts the command or exits the macro.
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WSAVE: Session command for saving a worksheet
file

WSAVE "filename"
Saves all the worksheet data in a file. Use this command to rename your worksheet or save it to a new location.

If your current worksheet is untitled (“Worksheet1" appears in the tab of the worksheet), you can use WSAVE to
specify a name for your saved worksheet file.

FTYPE
Specifies a file format. The sub-subcommands (MINITAB, XLSX, and so on) are the file formats.

You must specify an FTYPE; FORMATNAME combination to use some of the other subcommands, such as
VNAMES.

If you do not use FTYPE when saving a file, Minitab saves the file as a Minitab worksheet for the version that
you have.

MINITAB K
Specifies the Minitab worksheet file type.

When you use the MINITAB file type, specify the earliest version of Minitab that can open the worksheet.
For Minitab 19 and higher, 19 is the earliest valid argument. You cannot specify a version newer than
the version of Minitab that you have.

XLSX
Specifies the Excel file type with a .xIsx extension.

EXCEL
Specifies the Excel file type with a .xIs extension.

XMLEXCEL
Specifies the XML Excel file type.

TEXT
Specifies the text file type.

UTEXT
Specifies the unicode text file type.

Ccsv
Specifies the comma-separated file type.

ucsv
Specifies the unicode comma-separated file type.

NOVNAMES
Saves a file from Minitab into another format without saving the variable names within the file.

DECSP
Specifies the form of decimal separation when you save a text file. The sub-subcommands give the decimal
separator.
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COMMA
Specifies a comma decimal separator.

PERIOD
Specifies a period decimal separator.

FIELD

Specifies how fields are delimited. Choosing one of the options chooses what character denotes the sections
of data to be put into each field. If FIELD is not specified, Minitab uses the default delimiter for the file type.
The sub-subcommands give the delimiter.

TAB
Specifies the tab as the delimiter.

COMMA
Specifies the comma as the delimiter.

SEMICOLON
Specifies the semicolon as the delimiter.

PERIOD
Specifies the period as the delimiter.

SPACE
Specifies the space as the delimiter.

CUSTOM K
Specifies a custom delimiter.

TDELIMITER
Specifies how text fields are delimited.

DOUBLEQUOTE
Use when the columns of data are separated by a double quotation mark.

SINGLEQUOTE
Use when the columns of data are separated by a single quotation mark.

NONE
Use to have text that is separated by a blank entered into its own column.

CUSTOM K

Use if the columns are separated by a character other than those listed above and enter that character
as K.

MISSING
Specifies how to write out a missing value. The sub-subcommands give the values.

TEXT K K

TEXT denotes text columns, with the first K as the "missing" value symbol in the file's original form, and
the second K as the word(s), character(s), or space(s) you want Minitab to replace these symbols with.
The default Minitab symbol for missing text is a space.
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NUMERIC K K

NUMERIC denotes numeric columns, with the first K as the "missing" value symbol in the file's original
form. The default Minitab symbol for missing numeric data is an asterisk (*). The missing value symbol
(first K) must be enclosed in single quotation marks, "*'. The second K can be a number or '*' and is how
the symbol appears in the output file. In Excel files, the missing value symbol becomes an empty cell.

XPPOINT: Session command for sending output to
Microsoft PowerPoint

XPPOINT
Sends Minitab output and graphs to Microsoft PowerPoint so that you can create reports and presentations.

All of Minitab's graphs and output can be sent to a PowerPoint presentation. In PowerPoint, text and titles appear
in the font that is used in Minitab.

Note When you send a graph to PowerPoint, Minitab's Embedded Graph Editor is not available.

APPEND

Exports output into an open Microsoft PowerPoint presentation. The output is starts on a new slide after the
currently active slide.

XWORD: Session command for sending output to
Microsoft Word

XWORD
Sends Minitab output and graphs to Microsoft Word so that you can create reports and presentations.

All of Minitab's graphs and output can be sent to a Word document. In Word, text and titles appear in the font
that is used in Minitab.

Note When you send a graph to Word, Minitab's Embedded Graph Editor is not available.

APPEND

Exports output into an open Microsoft Word document. The output is placed after the cursor location in the
Word document.
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Other Session Commands

PYSC: Session command for running a Python script

PYSC ["filename.py'"] ["Args"...]
Runs the Python script that you specify.

The default file extension for Python scripts is .PY. If the file extension is .PY, you do not need to type the file
extension.

The optional argument Args lets you pass arguments to the Python script through sys.argv[1:].Args can
be any text values separated by a space. Enclose arguments in quotation marks. The default value is None, which
means that the script does not receive any arguments.

For more information on integrating Python and Minitab, go to the Minitab Support Center.

NOSERR
Specifies not to display text from the stderr file in the Output pane in Minitab. For example:

PYSC "test.py";
NOSERR.

SOUT
Specifies to display text from the stdout file in the Output pane in Minitab. For example:

PYSC "test.py";
SOUT.

RSCR: Session command for running a R script

RSCR ["filename.R"] ["Args"...]
Runs the R script that you specify.

The default file extension for R scripts is .R. If the file extension is .R, you do not need to type the file extension.

The optional argument Args lets you pass arguments to the R script through commandArgs (trailingOnly
= TRUE).Args can be any text values separated by a space. Enclose arguments in quotation marks. The default
value is Nul1, which means that the script does not receive any arguments.

For more information on integrating R and Minitab, go to the Minitab Support Center.

NOSERR
Specifies to not display text from the standard error (message (), warning (), or stop ()) console output
in the Output pane in Minitab. The warning console output is where R error messages display when you run
your code in an R integrated development environment. For example:

RSCR "test.R";
NOSERR.
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SOuT

Specifies to display text from the standard console output in the Output pane in Minitab. The standard
console output is where the results of commands like print () display in an R integrated development
environment. For example:

RSCR "test.R";
SOUT.

NAME: Session command for assigning names to
columns, stored constants, and matrices

NAME E "name'"...E '"name"
Assigns names to columns, stored constants, and matrices.
Names must not do the following:
e Contain more than 31 characters
e Begin or end with a blank
¢ Include the symbols ' or #
e Start with or consist entirely of the symbol *
e Be repeated. You cannot use the same name for two variables (columns, stored constants or matrices) in the

same worksheet.

You can refer to a named column, constant, or matrix by either number or name, for example, M1 or "Inverse".
Any time you use a name, enclose the name in double quotation marks. Minitab always prints variable names, if
they exist, on all output involving that variable. You can change the name of a variable by using another NAME
command.

The following example names C1, K1, and K2.
NAME C1l"Height" K1"Min" K2"Max"

The following example erases the name of C1.
NAME C1 " "

You can use both upper and lower case letters in a name. When you use the name in a Minitab command, Minitab
considers upper and lower case letters equivalent. When a name is printed in the output, however, the upper and
lower case letters are used. For example, the following commands name the C1 column Height and print the data.

NAME C1"HEIGHT"
PRINT "HEIGHT"

Note You also can type column names into the worksheet as an alternative to the NAME command.
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ABORT: Subcommand for exiting a multi-line
command

ABORT
Use ABORT as the next subcommand to exit from a multi-line command without executing it.

HELP: Session command for opening this guide

HELP
Opens the Session Commands guide. The Session Commands guide provides summaries of commands and
specific information on each command and subcommand. You can use session commands as an alternative to
using menu commands, or as a way to build macros for repetitive functions.
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Dynamic Data Exchange

XDACTIVATE: Session command for activating a link

XDACTIVATE "application" '"topic" "item"

Activates a previously deactivated client link. When you deactivate a link using XDDEACTIVATE on page 59, Minitab
ignores/discards any queued transactions or incoming transactions until you reactivate the link.

You can use XDACTIVATE in execs and global macros, but not in local macros.

You also can pause activity globally.

application
Application is the name of a program that can participate in a DDE transaction. Usually, application is the
name of an EXE file that starts the program, without the .exe extension. For example, in the case of Minitab,
Mtb.exe starts the program, so for the application argument use Mtb.

topic
Topic is a name that depends on the type of application. In applications that use documents or data files,
the topic is often the name of the file. For example, the topic for a Microsoft Word document might be
mywork.doc. The file name can also include a path, as in c:\mywork\mywork.doc.

If one file can contain many documents or subwindows, the Topic can be the name of the file in brackets,
followed by the name of the document or window. For example, Minitab projects can contain many worksheet,
so a typical Topic would be [Minitab] worksheet 1.

Other applications have their own names for topics.

Tip Itis a good idea to save files from other applications before establishing any links to or from them. If you establish a link
before saving the file, you may need to change the link name from something like "untitled" to a file name. Likewise, before
linking from Minitab, rename a new worksheet from the default of "Worksheet 1" to something meaningful, such as "First Quarter."

item
Item is a name that depends on the type of application. In Minitab, the item always specifies a row/column
location or rectangular area in the form R4C1:R4C2. You can use all of Minitab column 1 as an item by
specifying C1. A single cell (row 4, column 1) is R4C1. Most spreadsheets use close variants of the R4C1:R3C2
format for items.

XDADD: Session command for adding a new link

XDADD "application" '"topic" "item"

Establishes a new DDE link between the specified application program and Minitab. With this command, Minitab
acts as a client, receiving data from the other application.

You often specify XDADD with either the APPEND or REPLACE subcommands to tell where to put the data in the
Minitab worksheet, as shown below.
XDADD "Minitab" " [myproj.mpj]pulse" "C1";

REPLACE C2;

PERFORM 2;
COMMAND "LET C2=4*C1".
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When another program supports Edit > Paste Link, you can find out the application, topic, and item names by
copying a range from the other application and pasting it into the worksheet in Minitab. The type of link established
by XDADD is often referred to as a hot link.

You can use XDADD in global macros and exec macros, but not in local macros.

Data

DATA

Specifies whether to add (append) the data to the end of the columns that you specify or to replace the entire
contents of the columns in the worksheet with new data from the item you specify in the XDADD or XDGET
command. The column argument specifies the starting, or anchor column for the data in the item. When the item
has more than one column, other columns are also included.
APPEND [C]

Specifies to add the data to the end of the columns that you specify.

REPLACE [C] (default)

Specifies to replace the entire contents of the columns in the worksheet with new data from the item you
specify in the XDADD or XDGET command.

Link status

ACTIVE

Specifies to open the new link in the active state. An active link starts receiving data from the other application
immediately.

INACTIVE
Specifies to open the new link in the inactive state. An inactive link does not receive data until you activate it.

Command arguments

PERFORM K

Specifies the action to take on each occurrence of a data transfer from the server application. The argument values
and associated actions are shown in the following table.

Value of K Description

0 Update data and execute commands.
1 Update data only.

2 Execute commands only.

COMMAND "command"

Specifies one Minitab command to execute upon each occurrence of a data transfer from the server application.
The command string can contain up to 128 characters (without line breaks) and include one Minitab command
or %macro. Do not use a period at the end.

Use a %macro or the dialog box if you need to use multiple commands.

If the command includes single quotation marks ('), enclose the single quotation marks with double quotation
marks ("). You can only use a single COMMAND subcommand for each link.
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This subcommand works differently than the Commands field in the Add New Links dialog box.

Link priority

PRIORITY K
Specifies the priority of the link relative to other links. The priority can be any integer from 1 (the highest priority)
to 32 (the lowest priority). Priority matters when more than one link attempts a transfer at the same time, or when
several queued transactions are waiting for processing. Minitab always completes transfers on links that have
higher priority first, then processes data from links with lower priority. Links with the same priority are transferred
on a first-in first-out basis. The default priority is 16.

XDDEACTIVATE: Session command for deactivating
a client link

XDDEACTIVATE "application'" "topic" "item"

Allows you to pause (deactivate) activity on a client link. When you deactivate a link, Minitab ignores/discards any
queued transactions or incoming transactions until you use XDACTIVATE on page 57 to reactivate the link.

You can use XDDEACTIVATE in execs and global macros, but not in local macros.

You can also pause activity globally.

application
Application is the name of a program that can participate in a DDE transaction. Usually, application is the
name of an EXE file that starts the program, without the .exe extension. For example, in the case of Minitab,
Mtb.exe starts the program, so for the application argument use Mtb.

topic
Topic is a name that depends on the type of application. In applications that use documents or data files,
the topic is often the name of the file. For example, the topic for a Microsoft Word document might be
mywork.doc. The file name can also include a path, as in c:\mywork\mywork.doc.

If one file can contain many documents or subwindows, the Topic can be the name of the file in brackets,
followed by the name of the document or window. For example, Minitab projects can contain many worksheets,
so a typical Topic would be [Minitab] worksheet 1.

Other applications have their own names for topics.

Tip Itis a good idea to save files from other applications before establishing any links to or from them. If you establish a link
before saving the file, you may need to change the link name from something like "untitled" to a file name. Likewise, before
linking from Minitab, rename a new worksheet from the default of "Worksheet 1" to something meaningful, such as "First Quarter."

item
Item is a name that depends on the type of application. In Minitab, the item always specifies a row/column
location or rectangular area in the form R4C1:R4C2. You can use all of Minitab column 1 as an item by
specifying C1. A single cell (row 4, column 1) is R4C1. Most spreadsheets use close variants of the R4C1:R3C2
format for items.
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XDEXEC: Session command for executing a
command in a remote application

XDEXEC "application" '"command"
Allows you to execute a command in a remote application.

You can use XDEXEC in any type of macro.

application
The application argument is the DDE application name that is defined by the other application.

Application is the name of a program that can participate in a DDE transaction. Usually, application is the
name of an EXE file that starts the program, without the .exe extension.

command

If the other application allows more than one command per line, you can use more than one command in
the command string. If the server does not allow more than one command, consider writing a macro in the
server language, or using several XDEXEC commands in a row to achieve the same result. Use double quotation
marks inside the command string if single quotation marks are required in the remote application.

Note If the command that you want to execute already contains double quotation marks, then put the command and application
in single quotation marks. For example, because the syntax for executing an Excel macro requires double quotation marks, the
correct syntax is XDEXEC 'EXCEL' ' [Run ("macro")]'.

XDGET: Session command for performing a
one-time data transfer

XDGET "application" "topic" "item"

Allows you to do a one time data transfer (often referred to as a cold link). You can use XDGET in place of copying
and pasting or in any type of macro.

application
Application is the name of a program that can participate in a DDE transaction. Usually, application is the
name of an EXE file that starts the program, without the .exe extension. For example, in the case of Minitab,
Mtb.exe starts the program, so for the application argument use Mtb.

topic
Topic is a name that depends on the type of application. In applications that use documents or data files,
the topic is often the name of the file. For example, the topic for a Microsoft Word document might be
mywork.doc. The file name can also include a path, as in c:\mywork\mywork.doc.

If one file can contain many documents or subwindows, the Topic can be the name of the file in brackets,
followed by the name of the document or window. For example, Minitab projects can contain many worksheets,
so a typical Topic would be [Minitab] worksheet 1.
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Other applications have their own names for topics.

Tip Itis a good idea to save files from other applications before establishing any links to or from them. If you establish a link
before saving the file, you may need to change the link name from something like "untitled" to a file name. Likewise, before
linking from Minitab, rename a new worksheet from the default of "Worksheet 1" to something meaningful, such as "First Quarter."

item
Item is a name that depends on the type of application. In Minitab, the item always specifies a row/column
location or rectangular area in the form R4C1:R4C2. You can use all of Minitab column 1 as an item by
specifying C1. A single cell (row 4, column 1) is R4C1. Most spreadsheets use close variants of the R4C1:R3C2
format for items.

APPEND and REPLACE

Specifies whether to add (append) the data to the end of the columns that you specify or to replace the entire contents
of the columns in the worksheet with new data from the item you specify in the XDADD or XDGET command. The
column argument specifies the starting, or anchor column for the data in the item. When the item has more than one
column, other columns are also included.

APPEND [C]
Specifies to add the data to the end of the columns that you specify.

REPLACE [C] (default)

Specifies to replace the entire contents of the columns in the worksheet with new data from the item you specify
in the XDADD or XDGET command.

XDREMOVE: Session command for deleting an
established link

XDREMOVE "application" "topic" "item"
Deletes an established client link.

This command deletes the specified client link immediately when Minitab accepts the command. When a link is
deleted, all existing queued requests are processed (that is transferred into the worksheet), but no new ones are
added.

You can use XDREMOVE in execs and global macros, but not in local macros.

application
Application is the name of a program that can participate in a DDE transaction. Usually, application is the
name of an EXE file that starts the program, without the .exe extension. For example, in the case of Minitab,
Mtb.exe starts the program, so for the application argument use Mtb.

topic
Topic is a name that depends on the type of application. In applications that use documents or data files,
the topic is often the name of the file. For example, the topic for a Microsoft Word document might be
mywork.doc. The file name can also include a path, as in c:\mywork\mywork.doc.

If one file can contain many documents or subwindows, the Topic can be the name of the file in brackets,
followed by the name of the document or window. For example, Minitab projects can contain many worksheets,
so a typical Topic would be [Minitab] worksheet 1.
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Other applications have their own names for topics.

Tip Itis a good idea to save files from other applications before establishing any links to or from them. If you establish a link
before saving the file, you may need to change the link name from something like "untitled" to a file name. Likewise, before
linking from Minitab, rename a new worksheet from the default of "Worksheet 1" to something meaningful, such as "First Quarter."

item
Item is a name that depends on the type of application. In Minitab, the item always specifies a row/column
location or rectangular area in the form R4C1:R4C2. You can use all of Minitab column 1 as an item by

specifying C1. A single cell (row 4, column 1) is R4C1. Most spreadsheets use close variants of the R4C1:R3C2
format for items.
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Manipulating and Calculating Data

Calculator

Calculations

ADD: Session command for addition

ADD E...E E
Adds E and E and stores in E. E can be any column, any constant, or matrix. For columns and constants, ADD allows
up to 50 arguments. If any element of a row is missing, the result is set to missing *. If the operation is impossible,
the result is also set to missing.

EIGEN: Session command for calculating eigenvalues

EIGEN M C [M]
Calculates eigenvalues (also called characteristic values or latent roots) and eigenvectors for a symmetric matrix.

The eigenvalues are stored in decreasing order of magnitude down the column. The eigenvectors are stored as
columns of the matrix. The first column corresponds to the first eigenvalue (largest magnitude), the second column
to the second eigenvalue, and so on.

LAG: Session command for calculating the lags of a column

LAG [K] CC
Calculates the lags of a column and stores them in a new column.

Moves the row elements of a column down K rows, where K is the lag specified, storing the result in a new column
of the same length. There will be K missing value symbols, *, at the top of the output column. The output column
has the same number of rows as the input column, so the last K values from the input column are not lagged. If
K is omitted, then K = 1 is used.

If C1 contains Z1, Z2, .., Zn, then LAG K C1 C2 puts asterisks (*) into rows 1 through K of C2, and puts Z; - Z;_,
intorowi, K+ 1<i<n.
LET: Session command for correcting a number in a worksheet or performing arithmetic

LET C [K] = K
Use to correct a number in the worksheet. You can change a single number with the LET command. For example,
LET C1[5] = 28.6 puts 28.6 into row 5 of C1. The rest of C1 remains the same.
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LET

= expression

Use to perform arithmetic with an algebraic expression. The expression can contain arithmetic operations,
comparison operations, logical operations, and functions. The functions that you can use with LET are described
below.

Note In an expression, you cannot use a hyphen to specify a range of columns or constants. For example, Minitab would interpret
C1-C4 as C1 minus C4 and 1-10 as 1 minus 10.

You can also access an individual row in a column. For arguments, you can use columns, stored constants, or
numbers. You cannot use matrices. You cannot use extra text on any session command, including LET, except
after the # symbol.

For arithmetic operations, if any element of a row is missing, the result is set to missing. If an operation is impossible,
such as division by zero, the result is set to missing. You can have up to nine nested parentheses.

Examples of LET

LET

LET

LET

LET

LET

LET

LET

LET

Cl = (C2 + C3)*10 - 60
Cl = Cl - MEAN(CI1)

Kl = 5.3

K2 = MEAN(C10)/STDEV (C1)
C5 = (C1 < 5)

K2 = C1[28]

Cl[28] = 2.35

C5[15] = "blue"

Arithmetic functions to use with LET

CEIL (E, K)

Rounds numbers up. In the first argument, specify the number you want rounded. In the second argument, specify
the number of decimals to round to. If K = 0 (the default), the number is rounded to the nearest integer greater
than or equal to the number. If K > 0, the number is rounded up to the specified number of decimal places after
the decimal point. If K < 0, the number is rounded up to 1- the specified number of place values to the left of the
decimal point.

For example:
CEILING (2.136, 0) equals 3

CEILING (2.136, 1) equals 2.2

CEILING (2.136, 2) equals 2.14
CEILING (-2.136, 1) equals —2.1
CEILING (253.6, —1) equals 260
CEILING (253.6, -2) equals 300
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COMBINATIONS (E, E)
Calculates the number of combinations of n items chosen k at a time. In the first argument, specify the number
of items. In the second argument, specify the number to choose. The number of items must be greater than or
equal to 1, and the number to choose must be greater than or equal to 0. Arguments can be columns or constants.
Missing values are not allowed.

FACTORIAL (E)
Calculates the factorial of a number, the product of all the consecutive integers from 1 to the number, inclusive.
The value of the number must be greater than or equal to 0. Missing values are not allowed.

FLOOR (E, K)
Rounds numbers down. In the first argument, specify the number you want rounded. In the second argument,
specify the number of decimals to round to. If K = 0 (the default), the number is rounded to the nearest integer
less than or equal to the number. If K > 0, the number is rounded down to the specified number of decimal places
after the decimal point. If K < 0, the number is rounded down to 1- the specified number of place values to the
left of the decimal point.

For example:
FLOOR (2.136, 0) equals 2

FLOOR (2.136, 1) equals 2.1
FLOOR (2.136, 2) equals 2.13
FLOOR (-2.136, 1) equals -2.2
FLOOR (253.6, 1) equals 250
FLOOR (253.6, —2) equals 200

FTC (E)
Performs the Freeman Tukey transformation to stabilize variance for Poisson data. Requires one argument, which
must be a column or stored constant that contains nonnegative integers.

FTP (E, E)
Performs the Freeman Tukey transformation to stabilize variance for binomial data. Requires one argument for
number of trials and one for number of successes. Each argument can be a column or stored constant. Trials must
be a positive integer, and successes must be an integer between 0 and n inclusive.

GAMMA (E)
Calculates the gamma function where E is the specified shape parameter (the number you want to take the function

of).

IGAMMA (E, E)
Calculates the incomplete gamma function. In the first argument, specify the upper limit of the integral. In the
second argument, specify the shape parameter (the number you want to take the function of).

LNGAMMA (E)
Calculates the natural log of the gamma function. E is the shape parameter.

MOD (E, E)
Stores the remainder after a number is divided by a divisor. In the first argument, specify the number. In the
second argument, specify the divisor. Minitab calculates the value using the formula: m — (n * FLOOR (m/n)) where
m is a number and n is the divisor.
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PERMUTATIONS (E, E)
Calculates the number of permutations of n things taken k at a time. In the first argument, specify the number of
items. In the second argument, specify the number to choose. The number of items must be greater than or equal
to 1, and the number to choose must be greater than or equal to 0. Missing values are not allowed.

Column functions to use with LET

DIFFERENCES (C, K)

Calculates row-by-row differences between the numeric values in a column. In the first argument, specify the
column. Minitab subtracts from each row the element K rows above, where K is the lag you specify, and stores
the differences in a new column. If you don't specify a value for lag, the differences are computed between
consecutive rows (lag = 1). The first K rows of the new column will contain the missing value symbol, *.

LAG (C, K)
Moves the row elements of a column down K rows, storing the result in a new column of the same length. If no
value is specified, the default lag (K =1) is used. There will be K missing value symbols, *, at the top of the output

column. The output column has the same number of rows as the input column, so the last value from the input
column is not lagged.

NSCORES (C)

Calculates and stores normal scores. This command is used mainly to produce normal probability plots and
perform various tests. Here is an example of normal scores.

LET C2 = NSCORES (C1)

Loosely speaking, -1.18 is the smallest value you would expect to get if you took a sample of size 5 from a standard
normal (i.e., the expected value of the first order statistic), and -0.50 is the second smallest value you would expect
to get (i.e., the expected value of the second order statistic), and so on.

C1 C2
1.1 0.0
0.1 -1.18
2.3 1.18
1.8 0.50
0.9 -0.50

Minitab does not calculate the expected values of the order statistics exactly, but uses percentage points as an
approximation. Thus, if there are n data values, Minitab puts f- 7[ (i- 3 /8) / (n + 1/ 4)] next to the ith smallest
data value, where f -7(x) is the inverse cumulative distribution function of the standard normal.

If several observations are equal, they are all given the same normal score. This is calculated using the average
of their ranks. The command NORMPLOT provides additional information. The output from NORMTEST includes
a normal probability plot, relevant statistics about the data, and test statistics useful for testing a hypothesis of
normality.

RANK (C)
Calculates and stores the ranks of the input column. Assigns the numeral 1 to the smallest value, the numeral 2

to the second smallest value, the numeral 3 to the third smallest value, and so on. Ties are assigned the average
rank.

Note RANK works only with numeric columns.

The following command language ranks the values in C1 and puts the ranked values in C2.
RANK C1l C2
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Before ranking

c1
0.5
1.0
1.5
1.0
2.0
0.0

After ranking

c1 c2
0.5 2.0
1.0 35
1.5 5.0
1.0 35
2.0 6.0
0.0 1.0

SORT (C)

Sorts the numerical values in a column in ascending order. Specify the column. Data must be numerical.

Date/time functions to use with LET

CTIME ()
Returns the current time, for example, 9:26:20 AM.

Note If stored in a column, the result is in a date/time format. If stored in a constant, the result is the numeric representation of the
date/time value. Currently, stored constants in Minitab do not have date/time formats.

DATE ("text")

DATE (E)
Returns the date portion corresponding to the argument. The argument should be a text string, such as "3/6/99
10:23", a column, or a stored constant. Text columns and constants should be in one of the Default date/time
formats on page 1140.

Note |If stored in a column, the result is in a date/time format. If stored in a constant, the result is the numeric representation of the
date/time value. Currently, stored constants in Minitab do not have date/time formats.

ELAPSED (E)
Returns the elapsed time, given the start and end times. Enter the column with the end times minus the column
with the start times. The columns or values must be in numeric or date/time format. The elapsed time in the
output is in minutes and seconds (mm:ss) if the maximum value of the output column is less than one hour; the
elapsed time in the output is in hours, minutes, and seconds (hh:mm:ss) if the maximum of the output column is
an hour or more.
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NETWORKDAYS (E, E, [E])
Returns the number of workdays between two dates, inclusive. Specify the start date and end date in the first two
arguments. You can enter a column of dates. You can also specify a column of holidays to skip for the optional
third argument. If the dates include time portions, Minitab ignores the times. You can also enter single dates in
double quotes with the additional use of DATE. For example, to find out the number of workdays between 1/1/09
and 1/31/09, use LET c1 = NETWORKDAYS(date("1/1/09"), date("1/31/09")). Text columns and constants should
be in one of the Default date/time formats on page 1140.

NOW ()
Returns the current date and time, for example, 3/8/2003 9:24.

Note If stored in a column, the result is in a date/time format. If stored in a constant, the result is the numeric representation of the
date/time value. Currently, stored constants in Minitab do not have date/time formats.

TIME ("text")

TIME (E)
Returns the time portion corresponding to the argument. The argument should be a text string, such as "3/6/99
10:23", a column, or a stored constant. Text columns and constants should be in one of the Default date/time
formats on page 1140.

Note |If stored in a column, the result is in a date/time format. If stored in a constant, the result is the numeric representation of the
date/time value. Currently, stored constants in Minitab do not have date/time formats.

TODAY ()
Returns today's date, for example, 3/8/2003.

Note |If stored in a column, the result is in a date/time format. If stored in a constant, the result is the numeric representation of the
date/time value. Currently, stored constants in Minitab do not have date/time formats.

WHEN ("text")

WHEN (E)
Returns the date and time corresponding to the argument. The argument should be a text string, such as "3/6/99
10:23", or a column or stored constant. Text columns and constants should be in one of the Default date/time
formats on page 1140.

Note |If stored in a column, the result is in a date/time format. If stored in a constant, the result is the numeric representation of the
date/time value. Currently, stored constants in Minitab do not have date/time formats.

WDAYS ("text'", K, ["text"])

WDAYS (E, E, [E] )
Offsets the date by the given number of workdays. Enter the start date and the number of workdays to add to
the date. Minitab returns the date that is the number of working days (defined as Monday through Friday) from
the start date you specify. You can also choose to skip holidays by entering a date or column or dates for the
optional third argument. When you enter single dates in double quotes, you need to also use DATE. For example,
to find out the date of tenth workday after 1/5/09, use LET c1 = WORKDAYS(date("1/5/09"),10). Text columns and
constants should be in one of the Default date/time formats on page 1140.

Note |[f stored in a column, the result is in a date/time format. If stored in a constant, the result is the numeric representation of the
date/time value. Currently, stored constants in Minitab do not have date/time formats.
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Logical functions to use with LET

ANY (E, K...)
Returns a 1 if a value equals any value from a set of values, returns a 0 otherwise. Use to flag specified values in
a column. In the first argument, specify the column. In the subsequent arguments, specify the values for which to
returna 1.

IF (C <>=K, "text", ["text"])

IF (c<>=C, C, [C])
Chooses which of two values to return based on whether a condition is true or false. Conditions can be any
numerical or logical expressions. For the first argument, specify the column and the condition using >, <, or =.
For the second argument, specify the value to return if the condition is true. The third argument is optional and
allows you to specify a value to return if the condition is false. If nothing is specified, Minitab returns a missing

value. For example, IF(c1 = 1, "male", "female") returns "male" for values in c1 equal to 1 and returns "female" for
the other values in c1.

IF (C<>=K,"text", C<>= "text"...["text"])

IF (C<>=K, C, C<>= C...[C])
Chooses a value to return for each of multiple conditions evaluated sequentially. Conditions can be any numerical
or logical expressions. For the first argument, specify the column and the condition using >, <, or =. For the second
argument, specify the value to return if the condition is true. You can enter multiple conditions and values. All
values must be the same data type (numeric or text). Minitab returns the value corresponding to the first true
condition, working from left to right. The final argument is optional and allows you to specify a value to return if
all the conditions are false. If nothing is specified, Minitab returns a missing value.

For example, IF(c1 <= 2, "low", c1 <=4, "medium", "high") returns "low" for c1 values less than or equal to 2,
"medium"” for values less than or equal to 4 but greater than 2, and "high" for the remaining data in c1.

Statistics functions to use with LET

COUNT (C)
Counts the number of nonmissing and missing values in a column.

GMEAN (C)
Calculates the geometric mean, the nth root of the product of the n values. All values must be greater than 0.

MAXIMUM (C)
Calculates the maximum value in a column. Missing values are omitted from the calculation.

MEAN (C)
Calculates the arithmetic mean of all the values in a column. Missing values are omitted from the calculation.

MEDIAN (C)
Calculates the median of the values in a column. Missing values are omitted from the calculation.

MINIMUM (C)
Identifies the minimum value in a column. Missing values are omitted from the calculation.

N (C)
Counts the number of nonmissing values in a column.

NMISS (C)
Counts the number of missing values in a column.
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NSCORES (C)
Calculates normal scores.

PERC (C, E)
Calculates the sample percentiles For the first argument, enter the column of data. For the second argument,
enter the column or constant speci }/lng the desired percentiles, from 0 to 1. Missing values are ignored. For

example, to find the first quartile (25" percentile) of a column of data, enter the column number and the percentile
0.25.

RANGE (C)
Calculates the range of the values in a column. Missing values are omitted from the calculation.

s$sQ (C)
Calculates the uncorrected sum of squares for a column. Missing values are omitted from the calculations.

STDEV (C)
Calculates the standard deviation for all the values in a column. Missing values are omitted from the calculation.

SUM (C)
Adds all the values in a column. Missing values are omitted from the calculation.

Text functions to use with LET

CLEAN ("text")

CLEAN (E)
Removes all nonprintable characters. Specify the text, column, or stored constant.

CONCATENATE ("text", "text"...)

CONCATENATE (E, E...)

Combines two or more columns or values side-by-side. Specify the text, columns, or stored constants. Minitab
treats numbers appearing in a text column (as in a street address or date/time) as text characters and will convert
numeric values to text.

FIND (E, E, [E])
Identifies the starting position of a string of text within another string of text. For the first argument, specify the
text string or the column of text that you want to find. For the second argument, specify the text value or column
of text to search. FIND is case-sensitive.

By default, Minitab searches from the first position of each text entry. You can also specify another starting position
(the location in the string from where to start the search) by inserting a number for K, the optional third argument.

For example, if c1 contains 234b75, FIND("b7",c1) returns 4, because b7 begins at the 4th position in the text.

Minitab returns a missing value * if the string of text is not found.

FIXED (E, K, [1])
Rounds a number to the specified number of decimals and converts it to text with or without commas. For the
first argument, specify the number or the column of numeric data you want to convert. For the second argument,
specify the number of decimals to retain. If K = 1, Minitab rounds to the nearest tenth. If K = 0 Minitab rounds
to the nearest integer. If K = -1, Minitab rounds to a multiple of ten. If you don't enter a second argument, Minitab
rounds to 2 decimal places by default.
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Minitab inserts commas to separate some place values (hundreds and thousands, hundred-thousands and millions,
etc.) in the converted text. If you don't want the commas to appear, enter a value of 1 for the optional third
argument.

HTOD (E)
Converts hexadecimal values to their equivalent decimal form. The original hexadecimal data must be in text
format.

ITEM ("text", E, [E])

ITEM E, E, [E])
Extracts the nth word from a string of text. For the first argument, specify the text or column of text. For the second
argument, specify the position of the word to extract.

By default, one or more spaces define where each word begins and ends. If you want to specify other criteria for
determining the separation between the words, such as a comma, specify the separator using the optional third
argument.

The ITEM function is similar to the WORD function, except that ITEM extracts empty text that occurs between
consecutive separators (such as ,,) while WORD ignores the empty string and extracts the text that follows
consecutive separators.

LAG (C, [K])
Copies the text in the input column to the storage column, moving each value down by the numbers of rows you
specify. For the first argument, specify the input column. For the second argument, specify the number of rows
the text values should be moved down. By default, if no value is specified, Minitab moves the text values down
one row (lag = 1).

LEFT ("text", E)

LEFT (C, E)
Returns the specified number of characters from the beginning of a string of text. For the first argument, specify
the text or the column of text values. For the second argument, indicate how many characters from the left you
want to retain.

LEN ("text")

LEN (C)
Identifies the number of characters in a string of text. Specify the text or the column of text values.

LOWER ("text")

LOWER (C)
Converts all letters to lowercase. Specify the text or the column of text values.

MID ("text", E, [E])

MID (C, E, [E])
Returns the characters from the middle part of a string of text, given the starting position and the length. For the
first argument, specify the text or the column of text values. For the second argument, specify the position of the
first character to return.

You can specify an integer for the optional third argument to limit the number of characters that Minitab returns.
If you don't enter the third argument, Minitab returns all the characters that follow the starting position.
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PAD ("text", E)

PAD (C, E)
Pads text with trailing spaces. For first argument, specify the text or the column of text values. For the second
argument, enter the total number of characters needed for the text and the trailing spaces. The padding is indicated
by total number of characters minus the number of characters in the text.

PROPER ("text")

PROPER (C)
Capitalizes the first letter in each word and converts all other characters to lowercase. Specify the text or the
column of text values.

REPT ("text", E)

REPT (C, E)
Repeats text a given number of times. For the first argument, specify the text or the column of text. For the second
argument, specify how many times to repeat the text.

REPLACE ("text", E, E, E)

REPLACE (C, E, E, E)
Replaces a substring of text within a string of text. For the first argument, specify the original text or column of
text values. For the second argument, specify the position of the first character to replace. For the third argument,
specify how many characters to replace. For the last argument, enter the new text that you want to replace the
old text with.

RIGHT ("text", E)

RIGHT (C, E)
Returns the specified number of characters from the end of a string of text. For the first argument, specify the
text or the column of text values. For the second argument, indicate how many characters from the right you want
to retain.

SEARCH (E, E, E)
Identifies the starting position of a string of text within another string of text. For the first argument, specify the
text string you want to find. For the second argument, specify the column of text to search. FIND is case-sensitive
(distinguishes between b and B).

By default, Minitab searches from the first position of each text entry. You can also specify another starting position
(the location in the string from where to start the search) by inserting a number for K, the optional third argument
of the function.

SEARCH is similar to FIND, except that SEARCH is not case-sensitive (does not distinguish between b and B).

SUBSTITUTE ("text", E, E, [E])

SUBSTITUTE (C, E, E, [E])
Replaces existing text with new text and allows you to specify which occurrence of the old text you want to replace
if the text occurs more than once in a single entry. For the first argument, specify the text or column of text. For
the second argument, specify the text that you want to replace. For the third argument, specify the new text you
want to substitute. For the last (optional) argument, you can specify which occurrence of the old text you want
to replace, if the old text occurs more than once. For example, If c1 contains 600 Pine Lane SUBSTITUTE (c1, "0",
"2", 1) returns 620 Pine Lane.

TEXT (E)

Converts a numeric value to text. Converting numeric values to text allows you to edit and manipulate the values
using text manipulation functions. Specify the number or the column of numeric values.
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TRIM ("text")

TRIM (C)
Removes all spaces except single spaces between words. Specify the text or column of text.

WORD ("text", E, [E])

WORD (C, E, [E]
Extracts the n" word from a string of text. For the first argument, specify the text or column of text. For the second
argument, specify the position of the word to extract.

By default, one or more spaces define where each word begins and ends. If you want to specify other criteria for
determining the separation between the words, such as a comma, specify the separator using the optional third
argument.

The WORD function is similar to the ITEM function, except that ITEM extracts the empty text that occurs between
consecutive separators (such as the comma and space) while WORD ignores the empty string and extracts the
text that follows the consecutive separators.

Trigonometry functions to use with LET

ACSH (E)

Calculates the hyperbolic arccosine of a value. Specify the value or the column of values.
ASNH (E)

Calculates the hyperbolic arcsine of a value. Specify the value or the column of values.
ATNH (E)

Calculates the hyperbolic arctangent of a value. Specify the value or the column of values.
COSH (E)

Calculates the hyperbolic cosine of a value. Specify the value or the column of values.
DEGREES (E)

Changes radians to degrees. Specify the value or the column of values.
RADIANS (E)

Changes degrees to radians. Specify the value or the column of values.
SINH (E)

Calculates the hyperbolic sine of a value. Specify the value or the column of values.
TANH (E)

Calculates the hyperbolic tangent of a value. Specify the value or the column of values.
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Constants functions to use with LET

E ()
Calculates e = 2.71828...

MISS ()
Returns the * = missing value symbol in the specified column.

PI ()
Calculates pi = 3.14159...

Row statistics functions to use with LET

RCOUNT (E, E...)
Counts the number of missing and nonmissing values in the row. You cannot use a hyphen to specify a range of
columns. For example, Minitab would interpret C1-C4 as C1 minus C4.

However, you can use the session command RCOUNT on page 77 to count the number of values in each row
while specifying a range of columns, such as C1-C4.

RMAXIMUM (E, E...)
Identifies the maximum value in each row. Missing values are omitted from the calculation. You cannot use a
hyphen to specify a range of columns. For example, Minitab would interpret C1-C4 as C1 minus C4.

However, you can use the session command RMAXIMUM on page 77 to calculate the maximum value in each
row while specifying a range of columns, such as C1-C4.

RMEAN (E, E...)
Calculates the arithmetic mean of the values in each row. Missing values are omitted from the calculation. You
cannot use a hyphen to specify a range of columns. For example, Minitab would interpret C1-C4 as C1 minus C4.

However, you can use the session command RMEAN on page 78 to calculate the mean of each row while specifying
a range of columns, such as C1-C4.

RMEDIAN (E, E...)
Identifies the median of the values in each row. Missing values are omitted from the calculation. You cannot use
a hyphen to specify a range of columns. For example, Minitab would interpret C1-C4 as C1 minus C4.

However, you can use the session command RMEDIAN on page 78 to calculate the median of each row while
specifying a range of columns, such as C1-C4.

RMINIMUM (E, E...)
Identifies the minimum value in each row. Missing values are omitted from the calculation. You cannot use a
hyphen to specify a range of columns. For example, Minitab would interpret C1-C4 as C1 minus C4.

However, you can use the session command RMINIMUM on page 78 to calculate the minimum value in each row
while specifying a range of columns, such as C1-C4.

RN (E, E...)
Counts the number of nonmissing values in the row. You cannot use a hyphen to specify a range of columns. For
example, Minitab would interpret C1-C4 as C1 minus C4.
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However, you can use the session command RN on page 78 to count the number of nonmissing values in each
row while specifying a range of columns, such as C1-C4.

RNMISS (E, E...)

Counts the number of missing entries in the row. You cannot use a hyphen to specify a range of columns. For
example, Minitab would interpret C1-C4 as C1 minus C4.

However, you can use the session command RNMISS on page 78 to count the number of missing values in each
row while specifying a range of columns, such as C1-C4.

RRANGE (E, E...)
Calculates the range of values in each row. Missing values are omitted from the calculation. You cannot use a
hyphen to specify a range of columns. For example, Minitab would interpret C1-C4 as C1 minus C4.

However, you can use the session command RRANGE on page 79 to calculate the range of each row while
specifying a range of columns, such as C1-C4.

RSSQ (E, E...)
Calculates the uncorrected sum of squares of the values in each row. Missing values are omitted from the calculation.

You cannot use a hyphen to specify a range of columns. For example, Minitab would interpret C1-C4 as C1 minus
C4.

However, you can use the session command RSSQ on page 79 to calculate the uncorrected sum of squares for
each row while specifying a range of columns, such as C1-C4.

RSTDEV (E, E...)

Calculates the standard deviation of the values in each row. Missing values are omitted from the calculation. You
cannot use a hyphen to specify a range of columns. For example, Minitab would interpret C1-C4 as C1 minus C4.

However, you can use the session command RSTDEV on page 79 to calculate the standard deviation of each row
while specifying a range of columns, such as C1-C4.

RSUM (E, E...)

Adds the values in each row. Missing values are omitted from the calculation. You cannot use a hyphen to specify
a range of columns. For example, Minitab would interpret C1-C4 as C1 minus C4.

However, you can use the session command RSUM on page 79 to add values in each row while specifying a range
of columns, such as C1-C4.

MULTIPLY: Session command for multiplication

MULTIPLY E...E E

Note This functionality is available only as a session command, and not in a menu.

Multiplies E by E and stores the result in E. E can be any column, any constant, or any matrix. For columns and
constants, MULTIPLY allows up to 50 arguments. If any element of a row is missing, the result is set to missing. If
the operation is impossible, the result is also set to missing, *.
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Column Statistics

COUNT: Session command for counting the number of values in a column

COUNT C [K]
Counts and optionally stores the number of nonmissing and missing values in a column. (Equivalent to N total
in the menu command dialog box.)

You can also use this command as a function with LET on page 63.

MEAN: Session command for calculating the arithmetic mean of a column

MEAN
Calculates the arithmetic mean of all the values in a column and optionally stores the result. Missing values are
omitted from the calculation.

You can also use this command as a function with LET on page 63.

MEDIAN: Session command for identifying the median of a column

MEDIAN C [K]
Identifies the median of the values in a column and optionally stores the result. Missing values are omitted from
the calculation.

You can also use this command as a function with LET on page 63.

N: Session command for counting the nonmissing values in a column

N C [K]
Counts and optionally stores the number of nonmissing values in a column. (Equivalent to N nonmissing in the
menu command dialog box.)

You can also use this command as a function with LET on page 63.

NMISS: Session command for counting the missing values in a column

NMISS C [K]
Counts and optionally stores the number of missing values in a column. (Equivalent to N missing in the menu
command dialog box.)

You can also use this command as a function with LET on page 63.

Minitab =’ 76



Minitab Statistical Software Manipulating and Calculating Data

RANGE: Session command for calculating a range of values in a column

RANGE C [K]
Calculates the range of values in a column and optionally stores the result. Missing values are omitted from the
calculation.

You can also use this command as a function with LET on page 63.

SSQ: Session command for calculating the uncorrected sum of squares

SSQ C [K]
Calculates the uncorrected sum of squares for a column and optionally stores the result. Missing values are omitted
from the calculations.

You can also use this command as a function with LET on page 63.

STDEV: Session command for calculating the standard deviation of all the values in a column

STDEV C [K]
Calculates the standard deviation for all the values in a column and optionally stores the result. Missing values
are omitted from the calculation.

You can also use this command as a function with LET on page 63.

SUM: Session command for adding the values in a column

SUM C [K]
Adds all the values in a column and optionally stores the result. Missing values are omitted from the calculation.

You can also use this command as a function with LET on page 63.

Row Statistics

RCOUNT: Session command for counting missing and nonmissing values in a row

RCOUNT E...E C
Counts and stores the number of missing and nonmissing values in the row. (Equivalent to N total in the menu
command dialog box.)

Note You can also use this command as a function with LET on page 63. If you use this command as an argument of LET, you cannot
use a hyphen to specify a range of values. For example, Minitab would interpret C1-C4 as C1 minus C4.

RMAXIMUM: Session command for identifying the maximum value in each row

RMAXIMUM E...E C
Identifies and stores the maximum value in each row. Missing values are omitted from the calculation.
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You can also use this command as a function with LET on page 63. If you use this command as an argument of
LET, you cannot use a hyphen to specify a range of values. For example, Minitab would interpret C1-C4 as C1
minus C4.

RMINIMUM: Session command for identifying the minimum value in each row

RMINIMUM E...E C
Identifies and stores the minimum value in each row. Missing values are omitted from the calculation.

You can also use this command as a function with LET on page 63. If you use this command as an argument of
LET, you cannot use a hyphen to specify a range of values. For example, Minitab would interpret C1-C4 as C1
minus C4.

RMEAN: Session command for calculating the arithmetic mean in each row

RMEAN
Calculates and stores the arithmetic mean of the values in each row. Missing values are omitted from the calculation.

You can also use this command as a function with LET on page 63. If you use this command as an argument of
LET, you cannot use a hyphen to specify a range of values. For example, Minitab would interpret C1-C4 as C1
minus C4.

RMEDIAN: Session command for identifying the median in each row

RMEDIAN
Identifies and stores the median of the values in each row. Missing values are omitted from the calculation.

You can also use this command as a function with LET on page 63. If you use this command as an argument of
LET, you cannot use a hyphen to specify a range of values. For example, Minitab would interpret C1-C4 as C1
minus C4.

RN: The session command for counting the nonmissing values in a row

RN E...E C
Counts and stores the number of nonmissing values in the row. (Equivalent to N nonmissing in the menu command
dialog box.)

You can also use this command as a function with LET on page 63. If you use this command as an argument of
LET, you cannot use a hyphen to specify a range of values. For example, Minitab would interpret C1-C4 as C1
minus C4.

RNMISS: Session command for counting the missing values in a row

RNMISS E...E C

Counts and stores the number of missing entries in the row. (Equivalent to N missing in the menu command
dialog box.)
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You can also use this command as a function with LET on page 63. If you use this command as an argument of
LET, you cannot use a hyphen to specify a range of values. For example, Minitab would interpret C1-C4 as C1
minus C4.

RRANGE: Session command for calculating the range in each row

RRANGE E...E C
Calculates and stores the range of values in each row. Missing values are omitted from the calculation.

You can also use this command as a function with LET on page 63. If you use this command as an argument of
LET, you cannot use a hyphen to specify a range of values. For example, Minitab would interpret C1-C4 as C1
minus C4.

RSSQ: Session command for calculating the uncorrected sum of squares

RSSQ E...E C

Calculates and stores the uncorrected sum of squares of the values in each row. Missing values are omitted from
the calculation.

You can also use this command as a function with LET on page 63. If you use this command as an argument of
LET, you cannot use a hyphen to specify a range of values. For example, Minitab would interpret C1-C4 as C1
minus C4.

RSTDEV: Session command for calculating the standard deviation in each row

RSTDEV E...E C

Calculates and stores the standard deviation of the values in each row. Missing values are omitted from the
calculation.

You can also use this command as a function with LET on page 63. If you use this command as an argument of
LET, you cannot use a hyphen to specify a range of values. For example, Minitab would interpret C1-C4 as C1
minus C4.

RSUM: Session command for adding the values in each row
RSUM E...E C
Adds and stores the values in each row. Missing values are omitted from the calculation.

You can also use this command as a function with LET on page 63. If you use this command as an argument of
LET, you cannot use a hyphen to specify a range of values. For example, Minitab would interpret C1-C4 as C1
minus C4.
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Standardize

CENTER: Session command for centering data

CENTER C...C, C...C
Centers the data in C...C and stores the results in C...C. Allows you to center and scale columns of data.

When you do not include subcommands, Minitab transforms each input column by subtracting its mean and then
dividing by its standard deviation. This is often called standardizing a variable.

LOCATION [K...K]

When you do not include Ks, Minitab transforms each column by subtracting its mean. When you specify
one K, Minitab subtracts that value from each column. Otherwise, you must list one K for each column to be
centered. Then Minitab subtracts each K from the corresponding column.

SCALE [K...K]
When you use LOCATION, Minitab first subtracts the location. When you do not specify Ks on SCALE, Minitab
divides each column by its standard deviation. When you specify one K, Minitab divides each column by K.
Otherwise, you must list one K for each column to be centered. Then Minitab divides each column by the
corresponding K.

You must specify K as greater than 0.

MINMAX [K K]
When you do not specify Ks, Minitab transforms all columns (linearly) to have minimum -1 and maximum
+1. When you specify both Ks, Minitab transforms all columns (linearly) to have the first K as minimum and
the second K as maximum.

Make Patterned Data

SET: Session command for entering data into a column

SET C
Inputs data, from the keyboard or from an ASClII file, into one column.

If there is any data in the column you list, SET erases that data and replaces it with the new data you enter. SET
is especially useful for entering data that follow a pattern, such as the numbers 1 through 10, into a column. For
more information, go to Entering patterned data for the SET session command on page 1143.

If you execute SET from the menu, the FORMAT and NOBS options are not available, the form of the data is
restricted, and data cannot be read from a file.

As a simple example, the following command language puts the numbers 2, 7, 9, 3.8, and 22 in column C7.

SET C7
2 79
3.8 22

END

FILE 'filename'
Enters data from the specified ASCII file. If the file has an extension other than DAT and/or if it is not in your
current directory, include the file name extension and the path within the quotation marks.
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FORMAT

The FORMAT subcommand for SET is similar to that for READ (for information, go to READ data into a
matrix on page 43 or READ data into columns on page 41). For example, the following command
language reads 10 numbers from each data line-the first from spaces 1 and 2, the second from spaces
3 and 4, and so on.

SET C1;
FILE "MYFILE";
FORMAT (10F2).

Text data can be input using the FORMAT subcommand. The field width can be up to 80 characters.
You cannot mix text and numeric data in a single column.

Here is an example that inputs four "words" using A format into C1.

SET C1;
FORMAT (All, Tl6, A2).
ABCDEFGHIJK LM
abcdefghijk 1m
END

For more information, go to Valid format items on page 1186.

NOBS K

Specifies the number of observations (rows) to be read. If an END on page 38 subcommand or end-of-file
is encountered before K observations are read, NOBS is ignored. NOBS is useful when you want to read
just the first portion of a file. NOBS is also useful when you prompt the user for information. For more
information, go to Prompting a user for information on page 1177.

SKIP K

Tells Minitab to skip K lines at the top of the data file before beginning to READ or SET data into the
file. This is most useful when you have one or more lines of text, such as column names and titles, at
the top of a data file that you want to import into Minitab.

DECIMAL ".” or ","
Specifies a period or comma as the decimal separator.

TSET: Session command for creating data that follow complicated patterns
TSET
Using TSET, you can create data that follow more complicated patterns. You can also use TSET to import text files.

TSET is the same as SET except there is no through construct, and you list text constants, stated or stored, instead
of numbers. Repeat factors are integers, stated or stored. A text string must be enclosed in double quotes as in
LET.

As in SET, you can input data from a file in addition to typing it from the keyboard.

FILE "filename'"

Enters data from the specified file. If the file has an extension other than DAT and/or if it is not in your current
directory, include the file name extension and the path within the quotation marks.
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Examples

This example contains text constants and repeat factors.

TSET C1
5("Red" "Green") 2("Yellow") 3 ("Green")
END
LET K1 = "Low"
LET K2 = 10
TSET Cl
5(K1 "Medium" "High")K2 K1 K1
END

DSET: Session command for making patterned data

DSET C
Creates a new column of dates and/or times that follow a pattern.

For example, the commands store the dates 1/1/15, 1/2/15, .., 1/31/15 into C1.

DSET C1;
DSTART "1/1/15";
DEND "1/31/15";
DAY 1.

Note Minitab's default date/time formats can change depending on the Regional Settings of your device. For more information, go
to Default date/time formats on page 1140.

LIST
Date/time K...K or "text" ..."text".

FORMAT K

The format statement can be used for two purposes. It provides the format for the resulting patterned data.
If no format is given then the resulting column will be in the format of the last date/time value given either
on the DSTART or DEND subcommand lines. Also, it can be utilized as a user-defined format for specifying
the input format of the start and end date/time value. If no format statement is given, the date/time values
on the DSTART and DEND subcommands must be in a default format. For example:

DSET C1;

DSTART "1/1/15";

DEND "1/31/15";

FORMAT (DTm-d-vyy) ;
DAY 1.

The format statement must begin with the characters DT followed by the desired date/time format. The
preceding example displays dates in the form 1-1-15.

Note Minitab's default date/time formats can change depending on the Regional Settings of your device. For more information,
go to Default date/time formats on page 1140.

DSTART K
DSTART specifies the beginning date/time value. The argument can be either a stored text constant or a text
string in double quotation marks. If you want to use a non-default date/time format for the text given with
DSTART and DEND, you must use the FORMAT subcommand. (If you are using a default date/time format,
FORMAT is not necessary.)

Note Minitab's default date/time formats can change depending on the Regional Settings of your device. For more information,
go to Default date/time formats on page 1140.
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DEND specifies the ending date/time value. The argument can be either a stored text constant or a text string
in double quotation marks. If you want to use a non-default date/time format for the text given with DSTART
and DEND, you must use the FORMAT subcommand. (If you are using a default date/time format, FORMAT

is not necessary.)

Note Minitab's default date/time formats can change depending on the Regional Settings of your device. For more information,

go to Default date/time formats on page 1140.

RLIST K

RLIST specifies the number of times to repeat the list. K must be a positive integer greater than or equal to

1.

RVALUE K

RVALUE specifies the number of times to repeat each value. K must be a positive integer greater than or

equal to 1.

Subcommands for incrementing the date/time data

You must use one (and only one) of the following subcommands with DSET to indicate how to increment the date/time

data. K must be a positive integer greater than or equal to 1.

The patterned data ends when a date/time value is greater than or equal to the end date/time value (DEND). The end
date/time value is part of the column only if the pattern equals the end date/time value.

Note Minitab's default date/time formats can change depending on the Regional Settings of your device. For more information, go to

Default date/time formats on page 1140.

DAY
Increments day by K units.

WDAY
Increments workday (M—F) by K units.

WEEK
Increments week by K units.

MONTH
Increments month by K units.

QUARTER
Increments quarter by K units.

YEAR
Increments year by K units.

HOUR
Increments hour by K units.

MINUTE
Increments minute by K units.

SECOND
Increment second by K units.
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HUNDREDTH
Increment hundredth by K units.

THOUSANDTHS
Increment thousandths by K units.

Make Mesh Data

MESH: Session command for making mesh data

MESH C C

Creates a mesh of regular x-y data and stores the data in C and C. (Data with a regular shape form a grid with
evenly spaced intervals. Data with an irregular shape are not located on evenly spaced intervals.)

You can use the mesh data for drawing surface and wireframe plots, with an option to create the z-data at the

same time.

XMESH K K K (optional)
Specifies the lowest x-value, the highest x-value, and the number of x-values. The defaultis—-55 11.

YMESH K K K (optional)
Specifies the lowest y-value, the highest y-value, and the number of y-values. The defaultis —-55 11.

SUSERFUNC K C C C (optional)
Specifies your own function as indicated by function number K in the macro %USERFUNC. For instructions
to add your own function, go to Add your own function on page 1131.

PARAMS K...K (optional)
Specifies parameters for the functions. See the table below for formulas and the number of parameters.

Functions for z-values (optional)

The function subcommands in the following table generate Z-values for the mesh and store them in C.

Subcommand Equation Parameters (in order)

BVNORMAL C C My =MU1, 04 =S1, 4, = MU2, 0, =S2, p = RHO

“b{2i1 - ot
z = ae[ f2it-p0) (01#20,0,0#20,-1<p<1)

The following variables are derived from the
above variables, as follows:

1

BOWL C Y 2 A, B, C
Z=M (A#0,B#0,C=%0)
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Subcommand
CONE C

COWBOYHAT C

EGGCARTON C

HEMISPHERE C

HILLANDDALE C

SADDLE C

WAVE C

Equation

o E L ¥
sing xcosy +sing xcosg

C
- (D)
whereifz < 0,setz=0

b)

.
sin—+ coss
A B

Make Indicator Variables

Manipulating and Calculating Data

Parameters (in order)
A B, C
(A#z0,B=z0,C#0)

A B C
(A#0,B#0,C#%0)

A B, C
(A#0,B#0,C=#0)

A B CR
(A#0,B#0,C#0,R#%0)

A B, C
(Az20,B=0,Cz0)

A B, C
(A#0,B#0,C#0)

A B, C
(A#0,B#0,C=#0)

INDICATOR: Session command for creating indicator variables

INDICATOR C C...C

Creates indicator variables (also called dummy variables) that you can use in a regression analysis. If you use

REGRESS on page 169, you do not need to create indicator variables.

The smallest number in C2 is 2 and the largest is 6. INDICATOR creates one indicator variable for each unique

value.

e C11is the indicator variable for the value 2. C11 contains a 1 in every row where C2 contains a 2, and 0
otherwise.

e (12 is the indicator variable for the value 3. C12 contains a 1 in every row where C2 contains a 3, and 0
otherwise.

e (13 is the indicator variable for 5. C13 contains a 1 in every row where C2 contains 5, and 0 otherwise.

e (14 is the indicator variable for 6. C13 contains a 1 in every row where C2 contains 6, and 0 otherwise.

If C2 contains an * (missing data code), then all indicator variables are also set to *.

The number of storage columns must be equal to the number of distinct values (not including *) in the input
column. Up to 100 storage columns are allowed on INDICATOR.
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The following command language is an example of using INDICATOR.

INDICATOR C2, Cl1-Cl4

Before using INDICATOR

Cc1

U o0 W U1 NN

*

After using INDICATOR

c1 C11 C12 C13 C14

2 1 0 0 0
2 1 0 0 0
5 0 0 1 0
3 0 1 0 0
6 0 0 0 1
5 0 0 1 0

Random Data

BASE: Session command for fixing a starting number for the random number generator

BASE K
Fixes a starting point for Minitab's random number generator.

Minitab has a long string of random numbers available. Minitab normally chooses its own starting point for this
process. If Minitab always started at the beginning of the list, you would always get the same data. To avoid this,
Minitab uses the time of day to choose a random starting point in the string.

However, you might want to control where Minitab starts the string. For example, you may wish to repeat a
sequence by generating the same set of random data. In this case, the BASE command tells the random number
generator where to start. The generator will use this base until you set a new BASE or exit Minitab.

Note If you use the same base on different platforms or different versions of Minitab, you might not get the same random number
sequence.
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RANDOM: Session command for generating random data

RANDOM E [E]
Use RANDOM to generate and store a random sample of one or more observations from a specified distribution.

The subcommand specifies the distribution. If no subcommand is given, data are simulated from a normal
distribution with mu = 0 and sigma = 1.

Use the BASE on page 86 command to generate the same set of data more than once.

Suppose you want 50 random samples, each containing 20 observations, from a binomial distribution with number
of trials n = 5, and probability of success p = 0.3. To place each sample in a separate column, type the following
commands.

RANDOM 20 C1-C50;
BINOMIAL 5 0.3.

CHISQUARE K
Specifies distribution to sample, with degrees of freedom = K.

NORMAL [K [K]]
Specifies distribution to sample. Generates data from a standard normal. Optionally, specify mean = K, and
standard deviation = K.

MNORMAL C M
Specifies distribution to sample, with mean column = C, and variance-covariance matrix = M.

F K K

Specifies distribution to sample, with numerator degrees of freedom = K, denominator degrees of freedom
=K

T K
Specifies distribution to sample, with degrees of freedom = K.

UNIFORM [K K]
Specifies distribution to sample. Generates data using lower endpoint = 0.0 and upper endpoint = 1.0.
Optionally, specify lower endpoint = K and upper endpoint = K.

BERNOULLI K
Specifies distribution to sample, with probability of success = K.

BINOMIAL K K
Specifies distribution to sample, with number of trials = K and event probability = K.

GEOMETRIC K
Specifies distribution to sample, with event probability = K.

NONEVENT
Models the number of nonevents before the first event occurs.

TOTAL
Models the total number of trials needed to produce one event.

NEGBINOMIAL K K
Specifies distribution to sample, with event probability = K and number of events needed = K.
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NONEVENT
Models the number of nonevents before the specified number of events occurs.

TOTAL
Models the total number of trials needed to produce the specified number of events.

HYPERGEOMETRIC K K K

Specifies distribution to sample, with population size = K, event count in population = K, and sample size =
K.

DISCRETE C C
Specifies distribution to sample, with values in C and probabilities in C.

INTEGER K K

Specifies distribution to sample, with discrete uniform on integers from minimum value = K to maximum
value = K.

POISSON K
Specifies distribution to sample, with mean = K.

BETA K K
Specifies distribution to sample, with first shape parameter = K and second shape parameter = K.

CAUCHY [K [K]]
Specifies distribution to sample. Generates data using location = 0.0 and scale = 1.0. Optionally, specify
location = K and scale = K.

EXPONENTIAL [K [K]]
Specifies distribution to sample. Generates data using mean = 1.0 and threshold = 0.0. Optionally, specify
mean = K and threshold = K.

GAMMA K K [K]
Specifies distribution to sample, with shape = K, scale = K, and optionally, threshold = K.

LAPLACE [K [K]]
Specifies distribution to sample. Generates data using location = 0.0 and scale = 1.0. Optionally, specify
location = K and scale = K.

LEXTREME [K [K]]
Specifies distribution. Generates data using location = 0.0 and scale = 1.0. Optionally, specify location = K
and scale = K.

LOGISTIC [K [K]]
Specifies distribution to sample. Generates data using location = 0.0 and scale = 1.0. Optionally, specify
location = K and scale = K.

LLOGISTIC [K [K [K]]]
Specifies distribution to sample. Generates data using location = 0.0, scale = 1.0, and threshold = 0.0.
Optionally, specify location = K, scale = K, and threshold = K.

LNORMAL [K [K [K]]]

Specifies distribution to sample. Generates data using location = 0.0, scale = 1.0, and threshold = 0.0.
Optionally, specify location = K, scale = K, and threshold = K.
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SEXTREME [K [K]]
Specifies distribution to sample. Generates data using location = 0.0 and scale = 1.0. Optionally, specify
location = K and scale = K.

TRIANGULAR K K K
Specifies distribution to sample, with lower endpoint = K, mode = K, and upper endpoint = K.

WEIBULL K K [K]
Specifies distribution sample, with shape = K, scale = K, and optionally, threshold = K.

SAMPLE: Session command for generating rows of random data from specified columns

SAMPLE K C...C

Generates K rows of random data from specified input columns, C...C, and stores in specified storage columns,
C..C.

Takes a random sample of rows. If you use REPLACE, you can select the same row more than once. If you use
NOREPLACE, you cannot select the same row more than once. If you do not use a subcommand, Minitab samples
without replacement.

Tip Ifthere are Krows in C...C columns, you can randomize their order by sampling all K rows and storing in the original input columns.
For example, SAMPLE K C1 C1.

REPLACE
When you sample with replacement, a selected observation goes back into the pool of possible choices and
can be selected again.

NOREPLACE
When you sample without replacement, a selected observation can be chosen only once.

Probability Distributions

PDF: Session command for calculating the probability distribution of a continuous random
variable

PDF E [E]
Calculates density values or probabilities for the specified values in E from a standard normal distribution or
another specified distribution and stores in E.

e For a discrete distribution, the probability distribution function (pdf) calculates probabilities for the specified
values (sometimes called the discrete probability distribution function). If you specify a discrete distribution
(BINOMIAL, GEOMETRIC, NEGBINOMIAL, HYPERGEOMETRIC, DISCRETE, INTEGER, POISSON), the arguments
on the PDF line are optional. If you do not specify arguments, Minitab displays a table of the distribution. If
you execute PDF from the menu, you must supply the input columns.

e For a continuous distribution, pdf calculates the continuous probability density function (often called the
density function).

¢ If you do not specify a distribution, results are generated for a normal distribution with mu = 0 and sigma =
1.

Storage is optional. If you specify a storage column, pdf values are stored there and are not displayed. If you do
not specify a storage column, Minitab displays pdf values.
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CHISQUARE K [K]
Specifies distribution with degrees of freedom = K.

NORMAL [K [K]]
Specifies distribution. Generates data from a standard normal; optionally specify mean = K, and standard
deviation = K.

F KK
Specifies distribution, with numerator degrees of freedom = K, denominator degrees of freedom = K.

T K
Specifies distribution, with degrees of freedom = K.

UNIFORM [K K]

Specifies distribution. Generates data using lower endpoint = 0.0 and upper endpoint = 1.0. Optionally,
specify lower endpoint = K and upper endpoint = K.

BINOMIAL K K
Specifies distribution, with number of trials = K and event probability = K.

GEOMETRIC K
Specifies distribution, with event probability = K.

NONEVENT
Models the number of nonevents before the first event occurs.

TOTAL
Models the total number of trials needed to produce one event.

NEGBINOMIAL K K
Specifies distribution, with event probability = K- and number of events needed = K.

NONEVENT
Models the number of nonevents before the specified number of events occurs.

TOTAL
Models the total number of trials needed to produce the specified number of events.

HYPERGEOMETRIC K K K
Specifies distribution, with population size = K, event count in population = K, and sample size = K.

DISCRETE C C
Specifies distribution, with values in C and probabilities in C.

INTEGER K K
Specifies distribution, with discrete uniform on integers from minimum value = K to maximum value = K.

POISSON K
Specifies distribution, with mean = K.

BETA K K
Specifies distribution, with first shape parameter = K and second shape parameter = K.
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CAUCHY [K [K]]

Specifies distribution. Generates data using location = 0.0 and scale = 1.0. Optionally, specify location = K
and scale = K.

EXPONENTIAL [K [K]]

Specifies distribution. Generates data using mean = 1.0 and threshold = 0.0. Optionally, specify mean = K
and threshold = K.

GAMMA K K [K]
Specifies distribution, with shape = K, scale = K, and optionally, threshold = K.

LAPLACE [K [K]]
Specifies distribution. Generates data using location = 0.0 and scale = 1.0. Optionally, specify location = K
and scale = K.

LEXTREME [K [K]]
Specifies distribution. Generates data using location = 0.0 and scale = 1.0. Optionally, specify location = K
and scale = K.

LOGISTIC [K [K]]

Specifies distribution. Generates data using location = 0.0 and scale = 1.0. Optionally, specify location = K
and scale = K.

LLOGISTIC [K [K [K]]]
Specifies distribution. Generates data using location = 0.0, scale = 1.0, and threshold = 0.0. Optionally, specify
location = K, scale = K, and threshold = K.

LNORMAL [K [K [K]]]
Specifies distribution. Generates data using location = 0.0, scale = 1.0, and threshold = 0.0. Optionally, specify
location = K, scale = K, and threshold = K.

SEXTREME [K [K]]

Specifies distribution. Generates data using location = 0.0 and scale = 1.0. Optionally, specify location = K
and scale = K.

TRIANGULAR K K K
Specifies distribution, with lower endpoint = K, mode = K, and upper endpoint = K.

WEIBULL K K [K]
Specifies distribution, with shape = K, scale = K, and optionally, threshold = K.

CDF: Session command for calculating the cumulative probability of an x-value

CDF E [E]
Calculates probabilities for the specified values in E from a standard normal distribution or another specified
distribution and stores the probabilities in E.

The cumulative distribution function, cdf, for any value x is the probability that a random variable with the specified
distribution has a value less than or equal to x. That is:

CDF (x) = Pr(X < x)
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e If you specify a discrete distribution (BINOMIAL, GEOMETRIC, NEGBINOMIAL, HYPERGEOMETRIC, DISCRETE,
INTEGER, POISSON), then the arguments on the CDF line are optional. If you do not specify an argument, then
Minitab displays a table of the distribution. (Entries where the cdf is less than 0.00005 or greater than 0.99995
might not be displayed in this table.) If you execute CDF from the menu, you must supply the input columns.

¢ |f you do not specify a distribution, then the results are generated for a normal distribution with mu = 0 and
sigma = 1.

Storage is optional. If you specify a storage column, the cdf values are stored there and are not displayed. If you
do not specify a storage column, Minitab displays the cdf values.

CHISQUARE K [K]
Specifies distribution with degrees of freedom = K, and, optionally, noncentrality parameter = K.

NORMAL [K [K]]
Specifies distribution. Generates data from a standard normal. Optionally, specify mean = K and standard
deviation = K.

F K K [K]
Specifies distribution, with numerator degrees of freedom = K, denominator degrees of freedom = K, and,
optionally, noncentrality parameter = K.

T K [K]
Specifies distribution, with degrees of freedom = K and, optionally, noncentrality parameter = K.

UNIFORM [K K]
Specifies distribution. Generates data using lower endpoint = 0.0 and upper endpoint = 1.0. Optionally,
specify lower endpoint = K and upper endpoint = K.

BINOMIAL K K
Specifies distribution, with number of trials = K and event probability = K.

GEOMETRIC K
Specifies distribution, with event probability = K.

NONEVENT
Models the number of nonevents before the first event occurs.

TOTAL
Models the total number of trials that are needed to produce one event.

NEGBINOMIAL K K
Specifies distribution, with event probability = K and number of events that are needed = K.

NONEVENT
Models the number of nonevents before the specified number of events occurs.

TOTAL
Models the total number of trials that are needed to produce the specified number of events.

HYPERGEOMETRIC K K K
Specifies distribution, with population size = K, event count in population = K, and sample size = K.

DISCRETE C C
Specifies distribution, with values in C and probabilities in C.
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INTEGER K K
Specifies distribution, with discrete uniform on integers from minimum value = K to maximum value = K.

POISSON K
Specifies distribution, with mean = K.

BETA K K
Specifies distribution, with first shape parameter = K and second shape parameter = K.

CAUCHY [K [K]]
Specifies distribution. Generates data using location = 0.0 and scale = 1.0. Optionally, specify location = K
and scale = K.

EXPONENTIAL [K [K]]

Specifies distribution. Generates data using mean = 1.0 and threshold = 0.0. Optionally, specify mean = K
and threshold = K.

GAMMA K K [K]
Specifies distribution, with shape = K, scale = K, and optionally, threshold = K.

LAPLACE [K [K]]
Specifies distribution. Generates data using location = 0.0 and scale = 1.0. Optionally, specify location = K
and scale = K.

LEXTREME [K [K]]

Specifies distribution. Generates data using location = 0.0 and scale = 1.0. Optionally, specify location = K
and scale = K.

LOGISTIC [K [K]]
Specifies distribution. Generates data using location = 0.0 and scale = 1.0. Optionally, specify location = K
and scale = K.

LLOGISTIC [K [K [K]]]

Specifies distribution. Generates data using location = 0.0, scale = 1.0, and threshold = 0.0. Optionally, specify
location = K, scale = K, and threshold = K.

LNORMAL [K [K [K]]]
Specifies distribution. Generates data using location = 0.0, scale = 1.0, and threshold = 0.0. Optionally, specify
location = K, scale = K, and threshold = K.

SEXTREME [K [K]]
Specifies distribution. Generates data using location = 0.0 and scale = 1.0. Optionally, specify location = K
and scale = K.

TRIANGULAR K K K
Specifies distribution, with lower endpoint = K, mode = K, and upper endpoint = K.

WEIBULL K K [K]
Specifies distribution, with shape = K, scale = K, and optionally, threshold = K.
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INVCDF: Session command for calculating the variable for a cumulative probability

INVCDF E [E]
Calculates the inverse of the cdf for the specified values in E from a standard normal distribution or another
specified distribution and stores in E.

INVCDF returns the inverse of the cumulative distribution function (cdf), meaning that for a given probability, p,
INVCDF finds a value of x such that p = CDF(x).

For discrete distributions, INVCDF (p) = min {x such that CDF(x) > p}.
If you do not specify a distribution, results are generated for a normal distribution with mu = 0 and sigma = 1.
Storage is optional. If you specify a storage column, the INVCDF values are stored there and are not displayed. If

you do not specify a storage column, Minitab displays the INVCDF values.

CHISQUARE K [K]
Specifies distribution with degrees of freedom = K, and, optionally, noncentrality parameter = K.

NORMAL [K [K]]
Specifies distribution. Generates data from a standard normal distribution. Optionally, specify mean = K, and
standard deviation = K.

F K K [K]
Specifies distribution, with numerator degrees of freedom = K, denominator degrees of freedom = K, and,
optionally, noncentrality parameter = K.

T K [K]
Specifies distribution, with degrees of freedom = K and, optionally, noncentrality parameter = K.

UNIFORM [K K]
Specifies distribution. Generates data using lower endpoint = 0.0 and upper endpoint = 1.0. Optionally,
specify lower endpoint = K and upper endpoint = K.

BINOMIAL K K
Specifies distribution, with number of trials = K and event probability = K.

GEOMETRIC K
Specifies distribution, with event probability = K.

NONEVENT
Models the number of nonevents before the first event occurs.

TOTAL
Models the total number of trials that are needed to produce one event.

NEGBINOMIAL K K
Specifies distribution, with event probability = K. and number of events needed = K.

NONEVENT
Models the number of nonevents before the specified number of events occurs.

TOTAL
Models the total number of trials that are needed to produce the specified number of events.
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HYPERGEOMETRIC K K K
Specifies distribution, with population size = K, event count in population = K, and sample size = K.

DISCRETE C C
Specifies distribution, with values in C and probabilities in C.

INTEGER K K
Specifies distribution, with discrete uniform on integers from minimum value = K to maximum value = K.

POISSON K
Specifies distribution, with mean = K.

BETA K K
Specifies distribution, with first shape parameter = K and second shape parameter = K.

CAUCHY [K [K]]

Specifies distribution. Generates data using location = 0.0 and scale = 1.0. Optionally, specify location = K
and scale = K.

EXPONENTIAL [K [K]]

Specifies distribution. Generates data using mean = 1.0 and threshold = 0.0. Optionally, specify mean = K
and threshold = K.

GAMMA K K [K]
Specifies distribution, with shape = K, scale = K, and, optionally, threshold = K.

LAPLACE [K [K]]
Specifies distribution. Generates data using location = 0.0 and scale = 1.0. Optionally, specify location = K
and scale = K.

LEXTREME [K [K]]

Specifies distribution. Generates data using location = 0.0 and scale = 1.0. Optionally, specify location = K
and scale = K.

LOGISTIC [K [K]]

Specifies distribution. Generates data using location = 0.0 and scale = 1.0. Optionally, specify location = K
and scale = K.

LLOGISTIC [K [K [K]]]
Specifies distribution. Generates data using location = 0.0, scale = 1.0, and threshold = 0.0. Optionally, specify
location = K, scale = K, and threshold = K.

LNORMAL [K [K [K]]]
Specifies distribution. Generates data using location = 0.0, scale = 1.0, and threshold = 0.0. Optionally, specify
location = K, scale = K, and threshold = K.

SEXTREME [K [K]]

Specifies distribution. Generates data using location = 0.0 and scale = 1.0. Optionally, specify location = K
and scale = K.

TRIANGULAR K K K
Specifies distribution, with lower endpoint = K, mode = K, and upper endpoint = K.

WEIBULL K K [K]
Specifies distribution, with shape = K, scale = K, and optionally, threshold = K.
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Resampling Analyses

BTFT: Session command for calculating a 1-sample bootstrap confidence interval of a function

BTFT C K

BTFT calculates a confidence interval for a function in a population. The C specifies the column that contains a
sample from the population. The K specifies the number of resamples. The number of resamples can be from 1
to 10,000. The available functions are mean, median, sum, variance, and standard deviation.

Use the appropriate subcommand to choose the function. Specify only one of MEAN, MEDIAN, SUM, VARIANCE,
and STDEV.

MEAN
Calculates a confidence interval for the mean.

MEDIAN
Calculates a confidence interval for the median.

SUM
Calculates a confidence interval for the sum.

VARIANCE
Calculates a confidence interval for the variance.

STDEV
Calculates a confidence interval for the standard deviation.

Options

ITYPE K
Enter K to specify the type of confidence interval.

Value of K Format of the alternative hypothesis
-1 Lower bound

0 (default) Two-sided

1 Upper bound

CONFIDENCE K

Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of K is 95.

BASE K
Fixes a starting point for Minitab's random number generator.
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Normally, Minitab uses the time of day to start the random number generator. Instead, you can use the BASE
subcommand to specify a number to use to start the generator. Use the BASE subcommand so that you can
generate the same sample repeatedly.

Note If you use the same base on different platforms or different versions of Minitab, you might not get the same random number
sequence.

SSAMPLE C
Stores the statistics from the resampling process.

Results

Use the following subcommands to control what output Minitab produces.

TSTATISTICS
Displays summary statistics for the sample: mean, standard deviation, variance, sum, minimum, median, and
maximum.

TBOOTSTRAP
Displays the confidence interval and the associated statistics.

GHISTOGRAM

Displays a histogram of the resampled statistics. GHISTOGRAM does not work if the number of resamples is 1 or
if you specify GINDIVIDUAL.

GINDIVIDUAL
Displays an individual value plot that compares the resample to the original sample. GINDIVIDUAL does not work
if the number of resamples is greater than 1 or if you specify GHISTOGRAM.

BTPR: Session command for calculating a 1-sample bootstrap confidence interval of a
proportion

BTPR C K

BTPR K K K
BTPR calculates a confidence interval for a proportion in a population. In the first parameterization, the C specifies
the column that contains a sample from the population. The column must contain 1 or 2 unique, non-missing
values. The K specifies the number of resamples. The number of resamples can be from 1 to 10,000.

In the second parameterization, the first K represents the number of events. The first K must be greater than or
equal to 1. The second K represents the number of trials. The number of trials must be greater than the number
of events and less than 100,000. The third K is the number of resamples. The number of resamples must be from
1 to 10,000.

EVENT K

When the sample data are in a column, use EVENT to specify the value in the column that the proportion should
be for. The value of K matches one of the values in the sample column. Enclose text values in quotation marks.
For example, to calculate an interval for the proportion of a "Fail" in the sample column, enter EVENT "Fail".
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Options

ITYPE K
Enter K to specify the type of confidence interval.

Value of K Format of the alternative hypothesis
-1 Lower bound

0 (default) Two-sided

1 Upper bound

CONFIDENCE K

Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of K'is 95.

BASE K
Fixes a starting point for Minitab's random number generator.

Normally, Minitab uses the time of day to start the random number generator. Instead, you can use the BASE
subcommand to specify a number to use to start the generator. Use the BASE subcommand so that you can
generate the same sample repeatedly.

Note If you use the same base on different platforms or different versions of Minitab, you might not get the same random number

sequence.

SSAMPLE C
Stores the proportions from the resampling process.

Results

Use the following subcommands to control what output Minitab produces.

TSTATISTICS
Displays summary statistics for the sample: sample size and proportion.

TBOOTSTRAP
Displays the confidence interval and the associated statistics.

GHISTOGRAM

Displays a histogram of the resampled proportions. GHISTOGRAM does not work if the number of resamples is
1 or if you specify GINDIVIDUAL.

GBARCHART

Displays a bar chart that compares the resample to the original sample. GBARCHART does not work if the number
of resamples is greater than 1 or if you specify GHISTOGRAM.
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BTTM: Session command for calculating a 2-sample bootstrap confidence interval for the
difference of means

BTTM C C K
BTTM calculates a confidence interval for the difference between the means of two populations. The columns can
have one of two formats:

e The first column contains the measurements. The second column identifies which population each observation
is from.

e Each column contains a sample from a different population. Use UNSTACKED to specify that the data are in
this format.

The value of K is the number of resamples. The number of resamples must be from 1 to 10,000.

The difference is the first sample minus the second sample. When the data are stacked, the first sample depends
on the values in the identification column. The first value is the lowest number, the first value alphabetically, the
earliest date, or the earliest value in a previously-specified value order. When the data are unstacked, the first
sample is in the first C after BTTM.

UNSTACKED
Indicates that the columns after BTTM contain different samples.

Options

ITYPE K
Enter K to specify the type of confidence interval.

Value of K Format of the alternative hypothesis
-1 Lower bound

0 (default) Two-sided

1 Upper bound

CONFIDENCE K
Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of K'is 95.

BASE K
Fixes a starting point for Minitab's random number generator.

Normally, Minitab uses the time of day to start the random number generator. Instead, you can use the BASE
subcommand to specify a number to use to start the generator. Use the BASE subcommand so that you can
generate the same sample repeatedly.

Note If you use the same base on different platforms or different versions of Minitab, you might not get the same random number
sequence.

SDIFFERENCES C
Stores the differences from the resampling process.
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Results

Use the following subcommands to control what output Minitab produces.

TOBSERVED

Displays summary statistics for the samples: mean, standard deviation, variance, sum, minimum, median, and
maximum.

TDIFFERENCES
Displays the difference between the sample means.

TBOOTSTRAP
Displays the confidence interval and the associated statistics.

GHISTOGRAM

Displays a histogram of the resampled differences. GHISTOGRAM does not work if the number of resamples is 1
or if you specify GINDIVIDUAL.

GINDIVIDUAL

Displays an individual value plot that compares the resamples to the original samples. GINDIVIDUAL does not
work if the number of resamples is greater than 1 or if you specify GHISTOGRAM.

RNMN: Session command for performing a 1-sample randomization test of a mean

RNMN C K K

RNMN performs a hypothesis test that the mean of the population equals the second K. The C specifies the column
that contains a sample from the population. The first K specifies the number of resamples. The number of resamples
can be from 1 to 10,000.

Options

ALTERNATIVE K
Enter K to specify the direction of the alternative hypothesis.

Value of K Format of the alternative hypothesis
-1 Less than
0 (default) Not equal to
1 Greater than
BASE K

Fixes a starting point for Minitab's random number generator.
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Normally, Minitab uses the time of day to start the random number generator. Instead, you can use the BASE
subcommand to specify a number to use to start the generator. Use the BASE subcommand so that you can
generate the same sample repeatedly.

Note If you use the same base on different platforms or different versions of Minitab, you might not get the same random number
sequence.

SMEAN C
Stores the means from the resampling process.

Results

Use the following subcommands to control what output Minitab produces.

TOBSERVED
Displays summary statistics for the sample: mean, standard deviation, variance, sum, minimum, median, and
maximum.

TRANDOMIZATION
Displays the results of the hypothesis test.

GHISTOGRAM
Displays a histogram of the resampled means. GHISTOGRAM does not work if the number of resamples is 1 or if
you specify GINDIVIDUAL.

GINDIVIDUAL
Displays an individual value plot that compares the resample to the original sample. GINDIVIDUAL does not work
if the number of resamples is greater than 1 or if you specify GHISTOGRAM.

RNPR: Session command for performing a 1-sample randomization test of a proportion

RNPR C K K

RNPR K K K K
RNPR performs a hypothesis test on a proportion in a population. In the first parameterization, the C specifies
the column that contains a sample from the population. The column must contain 1 or 2 unique, non-missing
values. The first K specifies the number of resamples. The number of resamples can be from 1 to 10,000. The last
K'is the hypothesized proportion. The hypothesized proportion must be a value between 0 and 1.

In the second parameterization, the first K represents the number of events. The first K must be greater than or

equal to 1. The second K represents the number of trials. The number of trials must be greater than the number
of events and less than 1 million. The third K is the number of resamples. The number of resamples must be from
1 to 10,000. The last K is the hypothesized proportion. The hypothesized proportion must be a value between 0
and 1.

Options

ALTERNATIVE K
Enter K to specify the direction of the alternative hypothesis.
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Value of K Format of the alternative hypothesis
-1 Less than
0 (default) Not equal to
1 Greater than
BASE K

Fixes a starting point for Minitab's random number generator.

Normally, Minitab uses the time of day to start the random number generator. Instead, you can use the BASE
subcommand to specify a number to use to start the generator. Use the BASE subcommand so that you can
generate the same sample repeatedly.

Note If you use the same base on different platforms or different versions of Minitab, you might not get the same random number
sequence.

SPROPORTION C
Stores the proportions from the resampling process.

Results

Use the following subcommands to control what output Minitab produces.

TOBSERVED
Displays summary statistics for the sample: sample size and proportion.

TRANDOMIZATION
Displays the results of the hypothesis test.

GHISTOGRAM

Displays a histogram of the resampled proportions. GHISTOGRAM does not work if the number of resamples is
1 or if you specify GINDIVIDUAL.

GBARCHART
Displays a bar chart that compares the resample to the original sample. GBARCHART does not work if the number
of resamples is greater than 1 or if you specify GHISTOGRAM.

RNTM: Session command for performing a 2-sample randomization test of means

RNTM C C K
RNTM performs a hypothesis test that the means of two populations are equal. The columns can have one of two
formats:

e The first column contains the measurements. The second column identifies which population each observation
is from.

e Each column contains a sample from a different population. Use UNSTACKED to specify that the data are in
this format.

The value of K specifies the number of resamples. The number of resamples must be from 1 to 10,000.
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The difference is the first sample minus the second sample. When the data are stacked, the first sample depends
on the values in the identification column. The first value is the lowest number, the first value alphabetically, the
earliest date, or the earliest value in a previously-specified value order. When the data are unstacked, the first
sample is in the first C after RNTM.

UNSTACKED
Indicates that the columns after RNTM contain different samples.

Options

ALTERNATIVE K
Enter K to specify the direction of the alternative hypothesis.

Value of K Format of the alternative hypothesis

-1 The mean of the first sample is less than the mean of the second sample.

0 (default) The mean of the first sample is not equal to the mean of the second sample.

1 The mean of the first sample is greater than the mean of the second sample.
BASE K

Fixes a starting point for Minitab's random number generator.

Normally, Minitab uses the time of day to start the random number generator. Instead, you can use the BASE
subcommand to specify a number to use to start the generator. Use the BASE subcommand so that you can
generate the same sample repeatedly.

Note |If you use the same base on different platforms or different versions of Minitab, you might not get the same random number
sequence.

SDIFFERENCES C
Stores the differences from the resampling process.

Results
Use the following subcommands to control what output Minitab produces.

TOBSERVED

Displays summary statistics for the samples: mean, standard deviation, variance, sum, minimum, median, and
maximum.

TRANDOMIZATION
Displays the results of the hypothesis test.

TDIFFERENCES
Displays the difference between the sample means.

GHISTOGRAM

Displays a histogram of the resampled differences. GHISTOGRAM does not work if the number of resamples is 1
or if you specify GINDIVIDUAL.
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GINDIVIDUAL

Displays an individual value plot that compares the resamples to the original samples. GINDIVIDUAL does not
work if the number of resamples is greater than 1 or if you specify GHISTOGRAM.

Matrices

READ data into a matrix

READ K K M
Puts numbers into a matrix. To input data to columns, go to READ data into columns on page 41. You can specify
the filename as either the name of the file in double quotes, or a stored text constant. If the file has an extension
other than DAT and/or if it is not in your current directory, include the file name extension and the path within
guotation marks.

You can use either spaces or commas to separate the data in the matrix.

You must specify the dimension of the matrix in the READ command. The first K gives the number of rows, the
second K the number of columns. The M is the matrix identifier for storage. If a file name is not used, READ is
followed by data lines, each containing one row of the matrix. The following command creates the following

matrix.
Command
READ 3 4 M2
1 2 3 4
5 6 7 8
9 10 11 12
END
Matrix
1 2 3 4
5 6 7 8

9 10 11 12

FILE "filename"

FILE K
Reads or inserts data from the specified text file.

DEFINE: Session command for defining a constant matrix

DEFINE K K K M

Defines a constant matrix where K is the value, K is the number of rows, K is the number of columns, and M is the
stored matrix. For example, the following command language creates a matrix, M1, has 4 rows and 3 columns,
and all of whose entries are 1.

DEFINE 1 4 3 M1

DIAGONAL: Session command for creating a matrix from a column

DIAGONAL C M

Forms a matrix out of a column. If C has n entries, then M will be an n x n matrix with C as its diagonal and zeros
elsewhere.
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DIAGONAL M C
Takes the diagonal of a matrix and puts it into a column.

INVERT: Session command for replacing a matrix value with its inverse

INVERT M M

Replaces each value in the matrix with its inverse. The first M is the matrix to be replaced. The second M is the
new inverted matrix. The matrix must be square.

TRANSPOSE: Session command for changing rows to columns, and columns to rows

TRANSPOSE C...C
TRANSPOSE C M
TRANSPOSE M C

TRANSPOSE M [M]
TRANSPOSE reconfigures data so that rows become columns and columns become rows.
e TRANSPOSE C...C transposes the values in the columns.
e TRANSPOSE C M transposes the values in a column to a matrix.
e TRANSPOSE MC transposes the values in a single row matrix to a column.

e TRANSPOSE M [M] transposes the values in a matrix to another matrix.

VARNAMES C
Specifies a column that contains variable names for the transposed columns.

STORE C...C

STORE M

Specifies where the transposed data are to be written. You can store the data in columns or a matrix. When
you transpose data to columns, the number of columns specified must equal the number of rows in the
original columns.

If you do not use STORE, the data are stored in a new worksheet.

LABELS C
Specifies the column in which the labels of the transposed column or columns or matrix are stored.

NEWWS
NEWWS '"text"

NEWWS K

Stores the results in a new worksheet. If you do not specify a worksheet name in "text" or in a constant (K)
argument, then Minitab uses the default naming of worksheets.

Important You cannot use NEWWS in a local macro. For more information, go to Session commands that are not allowed in
macros on page 1179.
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AFTER
Appends the transposed data into empty columns after the last column of data in the current worksheet.

Important You cannot use AFTER in a local macro. For more information, go to Session commands that are not allowed in
macros on page 1179.

EIGEN: Session command for calculating eigenvalues

EIGEN M C [M]
Calculates eigenvalues (also called characteristic values or latent roots) and eigenvectors for a symmetric matrix.

The eigenvalues are stored in decreasing order of magnitude down the column. The eigenvectors are stored as
columns of the matrix. The first column corresponds to the first eigenvalue (largest magnitude), the second column
to the second eigenvalue, and so on.

Data

INFO: Session command for summarizing the current worksheet

INFO [C...C]
Summarizes the current worksheet.

If no columns are specified, INFO prints a list of all columns used with their names and counts, all stored constants,
all matrices. If there are missing observations, a count of these is also given. If a column contains text data, the
letter T is printed to the left of the column. If columns have assigned formulas, these are printed along with the
method selected for updating the calculations (manual or automatic). If you list columns, information is given on
just those columns.

MERGE: Session command for merging two worksheets into one
worksheet

MERGE
Merges two worksheets into one new worksheet. You can combine any two open worksheets using MERGE. Unlike
the merging option available when opening additional worksheets, MERGE duplicates, and then combines, the
information from two original worksheets into a new worksheet. The default setting combines the worksheets,
side by side and with their existing attributes, into the new worksheet, named Merge Worksheet by default.

You can also customize the merged worksheet using the optional subcommands. You can use BY to combine the
worksheets according to the order and length of one or more columns. In addition, you can specify whether or
not to include unmatched values, missing values or multiple values from one or both of the BY columns. You can
also specify which columns will be included from each original worksheet using INCLUDE.

Note Stored constants, matrices, DOE objects, and worksheet descriptions do not transfer into the merged worksheet.
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NAME K

Specifies the name K for the new worksheet. The argument is a text constant, stated or stored. By default,
the name is Merge Worksheet.

WORKSHEET K
Specifies the name of one of the worksheets to be merged. The argument is a text constant, stated or stored.
This subcommand must be given twice.

BY C...C
Standardizes the combination of two worksheets. The order of the data within the BY columns becomes
ascending. The length and order of the remaining columns in the merged worksheet are manipulated
according to the BY column adjustments, no matter the order or length of the original columns.

The length of the columns also depends on how you would like to handle multiple, unmatched, and
missing observations within the BY columns. The adjusted length of the BY column or columns is still
applied to the order and length of the remaining columns.

Requirements for BY columns are as follows:

e The column names for each of the two worksheets do not have to be unique. Minitab will create a
unique name for the columns in the merged worksheet based on the original worksheet names.

e You must specify at least one pair of BY columns (one column from each worksheet) in the BY Columns
sub-dialog box. Additional BY columns must also come in pairs.

e BY columns must have the same data type (numeric, date/time, or text).

e When merging columns with value ordered text, the value orders in the BY columns must be the
same for both worksheets. For more information on value ordering, go to VORDER: Session command
for controlling the order for text categories to be processed by Minitab commands on page 137.

e Column lengths must be the same between multiple BY columns.

e Columns that are not the same lengths as the BY columns are excluded from the merged worksheet.
A note in the output documents the number of columns excluded.

NOMULTIPLES
Ignores all but the first row with the same values for the BY columns. If more than one row in a worksheet
has values for the BY columns, then only the first such row is used.

Including multiple observations indicates that you wish to keep the observations of the BY column that
are repeated within the column, regardless of the BY column values in the other worksheet. However,
the values can still be matched to multiple observations in the BY columns of the other worksheet,
depending on whether or not NOMULTIPLES is used for the other worksheet. Therefore, you could end
up with longer columns in the merged worksheet. For example, if there are two rows in one worksheet
and three rows in the other, all with the same values of the BY columns, then six rows would result.

NOMULTIPLES is available for each of the worksheets to be merged.

NOUNMATCHED
Removes unmatched BY column rows from the merged worksheet. If any row in a worksheet has values
for the BY columns that are not matched in the BY columns for the other worksheet, then that row is
not used.

By default, unmatched values are included which means that all of the rows in the opposite worksheet
that do not have matching BY column values are included. Missing value symbols would be added to
the cells for the entire row associated with the unmatched BY column values for the opposite worksheet.
Consequently, padding rows with missing values will make all of the columns for both of the worksheets
the same length as the BY columns.
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NOUNMATCHED is available for each of the worksheets to be merged.

INCLUDE C...C
Specifies which columns to include from the worksheet, whether you merge worksheets using the default
settings or using BY Columns. By default, all columns are included.

MISSINGS
Includes missing values within BY columns for both worksheets. The missing observations will be treated as
distinct values. The missing BY column value will be matched with a missing BY column value in the other
worksheet.

Note Missing values in text columns are represented by blanks and missing values in numeric and date/time columns are
represented by an asterisk.

SORT: Session command for sorting columns

SORT [C...C C...C]
Sorts one or more columns.

The default is to sort by the first column and carry along additional columns. Sorting by multiple columns is done
with the BY subcommand. SORT handles any combination of alpha or numeric columns.

The following is a simple example of the default method. Sorting is done based on the first column specified, C2.
The next two columns, C3 and C4, are carried along. Sorting is done in ascending order unless you use the
subcommand DESCENDING.

SORT C2 C3 C4 Cl2 C13 Cl4

Before sorting

c2 C3 ¢4
2 10 -1
3 11 -1
1 12 -3
4 13 -1
14 -1

After sorting

C12 C13 C14

1 2 -3
2 0 -1
3 M1 -1
4 13 -1
5 14 -1
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BY C...C

Specifies the columns to use to sort the worksheet. Rows are first sorted by the first column listed following
BY, then, within that, by the second column, then, within that, by the third, and so on.

SORT C2 C3 C4 Cl2 C13 Cl4;
BY C2.

Before sorting with BY

2 3 c4
2 10 -1
3 11 -1
1 2 -3
4 13 A
5 14 -1

After sorting with BY

C12 C13 C14

1 2 -3
2 0 -1
3 M -
4 13 -1
5 4 -1

DESCENDING C...C

Requests that sorting be done in descending, rather than the default ascending, order. Columns listed on
DESCENDING must also be listed on BY, or must be the first column listed on SORT if no BY is used.

SORT C3 C23;
BY C2;
DESCENDING C2.

Before sorting with DESCENDING

2 c3
2 10
317
1 12
4 13
5 14

After sorting with DESCENDING

c23
14
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Cc23
13
11
10
12

UNEQUAL
If the columns to be sorted have different numbers of rows, adds missing values so that the columns have an
equal number of rows.

Storage

Important You cannot use NEWWS and AFTER local macros. For more information, go to Session commands that are not allowed in
macros on page 1179.

Note These subcommands are optional, and are mutually exclusive. If you do not use one of these subcommands, results are stored in
the columns that you specify with the main command.

NEWWS
Stores the results in a new worksheet, with the default name.

NEWWS ["text"]

NEWWS [K]
Stores the results in a new worksheet. If you do not specify a worksheet name in a "text" argument or in a constant
(K) argument, then Minitab uses the default naming of worksheets.

AFTER ["text"]

Stores the results at the end of the specified worksheet. If you do not specify a worksheet name in a "text" argument
or in a constant (K) argument, then Minitab stores the copied data at the end of the active worksheet.

ORIGINAL
Stores the results in the original columns.

RANK: Session command for ranking values in a column

RANK

Calculates and stores the ranks of the input column. Assigns the numeral 1 to the smallest value, the numeral 2
to the second smallest value, the numeral 3 to the third smallest value, and so on. Ties are assigned the average
rank.

Note RANK works only with numeric columns.

The following command language ranks the values in C1 and puts the ranked values in C2.
RANK C1 C2
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Before ranking

c1
0.5
1.0
1.5
1.0
2.0
0.0

After ranking

Cc1 Cc2
0.5 2.0
1.0 3.5
15 5.0
1.0 3.5
2.0 6.0
0.0 1.0

DELETE: Session command for deleting rows of data

DELETE K...K C...C

Deletes rows K...K from columns C...C, and moves the remaining rows up to close the gap. DELETE works with both
text and numeric columns.

For example, the following command language changes the worksheet as shown below.
DELETE 2 5 6 C2-C4

Before DELETE

c2 a3 C4

23 4 154
31 5 175
22 4 143
26 3 153
32 6 167
30 6 158
24 4 155
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After DELETE

c2 a3 C4

23 4 154
22 4 143
26 3 153
24 4 155

You can abbreviate a list of consecutive rows by using a colon. For example, to delete rows 1 through 10 and
rows 25 through 30 from C1, use the following command language.

DELETE 1:10 25:30 C1

SPLIT: Session command for splitting a worksheet into multiple
worksheets

SPLIT

Important SPLIT cannot be used in local macros. For more information, go to Session commands that are not allowed in macros on
page 1179.

The SPLIT command splits a worksheet into multiple new worksheets, one for each combination of a set of BY
variables. Each new worksheet is automatically named to reflect the combination of the BY variables.

Use SUBSET on page 114 to copy specified rows from the active worksheet to a new worksheet. With this command,
you can specify the subset based on row numbers, brushed points on a graph, or a condition such as unmarried
males under 50 years old.

BY C...C (required)
Specifies the columns to use to subset the worksheet. A new worksheet will be created for each unique value
or combination of values in the columns. Columns must be non-empty, all the same length, and can be of
any data type.

COLUMNS C...C
Specifies the columns to be copied to the new worksheet. Columns must be the same length as the BY
columns. Columns other than these are not copied.

MATRICES M...M
Specifies the matrices to be copied to the new worksheet. Matrices must has the same number of rows as
the BY columns. Matrices other than these are not copied.

NOMATRICES
Prevents matrices from being copied to the new worksheets.

NOCONSTANTS
Prevents stored constants from being copied to the new worksheets.

MISSINGS
Specifies that missing values are treated as a distinct value of the BY variable.

Minitab =’ 112



Minitab Statistical Software Manipulating and Calculating Data

DATE: Session command for changing data type to date/time

DATE C...C C...C
Changes data type of C...C to date/time and places results in C...C.

FORMAT
Indicates the format of the new date/time column or columns. For example:

e FORMAT (DTm/d/yy) formats a new column as 5/25/16

e FORMAT (DTm-d-yy) formatsa new column as 5-25-16

For multiple columns, add the number of columns to the format statement. For example, for 2 columns, use
FORMAT (2DTm-d-yy).

For more information on date/time formats, go to Default date/time formats on page 1140.

ERASE: Session command for erasing variables

ERASE E...E
Erases any combination of columns (including their names), constants, and matrices.

Erasing all variables that you no longer need is a good practice.

ROWTOC: Session command for stacking multiple columns into
one column

ROWTOC C...C C

Stacks rows in C...C and places them in C. Enter the columns that contain the data you want to appear in a single
column, and then enter a column number or name in which to store the stacked data.

EXPAND C...C
Expands the specified column or columns, while stacking the rows.

EXSTORE C...C
Stores the expanded columns in the specified column.

SUBSCRIPTS C
Stores row subscripts in the specified column.

CSUBS C
Stores column subscripts in the specified column.
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SUBSET: Session command for copying specified rows to a new
worksheet

SUBSET

Important You cannot use SUBSET in a local macro. For more information, go to Session commands that are not allowed in macros
on page 1179.

Use SUBSET to copy specified rows from the active worksheet to a new worksheet. With this command, you can
specify the subset based on rows that match conditions, row numbers, formatted rows, brushed points on a graph,
or a formula that you specify, such as unmarried males under 50 years old.

One of INCLUDE and EXCLUDE must be used.

One of BRUSHED, WHERE, ROWS, conditions for values in a column, or conditions for row numbers, must be used.
If more than one is used, only the last valid one is honored.

Use SPLIT on page 112 to split, or unstack, the active worksheet into two or more new worksheets based on one
or more "By" variables. SUBSET and SPLIT always copy data to new worksheets.

INCLUDE
Includes the specified rows.

INCLUDE and EXCLUDE are mutually exclusive: the last one issued is honored. Choose INCLUDE or EXCLUDE
based on the degree of subsetting. For example, if you wish to use all but a few select rows in creating your
graph, itis more efficient to use EXCLUDE and name a small number of rows with the ROWS subsubcommand.

EXCLUDE
Excludes the specified rows.

INCLUDE and EXCLUDE are mutually exclusive: the last one issued is honored. Choose INCLUDE or EXCLUDE
based on the degree of subsetting. For example, if you wish to use all but a few select rows in creating your
graph, itis more efficient to use EXCLUDE and name a small number of rows with the ROWS subsubcommand.

MINCLUDE
Includes rows that contain missing values in the subset column.

MINCLUDE and MEXCLUDE are mutually exclusive: the last one issued is honored.

MEXCLUDE
Excludes rows that contain missing values in the subset column.

MINCLUDE and MEXCLUDE are mutually exclusive: the last one issued is honored.

AND
Allows you to specify multiple conditions. For example, LT C1 50 AND EQUAL C2 'Blue' denotes rows that
contain 50 or less in C1 and contain 'Blue’ in C2.

OR
Allows you to specify multiple conditions.

Conditions for values in a column

These subcommands specify values in a column. For example:
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e ANY C1 22 23 27 specifies the rows in C1 that contain 22, 23, and 27.

e NEQUALS Cl 'male' specifies the rows in C! that do not contain 'male'.

ANY C K...K
Values in C that equal any of the specified values.

EQUALS C K
Values in C that equal the specified value.

NEQUALS C K
Values in C that do not equal the specified value.

Conditions for values in a numeric or date/time column

These subcommands specify values in a numeric or date/time column. For example:
e GT C1 30 specifies the values in C1 that are greater than 30.

e LTLT Cl 30 70 specifies the values in C1 that are greater than 30 and less than 70.

LT C K
Values in C that are less than K.

LE C K
Values in C that are less than or equal to K.

GT C K
Values in C that are greater than K.

GE C K
Values in C that are greater than or equal to K.

LELE K C K
Values in C that are greater than or equal to K and less than or equal to K.

LELT K C K
Values in C that are greater than or equal to K and less than K.

LTLE K C K
Values in C that are greater than K and less than or equal to K.

LTLT K C K
Values in C that are greater than K and less than K.

Conditions for values in a text column

These commands specify values in a text column. The text value must be in single quotation marks. For example:
e BEGINS Cl1 'm' specifies all values in C1 that begin with "m".

e NCONTAINS Cl 'non' specifies all values in C1 that contain "non".

BEGINS C K
Values in C that begin with K (text columns only).
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ENDS C K
Values in C that end with K (text columns only).

CONTAINS C K
Values in C that contain K (text columns only).

NCONTAINS C K
Values in C that do not contain K (text columns only).

Conditions for row numbers

ROWS K...K
Specifies row numbers K through K. List all row numbers to be included or excluded with a space between each.
Denote a patterned range by K:K/K. For example, 10:50/5 denotes all values from 10 to 50 by intervals of 5.

ROWLE K
The row number is less than or equal to K.

ROWGE K
The row number is greater than or equal to K. For example, ROWGE 12 denotes row numbers that are greater
than or equal to 12.

ROWBETWEEN K K
The row number is between K and K inclusive. The first value must be less than or equal to the second.

Other conditions

BRUSHED
Specifies the rows that are currently brushed.

WHERE expression
Specify a formula for subsetting. This formula must be in quotes. For example:

e To subset where C1 is 2, enter WHERE "C1 = 2".
e To subset where C2 = a, enter WHERE "C2 = ""a""".
e To subset where C3 = 3/3/16, enter WHERE "C3 = DATE (""3/3/98"")".

CFORMAT C
Specifies a column that includes formatted rows.

Options for the new worksheet

NAME "text"

NAME K
Specifies the name of the new worksheet in a "text" argument or in a constant (K).

COLUMNS C...C
Specifies one or more columns of the appropriate length to be copied to the new worksheet. Columns other than
these are not copied.
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EQLN
Includes in the subset only columns that are the same length as the column with the condition. If this subcommand
is not used, all columns in the worksheet are included in the subset.

MATRICES M...M
Specifies one or more matrices with the appropriate number of rows to be copied to the new worksheet. Matrices
other than these are not copied.

NOMATRICES
Prevents matrices from being copied to the new worksheet.

NOCONSTANTS
Prevents stored constants from being copied to the new worksheet.

READ data into columns

READ C...C
Reads in data, row by row, that you type from the keyboard, or that you import from a text file. You cannot type
comments on a data line when the FORMAT subcommand is used.

READ enters new data into columns, replacing any data already in those columns, if it exists. For information on
entering data into a matrix, go to READ data into a matrix on page 43.

When you enter data manually, type END. after you enter your final value.

When you use READ, you can use a space or a comma to separate data entries. For example:

READ C1 Cb5.
12
3,4
END.

For details on using this command without subcommands to select data entry options, go to Using READ without
subcommands on page 1183.

FILE "filename"
Inserts data from the specified text file. You may specify the filename as either the name of the file in double
quotes, or a stored text constant. If the file has an extension other than DAT and/or if it is not in your current
directory, include the file extension and the path within the single quotation marks. For example, use the
following command to read a copy of the file SALES.ASC stored in the subdirectory JANUARY underneath
the directory SMITH on the C drive.

READ C1-C5;
FILE "C:\SMITH\JANUARY\SALES.ASC".

FORMAT (format statement)
Include a format statement, within parentheses to specify precisely how to enter data into the worksheet.
The entire expression within the parentheses is repeated once for each record. For more information, go to
Using READ with FORMAT on page 1183.

The FORMAT subcommand is useful when you want to skip over spaces, read data that have no spaces
between them, insert decimal points in numbers, or read in text data, date/time data, or currency data.

Format items may be combined together. For example, the following command reads the name in the first
20 spaces of each data line into Name (C12), skips the next 10 spaces (spaces 21 through 30), then reads the
number in space 31 into C1, the number in space 32 into C2, ..., the number in space 40 into C10.

NAME Cl12 'Name'
READ 'Name' C1-C10;
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FILE "MYDATA";
FORMAT (A20, 10X, 10F1).

Minitab has a special date/time (DT) format which works as shown below. This says to read the date/time
value in the first 8 spaces in the file into C1, and that the format of the date/time data in the file is m/d/yy.

READ C1;
FILE "DATEDATA";
FORMAT (DT8m/d/vyy) .

The following example shows the use of a decimal indicator, repeat factor in front of parentheses, and the
slash.

READ C11-C15;
FILE "EMPLOYEEDATA";
FORMAT (F2.1, 2(1X,F3), F4/F2).

This example uses two data lines for every row read. From the first line, the value of C11 is in spaces 1 and
2. The first value is a whole number and the second value is in the tenths place. The format skips space 3.
Then, C12 is read from spaces 4 to 6. The format skips space 7. Then, C13 is read from spaces 8 to 10, which
repeats the pattern inside of the parentheses. C14 is read from spaces 11 to 14. In response to the /, reading
moves to the second data line, and C15 is read from spaces 1 and 2. For more information, go to Valid format
items on page 1186.

NOBS K

The NOBS subcommand specifies the number of observations (rows) to be inserted. If an END on page 38
subcommand or end-of-file is encountered before K observations are inserted, NOBS is ignored. NOBS is
useful when you want to insert just the first portion of a file. It is also useful for Prompting a user for
information on page 1177.

SKIP K

Tells Minitab to skip K lines at the top of the data file before beginning to add data into the file. This is most
useful when you have one or more lines of text, such as column names and titles, at the top of a data file
that you want to import into Minitab.

With READ; FILE only
DECIMAL works with READ when only when reading a file. DECIMAL does not work with READ if you type data.

DECIMAL ", "

DECIMAL "."
Specifies a comma or period as a decimal separator.

READ data into a matrix

READ K K M

Puts numbers into a matrix. To input data to columns, go to READ data into columns on page 41. You can specify
the filename as either the name of the file in double quotes, or a stored text constant. If the file has an extension
other than DAT and/or if it is not in your current directory, include the file name extension and the path within
guotation marks.

You can use either spaces or commas to separate the data in the matrix.

You must specify the dimension of the matrix in the READ command. The first K gives the number of rows, the
second K the number of columns. The M is the matrix identifier for storage. If a file name is not used, READ is
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followed by data lines, each containing one row of the matrix. The following command creates the following

matrix.
Command
READ 3 4 M2
1 2 3 4
5 6 7 8
9 10 11 12
END
Matrix
1 2 3 4
5 6 7 8

9 10 11 12

FILE "filename"

FILE K
Reads or inserts data from the specified text file.

CONCATENATE: Session command for combining text columns

CONCATENATE C...C C
Combines text columns C...C and places into C, to form longer words.

In the following example, portions of numbers were originally entered into columns C1-C3. CONCATENATE
combines C1-C3 into one column, C4.

READ C1-C3;

FORMAT (A4, A3, A4d).
192-42-77717
123-45-6789
END
CONCATENATE C1-C3 C4

The worksheet is changed as follows.

C1-T C2-T C3-T C4-T
192- 42- 7777 192-42-7777
123- 45- 6789 123-45-6789

CODE: Session command for changing values in columns to new
values

CODE (K...KK ... (K...K)K C...C [C...C]
Copies columns, changing the indicated values. For example, the following command language codes every -1
and -2 to 100.
CODE (-1 -2)100 Cl1 C2;
AFTER.

The command language places the results at the end of the worksheet (C2), as follows.
c1 c2
-1.0 100.0
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c1 Cc2
3.0 3.0
1.1 1.1
-1.0 100.0
0.0 0.0
-2.0 100.0
2.4 24

An interval can be abbreviated with a colon. For example, the following command language changes all values
in the range 1 to 1.5, and the value 2 into a 5.

CODE (1:1.5, 2)5 C1-C3 Cl11-Cl5

You can make several changes at one time. For example, suppose the data in columns C1-C5 include integers 1
through 10. In this case, the following command language changes all values in C1-C5 that are from 1 to 5 into
10, and all values that are from 6 to 10 into 20, and stores the results in C11-C15.

CODE (1:5)10 (6:10)20 C1-C5 Cl1l1-C15

CODE can change values into the missing data code. For example, to change -99 to *, use the following command
language.

CODE (-99) '*' Cl-C1l0;

ORIGINAL.

You can also code text data. Enclose text values with double quotation marks. Denote a missing text value as two
double quotation marks, with no space in between, as "". For example, use the following command language to
code 1, 2, and 3 to low, medium, and high.

CODE (1) "low" (2) "medium" (3) "high" Cl1 C2

You can also use CONVERT on page 121 to recode text data.

ENDPOINTS K
For coding ranges of values, the value of K controls inclusion of the endpoints.

Value of K Endpoints that are included in the range
1 Lower endpoint only
2 Upper endpoint only
3 (default) Both endpoints
4 Neither endpoint
TSUMMARY

Shows the summary table in the output.

TSUMMARY and NODEFAULT are mutually exclusive.

NODEFAULT
Suppresses the summary table in the output.

TSUMMARY and NODEFAULT are mutually exclusive.
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LFPERCENT K K

Recodes the unique values (of the input columns specified in the CODE command) above the K percentile
in count to K, and places the recoded values into output columns specified in the CODE command.

LFVALUE K K

Recodes the unique values (of the input columns specified in the CODE command) that occur less than K
times to K, and places the recoded values into output columns specified in the CODE command.

Storage

The following subcommands are optional, and are mutually exclusive. If you do not use one of these subcommands,
results are stored in the columns that you specify with the main command.

Note You cannot use NEWWS and AFTER in a local macro.

NEWWS
NEWWS "text"

NEWWS K

Stores the results in a new worksheet. If you do not specify a worksheet name in a "text" argument or in a constant
(K) argument, then Minitab uses the default naming of worksheets.

AFTER

AFTER "text"

Stores the results at the end of the specified worksheet. If you do not specify a worksheet name in a "text"
argument, then Minitab stores the copied data at the end of the active worksheet.

ORIGINAL
Stores the results in the original columns.

CONVERT: Session command for converting text data to numeric
data, and numeric data to text data

CONVERT C C C C
Using the conversion table in C C, converts C to C.

A conversion table, assigning a numeric value to each text value, must be put into two columns before CONVERT
is used. Then, using these matching values, CONVERT changes all corresponding numeric values to the correct
text values (or vice versa). If no match is found, a missing value is stored. Missing values are denoted by * in a
numeric column and a blank in a text column. CONVERT can also be used to convert from numeric to numeric or
from text to text.

Use the following commands to store a conversion table in C1-C2. For more information on entering data using
format statements, go to READ data into a matrix on page 43 or READ data into columns on page 41.

READ Cl1 C2;
FORMAT (F1, 1X, A6).
1 RED
2 YELLOW
END
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Use the conversion table to do two conversions. The first CONVERT converts numbers in C3 to colors in C10. The
second converts colors in C4 to numbers in C11.

CONVERT Cl1 C2 C3 C10
CONVERT C2 Cl C4 Cl1l1

The worksheet is changed as follows.

c1 c2-T c3 C4-T C10-T Cc11

1 RED 1 RED RED 1
2 YELLOW 2 RED YELLOW 1
1 YELLOW  RED 2
3 RED 1

2 BLUE YELLOW  *

NODEFAULT
Suppresses the summary table in the output.

DROUND: Session command for rounding date/time values

DROUND C C
Rounds the original date/time values in the first C and stores them in the second C.

For example, suppose you have sales data for each day of the year, but you want to summarize sales for each
quarter of the year. You can use Round Date/Time to round the dates down to the nearest quarter.

Units for rounding

Specify the unit to round to. You must use one of these mutually exclusive subcommands.
YEAR

QUARTER
MONTH

WEEK

DAY

HOUR
MINUTE
SECOND
TENTH
HUNDREDTH
THOUSANDTH

Options

DROUND rounds down to the nearest whole unit.
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UP
Use UP to round up to the nearest whole unit.

NEAREST
Use NEAREST to round up or down to the nearest whole unit.

NUMERIC: Session command for changing the data format of a
date/time column or extracting date/time components

NUMERIC C C
The NUMERIC command serves two functions:

e To change a date/time or a text column to a numeric column. (Use with a date/time or text input column.)

e To extract one or more components (such as the day, quarter, or hour) from a date/time column, and save
those components in a numeric column. (Use with a date/time input column.)

Note When the input column is text, no subcommands are available.

Date/time input

WKDAY
Extracts the day of the week (Sun, Mon, Tue, Wed, Thu, Fri, Sat).

DAY
Extracts the day of the month (01, 02, ..., 31).

WEEK
Extracts the week of the year number (Wk01 - Wk53).

MONTH
Extracts the month (Jan, Feb, Mar, Apr, ..., Dec).

QUARTER
Extracts the quarter (Q1, Q2, Q3, Q4).

YEAR
Extracts the year.

TWODIGIT
Uses the two digit format (00, 01, ..., 99).

FOURDIGIT
Uses the four digit format (2000, 2001, ..., 2099).

HOUR
Extracts the hour (00, 01, ..., 23).

MINUTE
Extracts the minute (00, 01, ..., 59).
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SECOND
Extracts the second (00, 01, ..., 59).

TENTHS
Extracts the tenths of a second (0, 1, 2, ..., 9).

HUNDREDTHS
Extracts the hundredths of a second (0, 1, ..., 99).

THOUSANDTHS
Extracts the thousandths of a second (0, 1, 2, ..., 999).

TEXT: Session command for changing the data type of a column
o text

TEXT C...C C...C
Changes data type of C...C to text and places results in C...C. The TEXT command serves the following functions:

e Use TEXT to change a date/time or a numeric column to a text column. (Use with a date/time or numeric input
column.)

e Use TEXT to extract one or more components (such as the day, quarter, or hour) from a date/time column,
and save those components in a text column. (Use with a date/time input column.)

e Use TEXT to format the width of a text column. (Use with a text input column.)

Minitab automatically formats the new alpha column up to 8 characters wide. Use WIDTH or MAXWIDTH (you
cannot use both) to override this default.

Date/time input column

WKDAY
Extracts the day of the week (Sun, Mon, Tue, Wed, Thu, Fri, Sat).

DAY
Extracts the day of the month (01, 02, ..., 31).

WEEK
Extracts the week of the year number (Wk01 - Wk53).

MONTH
Extracts the month (Jan, Feb, Mar, Apr, ..., Dec).

QUARTER
Extracts the quarter (Q1, Q2, Q3, Q4).

YEAR
Extracts the year.

TWODIGIT
Uses the two digit format (00, 01, ..., 99).
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FOURDIGIT
Uses the four digit format (2000, 2001, ..., 2099).

HOUR
Extracts the hour (00, 01, ..., 23).

MINUTE
Extracts the minute (00, 01, ..., 59).

SECOND
Extracts the second (00, 01, ..., 59).

TENTHS
Extracts the tenths of a second (0, 1, 2, ..., 9).

HUNDREDTHS
Extracts the hundredths of a second (00, 01, ..., 99).

THOUSANDTHS
Extracts the thousandths of a second (000, 001, 002, ..., 999).

WIDTH K
Fixes the width (in characters) of the output column.

MAXWIDTH K
Fixes the maximum width (in characters) of the output column.

MISSING "text"
Converts missing values to "text".

Numeric input column

WIDTH K
Fixes the width (in characters) of the output column.

MAXWIDTH K
Fixes the maximum width (in characters) of the output column.

SIGNIFICANT K

Specifies the number of significant digits to maintain (up to a maximum of 6). You cannot use both SIGNIFICANT
and DECIMALS with one command.

DECIMALS K

Specifies the number of decimal digits to maintain. You cannot use both SIGNIFICANT and DECIMALS with one
command.

MISSING "text"

Converts the missing value symbol * to a specified character string. Unless you specify the width of your output
with WIDTH or MAXWIDTH, the default length for the string is 8 characters.
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Text input column

WIDTH K

Fixes the width (in characters) of the output column.

MAXWIDTH

Fixes the maximum width (in characters) of the output column.

K

Manipulating and Calculating Data

STACK: Session command for stacking blocks of columns and

constants on top of each other

STACK (E...E) C

STACK (E...E)
Stacks blocks of columns and constants on top of each other.

The following command language stacks C3 and C4 on C1 and C2.
(C1 C2) (C5 Co)

STACK

Columns to stack

c1
66
64
65

Stacked columns

()
70
66
69
66
64
65

(C3 C4)

c2

130
125
115

Cé

155
145
160
130
125
115

(E...E) (C...C)

C4
155
145
160

The following command language puts 66, 64, 65, 70, 66, 69, 67, and 63 into C10. The last column (or block of
columns) specified is the target column.

STACK Cl1 C3 67 63 C10

SUBSCRIPTS C

Creates a column of subscripts in the original worksheet. The first block is given the subscript 1, the second
block the subscript 2, and so on.

USENAMES
Creates subscripts based on variable names.
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NEWWS
NEWWS '"text"

NEWWS K

Stores the results in a new worksheet. If you do not specify a worksheet name in a "text" argument or in a
constant (K) argument, then Minitab uses the default naming of worksheets. Minitab automatically creates
a subscripts column in the new worksheet.

Important You cannot use NEWWS in a local macro. For more information, go to Session commands that are not allowed in
macros on page 1179.

USENAMES
Creates subscripts based on variable names.

UNSTACK: Session command for separating a column into multiple
columns

UNSTACK (C...C) (E...E)...(E...E)

Separates one or more columns into several blocks of columns and stored constants, based on subscript values
stored in an associated column.

Unstack is useful for subsetting data.

SUBSCRIPTS C...C

Uses columns to unstack data. The rows with the smallest subscript are stored in the first block, the rows
with the second smallest subscript in the second block, and so on. If you do not use SUBSCRIPTS, each row
is stored in a separate block.

In general, each block must be enclosed in parentheses. However, if a block contains just one argument, you
may omit the parentheses.

For most applications, the subcommand SUBSCRIPTS is needed.
MISSINGS
Includes rows subscripted with missing data as part of the unstacked data.
NEWWS
NEWWS "text"

NEWWS K

Stores the results in a new worksheet. If you do not specify a worksheet name in "text" or in a constant (K)
argument, then Minitab uses the default naming of worksheets.

Important You cannot use NEWWS in a local macro. For more information, go to Session commands that are not allowed in
macros on page 1179.

VARNAMES

Labels the columns for the unstacked data with the source variable name (the source column's label or
number if no label exists) and the corresponding row entries from the subscript column or columns. If you
do not use SUBSCRIPT, the text strings "Row1", "Row2", and so on are used.
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AFTER
Appends the unstacked data into empty columns after the last column of data in the current worksheet.

Important You cannot use AFTER in a local macro. For more information, go to Session commands that are not allowed in
macros on page 1179.

WSTACK: Session command for stacking worksheets

WSTACK

Important You cannot use WSTACK in a local macro. For more information, go to Session commands that are not allowed in macros
on page 1179.

Use WSTACK to stack two or more worksheets. The argument is the names of the worksheets. For example,
WSTACK "Worksheet1" "Worksheet 2" stacks Worksheet 1 on top of Worksheet 2. Minitab stacks columns with
the same names. Columns that don't have the matching names are kept as separate columns.

Within this command, you can specify that the results are placed in a new worksheet (NEWWS) or appended to
an existing worksheet (APPEND). NEWWS and APPEND subcommands are mutually exclusive. If neither is specified,
NEWWS is assumed.

You can use MERGE on page 106 to combine worksheets side-by-side.

NEWWS '"text"

NEWWS K
Stores the results in a new worksheet. If you do not specify a worksheet name in "text" or in a constant (K)
argument, then Minitab uses the default naming of worksheets.

APPEND
Appends the data to the bottom of the first worksheet that you specified in WSTACK.

SOURCE ['"column name"]
SOURCE appends the source worksheet name to the bottom of the specified column. If you do not
specify the column, the command creates a new ID column in the output sheet.

TSUMMARY (default)
TSUMMARY and NODEFAULT are mutually exclusive. TSUMMARY shows the summary table in the output.

NODEFAULT

TSUMMARY and NODEFAULT are mutually exclusive. NODEFAULT suppresses the summary table in the
output.
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TRANSPOSE: Session command for changing rows to columns,
and columns to rows

TRANSPOSE C...C
TRANSPOSE C M
TRANSPOSE M C

TRANSPOSE M [M]
TRANSPOSE reconfigures data so that rows become columns and columns become rows.
e TRANSPOSE C...C transposes the values in the columns.
e TRANSPOSE C M transposes the values in a column to a matrix.
e TRANSPOSE MC transposes the values in a single row matrix to a column.

e TRANSPOSE M [M] transposes the values in a matrix to another matrix.

VARNAMES C
Specifies a column that contains variable names for the transposed columns.

STORE C...C

STORE M
Specifies where the transposed data are to be written. You can store the data in columns or a matrix. When
you transpose data to columns, the number of columns specified must equal the number of rows in the
original columns.

If you do not use STORE, the data are stored in a new worksheet.

LABELS C
Specifies the column in which the labels of the transposed column or columns or matrix are stored.

NEWWS
NEWWS '"text"

NEWWS K
Stores the results in a new worksheet. If you do not specify a worksheet name in "text" or in a constant (K)
argument, then Minitab uses the default naming of worksheets.

Important You cannot use NEWWS in a local macro. For more information, go to Session commands that are not allowed in

macros on page 1179.

AFTER
Appends the transposed data into empty columns after the last column of data in the current worksheet.

Important You cannot use AFTER in a local macro. For more information, go to Session commands that are not allowed in
macros on page 1179.
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COPY: Session command for copying data

COPY [E...E E...E]

Copy specified columns, constants, and matrices, or a subset thereof, into a similar or compatible format in a
specified worksheet.

In addition to format, the source and destination must be compatible in size. For example, you cannot copy a

column with 100 rows into a set of 50 constants. You can subset the source data to accommodate the size of the
destination.

If you don't specify an argument, COPY copies the entire contents of the current worksheet to another worksheet.
You can specify an argument to do the following:

e Copy columns into columns, constants, or a matrix.
e Copy constants into constants or columns.

e Copy a matrix into columns or a matrix.

Specify a subset

INCLUDE and EXCLUDE are mutually exclusive. The last one issued is honored. Choose INCLUDE or EXCLUDE based
on the degree of subsetting. For example, if you want to use all rows, except a few, use EXCLUDE and specify a small
number of rows with the ROWS subsubcommand.

INCLUDE
Includes the specified rows.

BRUSHED
Use to specify all brushed rows for subsetting.

WHERE "expression"
Specify a condition to be met for subsetting. This condition must be in double quotation marks. For example:

e To subset where C1is 2, enter WHERE "C1 = 2".
e To subset where C2 = a, enter WHERE "C2 = ""a"".

e To subset where C3 = 3/3/16, enter WHERE "C3 = DATE (""3/3/16"")".

ROWS K:K

List all row numbers to be included or excluded with a space between each. Denote a patterned range by
K:K/K. For example, 10:50/5 denotes all values from 10 to 50 by intervals of 5.

EXCLUDE
Excludes the specified rows.

BRUSHED
Use to specify all brushed rows for subsetting.

WHERE "expression'
Specify a condition to be met for subsetting. This condition must be in double quotation marks. For example:
e To subset where C1is 2, enter WHERE "C1 = 2".

e To subset where C2 = a, enter WHERE "C2 = ""a"".

e To subset where C3 = 3/3/16, enter WHERE "C3 = DATE (""3/3/16"")".
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ROWS K:K
List all row numbers to be included or excluded with a space between each. Denote a patterned range by
K:K/K. For example, 10:50/5 denotes all values from 10 to 50 by intervals of 5.

USE [C] K...K
Selects rows to copy.

Specify target location

Important NEWWS, AFTER, and STORE cannot be used in local macros. For more information, go to Session commands that are not
allowed in macros on page 1179.

Note You can use only one NEWWS, AFTER, or STORE subcommand.

NEWWS
NEWWS "text"

NEWWS K

Stores the results in a new worksheet. If you do not specify a worksheet name in "text" or in a constant (K) argument,
then Minitab uses the default naming of worksheets.

AFTER
AFTER "text"

AFTER K

Stores the results at the end of the specified worksheet. If you do not specify a worksheet name in a "text" argument
or in a constant (K) argument, then Minitab stores the copied data at the end of the active worksheet.

STORE K E...E

STORE "text" E...E
Stores the copied data in the specified columns constants, or matrices of the worksheet named in a "text" argument
or in a constant (K).

Naming

VARNAMES
Gives default names to the stored columns, constants, or matrix.

RMERGE: Session command for merging worksheets

RMERGE K...K
Use RMERGE to combine two or more worksheets side-by-side into a new worksheet. The argument is the names
of the worksheets. For example, RMERGE "Worksheetl" "Worksheet 2" merges Worksheet 2 to the right
of Worksheet 1.

Note Stored constants, matrices, DOE objects, and worksheet descriptions do not transfer into the merged worksheet.
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NAME K (optional)
Specifies the name K for the new worksheet.

Editor

CFORMAT: Session command for conditional formatting of
worksheet cells

CFORMAT C...C
Formats cells in the specified columns based on the specified rule.

You can specify only one rule subcommand (and possibly its sub-subcommands) with the CFORMAT command
at a time. However, you can run CFORMAT on the same column multiple times, and the rules accumulate. If a cell
is affected by multiple rules, the formatting of the most recent rule is used.

The availability of a specific rule might depend on the data type of the column specified in CFORMAT.

Attribute subcommands

The following subcommands define the cell format for cells that meet the condition.

TCOLOR K
Specifies the text color with a number value in K, which is a number from Numbers for colors to use in session
commands on page 1172.

BOLD
Applies bold style to text in the cells to format.

NOBOLD
Removes bold style from text in the cells to formats.

ITALIC
Applies italic style to text in the cells to format.

NOITALIC
Removes italic style from text in the cells to format.

UNDERLINE
Underlines text in the cells to format.

NOUNDERLINE
Removes underline from text in the cells to format.

COLOR K
Specifies the fill color of the cells with a number value in K, which is a number from Numbers for colors to use in
session commands on page 1172.
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Rules for highlighting cells

MISSING
Formats cells that contain missing observations (available for columns with any data type).

GT K
Formats cells that are greater than K (available for columns with any data type).

LT K
Formats cells that are less than K (available for columns with any data type).

BETWEEN K K
Formats cells between K and K, inclusive (available for columns with any data type).

NOTBETWEEN K K
Formats cells that are not between K and K, inclusive (available for columns with any data type).

EQUALS K
Formats cells that are equal to K (available for columns with any data type).

TEXT "text"
Formats cells that contain the text string, 'text" (available for text columns) The text string may be found within a
larger text string. For example, if the rule is to format cells that contain "abc", a cell that contains dabcd would
be formatted.

VALUES C

VALUES K...K
Formats cells that match any of the values in C or in K...K (available for columns with any data type) C or K...K have
the same data type as the columns specified in CFORMAT.

NOVALUES C

NOVALUES K. ..K
Formats cells that do not match any of the values in C or in K...K (available for columns with any data type) C or
K...K have the same data type as the columns specified in CFORMAT.

YESTERDAY
Formats cells that contain yesterday's date (available for date/time columns).

TODAY
Formats cells that contain today's date (available for date/time columns).

LAST K
Formats cells that contain a date that occurred within the last K days (available for date/time columns).

LWEEK
Formats cells that contain a date that occurred last week (available for date/time columns).

TWEEK
Formats cells that occur this week (available for date/time columns).

LMONTH
Formats cells that occurred last month (available for date/time columns).
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TMONTH
Formats cells that occur this month (available for date/time columns).

Hi low rules

HVALUE K
Formats cells that contain the highest K values in the column (available for numeric and date/time columns). If
there are ties at the K™ location, all tied values will be formatted.

HPERCENT K
Formats cells that contain the highest K percentage of values in the column (available for numeric and date/time
columns).

LVALUE K
Formats cells that contain the lowest K values in the column (available for numeric and date/time columns) If
there are ties at the K" location, all tied values will be formatted.

LPERCENT K
Formats cells that contain the lowest K percentage of values in the column (available for numeric and date/time
columns).

Pareto rules

MFREQUENT K
Formats cells that contain the K most frequent values (available for columns with any data type).

MPERCENT K
Formats cells that contain the top K% of values (available for columns with any data type).

BFREQUENT
Formats cells that contain the K least frequent values (available for columns with any data type).

BPERCENT K
Formats cells that contain the bottom K% of values (available for columns with any data type).

Statistical rules

OUTLIER
Formats cells that are outliers (available for columns with any data type) Columns can be different data types.
Outliers are determined based on one of the following sub-subcommands:

BOXPLOT
Observations that meet the conditions for outliers on a boxplot are formatted.

STDEV K
Observations that are more than K standard deviations away from the mean are formatted.

CONTROL K K
Formats cells that contain values that are out of control (available for numeric and date/time data).
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The first K specifies the rule:
e K = 1if data are continuous.

e K = 2 if the data are attribute.

The second K specifies the subgroup size. K > 0.

Examples of subcommand syntax:

e CONTROL 1 1 specifies to use | chart test 1.

e CONTROL 1K, where K > 1, specifies to use XBar chart test 1.
e CONTROL K K, where K > 0, specifies to use P chart test 1.

The CONTROL subcommand honors preferences (File > Options) settings to determine the Test 1 rule criteria
and to determine the estimate of standard deviation used.

SPECIFICATION
Formats cells that are outside of the specification limits (available for numeric and date/time data)

Specify one or both of the following:

LSPEC K
Specifies the lower specification limit. Cells with values less than K are out of specification.

K for LSPEC can be any numeric or date/time value, but K for LSPEC must be less that K for USPEC. Both Ks
must match the type for the argument to CFORMAT.

USPEC K
Specifies the upper specification limit. Cells with values greater than K are out of specification.

K for USPEC can be any numeric or date/time value, but K for LSPEC must be less that K for USPEC. Both Ks
must match the type for the argument to CFORMAT.

RESIDUAL
Formats cells that are unusual observations from a model because of large standardized residual (available for
response columns that have a model associated with them).

UNUSUAL
Formats cells that are unusual observations from a model because they exhibit high leverage (available for response
columns that have a model associated with them).

CFAUTOMATICALLY: Session command for automatically
recalculating values

CFAUTOMATICALLY
Updates the data by automatically recalculating the values in columns or stored constants with assigned formulas
whenever you change the corresponding data for variables. To update formulas manually, use CFMANUALLY on
page 136.

This command cannot be used in a local macro.
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CFMANUALLY: Session command for manually recalculating values

Allows you to manually recalculate the values in columns or stored constants with assigned formulas only when
using the command CFNOW on page 136 (Calculate All Formulas Now). To update formulas automatically whenever
the data they depend on changes, use CFAUTOMATICALLY on page 135.

This command cannot be used in a local macro.

CENOW: Session command for recalculating values now

CEFNOW
Recalculates the values in columns or stored constants with assigned formulas using the current data for variables.
Can be used only when Calculate All Formulas Automatically is deselected. For more information about
calculating formulas manually with command language, go to CFMANUALLY on page 136.

This command cannot be used in a local macro.

FDATE/TIME: Session command for changing the format of
date/time columns

FDATE/TIME C...C
Changes the format of a date/time columns C...C. You can use FDATE/TIME for columns that are empty.

For more information on date/time formats, go to Default date/time formats on page 1140.

FORMAT (format statement)
Indicates the format of the date/time column. For example, use the subcommand FORMAT (DTm/d/yy) to
format the column as 5/25/18. Use the subcommand FORMAT (DTm-d-yy) to format the new column as
5-25-18.

For multiple columns, add the number of columns to the format statement. For example, for 2 columns, use
FORMAT (2DTm-d-yy).

FNUMERIC: Session command for changing columns to numeric
format

FNUMERIC C...C
Changes the format of columns C...C to the specified numeric format. You can use FNUMERIC for columns that
are empty.

AUTO
The values in the column determine the format of the column, for example, the number of decimal places
and the currency symbol (if entered).

FIXED K
Displays numeric data to K decimal places.
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EXPONENTIAL [K]
Displays numeric data using exponential notation. The optional argument K specifies the number of decimal
places.

CURRENCY [K]
Displays currency data. The optional argument K specifies the number of decimal places, from 0 to 30 inclusive.

SYMBOL "text"
Specifies the currency symbol as a text value.

NEGATIVE K
Displays negative values using a minus sign (K = 1) or parentheses (K = 2).

PERCENTAGE K
Displays percentage data to K decimal places.

FTEXT: Session command for changing the format of text columns

FTEXT
Changes the format of text columns C...C. You can use FTEXT for empty columns.

FORMULA: Session command for assigning a formula to a column

FORMULA E = expression
Assigns a formula to a column or stored constant. The expression that defines the formula may contain arithmetic
operations, comparison operations, logical operations, and functions. For a list of the functions you can use, go
to LET: Session command for correcting a number in a worksheet or performing arithmetic on page 63.

This command cannot be used in a local macro.

RFORMULA: Session command for removing formulas

RFORMULA E. . .E
Removes formulas from the columns or constants that you specify. Removing a formula from a column does not
remove the data from the column.

You cannot use this command in a local macro.

VORDER: Session command for controlling the order for text
categories to be processed by Minitab commands

VORDERC. . .C
Use VORDER to control the order in which you would like text categories to be processed by Minitab commands.
By default, text categories are processed in alphabetical order. However, alphabetical order might not always be
the most convenient way to process your data.
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VALUES K...K

VALUES C
Specifies the value order using either stored or stated text constants or a single text column.

If you use the VALUES subcommand more than one time, the last one with valid arguments wins. In the first
form, stored or stated text constants are used to specify the values in order. In the second form, the rows of
a single text column are used to specify the values in order. In either form, it is an error for values to be
repeated. Note that the command language does not provide access to standard orderings.

WORKSHEET
Specifies to order data based on the first occurrence in the worksheet.

ALPHABETICAL
Specifies to order data in alphabetical order.
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Basic Statistics

DESCRIBE: Session command for summarizing
numeric data with statistics

DESCRIBE C...C

Produces descriptive statistics for each column. You can do the calculations and display graphs separately for
each level of a BY variable.

For information on storing many different statistics, go to STATS on page 143.

Control of grouping

BY

Use BY to produce separate statistics and graphs for each unique value in C. The values in the BY column may
contain numeric, text, or date/time data and may be any value. When the BY column is text, the first entry (row
1) is level 1, the next entry that is different is level 2, and so on. Column lengths must be equal to use BY.

Statistics

MEAN

Calculates the arithmetic mean, or average. The mean is a commonly used measure of the center of a batch of
numbers.

Note Missing values are omitted from the calculation of the function Mean.

SEMEAN
Gives the standard error of the mean. It is calculated as StDev / SQRT (N).

STDEV

Calculates the sample standard deviation, which provides a measure of how spread out the data are. To calculate
the variance, simply square the standard deviation value.

If the column contains x1, X2, ..., xn, with mean x, then the standard deviation is calculated as follows:

Note Missing values are omitted from the calculation of the function Standard deviation.

VARIANCE

Variance is a measure of how far the data are spread about the mean. Sample variance equals the standard
deviation squared. It can also be computed with this formula:

T(x-% T

n—1
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CVARIATION
Displays the coefficient of variation, a measure of relative variability. It is calculated as: 100 (s / x).

MEDIAN
Stores the median of a column. The median is in the middle of the data: half the observations are less than or
equal to it. Suppose the column contains n values. If n is odd, the median is the value in the middle. If n is even,
the median is the average of the two middle values.

Note Missing values are omitted from the calculation of the function Median.

MODE

Displays the mode of a column. The mode of a data set is the value that occurs most frequently. For example, the
mode for data set {1, 3, 4, 4, 7} is 4.

Note For data sets that have multiple mode values, Minitab displays only the four smallest modes.

TRMEAN
A 5% trimmed mean is calculated. Minitab removes the smallest 5% and the largest 5% of the values (rounded
to the nearest integer).

SUM
Calculates the sum.

Note Missing values are omitted from the calculation of the function Sum.

MIN
Stores the smallest number in a column.

Note Missing values are omitted from the calculation of the function MIN.

MAX
Stores the largest number in a column.

Note Missing values are omitted from the calculation of the function MAX.

RANGE
Calculates the difference between the largest and smallest data value.

SSQ
Squares each value in the column, and computzes th% sum of tgose squared values. That is, if the column contains
X1, X5, ..., Xp, then sum of squares calculates (x;” + X" + .. + X;,).

Note Missing values are omitted from the calculation of the function the function Sum of Squares (corrected).

SKEWNESS
Skewness is a measure of asymmetry. A value more than or less than zero indicates skewness in the data. But a
zero value does not necessarily indicate symmetry.

KURTOSIS
Kurtosis is one measure of how different a distribution is from the normal distribution. A positive value characterizes
a distribution with heavier tails than the normal distribution. A negative value characterizes a distribution with
lighter tails than the normal distribution.
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MSSD

MSSD computes half the Mean of the Squared Successive Differences of a batch of numbers. For example, suppose
a column contains 1, 2, 4, and 10. The successive differencesare2-1=1,4-2=2,and 10 - 4 = 6. Then:

MSSD = mean(1-squared, 2-squared, and 6-squared) / 2 = 6.83333

N
Returns the number of nonmissing observations in a column.

NMISS
Returns the number of missing observations in a column.

COUNT
Returns the total number of observations in a column.
When used as an option with TALLY on page 903 (Stat > Tables > Tally > Tally Individual Variables) or the
STATS on page 143, COUNT computes the number of observations in each group. For example, if you tally a column
containing 1s, 2s and 3s, COUNT tells you how many of each there are. Using COUNTS with STATS, you can store
these counts, which is useful if you want to generate a frequency plot.

CUMN
CUMN, or cumulative n, computes a cumulative frequency count of the number of non-missing observations in
each group listed in the BY columns. If there are no BY columns listed, CUMN simply counts the non-missing
observations in the columns listed with DESCRIBE or STATS. CUMN counts observations for non-missing groups
only, unless you include the MISSING subcommand.

PERCENT
If you want statistics for different groups listed in one or more BY columns, PERCENT computes what percentage
of the whole is accounted for by each group.
For example, suppose you list one BY column containing five 1s, one 2, and four 3s. PERCENT computes 50% for
the first group, 10% for the second, and 40% for the third.
If you omit the BY subcommand, then PERCENT and CUMPERCENT calculate the value 100 (for 100%).
If you include columns on the main DESCRIBE or STAT command line, then PERCENT and CUMPERCENT calculate
percentages for only the non-missing values in those columns.

CUMPERCENT
If you want statistics for different groups listed in one or more BY columns, CUMPERCENT computes the cumulative
percentage represented by each group.
For example, suppose you list one BY column containing five 1s, one 2, and four 3s.
If you omit the BY subcommand, then PERCENT and CUMPERCENT calculate the value 100 (for 100%).
If you include columns on the main DESCRIBE or STAT command line, then PERCENT and CUMPERCENT calculate
percentages for only the non-missing values in those columns.

Graphs

Each graph subcommand displays a separate graph for each variable listed on the command line.

If you use the BY subcommand, Minitab generates one graph for each column listed on the command line.
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GHISTOGRAM
Displays a histogram for each variable.

GHISTOGRAM and GNHISTOGRAM display a histogram for each level of the BY variable in a separate panel of
the graph. The histograms for one variable are on the same scale to facilitate comparisons between the levels.

GNHISTOGRAM
Displays a histogram with a normal curve for each variable. GNHISTOGRAM bases each normal curve on the
sample mean and standard deviation of the data in the corresponding histogram.

GHISTOGRAM and GNHISTOGRAM display a histogram for each level of the BY variable in a separate panel of
the graph. The histograms for one variable are on the same scale to facilitate comparisons between the levels.

GINDPLOT
Displays an individual value plot for each variable.

GINDPLOT and GBOXPLOT display side-by-side plots in a single graph, one for each level of the BY variable. This
allows you to easily compare the different levels of the BY variable.

GBOXPLOT
Displays a boxplot for each variable.

GINDPLOT and GBOXPLOT display side-by-side plots in a single graph, one for each level of the BY variable. This
allows you to easily compare the different levels of the BY variable.

GSUMMARY
Displays a graphical summary for each variable.

Quartiles

Every group of data has three quartiles. To calculate quartiles, use Sort (Data > Sort) to order the data from smallest
to largest. The first quartile (Q1) is the observation at position (n+1) / 4. The second quartile is the median. The third
quartile (Q3) is the observation at position 3(n+1) / 4, where n is the number of observations. If the position is not an
integer, interpolation is used.

For example, suppose n=10. Then (10 + 1)/4 = 2.75, and Q1 is between the second and third observations (call them
x2 and x3), three-fourths of the way up. Thus, Q1 = x2 + 0.75(x3 — x2). Since 3(10 + 1)/4 = 8.25, Q3 = x8 + 0.25(x9 —
x8), where x8 and x9 are the eight and ninth observations.

QONE
The first quartile is also referred to as the 25t percentile because data from 25% of the observations are less than
or equal to this value.

IQRANGE
The interquartile range equals Q3 - Q1.

QTHREE
The third quartile is also referred to as the 75t percentile because data from 75% of the observations are less
than or equal to this value.
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STATS: Session command for storing descriptive
statistics

STATS [C...C]

STATS computes a wide range of statistics on entire columns or subsets of columns and stores those statistics in
the worksheet.

STATS is similar to the commands TALLY on page 903, TABLE on page 901, and DESCRIBE on page 139. TALLY, TABLE,
and DESCRIBE compute many of these statistics and display them in an easy-to-read table format. But TABLE and
DESCRIBE cannot store the values of these statistics for use in further analysis as STATS can.

Here is an example using the PULSE.MTW data set. This data set includes three columns named Height, Weight,
and Sex (containing 1's for males, 2's for females). The NAME command names the three new columns that STATS
will store its results in. GVALUES will store the numbers 1 and 2 into C11, because these are the distinct values in
the BY column named Sex. MEAN will store the mean height for males and the mean height for females in C12,
and the mean weight for males and the mean weight for females in C13.
NAME C1l1 'SexID' Cl2 'MeanHt' C1l3 'MeanWt'
STATS 'Height' 'Weight';

BY 'Sex';

GVALUES C11;

MEAN C12 C13.

When there is no BY subcommand, you must list at least one column on the main STATS command line. In that
case, STATS computes the requested statistics for the entire column.

When you omit columns from the main STATS command line, you must use the BY subcommand. In that case,
you may store these statistics: N, NMISS, COUNT, CUMN, PERCENT, and CUMPERCENT. For more information,
go to Notes on subcommands that store descriptive statistics (STATS command) on page 1172.

You can use either the GLABELS, GVALUES, or GIDS subcommand so that you know which group each row of
statistics belongs to. Use the NAME on page 55 command to name each column so that you know what you
stored.

Control of grouping

BY C...C

BY lists the columns that contain the group variables (such as a column named Temp containing the values Low,
Medium, and High). Columns listed with BY may contain numeric, text, or date/time data. When you include the
BY subcommand, STATS computes statistics for each group listed in the BY columns or columns. When you omit
the BY subcommand, STATS computes statistics for whole columns rather than for subgroups.

NOEMPTY
NOEMPTY omits empty cells.

MISSINGS

MISSINGS includes missing as a distinct value of the BY column (when the BY column includes a missing value).
Otherwise, rows with missing values in BY columns are omitted.

Options

These subcommands store each distinct value listed in each BY column. Therefore, use the same number of columns
as you list with BY. It is a good idea to include at least one of these subcommands so you will know which group each
row of statistics belongs to.
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GLABELS C...C
GLABELS stores the actual labels from your BY columns (such as 10, 20, 30, or Low, Medium, High). GLABELS
always stores the labels as text.

GVALUES C...C
GVALUES also stores the actual labels from your BY columns, but it stores them as the same data type (numeric
or text) as the BY variable.

GIDS C...C
GIDS stores a 1 for the first value in your BY column, a 2 for the second value, and so on, in a numeric column. If
the BY column is numeric, GIDS stores a 1 for the smallest number in the BY column, a 2 for the next largest
number, and so on. If the BY column contains text, GIDS stores a 1 for the first entry (row 1), a 2 for the next entry
that is different, and so on.

EXPAND
Stores a row of the desired statistic for each row of input instead. If you do not issue EXPAND, Minitab stores the
statistic in the first row.

Statistics
MEAN
Stores the arithmetic mean, or average. The mean is a commonly used measure of the center of a batch of numbers.

Note Missing values are omitted from the calculation of the function Mean.

SEMEAN
Stores the standard error of the mean. It is calculated as StDev / SQRT (N).

STDEV
Stores the sample standard deviation, which provides a measure of how spread out the data are. To calculate the
variance, simply square the standard deviation value.

If the column contains x1, x2, ..., xn, with mean x, then the standard deviation is calculated as follows:

Note Missing values are omitted from the calculation of the function Standard deviation.

VARIANCE
Stores the sample variance, which is a measure of how far the data are spread about the mean. Sample variance
equals the standard deviation squared. It can also be computed with this formula:

Tx-%T

n—1

CVARIATION
Stores the coefficient of variation, a measure of relative variability. It is calculated as: 100 (s / x).
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MEDIAN
Stores the median of a column. The median is in the middle of the data: half the observations are less than or
equal to it. Suppose the column contains n values. If n is odd, the median is the value in the middle. If n is even,
the median is the average of the two middle values.

Note Missing values are omitted from the calculation of the function Median.

TRMEAN
Stores a 5% trimmed mean. Minitab removes the smallest 5% and the largest 5% of the values (rounded to the
nearest integer).

SUMS
Stores the sum.

Note Missing values are omitted from the calculation of the function Sum.

MIN
Stores the smallest number in a column.

Note Missing values are omitted from the calculation of the function MIN.

MAX
Stores the largest number in a column.

Note Missing values are omitted from the calculation of the function MAX.

RANGE
Stores the difference between the largest and smallest data value.

SSQ
Stores the sum of squares. Squares each value in the column, and computes Ehe sum of those squared values.
That is, if the column contains x4, X, ..., X, then sum of squares calculates (x;“ + x,° + ... + x,).

Note Missing values are omitted from the calculation of the function the function Sum of Squares (corrected).

SKEWNESS
Stores the skewness value. Skewness is a measure of asymmetry. A value more than or less than zero indicates
skewness in the data. But a zero value does not necessarily indicate symmetry.

KURTOSIS
Stores the kurtosis value. Kurtosis is one measure of how different a distribution is from the normal distribution.
A positive value characterizes a distribution with a heavier tails than the normal distribution. A negative value
characterizes a distribution with lighter tails than the normal distribution.

MSSD
Stores half the Mean of the Squared Successive Differences of a batch of numbers. For example, suppose a column
contains 1, 2, 4, and 10. The successive differencesare2-1=1,4-2 =2, and 10-4 = 6. Then:

MSSD = mean(1-squared, 2-squared, and 6-squared) / 2 = 6.83333

Stores the number of nonmissing observations in a column.
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NMISS
Stores the number of missing observations in a column.

COUNT
Stores the total number of observations in a column.

When used as an option with TALLY on page 903 (Stat > Tables > Tally > Tally Individual Variables) or the
STATS command, COUNT computes the number of observations in each group. For example, if you tally a column
containing 1s, 2s and 3s, COUNT tells you how many of each there are. Using COUNTS with STATS, you can store
these counts, which is useful if you want to generate a frequency plot.

CUMN
Stores a cumulative frequency count of the number of non-missing observations in each group listed in the BY
columns. If there are no BY columns listed, CUMN simply counts the non-missing observations in the columns
listed with DESCRIBE or STATS. CUMN counts observations for non-missing groups only, unless you include the
MISSING subcommand.

PERCENT
If you want statistics for different groups listed in one or more BY columns, PERCENT computes what percentage
of the whole is accounted for by each group.

For example, suppose you list one BY column containing five 1s, one 2, and four 3s. PERCENT computes 50% for
the first group, 10% for the second, and 40% for the third.

If you omit the BY subcommand, then PERCENT and CUMPERCENT calculate the value 100 (for 100%).

If you include columns on the main DESCRIBE or STAT command line, then PERCENT and CUMPERCENT calculate
percentages for only the non-missing values in those columns.

CUMPERCENT
If you want statistics for different groups listed in one or more BY columns, CUMPERCENT computes the cumulative
percentage represented by each group.

For example, suppose you list one BY column containing five 1s, one 2, and four 3s.
If you omit the BY subcommand, then PERCENT and CUMPERCENT calculate the value 100 (for 100%).

If you include columns on the main DESCRIBE or STAT command line, then PERCENT and CUMPERCENT calculate
percentages for only the non-missing values in those columns.

GSUMMARY: Session command for displaying a
graphical summary of each variable

GSUMMARY
Displays a graphical summary of each variable.

BY

Lists the columns that contain the group variables (such as a column named Temp containing the values
Low, Medium, and High). Columns listed with BY may contain numeric, text, or date/time data.
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When you include the BY subcommand, GSUMMARY creates a summary for each group listed in the BY
column or columns. When you omit the BY subcommand, GSUMMARY creates a summary for whole columns
rather than for subgroups.

CONFIDENCE K

Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default
value of K is 95.

SMCONF C C
Stores the confidence interval for the median in C and C.

SSCONF C C
Stores the confidence interval for the standard deviation in C and C.

ONEZ: Session command for performing a 1-sample
/-test

ONEZ C...C

ONEZ K K

Performs a 1-sample Z-test for the raw or summarized data. You need to provide a value for population standard
deviation the SIGMA subcommand. When you do not know the population standard deviation, you can use ONET
on page 148.

ONEZ C...C performs a Z-test for each of the columns in C...C.
ONEZ K K performs a Z-test using summarized data with sample size and sample mean in K and K, respectively.

SIGMA K (required)
Specifies the value of the population standard deviation.

CONFIDENCE K

Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default
value of K is 95.

ALTERNATIVE K
Enter K to specify the direction of the alternative hypothesis.

Value of K Format of the alternative hypothesis
-1 Less than
0 (default) Not equal to
1 Greater than
TEST K

Tests the null hypothesis using the hypothesized mean specified in K.

SPVALUE C
SPVALUE stores the p-value of the test in a column.
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SCONF C C
SCONF stores the confidence interval for the mean in two columns.

Graphs

Displays a graph for each column listed with ONEZ. Each graph displays the sample mean and a K% confidence interval
for the mean. No graph is displayed for the summarized data.

GHISTOGRAM
Displays a histogram.

GINDPLOT
Displays an individual value plot.

GBOXPLOT
Displays a boxplot.

ONET: Session command for performing a 1-sample
t-test

ONET C...C

ONET K K K

Performs a t-test using raw or summarized data. The population standard deviation for the test is estimated form
the columns listed with ONET. A test value is specified with the TEST subcommand. ONET performs a two-sided
test unless you use the ALTERNATIVE subcommand to specify a one-sided test. If you know the population
standard deviation or deviations, use ONEZ on page 147 instead.

ONET C...C performs a t-test for each of the columns in C...C.
ONET K K K performs a t-test for the summarized data using sample size, sample mean, and population standard

deviation specified in K, K, and K, respectively.

CONFIDENCE K

Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default
value of K is 95.

ALTERNATIVE K
Enter K to specify the direction of the alternative hypothesis.

Value of K Format of the alternative hypothesis
-1 Less than
0 (default) Not equal to
1 Greater than
TEST K

Tests the null hypothesis using the hypothesized mean specified in K.
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SPVALUE C
SPVALUE stores the p-value of the test in a column.

SCONF C C
SCONF stores the confidence interval for the mean in two columns.

Graphs

Displays a graph for each column listed with ONET. Each graph displays the sample mean and a K% confidence interval
for the mean. No graph is displayed for the summarized data.

GHISTOGRAM
Displays a histogram.

GINDPILOT
Displays an individual value plot.

GBOXPLOT
Displays a boxplot.

TWOT: Session command for performing a 2-sample
t-test when samples are in one column

TWOT C C

TWOT K K K K K K

TWOT performs a two-sample t-test and confidence interval when the samples and subscripts are in separate
columns or when you have summarized data. Use TWOSAMPLE on page 150 when the samples are in different
columns.

You can specify a confidence level to change the default level for the confidence interval produced by TWOT. The
default level is 95%. K can be any number between 1 and 100. For example, if you enter the command TWOT 90
C1 C2, Minitab calculates a 90% confidence interval.

TWOT C C performs a 2-sample t-test when the samples are in one column and subscripts are in another column.
TWOT K K K K K K performs a 2-sample t-test using summarized data with sample size, mean, and standard

deviation listed for each sample.

ALTERNATIVE K
Specifies a one-sided test. K = -1 gives H1: u < K, and K = +1 gives H1: p > K1.

TEST K
Specifies the null hypothesis value K.

POOLED
Uses a pooled procedure to estimate o. This procedure assumes the two populations have equal variances.

The POOLED procedure is slightly more powerful than the method that does not assume equal variances,
but can be seriously in error if the variances are not equal. Thus, the POOLED subcommand should not be
used in most cases.
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GINDPLOT

The graph for GINDPLOT contains two individual value plots, one for each sample. The individual value plots
displays the sample mean and a K% confidence interval for each sample.

GBOXPLOT

The graph for GBOXPLOT contains two boxplots, one for each sample. The boxplots display the sample mean
and a K% confidence interval for each sample.

SPVALUE C
SPVALUE stores the p-value of the test in a column.

SCONF C C
SCONF stores the confidence interval for the mean in two columns.

TWOSAMPLE: Session command for performing a
2-sample t-test when the samples are in different
columns

TWOSAMPLE

TWOSAMPLE performs a 2-sample t-test and confidence interval when the samples are in different columns. Use
TWOT on page 149 when samples and subscripts are in separate columns or when you have summarized data.

You can specify a confidence level to change the default level for the confidence interval produced by TWOSAMPLE.
The default level is 95%. K can be any number between 1 and 100. For example, if you enter the command
TWOSAMPLE 90 C1 C2, then a 90% confidence interval is calculated.

ALTERNATIVE K
Specifies a one-sided test. K = -1 gives H1: u < K, and K = +1 gives H1: p > K1.

TEST K
Specifies the null hypothesis value K.

POOLED
Uses a pooled procedure to estimate o. This procedure assumes the two populations have equal variances.

The POOLED procedure is slightly more powerful than the method that does not assume equal variances,
but can be seriously in error if the variances are not equal. Thus, the POOLED subcommand should not be
used in most cases.

GINDPLOT

The graph for GINDPLOT contains two individual value plots, one for each sample. The individual value plots
displays the sample mean and a K% confidence interval for each sample.

GBOXPLOT

The graph for GBOXPLOT contains two boxplots, one for each sample. The boxplots display the sample mean
and a K% confidence interval for each sample.
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SPVALUE C
SPVALUE stores the p-value of the test in a column.

SCONF C C
SCONF stores the confidence interval for the mean in two columns.

PAIR: Session command for performing a paired
t-test

PAIR C C

PAIR K K K
Performs a paired t-test. This test is appropriate for testing the mean difference between paired observations
when the paired differences follow a normal distribution.

Use to calculate a confidence interval and perform a hypothesis test of the mean difference between paired
observations in the population. A paired t-procedure matches responses that are dependent or related in a pairwise
manner. This matching allows you to account for variability between the pairs usually resulting in a smaller error
term, thus increasing the sensitivity of the hypothesis test or confidence interval.

Typical examples of paired data include measurements on twins or before-and-after measurements. For a paired
t-test, the hypotheses are as follows:

Ho: g = Mg versus Hy: pg= Ko
where 4 is the population mean of the differences and 1 is the hypothesized mean of the differences.

When the samples are drawn independently from two populations, use TWOSAMPLE on page 150 or TWOT on
page 149.

PAIR C C performs a paired t-test when the data are in columns.
PAIR K K K performs a paired t-test using summarized data when K = sample size, K = mean difference, and K =

standard deviation difference.

CONFIDENCE K
Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default
value of K is 95.

ALTERNATIVE K
Specifies a one-sided test. K = —1 gives Hy: pg < Ho, and K = +1 gives Hq: pg > Mo

TEST K
Conducts a test of the null hypothesis p = K.

SPVALUE C
SPVALUE stores the p-value of the test in a column.

SCONF C C
SCONF stores the confidence interval for the mean in two columns.
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Graphs

Each of the following graphs displays the sample mean, a K% confidence interval for the mean, and the value under
Ho-

GHISTOGRAM
Displays a histogram of the paired differences.

GINDPLOT
Displays an individual value plot of the paired differences.

GBOXPLOT
Displays a boxplot of the paired differences.

PONE: Session command for performing a
hypothesis test of the proportion

PONE C...C

PONE K K. ..K
Performs a test of one binomial proportion.

Use PONE to compute a confidence interval and perform a hypothesis test of the proportion. For example, an
automotive parts manufacturer claims that his spark plugs are less than 2% defective. You could take a random
sample of spark plugs and determine whether or not the actual proportion defective is consistent with the claim.
For a two-tailed test of a proportion:

Ho: p = pg versus Hq: p=pg

where p is the population proportion and pg is the hypothesized value.

To compare two proportions, use PTWO on page 154.

PONE C...C performs an analysis of one proportion on samples in columns.

PONE K K...K performs an analysis of one proportion on summarized data where K = the number of trials and

subsequent Ks = the number of events.

EVENT K
Specifies the event of interest in a column of data. Use a value from the column for K. Enclose text values in
quotation marks. For example, to assess the proportion of "Failure" in a column, enter EVENT "Failure".

TEST K
Specifies the null hypothesis value K.

Options

CONFIDENCE K
Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of K'is 95.
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ALTERNATIVE K

Specifies the alternative hypothesis and the type of confidence interval. K = -1 gives H1: p < py and an upper
bound for p. K = +1 gives H1: p > pyand a lower bound for p. The default of K = 0 gives H1: p # pg and a two-sided
interval for p.

ABLAKER
When the argument for ALTERNATIVE is 0, specifies to use the adjusted Blaker's exact method for calculating the
two-sided hypothesis test and a two-sided confidence interval.

When the argument for the ALTERNATIVE subcommand is -1 or 1, specifies to use the Clopper-Pearson method
to calculate one-sided hypothesis tests and confidence intervals.

CTOLERANCE K

Specifies the convergence criterion for the calculation of the p-value and confidence interval for the adjusted
Blaker's exact method. K is a positive, real number. The default value is 10710,

ITERATION K

Specifies the maximum number of iterations for the calculation of the p-value and confidence interval for
the adjusted Blaker's exact method. K is a non-negative integer. The default value is 100.

WILSON

Specifies to use the classical Wilson-score approximate procedure for calculating the hypothesis test and confidence
interval. The method is also known as the score method. To use the method with a continuity correction, issue
the CCORRRECTION sub-subcommand.

CCORRRECTION

Specifies to use the Wilson-score approximate method with a continuity correction. Without a continuity
correction, the method is liberal for small to moderate sample sizes. The continuity correction makes the
actual confidence level and the actual alpha value at least the levels that the analysis specifies.

ACOULL

Specifies to use the Agresti-Coull approximate procedure for calculating the hypothesis test and confidence
interval.

CPEARSON
Specifies to use the Clopper-Pearson exact method for calculating the hypothesis test and confidence interval.

USEZ

Specifies to use the normal approximation to the binomial distribution for calculating the hypothesis test and
confidence interval.

Storage

SPVALUE C
SPVALUE stores the p-value of the test in a column.

SCONF C (C)

For the default analysis or when the argument for ALTERNATIVE is 0, stores the lower side of the confidence
interval in the first column and the upper side of the confidence interval in the second column.

When the argument for ALTERNATIVE is -1 or 1, stores the confidence limit in one column.
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PTWO: Session command for performing a
hypothesis test of the difference between two
proportions

PTWO C C

PTWO K K K K
Performs a test of two binomial proportions.

Use PTWO to compute a confidence interval and perform a hypothesis test of the difference between two
proportions. For example, suppose you wanted to know whether the proportion of consumers who return a survey
could be increased by providing an incentive such as a product sample. You might include the product sample
with half of your mailings and see if you have more responses from the group that received the sample than from
those who did not. For a two-tailed test of two proportions:

Ho: p1 = pp versus Hy: py=ps

where p; and p, are the proportions of success in populations 1 and 2, respectively.
To test one proportion, use PONE on page 152.

You can input either raw or summarized data.

Raw data can be entered in two ways: stacked and unstacked.

e Enter both samples in a single column (stacked) with a group column to identify the population. Columns may
be numeric, text, or date/time. Successes and failures are determined by numeric or alphabetical order. Minitab
defines the lowest value as the failure; the highest value as the success. For example:

o For the numeric column entries of "5" and "10", observations of 5 are considered failures; observations of
10 are considered successes.

o For the text column entries of "agree" and "disagree," observations of agree are considered failures;
observations of disagree are considered successes. If the data entries are "yes" and "no", observations of
no are considered failures; observations of yes are considered successes.

e Enter each sample (unstacked) in separate numeric or text columns. Both columns must be the same
type-numeric or text. Successes and failures are defined as above for stacked data.

You can reverse the definition of success and failure in a text column by applying a value order. For more
information, go to VORDER on page 137.

The sample sizes do not need to be equal. Minitab automatically omits missing data from the calculations.

For raw data, enter the number of trials and the number of successes for each sample on the main command line.
Enter four integers: the number of trials and the number of successes in the first sample followed by the number
of trials and the number of successes in the second sample.

PTWO C C performs a test of two proportions on samples in columns.

PTWO K K K K performs a test of two proportions on summarized data where K = the number of trials and K =
the number of events for the first proportion, and K = the number of trials and K = the number of events for the
second proportion.

CONFIDENCE K
Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default
value of K is 95.
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ALTERNATIVE K
Specify a one-sided test. K = -1 gives H1: p < K, and K = +1 gives H1: p > K1.

TEST K
Specifies the null hypothesis value K.

STACKED

Specifies that the data have been entered in a stacked format: the raw data is in one column and the subscripts
or group column to identify the population are in a second column.

POOLED
Specifies to use a pooled estimate of p to calculate the test statistic.

SPVALUE C
Stores the p-value of the test in a column.

SFISHER C
Stores the p-value for the Fisher's exact test in a column.

SCONFC C
Stores the confidence interval for the mean in two columns.

ONERATE: Session command for performing a
1-sample Poisson rate test

ONERATE C...C

ONERATE K K...K
Performs a hypothesis test and calculates a confidence interval for the population Poisson rate for each sample
you input. You can enter data in raw, summarized, or frequency format. Specify a hypothesized test value with
the TEST subcommand. Minitab performs a two-sided test unless you use the ALTE subcommand to specify a
one-sided test. Specify the length of the observation space with the LENGTH subcommand to analyze the mean
number of occurrences in addition to the occurrence rate.

ONERATE C...C calculates a confidence interval for the population Poisson rate for each column of raw sample
data.

ONERATE K K...K calculates a confidence interval for the population Poisson rate for summarized data. The first
K equals the sample size; subsequent values of K correspond to the number of events in each summarized sample.
You cannot use this command to analyze samples with different sample sizes.

FREQ C...C
If your data exists in frequency format, use this subcommand to specify the frequency columns. Enter them
in the same order in which you enter the columns of unique observations.

LENGTH K [K]...[K]

Specify the length of the observation space for each sample to obtain confidence intervals of mean number
occurrences in addition to the rate of occurrences. By default, length equals 1, and the occurrence rate equals
the mean number of occurrences.
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CONFIDENCE K

Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default
value of K is 95.

ALTERNATIVE K
Enter K to specify the direction of the alternative hypothesis.

Value of K Format of the alternative hypothesis

-1 Less than

0 (default) Not equal to

1 Greater than
TEST K

Performs a hypothesis test of population Poisson rate. Enter the hypothesized value of the population Poisson

rate for K.
USEZ

Specifies the normal approximation method for calculating the hypothesis test and confidence interval. By
default, Minitab uses the exact method instead of the normal approximation method. This subcommand
accepts no arguments.

TWORATE: Session command for performing a
2-sample Poisson rate test

TWORATE C C

TWORATE K K K K
Use TWORATE C C to perform a hypothesis test and calculates a confidence interval for the difference between
the Poisson rates of two populations. For unstacked data, the arguments correspond to the two columns of data.
For stacked data, the first C corresponds to the column of stacked sample data, and the second C corresponds
to the column of subscripts.

Use TWORATE K K K K with summarized data to perform a hypothesis test and calculate a confidence interval for
the difference between the Poisson rates of two populations. The first K equals the size of the first sample; the
second K equals the number of occurrences in the first sample; the third K equals the size of the second sample;
the fourth K equals the number of occurrences in the second sample.

LENGTH K [K]

Specify the length of observation for each sample to analyze both the mean number of occurrences and the
occurrence rate. If you enter one K, this value becomes the length for both samples. If you enter two values
for K, the first becomes the length for the first sample, and the second K becomes the length of the second
sample.

CONFIDENCE K

Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default
value of K is 95.
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ALTERNATIVE K
Enter K to specify the direction of the alternative hypothesis.

Value of K Format of the alternative hypothesis
-1 Less than
0 (default) Not equal to
1 Greater than
TEST K
Specifies the hypothesized value for the difference between the two population Poisson rates. The default
value is 0.
STACKED
Indicates that the data for both samples are stacked in a single column. This subcommand accepts no
arguments.
FREQ C [C]

Use this subcommand if your data exists in frequency format. For stacked data, enter only one column of
frequencies. For unstacked data, enter two columns of frequency data in the same order in which you enter
the columns of unique observations.

POOLED
Uses a pooled estimate of the occurrence rate for both populations. The argument for the TEST subcommand
must equal zero to use this option. By default, Minitab estimates the rate of each population separately by
using the observed sample rates. This subcommand accepts no arguments.

ONEV: Session command for performing a 1variance
test

ONEV C...C

ONEV K K
For each sample you input, this command performs a one variance hypothesis test and produces a confidence
interval for the population variance. A test value is specified with the STEST or VTEST subcommands. Minitab
performs a two-sided test unless you use the ALTERNATIVE subcommand to specify a one-sided test. If you prefer
to work in terms of standard deviation instead of variance, use the STDEV subcommand.

ONEV C...C calculates a confidence interval for the population variance for each column of raw data. Output
includes results of the chi-square method (for normal distributions) and the Bonett method (for any continuous
distribution).

ONEV K K calculates a confidence interval for the population variance with summarized data. The first K equals
the sample size; the second K equals the sample variance. Output only includes results of the chi-square method
(for normal distributions).

CONFIDENCE K
Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default
value of K is 95.
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ALTERNATIVE K
Enter K to specify the direction of the alternative hypothesis.

Value of K Format of the alternative hypothesis
-1 Less than
0 (default) Not equal to
1 Greater than
STEST K

STEST performs a hypothesis test of the population standard deviation.

STEST and VTEST are mutually exclusive.

VTEST K
VTEST performs a hypothesis test of the population variance. K specifies the hypothesized value of the
population and must be a positive number.

STEST and VTEST are mutually exclusive.

STDEV
This subcommand indicates that input values refer to standard deviation instead of variance, where applicable.
Furthermore, this subcommand causes Minitab to produce output in terms of standard deviation instead of
variance. By default, Minitab interprets input and produces output in terms of variance. This subcommand
accepts no arguments.

TWOVARIANCES: Session command for determining
whether the variances or standard deviations of two
groups differ

TWOVARIANCES performs hypothesis tests and computes confidence intervals for the ratios between two populations'
variances and standard deviations. You can use this command when samples and subscripts are in separate columns,
when each sample is in a single column, or when you have summarized data.

TWOVARIANCES C C
Performs two variances test when sample data are in different columns.

TWOVARIANCES C C

Performs two variances test when all sample data are in one column C and subscripts are in a second column C.
Use STACKED with this option.

STACKED
Specifies that data are stacked.
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TWOVARIANCES K K K K

Performs two variances test using summarized data. Specify the sample size and variance for Sample 1 and the

sample size and variance for Sample 2. If you specify standard deviations instead of variances, use the STDEV
subcommand.

Options

STDEV
Indicates that the input summary values refer to standard deviations instead of variances.

CONFIDENCE K

Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of K'is 95.

ALTERNATIVE K
Enter K to specify the direction of the alternative hypothesis.

Value of K Format of the alternative hypothesis
-1 Less than
0 (default) Not equal to
1 Greater than
STEST K

STEST specifies the hypothesized value K for the ratio of two standard deviations. K must be a positive number.
The default is 1, which tests for equal standard deviations. STEST and VTEST are mutually exclusive.

VTEST K
VTEST specifies the hypothesized value K for the ratio of two variances. K must be a positive number. The default

is 1, which tests for equal variances. STEST and VTEST are mutually exclusive.

SNAMES K K
Specifies names for the samples when you enter summarized data. The default sample names are "Sample 1" and
"Sample 2".

USEF

Specifies to use the F-test method instead of Bonett's method and Levene's method. The F-test is accurate only
for normally distributed data. Any departure from normality can cause the F-test to yield inaccurate results.
However, if the data conform to the normal distribution, then the F-test is typically more powerful than either
Bonett's test or Levene's test.

Graphs

GINTERVAL
GINTERVAL displays a graphical summary of the results including the following:

e Confidence intervals for the ratio of the standard deviations or variances
e P-values for the hypothesis tests

e Boxplots of each sample
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GHISTOGRAM
GHISTOGRAM displays a graph containing a histogram for each sample.

GINDPLOT
GINDPLOT displays a graph containing an individual value plot for each sample.

Results

NODEFAULT
Specifies that none of the following results are displayed.

TMETHOD
TMETHOD displays the method table which includes the null hypothesis, the alternative hypothesis, and the
significance level (denoted by a or alpha).

TSTATISTICS
TSTATISTICS displays the statistic table which includes the standard deviation of each sample, the variance of
each sample, and the confidence interval for the standard deviation or the variance of each sample. The ratio of
the standard deviations and the ratio of the variances are also displayed.

TCONFIDENCE
TCONFIDENCE displays the confidence interval table which includes confidence intervals for the ratio of the
standard deviations and the ratio of the variances.

TTEST
TTEST displays the test table which includes the degrees of freedom, the test statistics, and the p-values. When
the sample sizes are unequal, the test statistic for Bonett's method is undefined. However, the p-value can be
calculated by inverting the confidence interval procedure.

CORRELATION: Session command for measuring
the strength and direction of the association
between two variables

CORRELATION C...C
Calculates the Pearson product moment correlation or the Spearman rank-order correlation for every pair of
samples in C...C.

Options

Minitab calculates the Pearson product moment correlation or the Spearman rank-order correlation and the associated
confidence intervals and p-values.

PEARSON
Calculates the Pearson (product-moment) correlation. Use the Pearson correlation coefficient to examine the
strength and direction of the linear relationship between two continuous variables.
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For each pair of samples, Minitab calculates the p-value for the hypothesis test of zero-correlation and the
confidence interval for the Pearson correlation. The confidence intervals are based on the Fisher's Z transformation.

SPEARMAN
Calculates the Spearman rank-order correlation (also called Spearman's rho). The Spearman correlation evaluates
the monotonic relationship between two continuous or ordinal variables. In a monotonic relationship, the variables
tend to change together, but not necessarily at a constant rate. The Spearman correlation coefficient is based on
the ranked values for each variable rather than the raw data.

Spearman correlation is often used to evaluate relationships involving ordinal variables. For example, you might
use a Spearman correlation to evaluate whether the order in which employees complete a test exercise is related
to the number of months they have been employed.

For each pair of samples, Minitab calculates the p-value for the hypothesis test of zero-correlation and the
confidence interval for the Spearman correlation. The confidence intervals are based on the Fisher's Z transformation
of the Spearman correlation and Bonett and Wright adjustments.

CONFIDENCE K

Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of K is 95.

Results

NODEFAULT
Suppresses the display of default tables and graphs.

TMETHOD
Displays the Method table which includes the correlation method. When the matrix plot includes p-values or the
output includes the table of pairwise correlations, the Method table also includes the hypotheses and the
significance level.

TCORRELATION
Displays the correlation matrix.

TPCORRELATION M
Displays the table of pairwise correlations. The table includes pairwise sample sizes, the correlation estimates, the
confidence intervals, and the p-values.

Graphs

GMPLOT
Displays a matrix of scatterplots for all pairs. By default, the matrix plot includes correlation values and the matrix
plot is the lower left triangle of the matrix so that each pair of variables is on one plot. There are two groups of
optional subcommands used to control the statistics and the display of the plot.

Use one of the following optional subcommands to change the display statistics:

R
Displays the correlation values on the plots.

RPVALUES
Displays the correlation values and the p-values for the test of zero-correlation on the plots.
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RCIS
Displays the correlation values and the confidence intervals on the plots.

NOSTATS
Suppresses the display of statistics on the plots.

Use one of the following optional subcommands to specify how to display the matrix plot:

LL
Displays the lower left triangle portion of the matrix plot.

UR
Displays the upper right triangle portion of the matrix plot.

FULL
Displays the entire matrix plot (both the lower left triangle and the upper right triangle) of the matrix plot.

Storage

SCORRELATION M
Stores the correlation matrix.

SPVALUES M
Stores a matrix that contains the p-values for the hypothesis test of zero-correlation.

SCIS MM

Stores two matrices that contain the lower bounds and the upper bounds of the confidence intervals for the
pairwise correlations. The first matrix stores the lower bounds and the second matrix stores the upper bound.

COVARIANCE: Session command for calculating the
covariance between pairs of columns

COVARIANCE C...C [M]

Calculates the covariance between each pair of columns. You can display the result or you can store the covariance
matrix.

When you list two columns on the command line, Minitab calculates the covariance for the pair. When you list
more than two columns, Minitab calculates the covariance for every pair of columns, and displays the lower triangle
of the resulting covariance matrix (in blocks if there is insufficient room to fit across a page). Minitab does not
display the covariance matrix when the matrix is stored in M.
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NORMTEST: Session command for performing a
normality test

NORMTEST C
Generates a normal probability plot.

Normal plots use the values in the input column as x-values. The grid on the graph resembles the grids found on
normal probability paper. The horizontal axis is a linear scale. The line forms an estimate of the cumulative
distribution function for the population from which data are drawn.

By default, an Anderson-Darling test for normality is performed and the numerical results are displayed with the
graph. You can also use a Ryan-Joiner test (similar to a Shapiro-Wilk test) or a Kolmogorov-Smirnov test.

PTILES C

PTILES K...K
Specifies a set of reference percents. The values must be between 0 and 100 when percents are used as the
y-scale type or 0 to 1 when probability is the y-scale type. Minitab marks each percent in the column with a
horizontal reference line on the plot, and marks each line with the percent value. Minitab draws a vertical
reference line where the horizontal reference line intersects the line fit to the data, and marks this line with
the estimated data value.

DVALUE

Use DVALUE to show the percents at the reference x-scale positions specified in PTILES.

PERCENT
Specifies a percent y-scale.

PROBABILITY
Specifies a probability y-scale.

SCORES
Specifies a percentile y-scale.

TITLE "title"
Specifies a title for the graph. If you do not specify a title, Minitab uses a default title.

WTITLE "title"
You can use WTITLE as a subcommand with LAYOUT and all graphs. The title that you specify becomes the
command title of the resulting graph.

SPVALUE C
SPVALUE stores the p-value of the test in a column.

GSAVE "file name"

GSAVE K
Saves the graph in a file.

The default file name is Minitab.PNG. You can specify a custom file name in double quotation marks
("file_name"), or as a stored text constant (K). You can also use any of the following subcommands to save
the graph in a different graphics format.

Some graph commands—for example, HISTOGRAM C1 C2 C3—generate more than one graph. If you include
the GSAVE subcommand with such a command, Minitab saves multiple files. Minitab gives each file a different
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file name. Minitab uses the first five characters of the name you specify, then appends a number (001, 002,
and so on), for up to 300 files.

JPEG
JPEG color

PNGB
PNG grayscale

PNGC
PNG color

TIFB
TIF grayscale

TIF
TIF color

BMPB
BMP grayscale

BMPC
BMP color

GIF
GIF

EMF
EMF

RESOLUTION K
Saves the graph at a resolution of K dots per inch.

Goodness-of-fit tests

There are 3 types of goodness-of-fit test: a chi-square based test, an ECDF based test, and a correlation based test.
By default, Minitab uses the Anderson-Darling test, which is an ECDF based test.

When your a-value is greater than the p-value displayed with the graph, you reject the hypothesis of normality. The
a-value (also called significance level), is the probability that you will reject the hypothesis of normality when the
hypothesis is true.

For example, if you are using an a-value of 0.10 and the p-value is 0.07, then you reject the hypothesis of normality
at the 0.10 level.

RJTEST
Use RITEST to perform a Ryan-Joiner test, which is a correlation based test.

KSTEST
Use KSTEST to perform a Kolmogorov-Smirnov test, which is a chi-square based test.
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OUTLIER: Session command for performing an
outlier test

OUTLIER C...C
Use to identify a single outlier in a sample. The hypotheses are as follows:

e Hj (the null hypothesis): All values in the sample are from the same, normally distributed population.

e H, (the alternative hypothesis): One of the values in the sample is not from the same, normally distributed
population.

You should not use Minitab's outlier tests more than once on the same sample. If you remove an outlier from
your sample and then retest, you risk removing values that are not actually outliers.

BY C...C

Lists the columns that contain the grouping variables (such as a column named Temp that contains the values
Low, Medium, and High). Columns listed with BY may contain numeric, text, or date time data. When you
include the BY subcommand, OUTLIER conducts a separate analysis for each group listed in the BY column
or columns.

Options

GRUBBS
GRUBBS specifies to use Grubbs' test, which is the default test.

The arguments K K specify the specific ratio to test. For example, to perform the standard Dixon's Q test, which
corresponds to a Dixon ratio of r10, the arguments are 1 and 0. The first argument can either be 1 or 2 and the
second argument can be O, 1, or 2.

DIXON K K
DIXON specifies to use one of the six versions of Dixon's outlier test instead of Grubbs' test.

The arguments K K specify the specific ratio to test. For example, to perform the standard Dixon's Q test, which
corresponds to a Dixon ratio of r10, the arguments are 1 and 0. The first argument can either be 1 or 2 and the
second argument can be O, 1, or 2.

ALPHA K
Specifies the significance level (denoted by a or alpha) for the test as K. The default is 0.05.

ALTERNATIVE K
Enter K to specify the direction of the alternative hypothesis.

Value of K Format of the alternative hypothesis
-1 Less than

0 (default) Not equal to

1 Greater than
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Graphs

GOUTLIERPLOT
Displays the outlier plot with a summary of the results, including an individual value plot of the data which
highlights the outlier if one is identified. The outlier plot also includes summary statistics, the test statistic, and
the p-value for the test statistic.

Results
Minitab displays all output tables by default; you do not have to enter the subcommands.

NODEFAULT
If you enter NODEFAULT, then each table is only displayed if you enter TMETHOD, TTEST, or TOUTLIER.

TMETHOD
TMETHOD displays the method table which includes the null hypothesis, the alternative hypothesis, and the
significance level significance level (denoted by o or alpha).

TTEST
TTEST displays the test table which includes the specific test performed, summary statistics for the sample, and
the p-value for the hypothesis test.

TOUTLIER
TOUTLIER displays the value of the outlier if one is identified, and the row in the worksheet that contains the
outlier.

Storage

SINDICATOR C...C
Stores an indicator column for each variable. A one (1) is stored in the row that contains the outlier. A zero (0) is
stored in each of the remaining rows.

PGOODNESS: Session command for performing a
chi-square goodness-of-fit test for Poisson
distribution

PGOODNESS C...C
Performs a chi-square goodness-of-fit test for Poisson distribution for each data set. Each C corresponds to one
data set containing nonnegative integers. If the column contains missing data, that row is excluded from all
computations.

FREQUENCY C...C
Specifies the frequency column, one for each data set. The length of each column must match the length of
the corresponding data set.
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MEAN C

MEAN K...K
Specifies the mean of the Poisson distribution for each data set as K...K or in C. If you specify only one value
for the mean, then this value applies to all data set.

Graphs

GBAR
Displays a bar chart of the observed and expected values.

GCHISQ
Displays a bar chart of each category's contribution to the chi-square value.

PARETO
Use PARETO with GCHISQ to display a bar chart that orders each category's contribution to the chi-square
value from largest to smallest.

Results

RTABLE
Displays a table of the observed values and the expected values and the test results.
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Regression

INDICATOR: Session command for creating indicator
variables

INDICATOR C C...C
Creates indicator variables (also called dummy variables) that you can use in a regression analysis. If you use
REGRESS on page 169, you do not need to create indicator variables.

The smallest number in C2 is 2 and the largest is 6. INDICATOR creates one indicator variable for each unique
value.

e C11is the indicator variable for the value 2. C11 contains a 1 in every row where C2 contains a 2, and 0
otherwise.

e (12 is the indicator variable for the value 3. C12 contains a 1 in every row where C2 contains a 3, and 0
otherwise.

e (13 is the indicator variable for 5. C13 contains a 1 in every row where C2 contains 5, and 0 otherwise.

e (14 is the indicator variable for 6. C13 contains a 1 in every row where C2 contains 6, and 0 otherwise.

If C2 contains an * (missing data code), then all indicator variables are also set to *.

The number of storage columns must be equal to the number of distinct values (not including *) in the input
column. Up to 100 storage columns are allowed on INDICATOR.

The following command language is an example of using INDICATOR.

INDICATOR C2, Cl1-Cl4

Before using INDICATOR

Cc1

Um0 W U1 NN

*

After using INDICATOR

Cc1 C11 C12 C13 C14
2 1 0 0 0
2 1 0 0 0
5 0 0 1 0
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Cc1 C11 C12 C13 C14
3 0 1 0 0
6 0 0 0 1
5 0 0 1 0
* * * * *

REGRESS: Session command for performing a
regression analysis

REGRESS
Performs simple, polynomial, and multiple regression using the least squares method.

REGRESS uses least squares to fit a model to one or more continuous or categorical predictors. Optionally, you
can:

e Perform stepwise regression

e Fit the model without an intercept

e Perform weighted regression

e Use a test data set or cross-validation to validate the model

e Store the residuals, fitted values, and many other diagnostics for additional analysis

e Generate point estimates, and prediction and confidence intervals for predicted values
e Transform non-normal data using the Box-Cox transformation

e Generate several plots for residual analysis. For more information, go to Residual analysis and regression
diagnostics on page 1178.

Options
Specifies information about the variables and terms to include in the model.

RESPONSE C
Specifies the column that contains the response variable. The column must be numeric or date/time.

CONTINUOUS C...C
Specifies the continuous predictors if you have any. The column(s) must be numeric or date/time and must match
the length of the response column.

CATEGORICAL C...C
Specifies the categorical predictors if you have any. The column(s) can be numeric, text, or date/time and must
match the length of the response column.

TERMS termlist
Specifies the model terms. Terms must be legal cross-terms. Only continuous predictors may be repeated. Nested
terms are not allowed. The model can be nonhierarchical.
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WEIGHT C

Performs a weighted regression. An n x n matrix W is formed with the column of weights as its diagonal and zeros
elsewhere. The regression coefficients are estimated by:

XWX ' (X' WY)
This is equivalent to minimizing the weighted SS Error,

Twi (Y-F )2 where w i is the weight in row i.

CONSTANT

When you use CONSTANT, Minitab includes the B, term (the intercept) in the equation. Thus, Minitab fits the
model:

Y =Bo+ BiXqg + BXy ++ BX + €

NOCONSTANT
When you use NOCONSTANT, Minitab omits the B, term (the intercept) from the equation. Thus, Minitab fits the
model:

Y = BiXq + BoXy +ot BX( + €

CONFIDENCE K

Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of K'is 95.

ITYPE K
Specifies the type of confidence interval.

Value of K Type of confidence interval
-1 Lower bound
0 (default) Two-sided
1 Upper bound
TOLER K

Specifies the tolerance level for collinearity and constant check. By default, K = 4 * 2.22e-012.

SSQUARES
Specifies sequential sum of squares for tests in the ANOVA table. The default is the adjusted sums of squares.

EFFECT
Specifies the effect coding (-1, 0, +1) scheme for categorical predictors.

If you do not specify either EFFECT or BINARY, Minitab uses the preference set in File > Options > Linear Models
> Coding of Predictors.

BINARY
Specifies the binary coding (1, 0) scheme for categorical predictors.

If you do not specify either EFFECT or BINARY, Minitab uses the preference set in File > Options > Linear Models
> Coding of Predictors.
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REFERENCE C K ... CK
Changes the default coding for the categorical predictor columns. To change the default reference factor level,
specify the factor column followed by the reference level. (You must enclose text and date/time levels in double
quotation marks.) You can assign a reference level only when you use the binary coding (1, 0) scheme.

Standardizing the continuous predictor

Use this set of subcommands to standardize the continuous predictors in your model. You can use SCALE and LOCATION
in conjunction with each other. LEVELS is mutually exclusive with the LOCATION and SCALE subcommands.

If you do not specify LOCATION, SCALE, LEVELS, or UNSTANDARDIZED, Minitab uses the preferences set in File >
Options > Linear Models > Coding of Predictors.

LOCATION [K...K]
Specifies that the analysis is to be performed on coded continuous predictors by subtracting a constant from
each predictor. If you do not specify any arguments, the mean of each predictor column is subtracted. K specifies
to subtract a constant. If you specify arguments, the number of arguments must match the number of continuous
predictors.

SCALE [K...K]
Specifies that the analysis is to be performed on coded continuous predictors by dividing each predictor by a
constant. If you do not specify any arguments, each predictor column is divided by the standard deviation. K
specifies to divide by a constant. If you specify arguments, the number of arguments must match the number of
continuous predictors.

LEVELS [K...K]
Specifies that the analysis is to be performed on coded continuous predictors by DOE-type coding for the specified
low and high levels K K&K K. The number of arguments must be twice the number of continuous predictors.

UNSTANDARDIZED
Specifies the analysis is to be performed on the original predictors.

Box-Cox

BOXCOX [K]
Performs a Box-Cox transformation with a specified lambda. K is the value of lambda and must be between -5
and +5. If you do not specify K, then Minitab will find the optimal lambda. By default, Minitab rounds the optimal
value.

Minitab cannot calculate the optimal lambda for stepwise regression. Consequently, you must specify a lambda
value for BOXCOX if you use STEPWISE, FORWARD, or BACKWARD.

Stepwise
FINFORMATION, STEPWISE, FORWARD, and BACKWARD perform a stepwise regression procedure to fit the model. No

arguments are needed for these subcommands.

FINFORMATION
Specifies a stepwise model selection procedure that uses forward information criteria selection. Use AICCORRECTED
or BICRITERION to specify which information criterion to use to select the final model. If you do not specify a
criterion, Minitab uses AICCORRECTED.
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The forward information criteria procedure adds the term with the lowest p-value to the model at each step. If
you do not include subcommands about hierarchy, FINFORMATION adds 1 term at a step and maintains model
hierarchy, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

Minitab calculates the information criteria for each step.

In most cases, the procedure continues until one of the following conditions occurs:

e The procedure does not find an improvement of the criterion for 8 consecutive steps.
e The procedure fits the full model.

e The procedure fits a model that leaves 1 degree of freedom for error.

If you specify settings for the procedure that require a hierarchical model at each step and allow only one term
to enter at a time, then the procedure continues until it either fits the full model or fits a model that leaves 1
degree of freedom for error. Minitab displays the results of the analysis for the model with the minimum value
of the selected information criterion, either the corrected Akaike's Information Criterion (AlCc) or the Bayesian
Information Criterion (BIC).

AICCORRECTED
Specifies the use of the corrected Akaike's Information Criterion (AlCc) to select the final model.

BICRITERION
Specifies the use of the Bayesian Information Criterion (BIC) to select the final model.

FVALIDATION

Specifies the use of forward selection with the validation R? as the criterion for the selection of the final model.
When you use FVALIDATION, you must also use TEST or CVTEST. When you use TEST, the procedure is similar
to forward selection for other methods. At the end of each step, Minitab Statistical Software calculates the test
R statistic. At the end of the forward selection procedure, the model with the greatest test R® value is the final
model.

When you use CVTEST, the procedure repeats forward selection on each fold. The procedure evaluates all the
folds at each step and identifies the step with the best overall k-fold R® value. The last part of the procedure is to
perform forward selection on the full dataset, stopping at the best step from the selections on the folds.

FVALIDATION stops under the same conditions as FINFORMATION. The ATEND sub-subcommand that adds
terms to the model to make it hierarchical at the end is not compatible with FVALIDATION.

GRSQUARE

When you use GRSQUARE after FVALIDATION, displays a graph of the R statistic and the validation R statistic
for each step in the model selection procedure.

STEPWISE

Specifies a stepwise model selection procedure that uses both forward selection and backward elimination. If you
do not include subcommands about hierarchy, STEPWISE and FORWARD add 1 term at a step and maintain model
hierarchy, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

FORWARD

Specifies a stepwise model selection procedure that uses forward selection. If you do not include subcommands
about hierarchy, STEPWISE and FORWARD add 1 term at a step and maintain model hierarchy, the equivalent of
the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.
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BACKWARD
Specifies a stepwise model selection procedure that uses backward elimination. Removes a single term at each
step and maintains a hierarchical model, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS.

AENTER K
Specifies the alpha level at which a term is entered into the model. The default is 0.15 for STEPWISE and 0.25
for FORWARD.

AREMOVE K
Specifies the alpha level at which a term is removed from the model. The default is 0.15 for STEPWISE and
0.10 for BACKWARD. For STEPWISE, K must be greater than or equal to K for AENTER.

ENTER termlist
Specifies the terms that are contained in the starting model for STEPWISE. The ENTER termlist must be a
subset of the TERMS termlist or in the default term list in the design.

FORCE termlist
Specifies the terms to be forced in the model. The FORCE termlist must be a subset of the TERMS termlist
or in the default term list in the design.

NOHIERARCHICAL
Specifies that the model selection procedure does not consider hierarchy.

HIERARCHICAL
Maintains a hierarchical model in stepwise regression. In a hierarchical model, if a higher-order term is
included, all lower-order terms that comprise the higher-order term also appear in the model. For example,
a model that includes the interaction term A*B*C is hierarchical if it includes the following main effects and
lower-order interactions: A, B, C, A*B, A*C, and B*C.

CATONLY
Specifies that only the categorical terms in the model have to be hierarchical.

ALLTERMS
Specifies that both categorical and continuous terms have to be hierarchical.

ATEND
Specifies that the final step of the stepwise procedure adds terms to make the model hierarchical.

ALWAYS
Specifies that the model is hierarchical at every step.

SINGLE
Specifies that only one term can enter the model at each step. So a higher-order term can enter
the model only if the terms that comprise the term are already in the model. For example, the
algorithm does not consider the addition of A*B unless A and B are already in the model.

BACKWARDS does not use SINGLE or MULTIPLE because terms only exit the model.

MULTIPLE
Specifies that multiple terms can enter the model at each step. So a higher order term can enter
the model, and the terms that comprise the term enter the model at the same time. For example,
if A*B is the most statistically significant term, A*B enters the model. At the same time, A and B
enter the model if those terms are not in the model already.
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BACKWARDS does not use SINGLE or MULTIPLE because terms only exit the model.

Validation

TEST C K

TEST K [K]

Specifies to perform validation with a test data set. When you specify a column you select the rows to include in
the test data set. The column has two distinct values. Use the constant to specify which value is for the test data
set.

When you specify a constant first, Minitab Statistical Software randomly selects the data for the test data set. The
constant is the fraction of the data in the test data set. The optional constant is a seed for the random number
generator. If you specify the seed, you can get the same test data set again by specifying the same seed.

CVTEST C

CVTEST K [K]
Specifies to perform k-fold cross validation. When you specify a column, you select the rows for each fold. Rows
with the same value in the column are in the same fold.

When you specify a constant, Minitab Statistical Software randomly selects the data for the folds. The constant
is the number of folds. The optional constant is a seed for the random number generator. If you specify the seed,
you can get the same folds again by specifying the same seed.

Graphs
When you use TEST, the residual plots include separate displays for the training data set and the test data set.

GPARETO
Displays a Pareto chart of the absolute effects. GPARETO draws a vertical reference line on the plot at the margin
of errors. This plot lets you look at both the magnitude and the importance of an effect at the same time. The
alpha level is 1- the confidence level that follows CONFIDENCE, unless you use stepwise selection. For forward
selection, the alpha level is the level that follows AENTER. For backward and stepwise selection, the alpha level is
the level that follows AREMOVE.

RTYPE K
Specifies the type of residual to plot with the graph subcommands.

Value of K Type of residuals

1 (default) Regular or raw residuals (RESIDUALS)

2 Standardized residuals (SRESIDUALS)

3 Deleted Studentized residuals (TRESIDUALS)
GHISTOGRAM

Displays a histogram or individual value plot of the residuals, depending on the sample size.

GNORMAL
Displays a normal probability plot of the residuals.

GFITS
Plots the residuals versus the fitted values.
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GORDER
Plots the residuals versus the order of the data. The row number for each data point is shown on the x-axis ( for
example, 123 4..n).

GFOURPACK
Displays a layout of a histogram of the residuals, a normal probability plot of the residuals, residuals vs fitted
values, and residuals vs order of the data.

GVARIABLE C...C
Displays a separate graph for the residuals versus each specified column.

Results

NODEFAULT
Specifies that no default tables or graphs will be displayed

TBASIC
Displays the tables for the Minitab 16 version of REGRESS.

TMETHOD
Displays the method table.

TMSDETAILS
Displays the type of stepwise procedure and the alpha values to enter and/or remove a predictor from the model.
Use FULL to display the coefficients, p-values, Mallows' Cp, and model summary statistics for each step of the
procedure. Use NOFULL to hide these statistics. If you do not specify FULL or NOFULL, Minitab uses the preferences
set in File > Options > Linear Models > Stepwise.

TEQUATION
Displays the regression equation table. Minitab will display up to 50 equations. If you want to see a single equation,
rather than a separate equation for each factor level combination, use SINGLE. To see the separate equations, use
SEPARATE. If you do not specify SINGLE or SEPARATE, Minitab uses the preferences set in File > Options > Linear
Models > Display of Results.

TCOEFFICIENTS
Displays the table of coefficients. Use FULL to display the full set of coefficients for categorical predictors. Use
NOFULL to show only the linearly independent coefficients. If you do not specify FULL or NOFULL, Minitab uses
the preferences set in File > Options > Linear Models > Display of Results.

TSUMMARY
Displays the summary of model table.

TANOVA
Displays the ANOVA table.

TDIAGNOSTICS

Displays a table of diagnostics. K = 0 displays diagnostics for only unusual observations. K = 1 displays diagnostics
for all observations. If you do not specify K, Minitab uses the preference set in File > Options > Linear Models
> Display of Results.

TDW
Displays Durbin-Watson statistics.
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TSIMPLE
Displays the simple versions of the ANOVA table, table of coefficients, model summary table, and table of unusual
observations.

TEXPAND
Displays the expanded version of the ANOVA table, table of coefficients, model summary table, and table of
unusual observations.

Storage for Box-Cox transformation

BCRESP C
Stores the Box-Cox transformation of the response in C.

BFITS
Stores the fits for the original response.

Storage for fits and residuals

Use to store the fits and residuals in the specified column. When you use TEST , the following statistics are missing
for the test data set: studentized residuals, Cook'’s distance, and DFITS. The Durbin-Watson statistic is for the training
data set.

FITS C
Stores the fitted values.

RESIDUALS C
Stores the residuals (fitted values — observed values).

SRESIDUALS C
Stores the standardized residuals.

TRESIDUALS C
Stores the deleted Studentized residuals.

HI C
Stores the leverages.

COOK C
Stores Cook's distance.

DFITS C
Stores the DFITS.

SDW C
Stores the Durbin-Watson statistic.

Storage for characteristics of the estimated equation
Use to store characteristics of the estimated equation in the specified column.

COEFFICIENTS C
Stores the estimated coefficients.
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FITS C
Stores the fitted values, often called the Y-hats (7).

MSE K
Stores the mean square error. When you use TEST, the statistic is for the training data set.

SPVALUE C
Stores the p-values for each predictor.

SVIF C
Stores the VIFs for each predictor.

Ss C

Stores the standard deviation of the error term. When you use TEST, the first row is for the training data set and
the second row is for the test data set.

SRSQ C
Stores the R-squared for the model. When you use TEST, the first row is for the training data set and the second
row is for the test data set.

SRSADJ C
Stores the adjusted r-squared for the model. When you use TEST, the statistic is for the training data set.

SPRESS C
Stores the PRESS statistic for the model. When you use TEST, the statistic is for the training data set.

XMATRIX M
Stores the design matrix for regression model.

XPXINV M

Stores a p x p matrix, inverse of X'X. This matrix, when multiplied by MSE is the variance-covariance matrix of the
coefficients. If the WEIGHTS subcommand is used, then XPXINV stores the inverse of the X'WX. When you use
TEST, the matrix is for the training data set.

RMATRIX M

Stores the R matrix of the QR decomposition, also known as the Cholesky decomposition. When you use TEST,
the matrix is for the training data set.

Storage for validation

Use the following commands to store statistics for validation with a test data set or validation with k-fold cross validation.

SSAMPLE C
When CVTEST is used:

e The storage column, Sample_Id, stores the fold identification in C.

e (C containsvalues 1, 2, ..., K.

When TEST is used:
e The storage column, Sample_Id, stores the training and test sample assignments in C.

e Cis a binary text column that contains Training and Test as the two values.
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CVFIT C
Stores the fitted values from each fold's turn as the test data set.

CVRESID C
Stores the residuals from each fold's turn as the test data set.

BREG: Session command for performing best subsets
regression

BREG C C...C
Performs best subsets regression, using the maximum R-squared criterion.

Suppose you specify m predictors. BREG first looks at all one-predictor regression models, selects the model with
the largest R-squared, and displays information on this model and the next best one-predictor model. Then BREG
looks at all two-predictor models, selects the model with the largest R-squared, and displays information on this
and the next best one. The process continues until all m predictors are used.

BREG is an efficient way to select a group of "best subsets" for further analysis by selecting the smallest subset
that fulfills certain statistical criteria. The subset model may actually estimate the regression coefficients and
predict future responses with smaller variance than the full model using all predictors.

INCLUDE C...C
Includes the predictors specified in C...C in all models. Only columns that were specified with the BREG
command can be specified in INCLUDE.

NVARS K [K]
By default, displays the best one-predictor models, the best two-predictor models, on up to the best
m-predictor models. If you specify, for example, NVARS 5 12, then only the best 5-, 6-, ..., 12-predictor
models are displayed.

Note NVARS does not count the predictors given in INCLUDE. Thus, INCLUDE C1-C3 with NVARS 2 6, displays models
with 3 + 2 = 5to 3 + 6 = 9 predictors.

BEST K

Displays information from the "best" K models of each size, if there are that many. K can be from 1 to 5. The
default is 2.

NOCONSTANT

When you use NOCONSTANT, Minitab omits the b 0 term (the intercept) from the equation. Thus, Minitab
fits the model:

Y= B1X1 +B2X2 +..+ Bka + e

When NOCONSTANT is specified, Minitab does not display R-squared and adjusted R-squared, since their
interpretation is difficult.

You can also use NOCONSTANT as a main command. In that case, it applies to all BREG, REGRESS, and
STEPWISE commands that follow.
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CONSTANT
When you use CONSTANT, Minitab includes the b 0 term (the intercept) in the equation. Thus, Minitab fits
the model:

Y = Bo + BiXq +BpXy +.+ BX + €

You can also use CONSTANT as a main command. In that case, it applies to all BREG, REGRESS, and STEPWISE
commands that follow.

NOWARN
When you specify more than 14 free variables with BREG, Minitab displays a prompt that asks whether you
want to continue with BREG computations even though it will take a long time. Use NOWARN if you want
to suppress this warning prompt.

TEXPAND

Displays the expanded table that includes PRESS, AlCc, BIC, and condition number. You can also set this
option in File > Options.

FITLINE: Session command for creating a fitted line
plot

FITLINE C C

Plots the regression line through the actual data or the log 10 of the data. The fitted line plot shows you how
closely the actual data lie to the fitted regression line. You can include only one predictor in the model.

Polynomial regression is one method for modeling curvature in the relationship between a response variable (Y)
and a predictor variable (X). Polynomial modeling techniques try to account for the curvature by extending the
simple linear regression model to include higher powers of X - such as X-squared - as predictors.

Use the POLY subcommand to specify the order of the polynomial you want to fit. If you have not transformed
the X or Y variables, you can fit the following models with FITLINE:

Model type Order POLY K Statistical model

Linear First 1 Y=Bp+BX+e

Quadratic Second 2 Y =Bp+ BiX + [32X2 +e

Cubit Third 3 Y = By + BiX + BoX2 + BXC + e

You can generate additional models by using the logq of X and/or Y for linear, quadratic, and cubic models. These
models provide another way of modeling curvature. In addition, taking the logq of Y can reduce right-skewness
and some forms of heteroskedasticity, such as unequal variances.

RTYPE K
Specifies the type of residual to plot with the graph subcommands.

Value of K Type of residuals
1 (default) Regular or raw residuals (RESIDUALS)
2 Standardized residuals (SRESIDUALS)
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Value of K Type of residuals
3 Deleted Studentized residuals (TRESIDUALS)
GHISTOGRAM

Displays a histogram of the residuals.

GNORMAL
Displays a normal probability plot of the residuals.

GFITS
Plots the residuals versus the fitted values.

GORDER
Plots the residuals versus the order of the data. The row number for each data point is shown on the x-axis
(for example, 1234 .. n).

GFOURPACK
Displays a layout of a histogram of the residuals, a normal probability plot of the residuals, residuals vs fitted
values, and residuals vs order of the data.

GVARIABLE C...C
Displays a separate graph for the residuals versus each specified column.

Options

POLY K
Specifies the order of the polynomial model you want to fit and plot. K is an integer from 1 to 3. The default is 1.

LOGY
Uses logyq Y as the response variable.

LOGX
Uses log4oX as the predictor variable. If LOGX is used with polynomials of order greater than one, then the
polynomial regression will be based on powers of the logqpX.

YSCALE

Plots the transformed response and predictor variables on a log scale. FITLINE ignores YSCALE if you do not use
LOGY.

XSCALE

Plots the transformed response and predictor variables on a log scale. FITLINE ignores XSCALE if you do not use
LOGX.

CI
Displays confidence bands about the fitted regression line.

PI
Displays prediction bands about the fitted regression line.

CONFIDENCE K
Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of K is 95.
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Storage

RESIDUALS C
Stores the residuals in C. If you specified LOGY, Minitab stores the log-transformed residuals. The residual for the
i th log-transformed response is:

e = (logqgY; - logyo¥))

FITS C
Stores the fitted values, often called the Y-hats (¥), in C. If you specified LOGY, Minitab stores the log-transformed
fits (Iogm“f').

COEFFICIENTS C
Stores the estimated coefficients in C.

BRESIDUALS C
Stores in C the residuals of the transformed response in the original scale of the data. This subcommand is only
available if you used LOGY.

BFITS C
Stores in C the fitted values of the transformed response in the original scale of the data. This subcommand is
only available if you used LOGY.

GSAVE "file name"

GSAVE K
Saves the graph in a file.

The default file name is Minitab.PNG. You can specify a custom file name in double quotation marks ("file_name"),
or as a stored text constant (K). You can also use any of the following subcommands to save the graph in a different
graphics format.

Some graph commands—for example, HISTOGRAM C1 C2 C3—generate more than one graph. If you include
the GSAVE subcommand with such a command, Minitab saves multiple files. Minitab gives each file a different
file name. Minitab uses the first five characters of the name you specify, then appends a number (001, 002, and
so on), for up to 300 files.

JPEG
JPEG color

PNGB
PNG grayscale

PNGC
PNG color

TIFB
TIF grayscale

TIF
TIF color

BMPB
BMP grayscale
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BMPC
BMP color

GIF
GIF

EMF
EMF

RESOLUTION K
Saves the graph at a resolution of K dots per inch.

TITLE "title"
Specifies a title for the graph. If you do not specify a title, Minitab uses a default title.

WTITLE "title"”
You can use WTITLE as a subcommand with LAYOUT and all graphs. The title that you specify becomes the
command title of the resulting graph.

SSWORKSHEET: Session command for creating a
stability study worksheet

Important SSWORKSHEET writes data to the active worksheet. To prevent possible confusion and lost data, it is best to use NEW immediately
prior to SSWORKSHEET. (Do not use NEW however, if you use the TIME subcommand.) NEW creates a new, blank worksheet and makes the
new worksheet the active worksheet.

SSWORKSHEET K K K
Creates a stability study worksheet with the following parameters (in the following order):

e The number of times as K
e The number of batches as K

e The number of replicates per batch at each time as K

TIME C

TIME K...K
Optional subcommand TIME specifies the test times as values from column C or as constants K...K.

SSWORKSHEET K K
Creates a stability study worksheet with the following parameters (in the following order):

e The number of batches as K

e The number of replicates per batch at each time as K

TIME C...C (required)
Required subcommand TIME specifies a column of test times for each batch
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Options

BNAME C

BNAME K. ..K
Specifies a name for each batch. The default batch names are the text values "1", "2", "3", ....

TSUMMARY

Displays a summary of the design that includes the number of sampling times, the number of batches, the number
of samples per batch at each time, and the total number of runs.

SORDER C
Stores the standard order of the runs in column C.

RORDER C
Stores the run order in column C.

XMATRIX C C
Stores the sampling times for each run in the first column C and the batch names in the second column C.

Randomization

Use the following commands to control how the runs are randomized in the worksheet. If you do not use any of these
subcommands, then the runs are not randomized, so the run order is the same as the standard order.

To generate the same random order, you can optionally set the base as K, where K is an integer that is greater than
0.

RANDOMIZE [K] (default)
RANDOMIZE specifies to randomize the order of the batches at each test time, and the repeats at each test time.

BRANDOMIZE [K]
BRANDOMIZE specifies to randomize the order of the batches at each test time, but to keep all repeats from one
batch together before switching to the next batch.

NRANDOMIZE

NRANDOMIZE specifies to sample each batch in sequential order and to take all repeats from one batch before
switching to the next batch.

SHELFLIFE: Session command for performing a
stability study

SHELFLIFE
Analyzes the stability of a product over time to determine the product's shelf life. Minitab fits a linear model to
represent the relationship between the response variable, the time variable, and an optional batch factor. The
batch factor can be fixed or random. Based on the model, Minitab calculates the shelf life, which is the length of
time that the response is expected to remain within the specifications.
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Options

RESPONSE C
Specifies the column that contains the response variable. The column must be numeric or date/time.

TIME C (required)
Specifies the time variable. The column must be numeric or date/time and must match the length of the response
column.

BATCH C
Specifies the categorical batch factor, if you have one. The column can be numeric, text, or date/time and must
match the length of the response column.

RANDOM

Specifies that BATCH is a random factor. If BATCH is not issued, RANDOM is ignored. For random batches, Minitab
uses an iterative algorithm to estimate the variance components and to select the model. There can be cases
where the variance components cannot be estimated and no further analysis is possible.

MAXITER K
Specifies the maximum number of iterations. K must be a nonnegative integer.

STARTING K K K
Specifies the starting estimates for the variance components. If you do not use STARTING, Minitab uses the
minimum norm quadratic unbiased estimation (MINQUE) estimates. The MINQUE estimates are typically
good estimates.

CTOLERANCE K
Specifies the convergence tolerance value for object function. K must be greater than 0. If this subsubcommand
is not issued, Minitab uses the value 1E-7.

ETOLERANCE K
Specifies the convergence tolerance value for estimates. K must be greater than 0. If this subsubcommand
is not issued, Minitab uses the value 1E-7.

LSPEC K
Specifies the lower specification limit. You must use LSPEC, USPEC, or both. If both LSPEC and USPEC are issued,
USPEC must be greater than LSPEC. K must be numeric.

USPEC K
Specifies the upper specification limit. You must use LSPEC, USPEC, or both. If both LSPEC and USPEC are issued,
USPEC must be greater than LSPEC. K must be numeric.

BPERCENT K

Specifies using K percent of the response above the lower spec or below the upper spec to estimate shelflife. K
must be between 0 and 100. Minitab uses 50 percent if BPERCENT is not issued.

PVALUE K

Specifies the significance level that is used for model selection. K must be between 0 and 1. Minitab uses 0.25 if
PVALUE is not issued.

ONESPEC
Specifies to use a one-sided significance level when you specify both specification limits. Use this subcommand
when the response variable has two specification limits, but only one limit is relevant for the shelf life. For example,
if the confidence level is 95% and you select this option, then the confidence level for the single bound that is
relevant to the shelf life is also 95%. If you do not select this option, then the confidence level for both bounds
is 97.5%. The single 95% bound gives a longer shelf life.
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For example, a medication has an upper specification limit of 12.5 micrograms and a lower specification limit of
12 micrograms. In storage, the medication degrades, but never increases in strength. Only the lower specification
limit is relevant to the shelf life.

CONFIDENCE K
Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of K is 95.

Box-Cox

BOXCOX [K]
Performs a Box-Cox transformation with a selected lambda. K is the value of lambda and must be between -5
and +5. If K'is not given and you have a fixed batch, Minitab will find the optimal lambda. By default, Minitab
rounds the optimal value.

Minitab cannot calculate the optimal lambda when batch is a random factor. Consequently, you must specify a
lambda value for BOXCOX if you use RANDOM.

Graphs
GSHELFLIFE
Displays the shelf life plot. Use the subsubcommands to control how the batches are displayed.

INDIVIDUAL
Displays a graph for each individual batch.

ALL [K]
Displays all batches on one graph. If you specify K, each graph displays up to K batches.

RTYPE K
Specifies the type of residual to plot with the graph subcommands in K. If MARGINAL is issued, K must be 1 or 2.

Value of K Type of residuals

1 (default) Regular or raw residuals (RESIDUALS)

2 Standardized residuals (SRESIDUALS)

3 Deleted Studentized residuals (TRESIDUALS)
MARGINAL

Displays marginal residuals on the residual plots. If MARGINAL is not issued, the residual plots display
conditional residuals for random batches.

GHISTOGRAM
Displays a histogram or individual value plot of the residuals, depending on the sample size.

GNORMAL
Displays a normal probability plot of the residuals.

GFITS
Plots the residuals versus the fitted values.
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GORDER
Plots the residuals versus the order of the data. The row number for each data point is shown on the x-axis (for
example, 123 4..n).

GVARIABLE C...C
Displays a separate graph for the residuals versus each specified column.

GFOURPACK
Displays a layout that includes a histogram of the residuals, a normal probability plot of the residuals, residuals
vs fitted values, and residuals vs the order of the data.

Results

Displays a variety of tables in the output. The availability of some tables depends on whether BATCH is a fixed factor
or a random factor.

NODEFAULT
Specifies that no default tables and graphs will be displayed.

TMETHOD
Displays the method table.

TFACTOR
Displays the name, number of levels, and the values for the batch factor in your model.

TITERATION
Displays the estimation iteration history table when batch is a random factor.

TVARIANCE
Displays the variance component table when batch is a random factor.

TCOVARIANCE
Displays the asymptotic variance covariance matrix of variance estimates when batch is a random factor.

TMSELECTION
Displays the model selection results, including the terms that are removed from the final model.

TANOVA
Displays the ANOVA table for a fixed batch.

TSUMMARY
Displays the summary of model table.

TCOEFFICIENTS

Displays the table of coefficients. Use FULL to display the full set of coefficients for the batch factor. Use NOFULL
to show only the linearly independent coefficients. If you do not specify FULL or NOFULL, Minitab uses the
preferences set in File > Options > Linear Models > Display of Results.

FULL
Specifies to display the full set of coefficients for the batch factor

NOFULL
Specifies to not display the full set of coefficients for the batch factor
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TRANDOM
Displays the random effect prediction table when batch is a random factor.

TEQUATION
Displays the regression equation table, or the marginal fitted equation table if batch is a random factor.

TDIAGNOSTICS [K]
Displays a table of fits and diagnostics. K = 0 displays diagnostics for only unusual observations. K = 1 displays
diagnostics for all observations. If you do not specify K, Minitab uses the preference set in File > Options > Linear
Models > Display of Results.

TCONDITIONAL [K]

Displays the conditional fits and residuals when batch is a random factor. K = 0 displays diagnostics for only
unusual observations. K = 1 displays diagnostics for all observations. If you do not specify K, Minitab uses K = 0.

TSHELFLIFE
Displays the shelf life table.

TSIMPLE
Displays the simple versions of the ANOVA table, table of coefficients, model summary table, and table of unusual
observations.

TEXPAND
Displays the expanded version of the ANOVA table, table of coefficients, model summary table, and table of
unusual observations.

Storage

Use to store analysis results in the specified column or matrix. The availability and function of the storage commands
depends on whether BATCH is a fixed factor or a random factor.

RESIDUALS C
Stores the residuals (fitted values — observed values) if batch is a fixed factor. Marginal residuals (marginal fitted
values — observed values) if batch is a random factor.

SRESIDUALS C
Stores the standardized residuals if batch is a fixed factor. Standardized marginal residuals if batch is a random
factor.

TRESIDUALS C
Stores the deleted Studentized residuals of the fit if batch is a fixed factor. If batch is a random factor, stores the
studentized marginal residuals.

CRESIDUALS C
Stores the conditional residuals when batch is a random factor.

CSRESIDUALS C
Stores the conditional standardized residuals when batch is a random factor.

FITS C
Stores the fitted values if batch is a fixed factor. Marginal fitted values if batch is a random factor.

CFITS C
Stores the conditional fitted values when batch is a random factor.
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HI C
Stores the leverages.

COOK C
Stores Cook's distance.

DFITS C
Stores the DFITS.

COEFFICIENTS C
Stores the estimated coefficients.

BLUP C
Stores the best linear unbiased predictor when batch is a random factor.

XMATRIX M
Stores the design matrix for fixed effects terms.

ZMATRIX M
Stores the design matrix for random effects terms.

COVARIANCE M
Stores the variance-covariance matrix of the variance component estimates if batch is a random factor.

FCOVARIANCE M
Stores the covariance matrix of fixed effect estimates.

NLINEAR: Session command for performing
nonlinear regression

NLINEAR
Fits regression models in which the expected value of the response is a nonlinear function.

Use nonlinear regression to mathematically describe the nonlinear relationship between a response variable and
one or more predictor variables. Specifically, use nonlinear regression instead of ordinary least squares regression
when you cannot adequately model the relationship with linear parameters. Parameters are linear when each
term in the model is additive and contains only one parameter that multiplies the term. Use this procedure for
fitting models that are nonlinear in the parameters, storing regression statistics, examining residual diagnostics,
generating point estimates, and generating prediction and confidence intervals.

Required subcommands

RESPONSE C
Specifies the response column. The column cannot be a text column.

CONTINUOUS C...C
Specifies one or more predictor columns. The columns cannot be text columns, and they must have the same
number of rows as the response column.
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PARAMETER "name" K...K

Use PARAMETER for each parameter in the model. The parameter name can match the name of a variable, but it
cannot match the name of the response column or any predictor columns.

The parameter name must be followed by one or more starting values for the parameter. Minitab does not allow
missing values.

If you give a parameter more than one starting value, Minitab evaluates the residual sum of squares (SSE) at all
combinations, and uses the combination with the smallest value of the SSE.

EXPECTATION expression

Specifies the expectation function. The expression must use all of the parameters and predictors. All columns you
use in the expression must be predictor columns.

If a parameter name looks like a variable name, Minitab interprets it as a variable name. To have Minitab interpret
it as a name, you must put quotes around it. For example, a parameter you named k1 must be referred to as 'k1".

Options

LOCK parameters

Locks one or more parameters at their starting values. If you give a locked parameter more than one starting
value, the first value is used. You must leave at least one parameter unlocked. For example, LOCK "b1", locks the
parameter b1.

WEIGHT C

Specifies weights for weighted regression in C. Weights must be nonnegative. Rows with zero or missing weight
are omitted. Note that there is no provision for these weights to change from one iteration to the next.

CONFIDENCE K

Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of K'is 95.

ITYPE K
Specifies the type of confidence interval.

Value of K Type of confidence interval
-1 Lower bound

0 (default) Two-sided

1 Upper bound

CONSTRAINT constraint

Specifies a constraint on a parameter. Repeat CONSTRAINT to specify multiple constraints. Each parameter can
appear one time on one CONSTRAINT subcommand. For example, CONSTRAINT 1200 < 'bl' < 1400
constrains the fitted value of parameter b1 to between 1200 and 1400.

MARQUARDT

Specifies the Levenberg-Marquardt algorithm rather than the default Gauss-Newton algorithm. Use this
subcommand if the Gauss-Newton algorithm fails to converge.

TOLERANCE K [K]
K is the tolerance level for convergence, and it must be a positive number. The default value is 107>,
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The convergence criterion is the relative offset orthogonality convergence criterion described in Bates and Watts
(1981).

ITERATIONS K
Specifies the maximum number of iterations used in the optimization algorithm. K must be a positive integer. If
you do not specify ITERATIONS, the default value is 200.

Predict

PCONTINUOUS E. .E
PCONTINUOUS also computes the standard errors of the fitted values, 95% confidence intervals, and 95% prediction
intervals. The number of arguments must equal the number of predictors in the model. If you include columns,
they must have the same number of rows. Minitab assigns predictors in the same order as they appear on the
CONTINUQUS subcommand.

If you omit PCONTINUOUS and include any of PFITS, PSEFITS, CLIMITS, or PLIMITS, then those subcommands are
ignored.

The prediction interval computed by PREDICT assumes a weight of 1. If you used the WEIGHT subcommand with
values other than 1, you should adjust the prediction interval values manually.

PFITS C
Stores the predicted values in C.

PSEFITS C
Stores the standard errors of the predicted values in C.

CLIMITS C C
Stores the upper and lower limits of the confidence intervals in C C. If you specify -1 or 1 with ITYPE then only
one argument is allowed.

PLIMITS C C
Stores the upper and lower limits of the prediction intervals in C C. If you specify -1 or 1 with ITYPE then only
one argument is allowed.

Tables

TMETHOD
Displays a table of information about the method and options. Includes the type of algorithm used, the maximum
number of iterations, and the tolerance level for convergence.

TSTARTING
Displays the parameters' starting values.

TCONSTRAINTS
Displays a table of constraints for the parameters.

TITERATIONS
Displays the parameter estimates, and the residual sum of squares (SSE) at each iteration.

TEQUATION
Displays the regression equation.
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TPARAMETERS
Displays the parameter estimates and their approximate standard errors.

CI
Adds a confidence interval for each parameter in the parameter estimates table.

TCORRELATION
Displays the correlation matrix for the parameter estimates.

TSUMMARY

Displays a test for lack of fit, and a summary of the fits that includes the number of iterations, SSE, the degrees
of freedom for error, MSE, and S.

TPREDICTIONS

Displays a table of fitted values, confidence intervals, and prediction intervals for the new observations specified
by PCONTINUOUS.

NODEFAULT
Suppresses the display of tables and graphs other than those specifically requested.

Graphs

GHISTOGRAM
Displays a histogram of the residuals.

GNORMAL
Displays a normal probability plot of the residuals.

GFITS
Plots the residuals versus the fitted values.

GFOURPACK

Displays a layout of a histogram of the residuals, a normal probability plot of the residuals, residuals vs fitted
values, and residuals vs order of the data.

GORDER

Plots the residuals versus the order of the data. The row number for each data point is shown on the x-axis ( for
example, 123 4..n).

GVARIABLE C...C
Displays a separate graph for the residuals versus each specified column.

GFCURVE
Displays a fitted curve plot. Minitab ignores the subcommand if there is more than one predictor.

GFCI
Overlays the confidence interval bands.

GFPI
Overlays the prediction interval bands.
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Storage

RESIDUALS C
Stores the residuals (fitted values — observed values).

FITS C
Stores the fitted values, often called the Y-hats (7).

SPARAMETERS C
Stores the estimated parameters.

SSEPARAMETERS C
Stores the standard error of each parameter.

SGRID C...C

Stores each starting value combination and the corresponding initial sum of the squared residuals (SSE). Minitab
performs the nonlinear regression analysis using the starting value combination that produces the smallest initial
SSE.

OREG: Session command for performing orthogonal
regression

OREG
Performs orthogonal regression in which both the response and predictor contain measurement error.
OREG uses orthogonal regression to fit a model to one predictor. Optionally, you can do the following:
e Store the residuals, fitted values, and variance estimates
e Generate predicted values for new observations
e Control display of results

e Generate several plots for residual analysis. For more information, go to Residual analysis and regression
diagnostics on page 1178.

VARRATIO C
Specifies the error variance ratio (Y/X). K must be greater than 0.

Graphs

RTYPE K
Specifies the type of residual to plot with the graph subcommands in K.

Value of K Type of residuals
1 (default) Regular or raw residuals (RESIDUALS)
2 Standardized residuals (SRESIDUALS)
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GHISTOGRAM
Displays a histogram of the residuals.

GNORMAL
Displays a normal probability plot of the residuals.

GFITS
Plots the residuals versus the fitted values.

GFOURPACK
Displays a layout of a histogram of the residuals, a normal probability plot of the residuals, residuals vs fitted
values, and residuals vs order of the data.

GORDER
Plots the residuals versus the order of the data. The row number for each data point is shown on the x-axis ( for
example, 123 4..n).

GVARIABLIE C...C
Displays a separate graph for the residuals versus each specified column.

GFLINE
Displays a fitted line plot of the original data.

LSFIT
Displays the least squares fitted line on the fitted line plot. When you use LSFIT, both the orthogonal and the least
squares regression equations are displayed on the graph.

Options

CONFIDENCE K
Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of K is 95.

PREDICT K

PREDICT C
Specifies the value of the predictor X. You can enter a constant or a column of values.

SPREDICT C
Stores the predicted values in the specified column.

SSTDEV C
Stores the standard deviations of the predicted values in the specified column.

Results

REVARRATIO
Displays the error variance ratio.

REQUATION
Displays the orthogonal regression equation.
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RCOEFFICIENT
Displays the coefficient table.

RVARCOMP
Displays the error variance estimates.

RFITRESID
Displays the fitted values for the true predictor and true response as well as the residuals.

Storage

SRESIDUALS C
Stores the residuals in the specified column.

SSRESIDUALS C
Stores the standardized residuals in the specified column.

SCOEFFICIENT C
Stores the intercept and slope in the specified column.

SVARIANCE C
Stores the error variances for the predictor and response in the specified column.

SXFIT C
Stores the fitted values of the predictor.

SYFIT C
Stores the fitted values of the response.

PLS: Session command for performing partial least
squares regression

PLS C...C = termlist

Use partial least squares regression (PLS) to relate a set of predictors to one or more response variables. Use PLS
with ill-conditioned data, when predictors are highly collinear or predictors outnumber observations. Predictors
can be either continuous or categorical. Use NCOMPONENTS to specify the number of components to use in the
model. Use XVALIDATION to select the number of components that maximize the model's predictive ability. Use
PCONTINUOUS and PCATEGORICAL to calculate fitted values for new observations using the PLS model.

CONTINUOUS C...C
Specifies which columns of variables are continuous. Columns must contain numerical or date/time data.

CATEGORICAL C...C
Specifies which, if any, columns of variables are categorical. Columns may be numerical, text, or date/time.

NCOMP K

Sets the maximum number of components to extract or cross-validate, which cannot exceed the number of
predictors in your model or the number of observations minus one. Minitab extracts 10 or cross-validates
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10 components by default, unless the number of predictors or the number of observations minus 1 is less
than 10.

Options

XVALIDATION K

XVALIDATION C
XVALIDATION estimates your model's predictive ability by recalculating your model, leaving 1 or more observations
out each time.

Use K to specify the number of observations to leave out each time the model is recalculated. Specifying 1 means
that the model is recalculated as many times as there are observations.

Use C as a group identifier to indicate which observations are deleted together each time the model is recalculated.
Observations with identical numbers in C are removed at the same time. The column must contain positive integers
and equal the length of the predictor and response columns.

CODING K
CODING specifies the type of coding to use for categorical predictors.
e K=-1for(-1,0, +1) coding
e K=1for(1,0)coding

REFERENCE C K...C K
REFERENCE changes the default coding for the categorical predictor columns. To change the default reference
level, specify the categorical predictor column followed by the reference level. (You must enclose text and
date/time levels in double quotes.) You can assign a reference level only when you use 1, 0 coding.

Prediction
Computes the fitted Ys, or ¥ for new observations using your PLS model.

PCONTINUOUS E...E
Use PCONTINUOUS for new continuous predictors.

PCONTINUOUS displays a table that contains the fitted Y's, standard errors of the fitted Y's, a 95% confidence
interval, and a 95% prediction interval. E...E may be a list of constants or a list of columns, or a mixture of constants
and columns. The number of predictors must equal the number of predictors in your PLS model.

PCATEGORICAL E...E
Use PCATEGORICAL for new categorical predictors.

PCATEGORICAL displays a table that contains the fitted Y's, standard errors of the fitted Y's, a 95% confidence
interval, and a 95% prediction interval. E...E may be a list of constants or a list of columns, or a mixture of constants
and columns. The number of predictors must equal the number of predictors in your PLS model.

RESPONSE C...C
Specifies response values for your new observations. Minitab calculates a test R? that indicates how well the model
fits new observations.
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CONFIDENCE K

Regression

Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value

of K is 95.

PFITS C...C
Stores the fits from PCONTINUOUS and PCATEGORICAL.

PSEFITS C...C

Stores the estimated standard errors of the fits from PCONTINUOUS and PCATEGORICAL.

CLIMITS C, C...C, C
Stores the lower and upper confidence limits from PCONTINUOUS and PCATEGORICAL.

PLIMITS C, C...C, C
Stores the lower and upper prediction limits from PCONTINUOUS and PCATEGORICAL.

Storage of fits and residuals

FITS C...C
Stores the fitted values, often called the Y-hats (7).

CVFITS C...C
Stores the cross-validated fitted values.

RESIDUALS C...C
Stores the residuals (fitted values — observed values).

PRESIDUALS C...C
Stores the cross-validated residuals.

SRESIDUALS C...C
Stores the standardized residuals.

Storage of model information

COEFFICIENTS C...C
Stores the estimated coefficients, one stored column for each response.

SCOEFFICIENTS C...C
Stores the standardized coefficients, one stored column for each response.

HI C
Stores the severage values.

XDISTANCE C
Stores the distances from the x-model.

YDISTANCE C
Stores the distances from the y-model.
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Storage of component information

XSCORES M
Stores the X-scores.

YSCORES M
Stores the Y-scores.

XLOADINGS M
Stores the X-loadings.

YLOADINGS M
Stores the Y-loadings.

XWEIGHTS M
Stores the X-weights.

XRESIDUALS M
Stores the X-residuals.

YRESIDUALS C...C
Stores the Y-residuals, one stored column for each response.

XCALCULATED M
Stores the X-calculated values.

YCALCULATED C...C
Stores the Y-calculated values, one stored column for each response.

Graphs for model evaluation

GSELECTIONPLOT
Displays a scatterplot of R® and predicted R® values vs the number of components

GFIT
Displays a scatterplot of fitted and cross-validated responses vs observed responses

GFCOEFFICIENT
Displays a projected scatterplot of the coefficients

GCCOEFFICIENT
Displays a projected scatterplot of the standardized coefficients

GDISTANCE
Displays a scatterplot of each observation's distance from the x-model and the y-model

Graphs for residual analysis

GHISTOGRAM
Displays a histogram of the standardized residuals

GNORMAL
Displays a normal probability plot of the standardized residuals

Minitab B’

Regression

197



Minitab Statistical Software Regression

GRESIDUALS
Displays a scatterplot of residuals vs fitted values

GLEVERAGE
Displays a scatterplot of standardized residuals vs leverages

GFOURPACK
Displays a layout of a histogram of the standardized residuals, a normal probability plot of the standardized
residuals, standardized residuals vs fitted values, and standardized residuals vs order of the data.

Graphs for model evaluation

GSCORE
Displays a plot of the x-scores of the first component versus the x-scores of the second component

GTHREEDPLOT
Displays a three-dimensional plot of the x-scores of the first component, second and third components

GLOADING
Displays a plot of the x-loadings of the first component vs the x-loadings of the second component

GXRESIDUALS
Displays a line plot of the x-residual matrix

GXCALCULATED
Displays a line plot of the x-calculated matrix.

Results

TMETHOD
Displays the number of components and analysis of variance table.

TANOVA
Displays the analysis of variance table.

TSELECTION
Displays the model selection and validation table.

TCOEFFICIENTS
Displays the unstandardized and standardized coefficients.

TFITS
Displays the table of fitted values and residuals.

TLEVERAGES
Displays the leverages and distances from the x- and y-model.

TPREDICTION
Displays the prediction table.

TXSCORES
Displays the x-score matrix.
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TYSCORES
Displays the y-score matrix.

TXLOADINGS
Displays the x-loading matrix.

TYLOADINGS
Displays the y-loading matrix.

TXRESIDUALS
Displays the x-residual matrix.

TYRESIDUALS
Displays the y-residual matrix.

TXCALCULATED
Displays the x-calculated matrix.

TYCALCULATED
Displays the y-calculated matrix.

GZLM: Session command for fitting a binary logistic
model or a Poisson model

GZLM
Creates a generalized linear model with the distribution model that you specify: logistic or Poisson. GZLM fits a
model with one or more predictors using an iterative-reweighted least squares algorithm to obtain maximum
likelihood estimates of the parameters. Use the logistic model for a binary response variable. Use the Poisson
model for a Poisson response variable.

The predictors can be either factors (categorical predictors) or covariates (continuous predictors). Factors can be
crossed. Covariates can be crossed with each other or with factors. For more information, go to How to specify
the model for ATCLASS, GZLM, OLOGISTIC and NLOGISTIC on page 1165. You can use stepwise methods to explore
different terms in the model. You can use a test data set or k-fold cross-validation to validate the results.

Factor columns can be numeric or text. For a numeric factor, Minitab designates the lowest numeric value as the
reference level. For a text factor, Minitab determines the reference level alphabetically. For an example, go to
Entering data for factor variables on page 1142.

When the response variable column is binary, the highest value is the reference event. When the response variable
column is text, reverse alphabetical order determines the event. For example, if you enter the response variable
as success and failure, success is the event. For examples and information on entering the response data, go to
Entering data for response variables on page 1142.

This analysis provides diagnostic plots, goodness-of-fit tests, and other diagnostic measures so you can assess
the validity of your model. For more information, go to Generalized linear model diagnostics and residual analysis
on page 1177.

Minitab excludes all observations with missing values on either the response variable or any of the predictors
from all calculations.
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BINOMIAL

Analyzes the relationship between a binary response variable that you specify in RESPONSE and the predictors
that you with CONTINUOUS and CATEGORICAL. You specify the model with TERMLIST.

LOGIT
Use the logit link function.

NORMIT
Use the normit link function.

GOMPIT
Use the gompit link function. The gompit link function is also called the complementary log-log link
function.

POISSON

Analyzes the relationship between a Poisson response variable that you specify in RESPONSE and the predictors
that you with CONTINUOUS and CATEGORICAL. You specify the model with TERMLIST.

LOG
Use the natural log link function.

SQRT
Use the square root link function.

IDENTITY
Use the identity link function. The identity link function does not transform the response.

RESPONSE C [C]
Enters the response data as counts. With BINOMIAL, you can enter a column that contains the number of
events first and then a column that contains the number of trials. For examples, go to Entering data for
response variables on page 1142.

CONTINUOUS C...C
Specifies the continuous predictors are in columns C...C. The columns must be numeric or date/time and
must match the length of the response column.

CATEGORICAL C...C
Specifies the categorical predictors are in columns C...C. The columns can be numeric, text, or date/time and
must match the length of the response column.

TERMS termlist
Specifies the model terms. Terms must be legal cross-terms. Only continuous predictors may be repeated.
Nested terms are not allowed. The model can be nonhierarchical. For examples, go to How to specify the
model for ATCLASS, GZLM, OLOGISTIC and NLOGISTIC on page 1165.

Options
FREQUENCY C

Indicates how often the data in a row occur. For examples, go to Entering data for response variables on page
1142.

CONSTANT
Fits the model with the intercept.
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When you use CONSTANT, Minitab includes the intercept term in the model. For example, for a binomial logistic
regression, Minitab fits the model

9(p) = B + x'B
If you do not specify CONSTANT or NOCONSTANT, then Minitab includes the intercept.

NOCONSTANT

Fits the model without the intercept.
When you use NOCONSTANT, Minitab omits the intercept term.

9(p) = x'B
If you do not specify CONSTANT or NOCONSTANT, then Minitab includes the intercept.

CONFIDENCE K

Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of K'is 95.

ITYPE K
Specifies the type of confidence interval.

Value of K Type of confidence interval
-1 Lower bound
0 (default) Two-sided
1 Upper bound
WALD

Use the Wald test for the ANOVA table.

LRT
Use the Likelihood ratio test for the ANOVA table.

ADJDEVIANCE
Use adjusted deviances for the tests of significance in the ANOVA table when the Likelihood ratio test is used.

SEQDEVIANCE

Use sequential deviances for the tests of significance in the ANOVA table when the Likelihood ratio test is used.
The order of the terms in TERMLIST affects the statistical significance. The default is to use adjusted deviances.

PEARSON
Specifies the use of Pearson residuals. The default is to use deviance residuals.

WEIGHT C

Performs a weighted regression. An n x n matrix W is formed with the column of weights as its diagonal and zeros
elsewhere. The regression coefficients are estimated by:

XWX (X' WY)

EFFECT

Specifies an effect coding scheme for categorical predictors (+1, 0, - 1). With effect coding, the coefficients compare
the levels of the categorical variable to the mean. The default is binary coding (1, 0). With binary coding, the
coefficients compare the levels of the categorical variable to a reference level.
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HGROUP K
Specifies the number of groups for the Hosmer-Lemeshow goodness-of-fit test with K. The default is 10.

REFERENCE C K...C K
Specifies the reference level for categorical predictor C with K. The coefficients compare the other levels of
categorical variables to the reference level when you use binary coding.

LOCATION [K...K]
Standardize continuous predictors by subtracting the means. Optionally, you can subtract different constants that
you specify with K...K. The order of the constants matches the order of the columns after CONTINUOUS.

SCALE [K...K]
Standardize continuous predictors by dividing by the standard deviations. Optionally, you can divide by different
constants that you specify with K...K. The order of the constants matches the order of the columns after
CONTINUOUS.

LEVELS K K...K K
Standardize continuous predictors by coding the low and high levels K K of each predictor to —1 1. The order of
the constants matches the order of the columns after CONTINUOUS.

UNSTANDARDIZED
Use the original units for the continuous predictors. If you do not specify LOCATION, SCALE, LEVELS, or
UNSTANDARDIZED, then Minitab uses the preferences that are set in File > Options > Linear Models > Coding
of Predictors.

REVENT K
Specifies which is the response event with K. The value of K matches one of the values in the response column.
Enclose text values in quotation marks. For example, to model the probability of a "Fail" in the response column,
enter REVENT "Fail".

EVNAME K
When the RESPONSE command has two columns, you can specify the name of the event with K. Enclose text
values in quotation marks.

ITERATION K
Specifies the maximum number of iterations for the optimization algorithm that estimates the coefficients. The
default is 50.

TOLERANCE K
Specifies the tolerance level to keep a predictor in the model that is either highly correlated with another predictor
or nearly constant. By default, K = 4 * 2.22E-012. K must be a positive number. Lowering tolerance by giving a
very small argument can prevent Minitab from eliminating problematic predictor columns from the model.

Correlated predictors
1 - R-squared, where R-squared is the value resulting from regressing one predictor on the remaining
predictors. If (1 — R-squared) is < K, Minitab removes the predictor from the equation.

Constant predictors
The parameter for forcing in a variable that is nearly constant. If the coefficient of variation of a predictor
(the standard deviation / the mean) is < square root K, Minitab considers the predictor to be essentially
constant and removes it from the equation.

CTOLERANCE K
Specifies the convergence criterion for the algorithm that estimates the coefficients. By default, K = 1E-8.
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START C

Specifies a column that contains starting values for the coefficients in the optimization algorithm. The column
begins with the estimate of the constant, then follows the order of the model after TERMS.

Stepwise selection

STEPWISE, FORWARD, BACKWARD, FINFORMATION and FVALIDATION perform a stepwise regression procedure to
fit the model. No arguments are needed for these subcommands.

STEPWISE
Specifies a stepwise model selection procedure that uses both forward selection and backward elimination. If you
do not include subcommands about hierarchy, STEPWISE and FORWARD add 1 term at a step and maintain model
hierarchy, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

FORWARD
Specifies a stepwise model selection procedure that uses forward selection. If you do not include subcommands
about hierarchy, STEPWISE and FORWARD add 1 term at a step and maintain model hierarchy, the equivalent of
the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

BACKWARD
Specifies a stepwise model selection procedure that uses backward elimination. Removes a single term at each
step and maintains a hierarchical model, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS.

FINFORMATION
Specifies a stepwise model selection procedure that uses forward information criteria selection. Use AICCORRECTED
or BICRITERION to specify which information criterion to use to select the final model. If you do not specify a
criterion, Minitab uses AICCORRECTED.

The forward information criteria procedure adds the term with the lowest p-value to the model at each step. If
you do not include subcommands about hierarchy, INFORMATION adds 1 term at a step and maintains model
hierarchy, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.
Minitab calculates the information criteria for each step.

In most cases, the procedure continues until one of the following conditions occurs:

e The procedure does not find a new minimum of the criterion for 8 consecutive steps.

e The procedure fits the full model.

e The procedure fits a model that leaves 1 degree of freedom for error.

If you specify settings for the procedure that require a hierarchical model at each step and allow only one term
to enter at a time, then the procedure continues until it either fits the full model or fits a model that leaves 1
degree of freedom for error. Minitab displays the results of the analysis for the model with the minimum value

of the selected information criterion, either the corrected Akaike's Information Criterion (AlCc) or the Bayesian
Information Criterion (BIC).

AICCORRECTED
Specifies the use of the corrected Akaike's Information Criterion (AlCc) to select the final model.

BICRITERION
Specifies the use of the Bayesian Information Criterion (BIC) to select the final model.
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FVALIDATION

Specifies the use of forward selection with the test deviance R? as the criterion for the selection of the final model.
When you use FVALIDATION, you must also use TEST. FVALIDATION is not compatible with FREQUENCY or
ATEND.

When you use TEST, the procedure is similar to forward selection for other methods. At the end of each step,
Minitab Statistical Software calculates the test R? statistic. At the end of the forward selection procedure, the
model with the greatest test R® value is the final model. FVALIDATION stops under the same conditions as
FINFORMATION.

AENTER K
Specifies the alpha level at which a term is entered into the model. The default is 0.15 for STEPWISE and 0.25
for FORWARD.

AREMOVE K

Specifies the alpha level at which a term is removed from the model. The default is 0.15 for STEPWISE and
0.10 for BACKWARD. For STEPWISE, K must be greater than or equal to K for AENTER.

ENTER termlist

Specifies the terms that are contained in the starting model for STEPWISE. The ENTER termlist must be a
subset of the TERMS termlist or in the default term list in the design.

FORCE termlist
Specifies the terms to be forced in the model. The FORCE termlist must be a subset of the TERMS termlist
or in the default term list in the design.

NOHIERARCHICAL
Specifies that the model selection procedure does not consider hierarchy.

HIERARCHICAL
Maintains a hierarchical model in stepwise regression. In a hierarchical model, if a higher-order term is
included, all lower-order terms that comprise the higher-order term also appear in the model. For example,
a model that includes the interaction term A*B*C is hierarchical if it includes the following main effects and
lower-order interactions: A, B, C, A*B, A*C, and B*C.

CATONLY

Specifies that only the categorical terms in the model have to be hierarchical.

ALLTERMS
Specifies that both categorical and continuous terms have to be hierarchical.

ATEND
Specifies that the final step of the stepwise procedure adds terms to make the model hierarchical.

ALWAYS
Specifies that the model is hierarchical at every step.

SINGLE

Specifies that only one term can enter the model at each step. So a higher-order term can enter
the model only if the terms that comprise the term are already in the model. For example, the
algorithm does not consider the addition of A*B unless A and B are already in the model.

BACKWARDS does not use SINGLE or MULTIPLE because terms only exit the model.
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MULTIPLE

Specifies that multiple terms can enter the model at each step. So a higher order term can enter
the model, and the terms that comprise the term enter the model at the same time. For example,
if A*B is the most statistically significant term, A*B enters the model. At the same time, A and B
enter the model if those terms are not in the model already.

BACKWARDS does not use SINGLE or MULTIPLE because terms only exit the model.

GRSQUARE
After FVALIDATION, displays a graph of the R statistic and the test deviance R? statistic for each step
in the model selection procedure.

Validation

TEST CK

Specifies to perform validation with a test data set that you specify. The column must have two distinct values
that indicate which rows are in the test data set and which rows are in the training data set. K is the value for rows
that are in the test data set.

TESTK [K]

Specifies to perform validation with a randomly-selected test data set. The first K is the fraction of the data in the
test data set, a value between 0 and 1. The second K is optional. The second K is a base for the random number
generator. If you specify the base, you can get the same test data set again by specifying the same base.

CVTEST C

Specifies to perform k-fold cross validation with a test data set that you specify. Rows with the same value in the
column are in the same fold.

CVTEST K [K]
Specifies to perform k-fold cross validation with randomly-selected folds. The constant is the number of folds.
The optional constant is a base for the random number generator. If you specify the base, you can get the same
folds again by specifying the same base.

Tables for all models

TMETHOD
Displays a table of information about the method and options.

TMSDETAILS
Displays the type of stepwise procedure and the alpha values to enter and/or remove a predictor from the model.

If you do not specify FULL or NOFULL, then Minitab uses the preferences that are set in File > Options > Linear
Models > Stepwise.

FULL

Specifies to display the coefficients, p-values, and model summary statistics for each step of the procedure.
If you use the TEST subcommand, the model summary statistics include test R%.

NOFULL
Hides these statistics.
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TEQUATION
Displays the model equation.

SINGLE

SINGLE specifies to show one equation instead of a separate equation for each combination of the levels of
the categorical predictors. The equation has a coefficient for each level of the categorical variables.

SEPARATE
Specifies to show separate equations for each combination of the levels of the categorical predictors. Each
equation has a different constant term.

TDEVIANCE
Displays the ANOVA table for the Wald test or the likelihood ratio tests.

TSUMMARY
Displays the statistics that evaluate model fit, including deviance R.

TCOEFFICIENTS
Displays the coefficients and the p-values for the Wald normal approximation tests.

If you do not specify FULL or NOFULL, Minitab uses the preferences set in File > Options > Linear Models >
Display of Results.

FULL
Specifies to show the coefficients for the reference level when you use (0, 1) coding for categorical predictors.

NOFULL
Hides these statistics.

TGOODNESS
Displays the Pearson and Deviance goodness-of-fit tests. For the binomial distribution models, also shows the
Hosmer-Lemeshow goodness-of-fit test.

TDIAGNOSTICS [K]
Displays a table of diagnostics. K = 0 displays diagnostics for only observations with high leverage values or
standardized residuals greater than 2. K = 1 displays diagnostics for all observations.

TSTEP
Displays the deviance at each iteration of the coefficients.

TEXPAND
Displays the expanded versions of the tables that have them. The expanded Analysis of Variance table adds the
sequential deviances and percent contributions for each term. The Coefficients table adds confidence intervals
for the coefficients. The Fits and Diagnostics table adds the standard error of the fit, the 95% confidence interval
for the fit, the deleted residual, the HI, the Cook's D, and the DFITS.

TSIMPLE
Displays the simple versions of the Analysis of Variance table, the Coefficients table, and the Fits and Diagnostics
table.

NODEFAULT
Hides default tables and graphs that you do not include the subcommand to display.
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Tables for binomial distribution models

TRINFO

Displays the number of events, non-events, and the total. The table also indicates which response value is the
reference event.

TODDS
Displays odds ratios for each continuous predictor and each level of the categorical predictors. The output does
not show odds ratios for predictors with interactions in the model or for categorical predictors with (-1, 0,+1)
coding.
INCREMENT K. ..K

Specifies the increment for the odds ratio for the predictor with K. For example, if the predictor is mass in
grams, enter 1000 to see the change in the odds ratio for a kilogram. Enter the values in the same order that
the predictors follow CONTINUOUS. Enter 1 for a predictor to use the units of the data.

THOSMER
Displays the table of observed and expected values for the Hosmer-Lemeshow test.

TASSOCIATION

Displays the number of concordant and discordant pairs, the Somers' D, the Goodman-Kruskal Gamma, and
Kendall's Tau-a.

Graphs for all models

RTYPE K
Specifies the type of residual to plot with the graph subcommands.

Value of K Type of residuals

1 (default) Regular or raw residuals (RESIDUALS)

2 Standardized residuals (SRESIDUALS)

3 Deleted Studentized residuals (TRESIDUALS)
GHISTOGRAM

Displays a histogram of the residuals.

GNORMAL
Displays a normal probability plot of the residuals.

GFITS

Displays residuals versus fitted values. For binary logistic regression, this plot is not available when the data are
in response/frequency format because the pattern that appears is not a violation of the assumptions.

GORDER

Displays residuals versus the order of the worksheet. The row number for each data point is shown on the x-axis
(for example, 12 3 4..n).

GFOURPACK

Choose to display a layout of the residual plots. For Poisson models, the layout includes a histogram of residuals,
a normal plot of residuals, a plot of residuals versus fits, and a plot of residuals versus order.
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For the binary logistic model, the layout depends on the format of the data. If the data are in response/frequency
format, the layout has a histogram of residuals, a normal plot of residuals, and a plot of residuals versus order. If
the data are in event/trial format, the layout also has a plot of residuals versus fits.

GVARIABIE C...C
Displays the residuals versus the variables in C. Typically, you enter the columns for the predictors.

Graphs for binomial distribution models

GROC
Displays the receiver operating characteristic (ROC) curve for a binomial logistic regression. A footnote on the
plot gives the area under the ROC curve. You can use the area under the ROC curve to compare models. The ROC
curve plots the true positive rate (TPR) against the false positive rate (FPR).

Storage for all models

When you use the TEST subcommand, Minitab Statistical Software stores the following statistics for the training data
set and not the test data set:

Subcommand Statistic

TRESIDUALS Deleted residuals

COOK Cook's distances

DFITS DFITS

SADJUSTEDRESP Adjusted response values

XPWXINVERSE X'WX inverse matrix of the estimated coefficients
FITS C

Stores the event probabilities.

RESIDUALS C
Stores the Deviance residuals by default. Stores the Pearson residuals if you use the subcommand PEARSON.

SRESIDUALS C

Stores the standardized Deviance by default. Stores the standardized Pearson residuals if you use the subcommand
PEARSON.

TRESIDUALS C

Stores the deleted Deviance residuals by default. Stores the deleted Pearson residuals if you use the subcommand
PEARSON.

COCK C
Stores the Cook's distances. If you use a test data set, the storage is for the training data set only.

DFITS C
Stores the DFITS.

HI C
Stores the leverages.
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SADJUSTEDRESP C
Stores the final adjusted response values.

SIWEIGHTS C
Stores the internal weights used to estimate the model parameters.

SECOEFFICIENTS C
Stores the standard errors of the estimated coefficients.

COEFFICIENTS C
Stores the estimated coefficients.

XMATRIX M
Stores the design matrix.

XPWXINVERSE M
Stores the X'WX inverse matrix of the estimated coefficients.

When you use the TEST subcommand or the CVTEST subcommand, Minitab Statistical Software stores the following
statistics for the training data set but not for the validation data set.

DBETA C

Stores the change in the estimated regression coefficients (delta b) when you delete all observations with a
particular factor/covariate pattern. Use the delta b values to detect observations with a strong influence on the
coefficients. If you use a test data set, the storage is for the training data set only.

DSBETA C

Stores the change in the estimated regression coefficients when you delete all observations with a particular
factor/covariate pattern based on the standardized Pearson residual. If you use a test data set, the storage is for
the training data set only.

DCHISQUARE C

Stores the change in the chi-square statistic when you delete all observations with a particular factor/covariate
pattern. Observations that are poorly fit by the model have high delta chi-square values. If you use a test data
set, the storage is for the training data set only.

DDEVIANCE C

Stores the change in the deviance when you delete all observations with a particular factor/covariate pattern. If
you use a test data set, the storage is for the training data set only.

Storage for validation

Use the following commands to store statistics for validation with a test data set. These commands are sub-sub
commands to the TEST subcommand. As such, these commands must come after TEST.

Use the following commands to store statistics for validation with a test data set or validation with k-fold cross validation.

SSAMPLE C
When CVTEST is used:

e The storage column, Sample_Id, stores the fold identification in C.

e (C contains values 1, 2, ..., K.

When TEST is used:

e The storage column, Sample_ld, stores the training and test sample assignments in C.
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e (Cis a binary text column that contains Training and Test as the two values.

CVFIT C
Stores the fitted values from each fold's turn as the test data set.

CVRESID C
Stores the residuals from each fold's turn as the test data set.

BFIT: Session command for creating a binary fitted
ine plot

BFIT

Performs logistic regression on a binary response variable. A binary variable has only two possible values, such
as presence or absence. BFIT fits a model with one continuous predictor using an iterative-reweighted least squares
algorithm to obtain maximum likelihood estimates of the parameters.

For examples and information on entering the response data, go to Entering data for response variables on page
1142.

BFIT provides diagnostic plots, goodness-of-fit tests, and other diagnostic measures so you can assess the validity
of your model. For more information, go to Generalized linear model diagnostics and residual analysis on page
1177.

Note Minitab excludes all observations with missing values on either the response variable or any of the predictors from all calculations.

RESPONSE C [C]
Enters the response data as counts. For examples and information on entering the response data, go to
Entering data for response variables on page 1142.

CONTINUOUS C
Indicates the continuous predictor is in C.

LOGIT
Use the logit link function.

NORMIT
Use the normit link function.

GOMPIT
Use the gompit link function. The gompit link function is also called the complementary log-log link function.

Options

FREQUENCY C
Indicates how often the data in a row occur.

CONFIDENCE K

Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of K'is 95.
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ITYPE K
Specifies the type of confidence interval.

Value of K Type of confidence interval
-1 Lower bound
0 (default) Two-sided
1 Upper bound
REVENT K

Specifies which is the response event with K. The value of K matches one of the values in the response column.
Enclose text values in quotation marks. For example, to model the probability of a "Fail" in the response column,
enter REVENT "Fail".

EVNAME K

When the RESPONSE command has two columns, you can specify the name of the event with K. Enclose text
values in quotation marks.

Tables

TMETHOD
Displays the link function.

TRINFO
Displays the number of events, non-events, and the total.

TDEVIANCE
Displays the ANOVA table.

TSUMMARY
Displays the statistics that evaluate model fit, including deviance R.

TCOEFFICIENTS
Displays the coefficients and the p-values for the Wald normal approximation tests.

TODDS
Displays odds ratios for each continuous predictor and each level of the categorical predictors. The output does
not show odds ratios for predictors with interactions in the model or for categorical predictors with (-1, 0, +1)
coding.
INCREMENT K

Specifies the increment for the odds ratio for the predictor with K. For example, if the predictor is mass in
grams, enter 1000 to see the change in the odds ratio for a kilogram.

TEQUATION
Displays the model equation.

TGOODNESS
Displays the deviance, Pearson, and Hosmer-Lemeshow tests. These tests assess the overall fit of the model.

TDIAGNOSTICS K

Displays a table of diagnostics. K = 0 displays diagnostics for only observations with high leverage values or
standardized residuals greater than 2. K = 1 displays diagnostics for all observations.
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NODEFAULT
Hides default tables and graphs that you do not include the subcommand to display.

Graphs

GFLINE
Displays the fitted line plot. The plot also shows the equation for the probabilities.

PROPORTIONS
Shows the data on the plot.

DCONFIDENCE
Shows the confidence interval for the fitted line on the plot.

RTYPE K
Specifies the type of residual to plot with the graph subcommands.

Value of K Type of residuals

1 (default) Regular or raw residuals (RESIDUALS)

2 Standardized residuals (SRESIDUALS)

3 Deleted Studentized residuals (TRESIDUALS)
GHISTOGRAM

Displays a histogram of the residuals.

GNORMAL
Displays a normal probability plot of the residuals.

GFITS

Displays residuals versus fitted values. This plot is not available when the data are in response/frequency format
because the pattern that appears is not a violation of the assumptions.

GORDER

Displays residuals versus the order of the worksheet. The row number for each data point is shown on the x-axis
(for example, 12 3 4... n).

GFOURPACK

Displays a layout of the residual plots. If the data are in response/frequency format, the layout has a histogram
of residuals, a normal plot of residuals, and a plot of residuals versus order. If the data are in event/trial format,
the layout also has a plot of residuals versus fits.

GVARIABLE C...C
Displays the residuals versus the variables. Typically, you enter the columns for the predictors.

Storage

FITS C
Stores the event probabilities.
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RESIDUALS C
Stores the Deviance residuals.

SRESIDUALS C
Stores the standardized Deviance residuals.

TRESIDUALS C
Stores the deleted Deviance residuals.

COEFFICIENTS C
Stores the estimated coefficients.

OLOGISTIC: Session command for performing
ordinal logistic regression

OLOGISTIC C = C...C
Performs logistic regression on an ordinal response variable. Ordinal variables are categorical variables that have
3 or more possible levels with a natural ordering, such as strongly disagree, disagree, neutral, agree, and strongly
agree.

OLOGISTIC fits a model with one or more predictors using an iterative-reweighted least squares algorithm to
obtain maximum likelihood estimates of the parameters. OLOGISTIC assumes parallel lines; therefore, one set of
coefficients is associated with the predictors. When this assumption is not valid, use NLOGISTIC on page 216, which
generates separate logit functions.

The predictors can be either factors (nominal variables) or covariates (continuous variables). Factors can be crossed
or nested. Covariates can be crossed with each other or with factors, or nested within factors. The model can

include up to 9 factors and 50 covariates. Unless you specify a predictor in the model as a factor, Minitab assumes
the predictor is a covariate. Model continuous predictors as covariates and categorical predictors as factors. For
more information, go to How to specify the model for ATCLASS, GZLM, OLOGISTIC and NLOGISTIC on page 1165.

Factor columns can be numeric or text. For a numeric factor, Minitab designates the lowest numeric value as the
reference level. For a text factor, Minitab determines the reference level alphabetically. For an example, go to
Entering data for factor variables on page 1142. To change the default coding, use the REFERENCE subcommand.

When the response variable column is numeric, OLOGISTIC orders the levels from smallest to largest. When the
response variable column is text, OLOGISTIC orders the levels alphabetically. For examples and information on
entering the response data, go to Entering data for response variables on page 1142. Use the ORDER subcommand
to specify the ordering of the response variable.

FREQUENCY C
Enters the response data as counts. For examples, go to Entering data for response variables on page 1142.

Options

LOGIT
Specifies the logit link function (default).

NORMIT
Specifies the normit link function.
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GOMPIT
Specifies the gompit link function (also called the complementary log-log function).

FACTORS C...C

Specifies which of the predictors are factors. Minitab assumes all variables in the model are covariates unless
specified to be factors. Model continuous predictors as covariates and categorical predictors as factors.

REFERENCE C K, ..., CK

Changes the default coding for factors. To change the default reference factor level, specify the factor column
followed by the reference level. (Text and date/time levels must be enclosed in quotes.) For a discussion and
examples of the default coding scheme, go to Entering data for factor variables on page 1142.

Use the ORDER subcommand to specify the ordering of the response variable.

ORDER C

ORDER K. . .K
Specifies the order of the response values from lowest to highest. Values can be stored in C or K.

ITERATION K

Changes the maximum number of iterations that Minitab performs to reach convergence. The default value is 20.
Minitab's logistic regression commands obtain maximum likelihood estimates through an iterative process. If the
maximum number of iterations is reached before convergence, the command terminates.

START C

Specifies the initial values for model parameters. The column containing the initial values must have one row for
each estimated coefficient in the model. For OLOGISTIC, the starting values for all the constants appear first,
followed by starting values for the predictors in the model.

Note Each degree of freedom must be in one row.

CTOLERANCE K [K]
Changes the convergence criteria. Both Ks must be positive numbers.

K How convergence is attained

First K Convergence is attained relative to this criterion if from one iteration to the next the change
in the log-likelihood is less than K. The default is .0001.

Second K Convergence is attained relative to this criterion if from one iteration to the next the
maximum change in the coefficients is less than K. The default is .0001.

TOLERANCE K
Specifies the tolerance level to keep a predictor in the model that is either highly correlated with another predictor
or nearly constant. By default, K = 4 * 2.22E-012. K must be a positive number. Lowering tolerance by giving a
very small argument can prevent Minitab from eliminating problematic predictor columns from the model.

Correlated predictors
1 - R-squared, where R-squared is the value resulting from regressing one predictor on the remaining
predictors. If (1 — R-squared) is < K, Minitab removes the predictor from the equation.

Constant predictors
The parameter for forcing in a variable that is nearly constant. If the coefficient of variation of a predictor
(the standard deviation / the mean) is < square root K, Minitab considers the predictor to be essentially
constant and removes it from the equation.
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Results

BRIEF K
Controls the amount of output with a value in K.

Value of K Output that is displayed

0 Minitab displays no output, but performs all specified storage and displays the following
error messages, warnings, prompts, and notes; graphs; WRITE to the screen.

1 Minitab displays the response information, logistic regression table, log-likelihood, and test
that all slopes = 0.

2 (default) In addition to the BRIEF 1 output, displays the Pearson and deviance tests.

3 In addition to the BRIEF 2 output, displays factor level values and tests for terms with more

than 1 degree of freedom.

STEP
Displays the log-likelihood at each iteration of the parameter estimation process.

Storage of the characteristics of the estimated equation

COEFFICIENTS C
Estimated coefficients in a column.

SECOEFFICIENTS C
Standard errors of the coefficients in a column.

XPWXINVERSE M
Variance-covariance matrix of the estimated coefficients, expressed as (X' W X)'1.

LOGLIKELIHOOD K
Last log-likelihood value.

Storage of the event probabilities and aggregated data

EPROBABILITY C...C
Predicted event probabilities. Specify one column for each distinct value of the response.

CUMPROBABILITY C...C
Cumulative event probabilities. Specify one column for each distinct value of the response minus one.

NTRIALS C
Number of trials for each factor/covariate pattern.

NOCCUR C...C

Number of occurrences for the jth factor/covariate pattern. Specify one column for each distinct value of the
response.

Minitab =’ 215



Minitab Statistical Software Regression

NLOGISTIC: Session command for performing
nominal logistic regression

NLOGISTIC C = C.C
Performs logistic regression on a nominal response variable using an iterative-reweighted least squares algorithm
to obtain maximum likelihood estimates of the parameters. Nominal variables are categorical variables that have
3 or more possible levels but with no natural ordering. For example, the levels in a food-tasting study may include
crunchy, mushy, and crispy.

OLOGISTIC on page 213 assumes parallel lines. Therefore, one set of coefficients is associated with the predictors.
When this assumption is not valid, use NLOGISTIC, which generates separate logit functions.

The predictors can be either factors (nominal variables) or covariates (continuous variables). Factors can be crossed
or nested. Covariates can be crossed with each other or with factors, or nested within factors. The model can
include up to 9 factors and 50 covariates. Unless you specify a predictor in the model as a factor using the FACTORS
subcommand, Minitab assumes the predictor is a covariate. Model continuous predictors as covariates and
categorical predictors as factors. For more information, go to How to specify the model for ATCLASS, GZLM,
OLOGISTIC and NLOGISTIC on page 1165.

Factor columns can be numeric or text. For a numeric factor, Minitab designates the lowest numeric value as the
reference level. For a text factor, Minitab determines the reference level alphabetically. For an example, go to
Entering data for factor variables on page 1142.

When the response variable column is numeric, NLOGISTIC defines the highest value as the reference event. When
the response variable column is text, NLOGISTIC defines the event by reverse alphabetical order. For example, if
you enter the response variable as crunchy, mushy, and crispy, NLOGISTIC defines mushy as the event. For examples
and information on entering the response data, go to Entering data for response variables on page 1142.

Use the REFERENCE subcommand to change the default coding for both factor and response variables.

NLOGISTIC provides goodness-of-fit tests and other diagnostic measures so you can assess the validity of your
model.

FREQUENCY C
Enters the response data as counts. For examples and information on entering the response data, go to
Entering data for response variables on page 1142.

Options

FACTORS C...C

Specifies which of the predictors are factors. Minitab assumes all variables in the model are covariates unless
specified to be factors. Continuous predictors must be modeled as covariates; categorical predictors must be
modeled as factors.

REFERENCE C K, ..., CK
Changes the default coding for factor and response columns. To change the default reference factor level, specify
the factor column followed by the reference level. (Text and date/time levels must be enclosed in quotes.) For a
discussion and examples of the default coding scheme, go to Entering data for factor variables on page 1142.

To change the default event, specify the response column followed by the event value.
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START C

Specifies the initial values for model parameters. The column containing the initial values must have one row for
each estimated coefficient in the model. For NLOGISTIC, the starting values for logit 1 appear before logit 2, and
so on. For each logit, the starting value for the constant appears before the starting values for the predictors in
the model.

Note Each degree of freedom must be in one row.

ITERATION K

Changes the maximum number of iterations that Minitab performs to reach convergence. The default value is 20.
Minitab's logistic regression commands obtain maximum likelihood estimates through an iterative process. If the
maximum number of iterations is reached before convergence, the command terminates.

CTOLERANCE K K
Changes the convergence criteria. Both Ks must be positive numbers.

K How convergence is attained

First K Convergence is attained relative to this criterion if from one iteration to the next the change
in the log-likelihood is less than K. The default is .0001.

Second K Convergence is attained relative to this criterion if from one iteration to the next the
maximum change in the coefficients is less than K. The default is .0001.

TOLERANCE K

Specifies the tolerance level to keep a predictor in the model that is either highly correlated with another predictor
or nearly constant. By default, K = 4 * 2.22E-012. K must be a positive number. Lowering tolerance by giving a
very small argument can prevent Minitab from eliminating problematic predictor columns from the model.

Correlated predictors

1 - R-squared, where R-squared is the value resulting from regressing one predictor on the remaining
predictors. If (1 — R-squared) is < K, Minitab removes the predictor from the equation.

Constant predictors
The parameter for forcing in a variable that is nearly constant. If the coefficient of variation of a predictor
(the standard deviation / the mean) is < square root K, Minitab considers the predictor to be essentially
constant and removes it from the equation.

Results

BRIEF K
Controls the amount of output with a value in K.

Value of K Output that is displayed

0 Minitab displays no output, but performs all specified storage and displays the following
error messages, warnings, prompts, and notes; graphs; WRITE to the screen.

1 Minitab displays the response information, logistic regression table, log-likelihood, and test
that all slopes = 0.

2 (default) In addition to the BRIEF 1 output, displays the Pearson and deviance tests.

3 In addition to the BRIEF 2 output, displays factor level values and tests for terms with more

than 1 degree of freedom.
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STEP
Displays the log-likelihood at each iteration of the parameter estimation process.

Storage of the characteristics of the estimated equation

COEFFICIENTS C
Estimated coefficients in a column.

SECOEFFICIENTS C
Standard errors of the coefficients in a column.

XPWXINVERSE M
Variance-covariance matrix of the estimated coefficients, expressed as (X' W X)_1.

LOGLIKELIHOOD K
Last log-likelihood value.

Storage of the event probabilities and aggregated data

EPROBABILITY C...C
Predicted event probabilities. Specify one column for each distinct value of the response.

NTRIALS C
Number of trials for each factor/covariate pattern.

NOCCUR C...C
Number of occurrences for the jth factor/covariate pattern. Specify one column for each distinct value of the
response.
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ANOVA

ONEWAY: Session command for performing a
one-way ANOVA

ONEWAY
Performs a one-way analysis of variance. Your data can be arranged in one of two ways:

e Response data are in one column for all factor levels

e Response data are in a separate column for each factor level

Minitab performs the traditional one-way ANOVA procedure if you assume that the variance is constant across
all groups. However, if your data exhibit unequal variances between groups, Minitab can perform Welch's ANOVA.
To perform Welch's ANOVA, use the WELCH subcommand.

Use the comparison method subcommands to determine which group means differ and by how much.

The factor column may be numeric or text, and may contain any value. The levels do not need to be in any special
order. SET is especially useful for entering data that follow a pattern, such as subscripts (factor level values). For
examples, go to Entering patterned data for the SET session command on page 1143. (TSET and DSET can be used
to enter text and date/time data, respectively, that follow a pattern.)

Variables and terms to include in the model

Specifies information about the variables and terms to include in the model. How you use these commands depends
on how your data are arranged in the worksheet. Your response data can either be in one column for all factor levels
or the response data can be in a separate column for each factor level.

RESPONSE C

RESPONSE C...C
Specifies the column or columns that contains the response data. The column or columns must be numeric or
date/time. If your response data are in one column, specify the column with C. If your response data are in a
separate column for each factor level, specify all of the response columns with C...C.

CATEGORICAL C
Required when your response data are in one column for all factor levels. For this data arrangement, you must
use CATEGORICAL to specify the single column that contains the categorical factor. If you specify more than one
column for RESPONSE, CATEGORICAL is not allowed.

Options

CONFIDENCE K
Specifies a confidence level for the interval plot and means table, but not the multiple comparisons, in K. For
example, for a 90% confidence level, enter CONFIDENCE 90. The default value of K is 95.

ITYPE K
Specifies the type of confidence interval for the interval plot and means table.
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Value of K Type of confidence interval
—1 Lower bound
0 (default) Two-sided
1 Upper bound
WELCH

Specifies the Welch method. Use WELCH when you do not assume that all groups have equal variances. One-way
ANOVA with equal variances is slightly more powerful than Welch's ANOVA, but serious error can result if the
variances are not equal.

Comparisons

TUKEY [K]
Calculates all pairwise differences between level means using Tukey's method (also called Tukey's HSD or
Tukey-Kramer method) with the family error rate specified as K. If K is not specified, Minitab uses the default
family error rate of .05.

To obtain output for this comparison method, you must issue at least one of the following subcommands:
TGROUPING, TMTEST, GMCI.

FISHER [K]
Calculates all pairwise differences between level means using Fisher's LSD procedure with the individual error rate
specified as K. If K is not specified, Minitab uses the default individual error rate of .05.

To obtain output for this comparison method, you must issue at least one of the following subcommands:
TGROUPING, TMTEST, GMCI.

DUNNETT [K] K

DUNNETT C

Calculates the difference between each treatment mean and a control mean. The family error rate is specified by
the first K. How you specify the control group depends on how your data are arranged.

Specify the control group as follows:
e If your response data are in one column, specify the control group with the second K.

e |f your response data are in a separate column for each factor level, specify the control group column with C.

If the error rate is not specified, Minitab uses the default family error rate of .05.

When the column of levels contains text data, the control level will also be text so remember to enclose the value
you enter for K in double quotes.

To obtain output for this comparison method, you must issue at least one of the following subcommands:
TGROUPING, TMTEST, GMCI.

MCB [K] K
Calculates the difference between each level mean and the best of the other level means. The family error rate is
specified by the first K and the type of best is specified by the second K. If the error rate is not specified, Minitab
uses the default family error rate of .05.

There are two choices for "best." If the smallest mean is considered the best, set K = -1; if the largest is considered
the best, set K = 1.
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To obtain output for this comparison method, you must issue at least one of the following subcommands:
TGROUPING, TMTEST, GMCI.

GAMES [K]
Calculates all pairwise differences between level means using Games-Howell method with the family error rate

specified as K. If K is not specified, Minitab uses the default family error rate of .05. GAMES is only available when
WELCH is issued.

To obtain output for this comparison method, you must issue at least one of the following subcommands:
TGROUPING, TMTEST, GMCI.

Results

NODEFAULT
Specifies that no default tables and graphs will be displayed.

TEXPAND
Displays the expanded versions of the ANOVA table, Model summary, and Multiple comparisons tables.

TSIMPLE
Displays the simple version of all tables.

TMETHOD
Displays the method table.

TFACTOR
Displays the name, number of levels, and the values for the categorical factor.

TANOVA
Displays the ANOVA table.

TSUMMARY
Displays the summary of model table.

TMEANS
Displays the table of group means.

TGROUPING

Displays the grouping information table for each comparison method subcommand that you issue. This table
highlights the significant and non-significant comparisons for each comparison method.

TMTEST

Displays the multiple comparison test table for each comparison method subcommand that you issue. This table
displays the hypothesis test form of the comparison output, which includes the differences of the means, the
numeric values for the confidences intervals, and the adjusted p-values.

Graphs that display information by group

GINTPLOT
Displays an interval plot of the group means.
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GINDPILOT
Displays an individual value plot for each group.

GBOXPLOT
Displays a boxplot for each sample.

Graphs for the residuals

GHISTOGRAM
Displays a histogram of the residuals.

GNORMAL
Displays a normal probability plot of the residuals.

GFITS
Plots the residuals versus the fitted values.

GORDER

Plots the residuals versus the order of the data. The row number for each data point is shown on the x-axis ( for
example, 12 3 4..n).

GFOURPACK

Displays a layout of a histogram of the residuals, a normal probability plot of the residuals, residuals versus fitted
values, and residuals versus order of the data.

GVARIABLE C...C
Displays a separate graph for the residuals versus each specified column.

Other graphs

GMCI
Displays an interval plot of the differences between group means for each comparison method subcommand that
you issue.

Storage

FITS C

FITS C...C

Stores fitted values. The fitted values are the level means. Specify one storage column C for each column that
contains response data.

RESIDUALS C

RESIDUALS C...C

Stores residuals. Residual = (response — fit). Specify one storage column C for each column that contains response
data.
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ANOM: Session command for creating an analysis
of means chart

ANOM C
Displays an analysis of means (ANOM) chart. You must choose one distribution that the response data follows:
normal (one-way or two-way), binomial, or Poisson.

For ANOM with a normal distribution and one factor, a single plot displaying the means for each level of the
factor, a center line which is the grand mean, and upper and lower decision limits is produced. If you use ANOM
with a normal distribution and two factors, three plots are given: one showing the interaction effects, one showing
the main effects for the first factor, and one showing the main effects for the second factor. If you choose an
ANOM for a binomial distribution or a Poisson distribution, a single plot displaying the means for each level of
the factor, a center line which is the grand mean, and upper and lower decision points is produced.

The subcommands NORMAL, BINOMIAL, and POISSON replace the commands %ANOM, %BANOM, and %PANOM.
respectively.

NORMAL C [C]
For normal data, each row of the response column represents an observation for measurement data. Response
data are typically measurement data, such as weight or moisture content.

BINOMIAL K
For binomial data, the values in the response column are the numbers of defectives found in each sample.
These values must be positive integers (0 or greater). You can include up to 500 samples.

POISSON
For Poisson data, the values in the response column are the numbers of defects that are found in each sample.
These values must be positive integers (0 or greater). You can include up to 500 samples.

ALPHA K
The decision lines on an ANOM chart are based on an experiment-wide error rate, similar to what you might
use when making pairwise comparisons or contrasts in an ANOVA. By default, a rate of 0.05 is used. Use
ALPHA to enter a number between 0 and 1. Values greater than or equal to 1.0 are interpreted as percentages.

TITLE "title"
Specifies a title for the graph. If you do not specify a title, Minitab uses a default title.

When you use TITLE with %graphs or the DENDROGRAM subcommand, you can use it only one time, and
you cannot use any of the TITLE subcommands available with the graph commands.

WTITLE "title"
You can use WTITLE as a subcommand with LAYOUT and all graphs. The title that you specify becomes the
command title of the resulting graph.

GSAVE "file name"

GSAVE K
Saves the graph in a file.

The default file name is Minitab.PNG. You can specify a custom file name in double quotation marks
("file_name"), or as a stored text constant (K). You can also use any of the following subcommands to save
the graph in a different graphics format.
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Some graph commands—for example, HISTOGRAM C1 C2 C3—generate more than one graph. If you include
the GSAVE subcommand with such a command, Minitab saves multiple files. Minitab gives each file a different
file name. Minitab uses the first five characters of the name you specify, then appends a number (001, 002,

and so on), for up to 300 files.

JPEG
JPEG color

PNGB
PNG grayscale

PNGC
PNG color

TIFB
TIF grayscale

TIF
TIF color

BMPB
BMP grayscale

BMPC
BMP color

GIF
GIF

EMF
EMF

RESOLUTION K
Saves the graph at a resolution of K dots per inch.

ANOVA: Session command for performing a
balanced ANOVA

ANOVA C...C
Performs univariate and multivariate analysis of variance.

For one-way analysis of variance, you can have unbalanced designs. For multi-way analysis of variance, you must
have balanced designs (all cells must have the same number of observations). The command GLM on page 227
analyzes balanced and unbalanced designs. However, if your design is balanced, ANOVA is faster and requires
less space.

Factors can be crossed or nested, fixed or random. ANOVA calculates all exact F-tests, displays expected mean
squares, and estimates variance components. You can specify your own tests, store residuals and fitted values,
and display cell and marginal means. You can analyze up to 50 response variables and up to 9 factors on one
ANOVA command.
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Minitab verifies that your model is valid and displays a message if it is not. Minitab also verifies that your data set
is balanced.

Note Balanced data are not required for one-factor models.

If you do not use the subcommand RANDOM, ANOVA fits a fixed effect model. In this case, the F-statistic for a
term is always (MS term) / (MSE). However, when some of your factors are random, the denominator of an F-test,
in general, is not MSE. For more information, see the subcommands RANDOM and EMS.

You can use the subcommands MANOVA, SSCP, EIGEN, PARTIAL, and NOUNIVARIATE to do multivariate analysis
of variance. Hotelling's T-squared test can be performed as a special case of ANOVA with MANOVA.

ANOVA can analyze very complex designs, but, if you have a simple model, ANOVA is very easy to use.

Fore more information, go to How to specify the model in ANOVA on page 1169 and How to enter data for ANOVA
and GLM on page 1158.

Model

RANDOM C...C
Specifies which factors are random. Do not include interaction terms or nested factors. If at least one factor in an
interaction term is random, then Minitab considers the term to be random. Any term that is nested within a
random factor is considered random.

RESTRICT
There are two mixed model analysis of variance models: one requires the crossed, mixed terms to sum to 0 over
subscripts that correspond to fixed effects (Minitab refers to this as the restricted model.), and the other does
not. Most textbooks and BMDP's program 8V use the restricted model. SAS uses the unrestricted model.

By default, ANOVA fits the unrestricted model. This subcommand instructs the program to fit the restricted model,
which assumes that the mixed interaction terms are restricted to sum to 0 over the fixed effects. For more
information, go to Restricted and unrestricted mixed models on page 1144.

Results

EMS
Displays a table that contains expected mean squares, estimated variance components, and the error term (the
denominator) used in each exact F-test. If no exact F-test for a term exists, then use the expected mean squares
to determine how to construct an approximate F-test using the subcommand TEST.

The estimates of the variance components are the usual unbiased analysis of variance estimates. They are obtained
by setting each calculated MS equal to its EMS. This gives a system of linear equations in the unknown variance
components. This system is then solved. Unfortunately, this method can result in negative estimates, which should
be set to 0. However, Minitab displays the negative estimates because they sometimes indicate that the model
that is being fit is inappropriate for the data.

Terms that are fixed do not have variance components estimated.

MEANS termlist
Displays a table of means corresponding to each term listed. For example, the following command language
displays four tables, one table for each main effect, A, B, D, and one for the three-way interaction, A*B*D.

ANOVA Y = A|B|C(A B) |D;
MEANS A B D A*B*D

Minitab =’ 225



Minitab Statistical Software ANOVA

Terms listed on the MEANS statement must also be terms listed in the model. If you specify more than one MEANS
subcommand, then Minitab uses the last one. For more information, go to How to specify the model in ANOVA
on page 1169.

TEST termlist / errorterm
Calculates univariate F-tests. Termlist is a list of terms in the model. Each term is used as the numerator in a test.
Errorterm is a term in the model to be used as the denominator in all the test. Alternatively, errorterm can be a
linear combination of terms in the model and MSE (denoted by the reserved word ERROR). Minitab calculates the
F-ratios and p-values for you. Here are two examples.

TEST A/A*B + A*C + B*C - 2*A*B*C - 2*ERROR

TEST A B/A*B

Minitab constructs the synthetic denominator MS for the F-test. This denominator is the linear combination of
the MSs that are specified on TEST, and should have the same expectation as the numerator MS under the
hypothesis being tested. Suppose the denominator is the linear combination:

23 Ms,

Then it has approximate degrees of freedom calculated by

¥a s ?
OF (denominatar) =Z[E+s]j]ﬂ_‘3_1:]

where DF; is the degrees of freedom for the term MS,. For more information, go to Restricted and unrestricted
mixed models on page 1144.

Storage

FITS C...C
Stores fitted values, using one column for each response. If you specify a full model (you include all interaction
terms), then the fitted values are just the cell means. If you fit a reduced model, the fitted values are not the cell
means, but are the sum of the least squares estimates of the effects in the model.

RESIDUALS C...C
Stores residuals, using one column for each response variable. Residual = (response — fit).

Graphs

GHISTOGRAM
Displays a histogram of the residuals.

GNORMAL
Displays a normal probability plot of the residuals.

GFITS
Plots the residuals versus the fitted values.

GORDER
Plots the residuals versus the order of the data. The row number for each data point is shown on the x-axis ( for
example, 12 3 4..n).
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GFOURPACK
Displays a layout of a histogram of the residuals, a normal probability plot of the residuals, residuals vs fitted
values, and residuals vs order of the data.

GVARIABLE C...C
Displays a separate graph for the residuals versus each specified column.

Balanced MANOVA

MANOVA [termlist [ / errorterm]]
Performs four multivariate tests—Wilks' test, Lawley-Hotelling test, Pillai's test, and Roy's largest root test—for
each term in the model. If you include a termlist, MANOVA performs the four multivariate tests for each term
listed. Hotelling's T-squared test can be performed as a special case of ANOVA with MANOVA.

If you specify an errorterm, then it must be a single term that is in the model. MANOVA then uses this errorterm
in all tests. If you do not specify an errorterm, then Minitab determines an appropriate errorterm, as in the univariate
case.

All four tests are based on two SSCP (sums of squares and cross products) matrices: H = the hypothesis matrix
and E = the error matrix. There is one H associated with each term in termlist. E is the matrix associated with the
error for the test.

SSCP
Displays the hypothesis matrix, H, that corresponds to each term that is specified by MANOVA, and the error
matrix, E.

EIGEN
Displays a table that contains the eigenvalues and eigenvectors for the (nonsymmetric) matrix, E-1 H. These are
the eigenvalues that are used to calculate the four MANOVA tests. A separate table is displayed for each term
that is specified on MANOVA.

Note If an eigenvalue is repeated, then the corresponding eigenvectors are not unique. In this case, the eigenvectors that Minitab
displays and those in books or other software might not agree. However, the MANOVA tests are always unique.

PARTIAL
Displays a matrix of partial correlations. These are the correlations among the residuals or, equivalently, the
correlations among the responses conditioned on the model. The formula for the matrix is W**-.5 E W**-5, where
E is the error matrix and W has the diagonal of E as its diagonal and Os elsewhere.

NOUNIVARIATE
Suppresses the univariate output. Only the multivariate output is displayed.

GLM: Session command for fitting the general linear
model

GLM
Fits the general linear model (GLM). Using GLM, you can perform analysis of variance with balanced and unbalanced
designs, analysis of covariance, and regression.
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Factors can be crossed or nested, fixed or random. Covariates can be crossed with each other or with factors, or
nested within factors. You can store residuals, fitted values, and many other diagnostics, and display cell and
marginal means.

GLM does tests for fixed effects models automatically. The TEST subcommand allows you to calculate the
appropriate univariate F-tests for mixed models.

Output contains both the sequential sums of squares and the adjusted sums of squares (that is, each term is fit
after all other terms in the model). Automatic tests are done using the adjusted SS, assuming all factors are fixed.
Observations that are considered unusual are displayed. You can also display coefficients, along with their standard
deviations and t-values, and cell and marginal means.

Calculations are performed using a regression approach. First a "full rank" design matrix is formed from the factors
and covariates. The columns of the design matrix are used as predictors. Then each response variable is regressed
on these columns.

You can store the residuals, fitted values, prediction and confidence intervals, and many other diagnostics for
further analysis.

For more information, go to How to specify the model for GLM on page 1167 and How to enter data for ANOVA
and GLM on page 1158.

Options

RESPONSE C
Specifies the column that contains the response variable. The column must be numeric or date/time.

CONTINUOUS C...C
Specifies the continuous predictors if you have any. The column or columns must be numeric or date/time and
must match the length of the response column.

CATEGORICAL C...C
Specifies the categorical predictors if you have any. The column or columns can be numeric, text, or date/time
and must match the length of the response column.

TERMS termlist
Specifies the model terms. Terms must be legal cross-terms. Only continuous predictors may be repeated. Nested
terms are not entered in the term list. The model can be nonhierarchical when there are no random factors.

RANDOM C...C
Specifies random factors. Random factors must also be specified in CATEGORICAL.

NESTED C (C...), ..., C (C...C)
Specifies the nesting relationships. Parentheses are used for nesting. For example, when B is nested within A, use
B (A), and when C is nested within both A and B, use C (A, B). Terms in parentheses are always factors in the model
and are listed with commas between them. Thus, D (A, B, E) is correct but D (A*B E) and D (A*B*E) are not. Also,
parentheses are not used inside parentheses. Thus, C (A, B) is correct but C (A, B (A)) is not.

WEIGHT
Performs a weighted regression. Weights cannot be used with optimal Box-Cox transformation. Column must be
numeric with nonnegative values. Length must match response column length.

An n x n matrix W is formed with the column of weights as its diagonal and zeros elsewhere. The regression
coefficients are estimated by:

(X'WX) " (X' WY)
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This is equivalent to minimizing the weighted SS Error:
Zw; (Y ~%)? where w; is the weight in row i

CONFIDENCE K

Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of Kis 95.

ITYPE K
Specifies the type of confidence interval.

Value of K Type of confidence interval
-1 Lower bound
0 (default) Two-sided
1 Upper bound
TOLER K

Specifies the tolerance level for collinearity and constant check. Use to force Minitab to keep a predictor in the
model which is either highly correlated with another predictor or nearly constant. The default k = 4*2.22E-16.

SSQUARES
Specifies sequential sum of squares for tests in the ANOVA table. The default is the adjusted sums of squares.

MEANS termlist
Calculates least squares means for specified terms. Terms must be in the model.

TEST termlist / error term

Use TEST to specify your own tests. Termlist is a list of terms in the model. List them exactly as on the TERMS
subcommand. Error term is the term to be used as the denominator for the F-test. This can be a term in the model|,
a linear combination of terms in the model, or MSE (denoted by the word ERROR). Only available via command
line.

EFFECT

Specifies the effect coding (-1, 0, +1) scheme for categorical predictors. If you do not specify either EFFECT or
BINARY, then Minitab uses the preferences set in File > Options > Linear Models > Coding of Predictors.

BINARY

Specifies the binary coding (1, 0) scheme for categorical predictors. If you do not specify either EFFECT or BINARY,
then Minitab uses the preferences set in File > Options > Linear Models > Coding of Predictors.

REFERENCE C K...C K

Changes the default coding for the categorical predictor columns. To change the default reference factor level,
specify the factor column followed by the reference level. (You must enclose text and date/time levels in double
quotes.) You can assign a reference level only when you use the binary coding (1, 0) scheme.

Options for standardizing the continuous predictor

Use this set of subcommands to standardize the continuous predictors in your model. You can use SCALE and LOCATION
in conjunction with each other. LEVELS is mutually exclusive with the LOCATION and SCALE subcommands. If you do
not specify LOCATION, SCALE, LEVELS, or UNSTANDARDIZED, then Minitab uses the preferences set in File > Options
> Linear Models > Coding of Predictors.
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LOCATION [K...K]
Specifies that the analysis is to be performed on coded continuous predictors by subtracting a constant from
each predictor. If you do not specify any arguments, the mean of each predictor column is subtracted. K specifies
to subtract a constant. If you specify arguments, the number of arguments must match the number of continuous
predictors.

SCALE [K...K]
Specifies that the analysis is to be performed on coded continuous predictors by dividing each predictor by a
constant. If you do not specify any arguments, each predictor column is divided by the standard deviation. K
specifies to divide by a constant. If you specify arguments, the number of arguments must match the number of
continuous predictors.

LEVELS [K...K]
Specifies that the analysis is to be performed on coded continuous predictors by DOE-type coding for the specified
low and high levels K K...K K. The number of arguments must be twice the number of continuous predictors.

UNSTANDARDIZED
Specifies the analysis is to be performed on the original predictors.

Box-Cox

BOX-COX [K]
Performs a Box-Cox transformation with a specified lambda. K is the value of lambda and must be between -5
and +5. If K is not given, Minitab will find the optimal lambda. By default, Minitab rounds the optimal value.

Minitab cannot calculate the optimal lambda for stepwise regression or when the model contains random factors.
Consequently, you must specify a lambda value for BOXCOX if you use RANDOM, STEPWISE, FORWARD, or
BACKWARD.

Stepwise

FINFORMATION, STEPWISE, FORWARD, and BACKWARD perform a stepwise regression procedure to fit the model. No
arguments are needed for these subcommands.

FINFORMATION
Specifies a stepwise model selection procedure that uses forward information criteria selection. Use AICCORRECTED
or BICRITERION to specify which information criterion to use to select the final model. If you do not specify a
criterion, Minitab uses AICCORRECTED.

The forward information criteria procedure adds the term with the lowest p-value to the model at each step. If
you do not include subcommands about hierarchy, FINFORMATION adds 1 term at a step and maintains model
hierarchy, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.
Minitab calculates the information criteria for each step.

In most cases, the procedure continues until one of the following conditions occurs:

e The procedure does not find a new minimum of the criterion for 8 consecutive steps.

e The procedure fits the full model.

e The procedure fits a model that leaves 1 degree of freedom for error.

If you specify settings for the procedure that require a hierarchical model at each step and allow only one term

to enter at a time, then the procedure continues until it either fits the full model or fits a model that leaves 1
degree of freedom for error. Minitab displays the results of the analysis for the model with the minimum value
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of the selected information criterion, either the corrected Akaike's Information Criterion (AlCc) or the Bayesian
Information Criterion (BIC).

AICCORRECTED
Specifies the use of the corrected Akaike's Information Criterion (AlCc) to select the final model.

BICRITERION
Specifies the use of the Bayesian Information Criterion (BIC) to select the final model.

STEPWISE

Specifies a stepwise model selection procedure that uses both forward selection and backward elimination. If you
do not include subcommands about hierarchy, STEPWISE and FORWARD add 1 term at a step and maintain model
hierarchy, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

FORWARD
Specifies a stepwise model selection procedure that uses forward selection. If you do not include subcommands
about hierarchy, STEPWISE and FORWARD add 1 term at a step and maintain model hierarchy, the equivalent of
the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

BACKWARD
Specifies a stepwise model selection procedure that uses backward elimination. Removes a single term at each
step and maintains a hierarchical model, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS.

AENTER K
Specifies the alpha level at which a term is entered into the model. The default is 0.15 for STEPWISE and 0.25
for FORWARD.

AREMOVE K
Specifies the alpha level at which a term is removed from the model. The default is 0.15 for STEPWISE and
0.10 for BACKWARD. For STEPWISE, K must be greater than or equal to K for AENTER.

ENTER termlist
Specifies the terms that are contained in the starting model for STEPWISE. The ENTER termlist must be a
subset of the TERMS termlist or in the default term list in the design.

FORCE termlist
Specifies the terms to be forced in the model. The FORCE termlist must be a subset of the TERMS termlist
or in the default term list in the design.

NOHIERARCHICAL
Specifies that the model selection procedure does not consider hierarchy.

HIERARCHICAL
Maintains a hierarchical model in stepwise regression. In a hierarchical model, if a higher-order term is
included, all lower-order terms that comprise the higher-order term also appear in the model. For example,
a model that includes the interaction term A*B*C is hierarchical if it includes the following main effects and
lower-order interactions: A, B, C, A*B, A*C, and B*C.

CATONLY
Specifies that only the categorical terms in the model have to be hierarchical.
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ALLTERMS
Specifies that both categorical and continuous terms have to be hierarchical.

ATEND
Specifies that the final step of the stepwise procedure adds terms to make the model hierarchical.

ALWAYS
Specifies that the model is hierarchical at every step.

SINGLE

Specifies that only one term can enter the model at each step. So a higher-order term can enter
the model only if the terms that comprise the term are already in the model. For example, the
algorithm does not consider the addition of A*B unless A and B are already in the model.

BACKWARDS does not use SINGLE or MULTIPLE because terms only exit the model.

MULTIPLE

Specifies that multiple terms can enter the model at each step. So a higher order term can enter
the model, and the terms that comprise the term enter the model at the same time. For example,
if A*B is the most statistically significant term, A*B enters the model. At the same time, A and B
enter the model if those terms are not in the model already.

BACKWARDS does not use SINGLE or MULTIPLE because terms only exit the model.

Graphs

RTYPE K
Specifies the type of residual to plot with the graph subcommands.

Value of K Type of residuals

1 (default) Regular or raw residuals (RESIDUALS)

2 Standardized residuals (SRESIDUALS)

3 Deleted Studentized residuals (TRESIDUALS)
GHISTOGRAM

Displays a histogram or individual value plot of the residuals, depending on the sample size.

GNORMAL
Displays a normal probability plot of the residuals.

GFITS
Plots the residuals versus the fitted values.

GFOURPACK

Displays a layout of a histogram of the residuals, a normal probability plot of the residuals, residuals vs fitted
values, and residuals vs order of the data.

GORDER

Plots the residuals versus the order of the data. The row number for each data point is shown on the x-axis (for
example, 12 3 4..n).
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GVARIABLE C...C
Displays a separate graph for the residuals versus each specified column.

Results

NODEFAULT
Specifies that no default tables and graphs will be displayed.

TMETHOD
Displays the method table.

TFACTOR
Displays the name, number of levels, and the values for all categorical factors in your model.

TMSDETAILS

Displays the type of stepwise procedure and the alpha values to enter and/or remove a predictor from the model.
If you do not specify FULL or NOFULL, then Minitab uses the preferences set in File > Options > Linear Models
> Stepwise.

FULL
Displays the coefficients, p-values, Mallows' Cp, and model summary statistics for each step of the procedure.

NOFULL
Hides these statistics.

TEQUATION
Displays the regression equation table. Minitab will display up to 50 equations. If you do not specify SINGLE or
SEPARATE, Minitab uses the preferences set in File > Options > Linear Models > Display of Results.

SINGLE

If you want to view a single equation, rather than a separate equation for each factor level combination, use
SINGLE.

SEPARATE
To view the separate equations, use SEPARATE.

TCOEFFICIENTS
Displays the table of coefficients. If you do not specify FULL or NOFULL, Minitab uses the preferences set in File
> Options > Linear Models > Display of Results.

FULL
Displays the complete set of coefficients for categorical predictors.

NOFULL
Displays only the linearly independent coefficients.

TSUMMARY
Displays the summary of model table.

TANOVA
Displays the ANOVA table.
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TDIAGNOSTICS K

Displays a table of diagnostics. K = 0 displays diagnostics for only unusual observations. K = 1 displays diagnostics
for all observations.

TDW
Displays Durbin-Watson statistics.

TEXPAND

Displays the expanded version of the ANOVA table, table of coefficients, model summary table, and table of
unusual observations.

TSIMPLE
Displays the simple version of the ANOVA table, table of coefficients, model summary table, and table of unusual
observations.

TEMS
Displays the table of expected mean squares, estimated variance components, and error term in each F-test.

TMEANS
Displays the table of least squares means.

TVARIANCE
Displays the table of variance components.

TTEST
Displays the table of your own tests.

Storage for Box-Cox

BCRESP
Stores the Box-Cox transformation of the response in C.

BFITS
Stores the fits for the original response.

BSMEANS
Stores the means for the original response.

Storage of fits and residuals

RESIDUALS
Stores the residuals (fitted values — observed values).

SRESIDUALS
Stores the standardized residuals.

TRESIDUALS
Stores the deleted Studentized residuals.

HI
Stores the leverages.
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COOK
Stores Cook's distance.

DFITS
Stores DFITS.

Storage of characteristics of the estimated equation

COEFFICIENTS
Stores the estimated coefficients.

FITS
Stores the fitted values, often called the Y-hats (7).

SMEANS
Stores the least square means for the terms specified by MEANS.

XMATRIX
Stores the design matrix for regression model.

REML: Session command for fitting a mixed effects
model

REML

By default, fits a model with random factors with the Restricted Maximum Likelihood method (REML). Using REML,
you can perform analysis of variance on random factors with balanced or unbalanced designs. With the
subcommand MLE, you can use maximum likelihood estimation.

For REML, at least 1 factor must be random. Other factors can be fixed or random. Covariates can be crossed with
each other, with factors, or nested within factors. You can store residuals, fitted values, and other diagnostic
statistics.

REML tests for fixed effects with either the Kenward-Roger approximation or the Satterthwaite approximation.
To use the Satterthwaite approximation, use the subcommand SATTERTHWAITE. To show the tests, use the
subcommand TFIXEDEFFECT.

Tests use the adjusted sums of squares. Observations with standardized residuals that have absolute values greater
than 2 are in a table of unusual observations. to show the table, use the subcommand TDIAGNOSTICS.

REML has 4 required subcommands:
e RESPONSE

e RANDOM

e CATEGORICAL

e TERMS

For more information, go to the descriptions of the individual subcommands.
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Options

RESPONSE C
Specifies the column that contains the response variable. The column must be numeric or date/time.

CATEGORICAL C...C
Specifies the categorical predictors if you have any. The column or columns can be numeric, text, or date/time
and must match the length of the response column.

CONTINUOUS C...C
Specifies the continuous predictors if you have any. The column or columns must be numeric or date/time and
must match the length of the response column.

RANDOM C...C
Specifies random factors. Random factors must also be specified in CATEGORICAL. At least one factor must be
random.

NESTED C (C...), ..., C (C...C)
Specifies the nesting relationships. Parentheses are used for nesting. For example, when B is nested within A, use
B (A), and when C is nested within both A and B, use C (A, B). Terms in parentheses are always factors in the model
and are listed with commas between them. Thus, D (A, B, E) is correct but D (A*B E) and D (A*B*E) are not. Also,
parentheses are not used inside parentheses. Thus, C (A, B) is correct but C (A, B (A)) is not.

TERMS termlist
Specifies the model terms. Terms must be legal cross-terms. Only continuous predictors may be repeated. Nested
terms are not entered in the term list. The model can be nonhierarchical.

WEIGHT C
Performs a weighted regression. Weights cannot be used with optimal Box-Cox transformation. Column must be
numeric with nonnegative values. Length must match response column length.

An n x n matrix W is formed with the column of weights as its diagonal and zeros elsewhere. The regression
coefficients are estimated by:

(XWX ' XWY)
This is equivalent to minimizing the weighted SS Error:

Tw (Y ~%)? where w; is the weight in row |

REML
Specifies to use the restricted maximum likelihood estimation method to estimate the variance components.

MLE
Specifies to use the maximum likelihood method to estimate the variance components. Usually, you use the REML
method

MAXITER K
Specifies the maximum number of iterations for the Newton-Raphson algorithm to estimate the variance
components.

STARTING C...C or K...K
Specifies the starting estimates for the variance components for each response in C. The order of the values in
each column must be the same order of the random terms in TERMS. The last value in C is for the error term. If
you have only one response or you want to use the same starting estimates for all responses, you can enter
numbers K...K.
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CTOLERANCE K
Specifies the convergence tolerance value in K for the objective function. The objective function is -2 log likelihood.

ETOLERANCE K
Specifies the convergence tolerance value in K for the estimates of the variance components.

KENWARDROGER
Use Kenward-Roger approximation to estimate the denominator degrees of freedom for the fixed effect tests.

SATTERTHWAITE
Use Satterthwaite approximation to estimate the denominator degrees of freedom for the fixed effects.

DROWSTAT
Computes statistics that require row deletion:

e PRESS

e R-Sq(Pred)

e Cook'sD

e DFITS

e Marginal deleted residuals

e Marginal conditional residuals

CONFIDENCE K

Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of K'is 95.

ITYPE K
Specifies the type of confidence interval.

Value of K Type of confidence interval
-1 Lower bound

0 Two-sided

1 Upper bound

TOLERANCE K [K]

Specifies the tolerance level for the collinearity between variables and whether a variable is constant. The first K
specifies the tolerance for collinearity. The default value is 1E-18. The second K is for the tolerance for whether

a variable is constant. The default value is TE-21. Lower the tolerance to keep variables in the model that Minitab
would exclude with the default values.

MEANS termlist
Calculates least squares means for specified terms. Terms must be in the model.

Options for standardizing the continuous predictor

Use this set of subcommands to standardize the continuous predictors in your model. You can use SCALE and LOCATION
in conjunction with each other. LEVELS is mutually exclusive with the LOCATION and SCALE subcommands. If you do
not specify LOCATION, SCALE, LEVELS, or UNSTANDARDIZED, then Minitab uses the preferences set in File > Options
> Linear Models > Coding of Predictors.
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LOCATION [K...K]

Specifies that the analysis is to be performed on coded continuous predictors by subtracting a constant from
each predictor. If you do not specify any arguments, the mean of each predictor column is subtracted. K specifies
to subtract a constant. If you specify arguments, the number of arguments must match the number of continuous
predictors.

SCALE [K...K]
Specifies that the analysis is to be performed on coded continuous predictors by dividing each predictor by a
constant. If you do not specify any arguments, each predictor column is divided by the standard deviation. K
specifies to divide by a constant. If you specify arguments, the number of arguments must match the number of
continuous predictors.

LEVELS [K...K]
Specifies that the analysis is to be performed on coded continuous predictors by DOE-type coding for the specified
low and high levels K K...K K. The number of arguments must be twice the number of continuous predictors.

UNSTANDARDIZED
Specifies the analysis is to be performed on the original predictors.

Graphs

RTYPE K
Specifies the type of residual to plot with the graph subcommands.

Value of K Type of residuals

1 (default) Regular or raw residuals (RESIDUALS)

2 Standardized residuals (SRESIDUALS)

3 Deleted Studentized residuals (TRESIDUALS)
CONDITIONAL

Specifies to plot residuals for conditional fits.

MARGINAL
Specifies to plot residuals for marginal fits.

GHISTOGRAM
Displays a histogram or individual value plot of the residuals, depending on the sample size.

GNORMAL
Displays a normal probability plot of the residuals.

GFITS
Plots the residuals versus the fitted values.

GFOURPACK

Displays a layout of a histogram of the residuals, a normal probability plot of the residuals, residuals vs fitted
values, and residuals vs order of the data.

GORDER
Plots the residuals versus the order of the data. The row number for each data point is shown on the x-axis (for
example, 12 3 4..n).
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GVARIABLE C...C
Displays a separate graph for the residuals versus each specified column.

Tables

NODEFAULT
Specifies that no default tables and graphs will be displayed.

TEXPAND

Displays the expanded version of the variance components table, the table of coefficients, the random effect
predictions table, the table of fits and diagnostics, and the table of conditional means.

TSIMPLE
Displays the simple version of the variance components table, the table of coefficients, the random effect predictions
table, the table of fits and diagnostics, and the table of conditional means.

TMETHOD
Displays the method table.

TFACTOR
Displays the name, number of levels, and the values for all categorical factors in your model.

TITERATION
Displays the iteration history table that shows the value of -2 log likelihood for each iteration of the variance
components.

TVARIANCE
Displays the variance component estimates and the tests of whether the components are 0.

TCOVARIANCE
Display the asymptotic variance-covariance matrix of the variance component estimates.

TFIXEDEFFECT
Display tests of the fixed factors in the model.

TSUMMARY
Display S, R? and Rz(adj). The expanded version of the table adds AlCc and BIC.

TCOEFFICIENTS

Displays the table of coefficients for fixed factors and covariates. If you do not specify FULL or NOFULL, Minitab
uses the preferences set in File > Options > Linear Models > Display of Results.

FULL
Displays the complete set of coefficients for categorical predictors.

NOFULL
Displays only the linearly independent coefficients.

TRANDOM
Displays the Best Unbiased Linear Predictions (BLUP) and tests of whether the BLUP are 0.

TEQUATION

Displays the marginal fitted equation. Minitab will display up to 50 equations. If you do not specify SINGLE or
SEPARATE, Minitab uses the preferences set in File > Options > Linear Models > Display of Results.
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SINGLE

If you want to view a single equation, rather than a separate equation for each factor level combination, use
SINGLE.

SEPARATE
To view the separate equations, use SEPARATE.

TCEQUATION
Displays the conditional fitted equation. Minitab will display up to 50 equations. If you do not specify SINGLE or
SEPARATE, Minitab uses the preferences set in File > Options > Linear Models > Display of Results.

SINGLE

If you want to view a single equation, rather than a separate equation for each factor level combination, use
SINGLE.

SEPARATE
To view the separate equations, use SEPARATE.

TDIAGNOSTICS K

Displays a table of diagnostics for the marginal fits and residuals. K = 0 displays diagnostics for only unusual
observations. K = 1 displays diagnostics for all observations.

TCONDITIONAL K
Displays a table of diagnostics for the conditional fits and residuals. K = 0 displays diagnostics for only unusual
observations. K = 1 displays diagnostics for all observations.

TMEANS
Displays the table of least squares means.

Storage

RESIDUALS C
Stores the residuals for the marginal fits.

SRESIDUALS C
Stores the standardized residuals for the marginal fits.

TRESIDUALS C
Stores the deleted t residuals for the marginal fits.

FITS C
Stores the marginal fitted values.

CRESIDUALS C
Stores the conditional residuals.

CSRESIDUALS C
Stores the standardized residuals for the conditional fits.

CTRESIDUALS C
Stores the deleted t residuals for the conditional fits.

CFITS C
Stores the conditional fitted values.
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HI C
Stores the leverages.

COOK C
Stores Cook's distance.

DFITS C
Stores DFITS.

COEFFICIENTS C
Stores the estimated coefficients.

BLUP C
Stores the best linear unbiased predictors.

XMATRIX M
Stores the design matrix for fixed effects terms.

ZMATRIX M
Stores the design matrix for random effects terms.

COVARIANCE M
Stores the variance-covariance matrix of the variance component estimates.

SMEANS C
Stores the least square means for the terms specified by MEANS.

VARCOMP C
Stores the estimates of the variance components in the same order as the terms appear after TERMS.

LOGLIKE C
Stores the -2 log likelihood values for all iterations.

FIXCOV M
Stores the variance-covariance matrix of the fixed parameters.

COMPARE: Session command for performing
multiple comparisons of means

COMPARE C

Generates comparisons based on a model from a general linear model or from a mixed effects model for response
C.

If you have a general linear model or a mixed effects model stored in the worksheet, you can use COMPARE to
obtain multiple comparisons of means. Multiple comparisons of means allow you to examine which means are
different and to estimate by how much they are different.

You have the following choices when using multiple comparisons:
e All pairwise comparisons or comparisons with a control

e Which means to compare
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e The method of comparison

e How to display the results

Pairwise comparisons or comparison with a control
Use PAIRWISE when you do not have a control level but you would like to examine which pairs of means are different.

Use MCONTROL when you are comparing treatments to a control. When this method is suitable, it is inefficient to use
the all-pairwise approach, because the all-pairwise confidence intervals will be wider and the hypothesis tests less
powerful for a given family error rate.

Which means to compare

To specify which means to compare, enter terms from the model in the termslist for PAIRWISE or MCONTROL. If you
have 2 factors named A and B, entering A B will result in multiple comparisons within each factor. Entering A * B will
result in multiple comparisons for all level combinations of factors A and B.

The multiple comparisons method

You can choose from among four methods for both pairwise comparisons and comparisons with a control. Each
method provides simultaneous or joint confidence intervals, meaning that the confidence level applies to the set of
intervals computed by each method and not to each one individual interval. By protecting against false positives with
multiple comparisons, the intervals are wider than if there were no protection.

Some characteristics of the multiple comparison methods are summarized below. "Conservative" in this context indicates
that the true family error rate is less than the stated one.

Comparison method Properties

Dunnett Comparison to a control only, not proven to be conservative
Tukey All pairwise differences only, not proven to be conservative
Bonferroni Most conservative

Sidak Conservative, but slightly less so than Bonferroni

Fisher's LSD Does not control the family error rate

Display results

Minitab can present multiple comparison results in the following forms:
e TGROUPING displays the grouping information table that highlights the significant and non-significant comparisons.
e TMTEST displays the hypothesis test form which includes the adjusted p-values.

e GINTPLOT displays the interval plots of the confidence the intervals for the mean difference between two groups.

Conditions that restrict comparisons for general linear models

For general linear models, comparisons cannot be done in the following situations:
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e Comparisons are not available for terms that contain or interact with random factors. Nesting is a form of interaction.
For a model with random factors, you can do comparisons if you use a mixed effects model with the Restricted
Maximum Likelihood estimation method (REML). Suppose the model contains A B C A*B, where both A and C are
random, and B is fixed. Because A*B is a term in the model, no multiple comparison results for B are available even
though B is a fixed factor. However, if the model does not include A*B, multiple comparison results are available
for B.

There is a special case for a balanced design that has two factors. Suppose the model contains A B A*B, where A
is random, and B is fixed. Even though A*B is in the model, you can perform multiple comparisons for B.

e Comparisons is disabled if you choose (1, 0) coding and the model is non-hierarchical. To enable Comparisons
for this case, choose (-1, 0, +1) coding or specify a hierarchical model.

Commands

CONFIDENCE K
Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of K is 95.

PAIRWISE [termlist}
Specifies pairwise comparisons using the terms in the termlist. The terms in the termlist must be in the model.

You must use at least one of the following sub-subcommands with PAIRWISE:
TUKEY

BONFERRONI
SIDAK
FISHER

MCONTROL [termlist]
Specifies comparisons with a control using the terms in the termlist. The terms in the termlist must be in the
model.

You must use at least one of the following sub-subcommands with PAIRWISE:
DUNNETT

BONFERRONI
SIDAK
FISHER

LEVELS C K...C K
You must use LEVELS with MCONTROL. Use LEVELS to provide a factor (C) with a control level (K). You must
specify a control level for each factor that you listin MCONTROL. If these levels are text or date/time, enclose
each with double quotation marks.

ALTERNATIVE K
ALTERNATIVE specifies the alternative hypothesis for comparisons to the control level.

Value of K Alternative hypothesis
-1 Determines whether the treatment means are less than the control mean
0 Determines whether the treatment means are equal to the control mean
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Value of K Alternative hypothesis
1 Determines whether the treatment means are greater than the control mean
GINTPLOT

Displays interval plots that represent the confidence interval for the mean difference between two groups. A
separate graph is created for each comparison.

TGROUPING

Displays the grouping information table for each comparison. This table highlights the significant and non-significant
comparisons for each selected comparison method.

TMTEST
Displays the multiple comparison test table. This table displays the hypothesis test form of the comparison output,
which includes the differences of the means, the numeric values for the confidences intervals, and the adjusted
p-values.

MANOVA: Session command for performing a
general MANOVA

MANOVA C...C = C...C

Performs a general MANOVA. The columns specified before the equal sign are the responses, and the columns
after the equal sign are the factors.

Use general MANOVA to perform multivariate analysis of variance (MANOVA) with balanced and unbalanced
designs, or if you have covariates. This procedure takes advantage of the data covariance structure to simultaneously
test the equality of means from different responses.

Calculations are done using a regression approach. A full rank design matrix is formed from the factors and
covariates and each response variable is regressed on the columns of the design matrix.

Factors can be crossed or nested, but they cannot be declared as random. You can work around this restriction
by specifying the error term to test model terms. Covariates can be crossed with each other or with factors, or
nested within factors. You can analyze up to 50 response variables with up to 31 factors and 50 covariates at one
time.

With the MANOVA subcommand, you can specify model terms for a custom multivariate test and designate the
error term in Error. Minitab performs four multivariate tests (see the MANOVA subcommand) for those terms.
This option is most useful when you have factors that you consider as random factors. Model terms that are
random or that are interactions with random terms may need a different error term than general MANOVA
supplies. You can determine the appropriate error term by entering one response variable with General Linear
Model, choose to display the expected mean square, and determine which error term was used for each model
terms.

If you specify an error term, it must be a single term that is in the model. This error term is used for all requested
tests. If you have different error terms for certain model terms, enter each separately and exercise the general
MANOVA dialog for each one. If you do not specify an error term, Minitab uses MSE.

For more information, go to How to specify the model for GLM on page 1167 and How to enter data for ANOVA
and GLM on page 1158.
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Model

MANOVA [termlist [ / errorterm]]
Performs four multivariate tests—Wilks' test, Lawley-Hotelling test, Pillai's test, and Roy's largest root test—for
each term in the model. If you include a termlist, MANOVA does the four multivariate tests for each term listed.

If you specify an errorterm, it must be a single term that is in the model. MANOVA then uses this errorterm in all
tests. If you do not specify an errorterm, Minitab uses the error associated with MSE, as in the univariate case.

All four tests are based on two SSCP (sums of squares and cross products) matrices: H = the hypothesis matrix
and E = the error matrix.

If an error term is not specified on MANOVA, then the adjusted SSCP matrix is used for H and the SSCP matrix
associated with MSE is used for E. If an error term is specified on MANOVA, the sequential SSCP matrices associated
with H and E are used. Using sequential SSCP matrices guarantees that H and E are statistically independent.

COVARIATES C...C
The columns listed are used as covariates. If COVARIATES is used, it must be the first subcommand. This restriction
is needed to allow proper error checking. You may have up to 50 covariates.

Options

WEIGHTS C
Performs a weighted least squares fit. The weights must be greater than or equal to zero. An n x n matrix W is
formed with the column of weights as its diagonal and zeros elsewhere. The regression coefficients are calculated
by (X' WX)™" (X' WY).

This is equivalent to minimizing the weighted SS Error:

Zw(Y-YP

PREDICT

Computes the fitted Y's, or ¥ for given values of the predictors. PREDICT displays a table that contains the fitted
Y's, standard errors of the fitted Y's, a 95% confidence interval, and a 95% prediction interval. E...E may be a list
of values, one for each predictor, a list of columns, one for each predictor, or a mix of values and columns.

The prediction interval computed by PREDICT assumes a weight of 1. If you used the WEIGHT subcommand with

values other than 1, you should adjust the prediction interval values manually.

CONFIDENCE K
Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default
value of K is 95.

PFITS C
Stores the fits.

PSDFITS C
Stores the estimated standard errors of the fits.

CLIMITS CC, ..., CC
Stores the lower and upper confidence limits.

PLIMITS CC, ..., CC
Stores the lower and upper prediction limits.
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TEST termlist / errorterm
Use TEST to specify your own tests. Termlist is a list of terms in the model. List them exactly as on the MANOVA
subcommand. Error term is the term to be used as the denominator for the F-test. This can be a term in the model|,
a linear combination of terms in the model, or MSE (denoted by the word ERROR). Only available via command
line.

TOLERANCE K [K]
Use TOLERANCE to force Minitab to keep a predictor in the model which is either highly correlated with another
predictor or which is nearly constant. Lowering tolerance by giving very small argument values can prevent Minitab
from eliminating problematic predictor columns from the model.

K Description

First K 1 - R-squared, where R-squared is the value resulting from regressing one predictor on the
remaining predictors. The default is 1E — 18. If (1 — R-squared) is < (1E — 18), the predictor is
removed from the equation.

Second K The parameter for forcing in a variable which is nearly constant. The default is 2E — 21. If the
coefficient of variation of a predictor (the standard deviation / the mean) is < square root (2E
—21), then the predictor is considered essentially constant and is removed from the equation.

Both Ks must be positive numbers.

Graphs

RTYPE K
Specifies the type of residual to plot with the graph subcommands.

Value of K Type of residuals

1 (default) Regular or raw residuals (RESIDUALS)

2 Standardized residuals (SRESIDUALS)

3 Deleted Studentized residuals (TRESIDUALS)
GHISTOGRAM

Displays a histogram of the residuals.

GNORMAL
Displays a normal probability plot of the residuals.

GFITS
Plots the residuals versus the fitted values.

GORDER [C]
Plots the residuals versus the order of the data. The row number for each data point is shown on the x-axis (for
example, 12 3 4..n). Optionally, specify a column C that defines the order.

GFOURPACK
Displays a layout of a histogram of the residuals, a normal probability plot of the residuals, residuals vs fitted
values, and residuals vs order of the data.

GVARIABLIE C...C
Displays a separate graph for the residuals versus each specified column.
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Results

MEANS termlist
Displays a table of adjusted means (sometimes called least squares means) corresponding to each term listed.
Terms listed on MEANS must also be listed on MANOVA. If more than one MEANS subcommand is specified,
only the last one is used.

EMS
Displays a table that contains expected mean squares, estimated variance components, and the error term (the
denominator) used in each exact F-test. If there is no exact F-test for a term, the expected mean squares allow
you to determine how to construct an approximate F-test using the subcommand TEST.

The estimates of the variance components are the usual unbiased analysis of variance estimates. They are obtained
by setting each calculated MS equal to its EMS. This gives a system of linear equations in the unknown variance
components. This system is then solved. Unfortunately, this method can result in negative estimates, which should
be set to zero. Minitab, however, prints the negative estimates because they sometimes indicate that the model
being fit is inappropriate for the data.

Terms that are fixed do not have variance components estimated.

BRIEF K

Controls the amount of output with a value in K. You can also use BRIEF as a main command. When you use BRIEF
as a main command, it affects all other commands that use BRIEF to control the amount of output.

Value of K Output that is displayed

0 Minitab displays no output, but performs all specified storage and displays the following
error messages, warnings, prompts, and notes; graphs; WRITE to the screen.

1 Minitab displays the ANOVA table.

2 (default) K = 1, and Minitab displays the table of factor levels, coefficients for terms involving

covariates, and unusual observations.

3 K = 2 output, and Minitab displays all the coefficients.

SSCP
Displays the hypothesis matrix, H, corresponding to each term specified by MANOVA, and the error matrix, E.

EIGEN

Displays a table containing the eigenvalues and eigenvectors for the (nonsymmetric) matrix, E**-1 H. These are
the eigenvalues that are used to calculate the four MANOVA tests. A separate table is printed for each term
specified on MANOVA.

Note If an eigenvalue is repeated, then the corresponding eigenvectors are not unique. In this case, the eigenvectors Minitab displays
and those in books or other software might not agree. However, the MANOVA tests are always unique.

PARTIAL

Displays a matrix of partial correlations. These are the correlations among the residuals or, equivalently, the
correlations among the responses conditioned on the model. The formula for the matrix is W**-.5 E W**-5, where
E is the error matrix and W has the diagonal of E as its diagonal and 0's elsewhere.

NOUNIVARIATE
Suppresses the univariate output. Only the multivariate output is displayed.
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INTERACT terms

Used with SMEANS to store means for two-way interactions. List the model terms for which you calculate means
for level pairs. The means will be calculated by the order of terms and levels.

SMEANS C...C
Stores means for two-way interactions, main effects, and the overall mean. Use with INTERACT to store means
for two-way interactions. Specify a storage column for each response variable.

Storage

FITS C...C
Stores fitted values, using one column for each response.

RESIDUALS C...C
Stores residuals, using one column for each response variable. Residual = (response — fit).

SRESIDUALS C...C
Stores the standardized residuals, using one column for each response variable.

TRESIDUALS C...C
Stores the deleted Studentized residuals, using one column for each response variable.

HI C
Stores leverages.

COOKD C...C
Stores Cook's distance.

DFITS C...C
Stores the DFITS (also called DFFITS), using one column for each response.

XMATRIX M
Stores the design matrix corresponding to your model in M.

COEFFICIENTS C...C
Stores the coefficients for a model, using one column for each response. These are the same coefficients that are
printed under BRIEF 3. They correspond to the design matrix stored by XMATRIX. Thus, if M1 contains the design
matrix and C1 the coefficients, then M1 times C1 gives the fitted values.

NESTED: Session command for performing a
fully-nested ANOVA

NESTED C...C = C...C
Analyzes fully nested (hierarchical) designs. All factors are assumed to be random. Designs can be unbalanced.
In this case, F and p-values are not displayed. You can calculate these yourself using the expected mean squares
that are displayed.

You can analyze up to 50 response variables and up to 9 factors on one NESTED command. The columns specified
before the equal sign are the responses, and the columns after the equal sign are the factors. You can also have
replicates. One row then corresponds to one observation, giving the value of each response and the level of each
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factor for that observation. Factor levels can be any real numbers. They do not need to be consecutive or in any
special order.

VARTEST: Session command for performing an equal
variances test

VARTEST C...C
If you do not specify UNSTACKED, VARTEST performs tests for equal variances with all response data in one C
and factor level information in additional columns.

If you do specify UNSTACKED, VARTEST performs tests for equal variances with data from each factor level in a
different column C...C.

UNSTACKED
Indicates that data for each factor level are in different columns.

Options

CONFIDENCE K
Specifies the confidence level for the Bonferroni simultaneous confidence intervals and also the significance level
(denoted by a or alpha) for the multiple comparison intervals, and the tests. The default is 95, which corresponds
to a confidence level of 95% and an o = 1 - (95 / 100) = 0.05.

USEBARTLETT
Specifies to use the test based on the normal distribution instead of the multiple comparisons method and Levene's
method. If you have only 2 factor levels, then Minitab performs the F-test. If you have 3 or more factor levels,
then Minitab performs Bartlett's test.

The F-test and Bartlett's test are accurate only for normally distributed data. Any departure from normality can
cause these tests to yield inaccurate results. However, if the data conform to the normal distribution, then the

F-test and Bartlett's test are typically more powerful than either the multiple comparisons method or Levene's

method.

Graphs

GINTERVAL
Displays a graphical summary that includes the multiple comparison intervals for standard deviations and test
results by default. The multiple comparison intervals are not confidence intervals of the individual standard
deviations. The multiple comparison intervals are only useful for comparing the population standard deviations.
If USEBARTLETT is used, then GINTERVAL displays Bonferroni confidence intervals of the standard deviations.

GINDPLOT
Displays individual value plot.

GBOXPLOT
Displays a boxplot.
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Results

NODEFAULT

Minitab displays all output tables by default. You do not have to enter the subcommands. If you enter NODEFAULT,
then each table is only displayed if you enter the specific subcommand.

TMETHOD
Displays the method table which includes the null hypothesis, the alternative hypothesis, and the significance
level (denoted by o or alpha).

TBONFERRONI
Displays the table of Bonferroni simultaneous confidence intervals for the standard deviations of each factor level.

TTEST
Displays the test table which includes the p-values for the hypothesis tests.

Storage

STDEVS C
Stores the standard deviation of each factor level in column C.

VARIANCES C
Stores the variance of each factor level in column C.

SBONFERRONI C C

Stores Bonferroni confidence limits for the standard deviation of each factor level. The lower limits are stored in
the first column C and the upper limits is stored in the second column C.

SMCI C C
Stores the limits of the multiple comparisons intervals for each factor level. The lower limits are stored in the first
column C and the upper limits is stored in the second column C.

SFPVALUE C
Stores the p-value for Bartlett's test (or the F-test if there are only 2 factor levels).

SLPVALUE C
Stores the p-value for Levene's test.

SMPVALUE C
Stores the p-value for the multiple comparison test.

INTPLOT: Session command for creating an interval
plot

INTPLOT C...C

INTPLOT (C...C) * C
Use to plot means and confidence intervals for one or more variables. An interval plot illustrates both a measure
of central tendency and the variability of the data.
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By default, Minitab displays confidence intervals, but you can change the display type to standard error bars using
the INTBAR subcommand.

The data must be numeric or date/time. The categorical grouping data can be numeric, date/time, or text.
INTPLOT C...C displays a separate interval plot for each graph variable.

INTPLOT (C...C) * C displays a separate graph for each C on the left, with an interval for each category of the C on
the right.

The following table shows a few of the possible ways to generate interval plots.

Command language What the command language displays

INTPLOT 'Sales' 'Advertis'. Two graphs: interval plots of Sales and of Advertis

INTPLOT 'Sales'*'Year'. A graph with intervals representing yearly sales
Scale

AXLABEL: Session subcommand for customizing graph axis labels on page 1001

GAPWIDTH and COFFSET: Session subcommands for the space between clusters and items in a cluster on page 1028
MGRID, NOGRID, and NOMGRID: Session subcommands for controlling the grid on a graph on page 1029
NOFRAME: Session subcommand for suppressing lines and labels on a graph on page 1057

REFERENCE: Session subcommand for specifying the axis and location of reference lines on a graph on page 1073
SCALE: Session subcommand for customizing the axes and ticks of a graph on page 1076

TRANSPOSE and NOTRANSPOSE: Session subcommands for transposing the x- and y-axis on a graph on page 1091
TSHOW: Session subcommand for specifying the level of tick labels that are displayed on page 1091

Labels
FOOTNOTE: Session subcommand for adding a footnote to a graph on page 1025
ILABEL: Session subcommand for labeling individual values on a boxplot or interval plot on page 1033
INTLAB: Session subcommand for labeling interval bar endpoints on an interval plot on page 1039
MEALAB: Session subcommand for labeling means on a boxplot or an interval plot on page 1051
MEDLAB: Session subcommand for labeling medians on a boxplot on page 1055

NODTITLE, NODSUBTITLE, and NODFOOTNOTE: Session subcommands for suppressing titles, subtitles, and footnotes
on a graph on page 1057

NOPERFOOTNOTE: Session subcommand for suppressing My Footnote on page 1058
NOSEPSUBTITLE: Session subcommand for subtitles on separate graphs on page 1058
SUBTITLE: Session subcommand for adding a subtitle to a graph on page 1083

TITLE: Session subcommand for adding a title to a graph on page 1089

Data view

BAR: Session subcommand for representing data values with bars on page 1003
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CMEAN: Session subcommand for connecting means with lines on a boxplot on page 1010
CMEDIAN: Session subcommand for connecting means with lines on a boxplot on page 1011

INDIVIDUAL: Session subcommand for displaying a symbol for each individual data value on a boxplot or an
individual value plot on page 1036

INTBAR: Session subcommand for displaying a vertical line with horizontal lines at the endpoints of the confidence
interval for the mean on page 1037

JITTER and NOJITTER: Session subcommands for randomly offsetting data points to reveal overlapping points on
page 1043

MEAN: Session subcommand for displaying symbol for each mean on a boxplot, interval plot, or individual value
plot on page 1053

MEDIAN: Session subcommand for displaying a symbol for each median on a boxplot, interval plot, or individual
value plot on page 1054

SOFFSET: Session subcommand for offsetting points from the center on page 1082

Multiple graphs
GROUP: Session subcommand for specifying categorical variables for grouping on page 1029

OVERLAY: Session subcommand for combining graphs specified in a multiple graph command into a single graph
on page 1061

PANEL: Session subcommand for paneling graphs on page 1061
SAME: Session subcommand for specifying that one or more axes are the same for multiple graphs on page 1076

SEPARATE: Session subcommand for placing groups in separate graphs when you use a paneling variable on page
1079

Data options
FREQUENCY: Session subcommand for using a frequency column for a graph on page 1027
INCLUDE and EXCLUDE: Session subcommands for including or excluding rows on a graph on page 1036
NOEMPTY and NOMISS: Session subcommands for excluding missing data from graphs on page 1057

Graph, input, and output
GSAVE: Session subcommand for saving a graph in a file on page 38

WTITLE: Session subcommand for specifying the title of the output pane on page 1093

Annotation
ELLIPSE: Session subcommand for constructing an ellipse from points on a graph on page 1022
LINE: The session subcommand for constructing a line from points on a graph on page 1048
MARKER: Session subcommand for displaying a symbol at specified points on a graph on page 1050
POLYGON: Session subcommand for constructing a polygon from points on a graph on page 1063
RECTANGLE: Session subcommand for constructing a rectangle from points on a graph on page 1072

TEXT: Session subcommand for displaying text on a graph on page 1088
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Regions
DATA: Session subcommand for controlling the data region within the figure region on page 1015
FIGURE: Session subcommand for controlling the figure region within the graph region on page 1023
LEGEND and NOLEGEND: Session subcommands for controlling the legend on a graph on page 1045

GRAPH: Session subcommand for controlling the graph region fill and border line on page 1028

MAIN: Session command for creating a main effects
plot

MAIN C...C

Draws a main effects plot where the points in the plot are the raw data means at the various levels of each factor.
A reference line is drawn through the plot representing the grand mean of the response data. You can use factors
from designs generated by commands such as GLM on page 227 and ANOVA on page 224.

MAIN generates a plot that uses data means. After you have fit a model, use FACPLOT on page 276 to generate
plots that use fitted means.

Data means are the raw response variable means for each factor level combination whereas fitted means use least
squares to predict the mean response values of a balanced design. Therefore, the two types of means are identical
for balanced designs but can be different for unbalanced designs. While you can use raw data with unbalanced
designs to obtain a general idea of which main effects may be evident, it is generally good practice to use the
fitted means to obtain more precise results.

Enter the factors on the main command line. The factor columns may be numeric or text, and may contain any
values. The levels do not need to be in any special order. When the factor column is text, the first entry (row 1) is
level 1, the next entry that is different is level 2, and so on.

RESPONSE C

Use RESPONSE to enter raw response data. Then, the main effects are calculated based on the means of the
data.

YMIN K
Specifies the y-axis minimum value. Making the minimum and maximum values the same is very useful when
you are comparing several main effects plots of related data.

YMAX K

Specifies the y-axis maximum value. Making the minimum and maximum values the same is very useful when
you are comparing several main effects plots of related data.

TITLE "title"
Specifies a title for the graph. If you do not specify a title, Minitab uses a default title.

WTITLE "title"

You can use WTITLE as a subcommand with LAYOUT and all graphs. The title that you specify becomes the
command title of the resulting graph.

GSAVE "file name"

GSAVE K
Saves the graph in a file.
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The default file name is Minitab.PNG. You can specify a custom file name in double quotation marks
("file_name"), or as a stored text constant (K). You can also use any of the following subcommands to save
the graph in a different graphics format.

Some graph commands—for example, HISTOGRAM C1 C2 C3—generate more than one graph. If you include
the GSAVE subcommand with such a command, Minitab saves multiple files. Minitab gives each file a different
file name. Minitab uses the first five characters of the name you specify, then appends a number (001, 002,

and so on), for up to 300 files.

JPEG
JPEG color

PNGB
PNG grayscale

PNGC
PNG color

TIFB
TIF grayscale

TIF
TIF color

BMPB
BMP grayscale

BMPC
BMP color

GIF
GIF

EMF
EMF

RESOLUTION K
Saves the graph at a resolution of K dots per inch.

INTERACT: Session command for creating an
interactions plot

INTERACT C...C
Draws a single interaction plot if 2 factors are entered on the command line, or a matrix of interaction plots if
more than 2 factors are entered. You can use factors from designs generated by commands such as GLM on page
227 and ANOVA on page 224.

INTERACT generates a plot that uses data means. After you have fit a model, use FACPLOT on page 276 to generate
plots that use fitted means.
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Data means are the raw response variable means for each factor level combination whereas fitted means use least
squares to predict the mean response values of a balanced design. Therefore, the two types of means are identical
for balanced designs but can be different for unbalanced designs. While you can use raw data with unbalanced
designs to obtain a general idea of which main effects may be evident, it is generally good practice to use the
fitted means to obtain more precise results.

Enter the columns containing the factors as the arguments to the main command. The factor columns may be
numeric or text, and may contain any values. The levels do not need to be in any special order. When the factor
column is text, the first entry (row 1) is level 1, the next entry that is different is level 2, and so on.

You must use the RESPONSE subcommand with a column argument. When you specify RESPONSE and a response
column, Minitab goes through each two factor pair in sequential order and calculates the means of all the responses
for each unique combination of values in the two factors.

RESPONSE C
Specifies the column containing the response data.

The RESPONSE version of the interaction plot does not require any model to be fit. It is useful for preliminary
exploratory analysis in order to get a preliminary look at which two factor interactions appear to be significant.
It can also be used after a model has been fit, provided the design is balanced.

FULL
Specifies to use the full interaction matrix when more than two factors are specified instead of the default
display of the upper right portion of the matrix. In the full matrix, the transpose of each plot in the upper
right displays in the lower left portion of the matrix. The full matrix takes longer to display than the half
matrix.

YMIN K
Specifies the y-axis minimum value. Making the minimum and maximum values the same is very useful when
you are comparing several main effects plots of related data.

YMAX K
Specifies the y-axis maximum value. Making the minimum and maximum values the same is very useful when
you are comparing several main effects plots of related data.

TITLE "title"
Specifies a title for the graph. If you do not specify a title, Minitab uses a default title.

WTITLE "title"
You can use WTITLE as a subcommand with LAYOUT and all graphs. The title that you specify becomes the
command title of the resulting graph.

GSAVE "file name"

GSAVE K
Saves the graph in a file.

The default file name is Minitab.PNG. You can specify a custom file name in double quotation marks
("file_name"), or as a stored text constant (K). You can also use any of the following subcommands to save
the graph in a different graphics format.

Some graph commands—for example, HISTOGRAM C1 C2 C3—generate more than one graph. If you include
the GSAVE subcommand with such a command, Minitab saves multiple files. Minitab gives each file a different
file name. Minitab uses the first five characters of the name you specify, then appends a number (001, 002,

and so on), for up to 300 files.
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JPEG
JPEG color

PNGB
PNG grayscale

PNGC
PNG color

TIFB
TIF grayscale

TIF
TIF color

BMPB
BMP grayscale

BMPC
BMP color

GIF
GIF

EMF
EMF

RESOLUTION K

Saves the graph at a resolution of K dots per inch.
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DOE

Screening Designs

DSDESIGN: Session command for creating a definitive screening
design

DSDESIGN K

Creates a definitive screening design with K factors. You can then use REPLICATES to replicate points and BLOCKS
to add block.

The design summary and design table can be displayed. The design table is displayed under BRIEF 3. Factors are
denoted by the letters A, B, C, D, E, F, G, H, J, K, ..., v, ww, Xxx.

Note The letter | is not used.

Quotation marks around column names are required. If you use a subcommand more than one time, DSDESIGN
uses the last instance of the subcommand.

REPLICATES K
Replicates each point K times.

The following example generates a definitive screening design with 4 factors and 2 replicates. Thus, there
are a total of 26 runs in this experiment.

DSDESIGN 4;
REPLICATES 2.

BLOCKS K
Specifies the number of blocks in K. If your design includes blocks, and the number of blocks equals the
number of replicates, each replicate is a separate block. You can include multiple replicates in a block. Each
block has the same number of replicates.

LEVELS KK, ..., KK
With LEVELS K K, ..., KK, you list one pair of arguments for each factor. The first K should be the low level,
and the second K should be the high level. Minitab calculates the center points as the value that is half way
between the low and high levels.

The following example stores 0 for the low level of A, 10 for the high level, and 5 for the center point; 100
for the low level of B, 102 for the high level, and 101 for the center point; .2 for the low level of C, .3 for the
high level, and 2.5 for the center point.

DSDESIGN 3;
LEVELS 0 10 100 102 .2 .3.

With LEVELS K K, ..., K K, you can set levels to be text data. The arguments that define text data must be
enclosed in double quotation marks. For example, if factor B is whether a catalyst is present or absent, you
can use the following:

DSDESIGN 3;
LEVELS 0 10 "absent" "present" .2 .3.
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RANDOMIZE [K]
Randomizes the runs in the design matrix. If you specify blocks, randomization is done separately within each
block, and then the blocks are randomized.

Kis the base for the random number generator and can take any positive integer as an argument. To always
get the same ordering of the rows, create the same design and randomize the runs with the same base. For
more information, go to BASE on page 86.

FNAME K. ..K
Specifies the names of the factors. You must enter as many arguments as number of factors. The arguments
must be enclosed in double quotation marks.

BRIEF K
Controls the amount of output.

You can also use BRIEF as a main command. When you use BRIEF as a main command, it affects all other
commands that use BRIEF to control the amount of output.

Value of K Output that Minitab displays

0 Minitab displays no output, but performs all specified storage.

1or2 Minitab displays a summary of the design.

3 In addition to the K = 1 or K = 2 output, Minitab displays the design table.

PBDESIGN: Session command for creating a Plackett-Burman
design

PBDESIGN K [K]

Creates Plackett-Burman designs. Plackett-Burman designs are a class of resolution Ill, 2-level fractional factorial
designs that are often used to study main effects. In a resolution Ill design, main effects are aliased with 2-way
interactions.

The two constants on PBDESIGN specify a design. The first K is the number of factors. The second K is the number
of runs. Factor columns can be text or numeric.

To see the designs that Minitab generates, go to Plackett-Burman designs on page 1176. A design is based on the
number of runs, from 8 to 48 and always a multiple of 4. Therefore, the second K on PBDESIGN must be a multiple
of 4. The number of factors must be less than the number of runs. If you don't include the second K, Minitab sets
the number of runs to the smallest possible value for the specified number of factors.

To store your design for additional analysis, use the DESIGN subcommand. (The DESIGN subcommand replaces
the obsolete subcommands SORDER, PTTPYE, and XMATRIX.)

CENTER K
Adds up to 50 center points to the design. If the design is blocked, the center points are divided equally
between the blocks. If K is not a multiple of the number of blocks, then each of the last few blocks has one
less point than the other blocks.

REPS K
Specifies up to 50 replicates of each point. REPS does not replicate center points.
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The following example generates a Plackett-Burman design that has 2 factors and 8 base runs. Thus, there
are a total of 16 runs in this experiment.

PBDESIGN 2 8;
REPS 2.

RBLOCK

Specifies blocks on replicates. Each set of replicate points are placed in a separate block. No arguments are
taken.

LEVELS

Use LEVELS to specify values for the levels of each factor. The level values can be text or numeric. The default
values are -1 for the low level, +1 for the high level, and 0 for a center point.

The two ways to use LEVELS are as follows.

LEVELS KK, ..., KK
With LEVELS K K, ..., KK, you list one pair of arguments for each factor. The first K should be the low
level and the second K should be the high level. When you add center points with CPBLOCK, Minitab
calculates the center points as the value that is half way between the low and high levels. The following
example stores 0 for the low level of A, 10 for the high level, and 5 for the center point. 100 for the low
level of B, 102 for the high level, and 101 for the center point; .2 for the low level of C, .3 for the high
level, and 2.5 for the center point.

PBDESIGN 2 8;

CENTER 2;
LEVELS 0 10 100 102;
DESIGN.

With LEVELS K K, ..., KK, you can set levels to be text data. The arguments that define text data must be
enclosed in double quotation marks. In the following example, factor B is whether a catalyst is present
or absent. Because you use CENTER 2 to add center points with a text factor, Minitab creates pseudo
center points.

PBDESIGN 2 8;

CENTER 2;
RBLOCK;
LEVELS 0 10 "absent" "present";
DESIGN.
LEVELS C

With LEVELS C, the level values must be numeric. Put the level values in a column, in the same order as
if they were listed on the subcommand. Then, specify the level column on the LEVELS subcommand.

RANDOMIZE [K]
Randomizes the runs in the design matrix. If you specify blocks, randomization is done separately within each
block and then the blocks are randomized. When you use RANDOMIZE, the standard order and the run order
are different and Minitab stores the design in run order.

K is the base for the random number generator and can take any integer as an argument. To get the same
ordering of the rows, create the same design and randomize the runs with the same base. For more
information, go to BASE on page 86.

DESIGN

Names and stores the standard order, run order, point type, block assignment, and each factor in separate
columns. Unless you have only 1 empty worksheet in the project, Minitab stores the columns in a new
worksheet.

Minitab =’ 259



Minitab Statistical Software DOE

NAMES K K, ..., KK

Specifies names for the factors. Enclose names in quotation marks. If you do not use NAMES, then the
names of the factors are letters, skipping the letter I: A, B, C...

BRIEF K

Controls the amount of output. You can also use BRIEF as a main command. When you use BRIEF as a main
command, it affects all other commands that use BRIEF to control the amount of output.

Value of K Output that is displayed

0 Minitab displays no output for the command, but performs all specified storage
and displays the following output: error messages, warnings, prompts, and notes.

1 Minitab displays a summary of the design.

2 (default) Same as K = 1 output.

3 Same as K = 2 output, but Minitab also displays the design table.

SCREEN: Session command for analyzing a screening design

SCREEN
Analyzes a screening design with a continuous response. Fits definitive screening and Plackett Burman models,
which are produced by DSDESIGN on page 257 and PBDESIGN on page 258. Each factor must have two levels. Also,
you can have covariates and a blocking factor. You can specify a single response. Specify interactions in the
following way: C5*C6. For more information on specifying the model, go to How to specify the model for factorial
designs on page 1166.

The factor columns can be numeric or text, and can contain any values. The levels do not need to be in any special
order. When the factor column is text, Minitab uses the first entry (row 1) for the low level of the factor and the
other entry for the high level. To change this default order, use the LEVEL subcommand. When you include center
points in the model, Minitab tests for curvature.

You can display effects plots and residual plots. You can store the residuals, fitted values, and many other diagnostics
for further analysis. You can use extra text on the command and subcommand lines only after a #. Quotation
marks around column names that are one word long are optional.

For information about how Minitab handles missing data, go to Missing values in factorial, response surface, and
mixture designs on page 1171.

RESPONSE C
Specifies the column that contains the response variable in C. The column must be numeric or date/time.

BLOCK C (optional)

Specifies the column that contains the blocking information in C. Include the blocking column together with
TERMS to make a model that considers blocks.

FACTOR C...C (required)

Specifies the factors in columns C...C. The columns must have the same number of rows that the response
column has.

COVARIATES C...C

Specifies columns that include covariates in C...C. Include the covariate columns with terms to make a model
that considers the covariates. Covariates are fit first, the blocks second, and then all other terms. You can
have up to 50 covariates.
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LEVELS K K,..., K K

LEVELS C

Specifies the uncoded factor levels for each factor, with K for the low level and K for the high level, or in C.
For each factor, the list or column must contain two values. Use LEVELS to change the default order of levels

that Minitab uses. You can use a column only when all of the levels are continuous or all of the levels are
categorical.

INUNIT K
Specifies whether the design is in coded form or uncoded form.

Value of K Form of design
0 Coded
1 Uncoded

TERMS termlist

Specifies the terms to include in the model. Only continuous predictors can repeat in a single term. Nested
terms are not allowed. The model can be nonhierarchical.

Options

WEIGHTS C

Specifies a numeric column (C) that contains weights to use in weighted regression analysis. The same weights
are used for all responses. If different responses require different weights, then SCREEN will need to be run as
many times as there are different weights.

Usually, the weights are the reciprocal of the variances of the responses. The leverages stored by Hl are affected
by weights.

CONFIDENCE K

Specifies a confidence level. For example, for a 90% confidence level, enter CONFTIDENCE 90. The default value
of K'is 95.

ITYPE K
Specifies the type of confidence interval.

Value of K Type of confidence interval
-1 Lower bound
0 (default) Two-sided
1 Upper bound
BOXCOX [K]

Transforms each variable or group to follow a normal distribution using the lambda value in K. K must be between

-5 and +5. If you do not specify K, then Minitab finds the optimal lambda. By default, Minitab rounds the optimal
value.

To use the exact lambda, change the setting in File > Options > Linear Models > Display of Results.

Minitab cannot calculate the optimal lambda for stepwise regression. So you must specify a lambda value for
BOXCOX if you use STEPWISE, FORWARD, or BACKWARD.
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NOROUNDING
Specifies no rounding of calculated lambda parameter.

MEANS termlist
Calculates the least squares means for the terms that you specify in the termlist. You can use the following
commands to display and store the least squares means.

TMEANS
Displays the least squares means for the specified terms.

SMEANS
Stores the least squares means for the specified terms.

BSMEANS
If you transformed the data, stores the least squares means for the specified terms.

TOLERANCE K
Specifies the value in K above which Minitab removes highly correlated predictors and nearly constant predictors.

Requires that Minitab retain a factor in the model that is either highly correlated with a different factor or that is
almost constant. Lowering tolerance by giving very small argument values can prevent Minitab from eliminating
problematic predictor columns from the model.

Collinearity 1-R? where R? is the value that results from regressing one predictor on the remaining
predictors. If (1 - R2) is < (K), then the predictor is removed from the equation.

Almost constant If the coefficient of variation of a predictor (the standard deviation / the mean) is <
square root (K), then the predictor is considered essentially constant and is removed
from the equation.

Stepwise regression

FINFORMATION, STEPWISE, FORWARD, and BACKWARD perform a stepwise regression procedure to fit the model. No
arguments are needed for these subcommands.

FINFORMATION
Specifies a stepwise model selection procedure that uses forward information criteria selection. Use AICCORRECTED
or BICRITERION to specify which information criterion to use to select the final model. If you do not specify a
criterion, Minitab uses AICCORRECTED.

The forward information criteria procedure adds the term with the lowest p-value to the model at each step. If
you do not include subcommands about hierarchy, FINFORMATION adds 1 term at a step and maintains model
hierarchy, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.
Minitab calculates the information criteria for each step.

In most cases, the procedure continues until one of the following conditions occurs:

e The procedure does not find a new minimum of the criterion for 8 consecutive steps.

e The procedure fits the full model.

e The procedure fits a model that leaves 1 degree of freedom for error.

If you specify settings for the procedure that require a hierarchical model at each step and allow only one term

to enter at a time, then the procedure continues until it either fits the full model or fits a model that leaves 1
degree of freedom for error. Minitab displays the results of the analysis for the model with the minimum value
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of the selected information criterion, either the corrected Akaike's Information Criterion (AlCc) or the Bayesian
Information Criterion (BIC).

AICCORRECTED
Specifies the use of the corrected Akaike's Information Criterion (AlCc) to select the final model.

BICRITERION
Specifies the use of the Bayesian Information Criterion (BIC) to select the final model.

STEPWISE

Specifies a stepwise model selection procedure that uses both forward selection and backward elimination. If you
do not include subcommands about hierarchy, STEPWISE and FORWARD add 1 term at a step and maintain model
hierarchy, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

FORWARD
Specifies a stepwise model selection procedure that uses forward selection. If you do not include subcommands
about hierarchy, STEPWISE and FORWARD add 1 term at a step and maintain model hierarchy, the equivalent of
the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

BACKWARD
Specifies a stepwise model selection procedure that uses backward elimination. Removes a single term at each
step and maintains a hierarchical model, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS.

AENTER K
Specifies the alpha level at which a term is entered into the model. The default is 0.15 for STEPWISE and 0.25
for FORWARD.

AREMOVE K
Specifies the alpha level at which a term is removed from the model. The default is 0.15 for STEPWISE and
0.10 for BACKWARD. For STEPWISE, K must be greater than or equal to K for AENTER.

ENTER termlist
Specifies the terms that are contained in the starting model for STEPWISE. The ENTER termlist must be a
subset of the TERMS termlist or in the default term list in the design.

FORCE termlist
Specifies the terms to be forced in the model. The FORCE termlist must be a subset of the TERMS termlist
or in the default term list in the design.

NOHIERARCHICAL
Specifies that the model selection procedure does not consider hierarchy.

HIERARCHICAL
Maintains a hierarchical model in stepwise regression. In a hierarchical model, if a higher-order term is
included, all lower-order terms that comprise the higher-order term also appear in the model. For example,
a model that includes the interaction term A*B*C is hierarchical if it includes the following main effects and
lower-order interactions: A, B, C, A*B, A*C, and B*C.

CATONLY
Specifies that only the categorical terms in the model have to be hierarchical.
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ALLTERMS
Specifies that both categorical and continuous terms have to be hierarchical.

ATEND
Specifies that the final step of the stepwise procedure adds terms to make the model hierarchical.

ALWAYS
Specifies that the model is hierarchical at every step.

SINGLE
Specifies that only one term can enter the model at each step. So a higher-order term can enter
the model only if the terms that comprise the term are already in the model. For example, the
algorithm does not consider the addition of A*B unless A and B are already in the model.

BACKWARDS does not use SINGLE or MULTIPLE because terms only exit the model.

MULTIPLE
Specifies that multiple terms can enter the model at each step. So a higher order term can enter
the model, and the terms that comprise the term enter the model at the same time. For example,
if A*B is the most statistically significant term, A*B enters the model. At the same time, A and B
enter the model if those terms are not in the model already.

BACKWARDS does not use SINGLE or MULTIPLE because terms only exit the model.

Graphs

GEFFECTS
Displays a normal probability plot of the effects or the standardized effects. Minitab labels the effects on the
probability plot that are considered significant. The alpha level is 1 - the confidence level that follows CONFIDENCE,
unless you use stepwise selection. For forward selection, the alpha level is the level that follows AENTER. For
backward and stepwise selection, the alpha level is the level that follows AREMOVE.

GHALF
Displays a half normal probability plot of the effects or standardized effects. Minitab labels the effects on the half
normal plot that are considered significant. The alpha level is 1 — the confidence level that follows CONFIDENCE,
unless you use stepwise selection. For forward selection, the alpha level is the level that follows AENTER. For
backward and stepwise selection, the alpha level is the level that follows AREMOVE.

GPARETO

Displays a Pareto chart of the absolute effects. GPARETO draws a vertical reference line on the plot at the margin
of error. This plot lets you to look at both the magnitude and the importance of an effect at the same time. The

alpha level is 1 — the confidence level that follows CONFIDENCE, unless you use stepwise selection. For forward

selection, the alpha level is the level that follows AENTER. For backward and stepwise selection, the alpha level is
the level that follows AREMOVE.

GALLEFFECTS K

Specifies to include the model terms and the terms that are not in the model up to order K on the plots. K can
only be 1 or 2. When K = 2, Minitab includes square terms as well as 2-factor interactions. If you specify a stepwise
method, Minitab ignores K and shows the terms in the candidate list.

GMODEL
Specifies that only the terms that are in the model are on the plots.
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RTYPE K
Specifies the type of residual to plot with the graph subcommands.

Value of K Type of residuals

1 (default) Regular or raw residuals (RESIDUALS)

2 Standardized residuals (SRESIDUALS)

3 Deleted Studentized residuals (TRESIDUALS)
GHISTOGRAM

Displays a histogram of the residuals.

GNORMAL
Displays a normal probability plot of the residuals.

GFITS
Plots the residuals versus the fitted values.

GORDER [C]
Plots the residuals versus the order of the data, or versus the order specified in C. The row number for each data
point is shown on the x-axis (for example, 12 3 4...n).

GFOURPACK [C]
Displays four residual plots—a histogram of the residuals, a normal probability plot of the residuals, the residuals
versus fitted the values, and the residuals versus the order of the data, or versus the order specified in C—in one
graph.

GVARIABLIE C...C
Plots the residuals versus variables. Displays a separate graph for the residuals versus each specified column.

Results
The following subcommands specify what is displayed in the results.

NODEFAULT
Specifies that no default tables or graphs are displayed.

TEXPAND
Displays the expanded versions of the ANOVA table, the table of coefficients, the model summary table, and the
table of unusual observations.

TSIMPLE
Displays the simple versions of the ANOVA table, the table of coefficients, the model summary table, and the
table of unusual observations.

TMETHOD
Displays the method table.

TMSDETAILS

Displays the type of stepwise procedure and the alpha values to enter and/or remove a predictor from the model.
If you do not specify FULL or NOFULL, then Minitab uses the settings in File > Options > Linear Models >
Stepwise.
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FULL
Displays the coefficients, the p-values, Mallows' Cp, and the model summary statistics for each step of the
procedure.

NOFULL
Does not display the coefficients, the p-values, Mallows' Cp, and the model summary statistics for each step
of the procedure.

TEQUATION
Displays the regression equation table. If the model is hierarchical, the equation is in uncoded units. If the model
is nonhierarchical, the equation is in coded units.

TCOEFFICIENT
Displays the table of coefficients. If you do not specify FULL or NOFULL, then Minitab uses the settings in File >
Options > Linear Models > Display of Results.

FULL
Displays the full set of coefficients for categorical predictors.

NOFULL
Displays only the linearly independent coefficients.

TSUMMARY
Displays the summary of model table, which includes the R statistics and S. The expanded version of the table
includes the prediction sum of squares (PRESS), the corrected Akaike's Information Criterion (AlCc) and the Bayesian
Information Criterion (BIC).

TANOVA
Displays the ANOVA table. The expanded version of the table includes the sequential sums of squares and the
percent contribution to the total sum of squares.

TDIAGNOSTICS [K]
Displays the table of diagnostics. The expanded version of the table includes the standard error of the fit, the
confidence interval for the fit, the deleted residual, the leverage, Cook's D, and DFITS.

Value of K Diagnostics that are displayed
0 Only for unusual observations
1 For all observations

TALIAS [K]

Displays the alias table up to order K. One line is displayed for each term in the model, with a list of all terms, up
to order K, that are aliased with the model term. If K is omitted, then Minitab uses the default rule of FFDESIGN:
all interactions for 2 to 6 factors, up to three-way interaction for 7 to 10 factors, and two-way interactions for
more than 10.

TMEANS
Displays the table of least squares means for all combinations of the factor levels that you specify in MEANS.

Storage

The following subcommands specify what is stored in the worksheet.
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FITS C
Stores the fitted values.

RESIDUALS C
Stores the residuals (response — fit) in C.

SRESIDUALS C
Stores the standardized residuals.

TRESIDUALS C
Stores the deleted Studentized residuals in C.

HI C
Stores the leverage values.

COCK C
Stores Cook's distance values, using one column for each response.

DFITS C
Stores DFITS (also called DFFITS), using one column for each response.

COEFFICIENTS C
Stores the coefficients that are included in the coefficients table in C.

The coefficients are based on coded levels (-1, 0, +1), not on the actual levels in the data set. A coefficient is
always half the value of the corresponding effect.

XMATRIX M

Stores the design matrix. The first column is a column of ones for the constant term. Next, there is one column
for each covariate. Next, if the design was blocked into k blocks, there are (k — 1) columns. Next, there is one
column for each factor, using -1 for the low level, O for a center point, and +1 for the high level. Next, there is
one column for each interaction in the model. The column for an interaction is the product of all the columns that
correspond to the factors that are contained in that interaction.

If FFACTORIAL or VFACTORIAL removed some of the interactions that you specified in your model, the interactions
are not included in the stored design matrix. The columns in XMATRIX match the coefficients that are displayed
and stored.

BCRESP C
Stores the Box-Cox transformation of the response.

BFITS C
Stores the back-transformed fits after the Box-Cox transformation in C.

BSMEANS C
If you use a Box-Cox transformation, BSMEANS stores the means for the back-transformed response in C.

SMEANS C
Stores the least squares means from MEANS in C.

If you use a Box-Cox transformation, SMEANS stores the means for the transformed response in C.
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BSCREEN: Session command for analyzing a screening design with
a binary response

Required commands

To perform the analysis, use the main command and at least these accompanying subcommands.

BSCREEN
Analyzes a screening design with a binary response.

Fits definitive screening and Plackett Burman models, which are produced by DSDESIGN on page 257 and PBDESIGN
on page 258. Each factor must have two levels. Also, you can have covariates and a blocking factor.

Specify interactions in the following way: C5*Cé6. For more information on specifying the model, go to How to
specify the model for factorial designs on page 1166.

This analysis provides diagnostic plots, goodness-of-fit tests, and other diagnostic measures so you can assess
the validity of your model. For more information, go to Generalized linear model diagnostics and residual analysis
on page 1177.

Minitab excludes all observations with missing values on either the response variable or any of the predictors
from all calculations.

RESPONSE C C

Enters the response data as a column that contains the number of events first and then a column that contains
the number of trials. The columns must have the same number of rows. For examples, go to Entering data
for response variables on page 1142.

FACTOR C...C

Specifies the factors in columns C...C. The columns must have the same number of rows as the response
columns.

TERMS termlist

Specifies the terms to include in the model. Only continuous predictors can repeat in a single term. Nested
terms are not allowed. The model can be nonhierarchical.

LEVELS K K,..., K K or LEVELS C
Specifies the uncoded factor levels for each factor. In a pair of levels, the first K is the low level and the second
Kis the high level. In a pair of column rows, the first row is the low level and the second row is the high level.
For each factor, the list or column must contain two values. Use LEVELS to change the default order of levels
that Minitab uses. You can use a column only when all of the levels are continuous or all of the levels are
categorical.

INUNIT K
Specifies whether the design is in coded form or uncoded form.

Value of K Form of design
0 Coded
1 Uncoded
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Optional subcommands

Use these subcommands and the subcommands in the following sections to change the default analysis.

EVNAME K
Specify the name of the event with K. Enclose text values in double quotation marks.

LOGIT
Use the logit link function.

NORMIT
Use the normit link function.

GOMPIT
Use the gompit link function. The gompit link function is also called the complementary log-log link function.

BLOCKS C

Specifies the column that contains the blocking information in C. Include the blocking column together with
TERMS to make a model that considers blocks.

COVARIATES C...C

Specifies columns that include covariates in C...C. Include the covariate columns with TERMS to make a model
that considers the covariates. Covariates are fit first, the blocks second, and then all other terms. You can have up
to 50 covariates.

Options subcommands

CONFIDENCE K

Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of K is 95.

ITYPE K
Specifies the type of confidence interval.

Value of K Type of confidence interval
—1 Lower bound
0 (default) Two-sided
1 Upper bound
SEQDEVIANCE

Use sequential deviances for the tests of significance in the ANOVA table. The order of the terms in TERMS affects
the statistical significance. The default is to use adjusted deviances.

PEARSON
Specifies the use of Pearson residuals. The default is to use deviance residuals.

WEIGHT C

Performs a weighted regression. An n x n matrix W is formed with the column of weights as its diagonal and zeros
elsewhere. The regression coefficients are estimated by:

X'WX) (X' WY)
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HGROUP K
Specifies the number of groups for the Hosmer-Lemeshow goodness-of-fit test with K. The default is 10.

MEANS termlist

Calculates the fitted mean probability for the terms that you specify in the termlist. You can use the following
commands to display and store the probabilities.

TMEANS
Displays the fitted mean probability for the specified terms.

SMEANS C
Stores the fitted mean probability for the specified terms.

ITERATION K

Specifies the maximum number of iterations for the optimization algorithm that estimates the coefficients. The
default is 50.

TOLERANCE K

Specifies the value in K above which Minitab removes highly correlated predictors and nearly constant predictors.
By default, K = 1E-12.

The tolerance value determines when Minitab retains a factor in the model that is either highly correlated with a
different factor or that is almost constant. Lowering tolerance by giving very small argument values can prevent
Minitab from eliminating problematic predictor columns from the model.

Collinearity 1-R? where R? is the value that results from regressing one predictor on the remaining
predictors. If (1 - R2) is < (K), then the predictor is removed from the equation.

Almost constant If the coefficient of variation of a predictor (the standard deviation / the mean) is <
square root (K), then the predictor is considered essentially constant and is removed
from the equation.

CTOLERANCE K
Specifies the convergence criterion for the algorithm that estimates the coefficients. By default, K = 1E-8.

START C

Specifies a column that contains starting values for the coefficients in the optimization algorithm. The column
begins with the estimate of the constant, then follows the order of the model after TERMS.

Stepwise regression subcommands

FINFORMATION, STEPWISE, FORWARD, and BACKWARD perform a stepwise regression procedure to fit the model. No
arguments are needed for these subcommands.

FINFORMATION
Specifies a stepwise model selection procedure that uses forward information criteria selection. Use AICCORRECTED
or BICRITERION to specify which information criterion to use to select the final model. If you do not specify a
criterion, Minitab uses AICCORRECTED.
The forward information criteria procedure adds the term with the lowest p-value to the model at each step. If
you do not include subcommands about hierarchy, FINFORMATION adds 1 term at a step and maintains model
hierarchy, the equivalent of the following:
HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.
Minitab calculates the information criteria for each step.

In most cases, the procedure continues until one of the following conditions occurs:
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e The procedure does not find a new minimum of the criterion for 8 consecutive steps.
e The procedure fits the full model.

e The procedure fits a model that leaves 1 degree of freedom for error.

If you specify settings for the procedure that require a hierarchical model at each step and allow only one term
to enter at a time, then the procedure continues until it either fits the full model or fits a model that leaves 1
degree of freedom for error. Minitab displays the results of the analysis for the model with the minimum value
of the selected information criterion, either the corrected Akaike's Information Criterion (AlCc) or the Bayesian
Information Criterion (BIC).

AICCORRECTED
Specifies the use of the corrected Akaike's Information Criterion (AlCc) to select the final model.

BICRITERION
Specifies the use of the Bayesian Information Criterion (BIC) to select the final model.

STEPWISE
Specifies a stepwise model selection procedure that uses both forward selection and backward elimination. If you
do not include subcommands about hierarchy, STEPWISE and FORWARD add 1 term at a step and maintain model
hierarchy, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

FORWARD
Specifies a stepwise model selection procedure that uses forward selection. If you do not include subcommands
about hierarchy, STEPWISE and FORWARD add 1 term at a step and maintain model hierarchy, the equivalent of
the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

BACKWARD
Specifies a stepwise model selection procedure that uses backward elimination. Removes a single term at each
step and maintains a hierarchical model, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS.

AENTER K
Specifies the alpha level at which a term is entered into the model. The default is 0.15 for STEPWISE and 0.25
for FORWARD.

AREMOVE K
Specifies the alpha level at which a term is removed from the model. The default is 0.15 for STEPWISE and
0.10 for BACKWARD. For STEPWISE, K must be greater than or equal to K for AENTER.

ENTER termlist
Specifies the terms that are contained in the starting model for STEPWISE. The ENTER termlist must be a
subset of the TERMS termlist or in the default term list in the design.

FORCE termlist
Specifies the terms to be forced in the model. The FORCE termlist must be a subset of the TERMS termlist
or in the default term list in the design.

NOHIERARCHICAL
Specifies that the model selection procedure does not consider hierarchy.

HIERARCHICAL

Maintains a hierarchical model in stepwise regression. In a hierarchical model, if a higher-order term is
included, all lower-order terms that comprise the higher-order term also appear in the model. For example,
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a model that includes the interaction term A*B*C is hierarchical if it includes the following main effects and
lower-order interactions: A, B, C, A*B, A*C, and B*C.

CATONLY
Specifies that only the categorical terms in the model have to be hierarchical.

ALLTERMS
Specifies that both categorical and continuous terms have to be hierarchical.

ATEND
Specifies that the final step of the stepwise procedure adds terms to make the model hierarchical.

ALWAYS
Specifies that the model is hierarchical at every step.

SINGLE

Specifies that only one term can enter the model at each step. So a higher-order term can enter
the model only if the terms that comprise the term are already in the model. For example, the
algorithm does not consider the addition of A*B unless A and B are already in the model.

BACKWARDS does not use SINGLE or MULTIPLE because terms only exit the model.

MULTIPLE

Specifies that multiple terms can enter the model at each step. So a higher order term can enter
the model, and the terms that comprise the term enter the model at the same time. For example,
if A*B is the most statistically significant term, A*B enters the model. At the same time, A and B
enter the model if those terms are not in the model already.

BACKWARDS does not use SINGLE or MULTIPLE because terms only exit the model.

Graphs subcommands

RTYPE K
Specifies the type of residual to plot with the graph subcommands.

Value of K Type of residuals

1 (default) Regular or raw residuals (RESIDUALS)

2 Standardized residuals (SRESIDUALS)

3 Deleted Studentized residuals (TRESIDUALS)
GEFFECTS

Displays a normal probability plot of the effects or the standardized effects. Minitab labels the effects on the
probability plot that are considered significant. The alpha level is (1 —the confidence level) that follows CONFIDENCE,
unless you use stepwise selection that depends on an alpha level. For forward selection, the alpha level is the level
that follows AENTER. For backward and stepwise selection, the alpha level is the level that follows AREMOVE.

GHALF
Displays a half normal probability plot of the effects or standardized effects. Minitab labels the effects on the half
normal plot that are considered significant. The alpha level is (1 — the confidence level) that follows CONFIDENCE,
unless you use stepwise selection that depends on an alpha level. For forward selection, the alpha level is the level
that follows AENTER. For backward and stepwise selection, the alpha level is the level that follows AREMOVE.
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GPARETO
Displays a Pareto chart of the absolute effects. GPARETO draws a vertical reference line on the plot at the margin
of error. This plot lets you to look at both the magnitude and the importance of an effect at the same time. The
alpha level is (1 —the confidence level) that follows CONFIDENCE, unless you use stepwise selection that depends
on an alpha level. For forward selection, the alpha level is the level that follows AENTER. For backward and stepwise
selection, the alpha level is the level that follows AREMOVE.

GALLEFFECTS K

Specifies to include the model terms and the terms that are not in the model up to order K on the plots. If you
specify a stepwise method, Minitab ignores K and shows the terms in the candidate list.

GMODEL
Specifies that only the terms that are in the model are on the plots.

GHISTOGRAM
Displays a histogram of the residuals.

GNORMAL
Displays a normal probability plot of the residuals.

GFITS
Displays residuals versus fitted values.

GORDER [C]
Plots the residuals versus the order of the data, or versus the order specified in C. The row number for each data
point is shown on the x-axis (for example, 12 3 4..n).

GFOURPACK [C]
Displays four residual plots—a histogram of the residuals, a normal probability plot of the residuals, the residuals
versus fitted the values, and the residuals versus the order of the data, or versus the order specified in C—in one

graph.

GVARIABLE C...C
Displays the residuals versus the variables in C. Typically, you enter the columns for the predictors.

Results subcommands

NODEFAULT
Hides default tables and graphs that you do not include the subcommand to display.

TEXPAND
Displays the expanded versions of the tables that have them. The expanded Analysis of Variance table adds the
sequential deviances and percent contributions for each term. The Coefficients table adds confidence intervals
for the coefficients. The Fits and Diagnostics table adds the standard error of the fit, the 95% confidence interval
for the fit, the deleted residual, the HI, the Cook's D, and the DFITS.

TSIMPLE
Displays the simple versions of the Analysis of Variance table, the Coefficients table, and the Fits and Diagnostics
table.

TMETHOD
Displays a table of information about the method and options.

Minitab =’ 273



Minitab Statistical Software DOE

TMSDETAILS
Displays the type of stepwise procedure and the alpha values to enter and/or remove a predictor from the model.

If you do not specify FULL or NOFULL, then Minitab uses the preferences that you set in File > Options > Linear
Models > Stepwise.

FULL
Specifies to display the coefficients, p-values, and model summary statistics for each step of the procedure.

NOFULL
Hides these statistics.

TRINFO

Displays the number of events, non-events, and the total. The table also indicates which response value is the
reference event.

TSTEP
Displays the deviance at each iteration of the coefficients.

TCOEFFICIENTS
Displays the coefficients and the p-values for the Wald normal approximation tests.

If you do not specify FULL or NOFULL, Minitab uses the preferences that you set in File > Options > Linear
Models > Display of Results.

FULL
Specifies to show the coefficients for the reference level when you use (0, 1) coding for categorical predictors.

NOFULL
Hides these statistics.

TODDS

Displays odds ratios for each continuous predictor and each level of the categorical predictors. The output does
not show odds ratios for predictors with interactions in the model.

INCREMENT K. . .K

Specifies the increment for the odds ratio for the predictor with K. For example, if the predictor is mass in
grams, enter 1000 to see the change in the odds ratio for a kilogram. Enter a value for each numeric factor
in the same order that the factors follow the FACTOR subcommand. Then, enter a value for each covariate
in the order that the covariates follow the COVARIATE subcommand. Enter 1 for a factor or covariate to use
the same units as the data.

TSUMMARY
Displays the statistics that evaluate model fit, including deviance R%.

TGOODNESS

Displays the Pearson and deviance goodness-of-fit tests. For the binomial distribution models, also shows the
Hosmer-Lemeshow goodness-of-fit test.

TDEVIANCE
Displays the ANOVA table.

TEQUATION

Displays the regression equation table. If the model is hierarchical, the equation is in uncoded units. If the model
is nonhierarchical, the equation is in coded units.
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TMEANS
Displays the table of fitted mean probabilities for all combinations of the factor levels that you specify in MEANS.

THOSMER
Displays the table of observed and expected values for the Hosmer-Lemeshow test.

TASSOCIATION
Displays the number of concordant and discordant pairs, the Somers' D, the Goodman-Kruskal Gamma, and
Kendall's Tau-a.

TDIAGNOSTICS [K]
Displays a table of diagnostics. K = 0 displays diagnostics for only observations with high leverage values or
standardized residuals greater than 2. K = 1 displays diagnostics for all observations.

TALIAS [K]
Displays the alias table up to order K. One line is displayed for each term in the model, with a list of all terms, up
to order K, that are aliased with the model term. If K is omitted, then Minitab uses the default rule of FFDESIGN:
all interactions for 2 to 6 factors, up to three-way interaction for 7 to 10 factors, and two-way interactions for
more than 10.

Storage subcommands

FITS C
Stores the event probabilities in C.

RESIDUALS C
Stores the deviance residuals by default in C. Stores the Pearson residuals if you use the subcommand PEARSON.

SRESIDUALS C

Stores the standardized deviance residuals by default in C. Stores the standardized Pearson residuals if you use
the subcommand PEARSON.

TRESIDUALS C

Stores the deleted deviance residuals by default in C. Stores the deleted Pearson residuals if you use the
subcommand PEARSON.

COOK C
Stores the Cook's distances in C.

DFITS C
Stores the DFITS in C.

HI C
Stores the leverages in C.

SADJUSTEDRESP C
Stores the final adjusted response values in C.

SIWEIGHTS C
Stores the internal weights used to estimate the model parameters in C.

SECOEFFICIENTS C
Stores the standard errors of the estimated coefficients in C.
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COEFFICIENTS C
Stores the estimated coefficients in C.

EFFECTS C
Stores the effects that are included in the output in C.
Note Effects are not displayed or stored for the constant, covariates, or blocks.

SMEANS C
Stores the fitted mean probability for the specified terms in C.

DBETA C

Stores the change in the estimated regression coefficients (delta b) when you delete all observations with a
particular factor/covariate pattern in C. Use the delta b values to detect observations with a strong influence on
the coefficients.

DSBETA C

Stores the change in the estimated regression coefficients when you delete all observations with a particular
factor/covariate pattern based on the standardized Pearson residual in C.

DCHISQUARE C

Stores the change in the chi-square statistic when you delete all observations with a particular factor/covariate
pattern in C. Observations that are poorly fit by the model have high delta chi-square values.

DDEVIANCE C

Stores the change in the deviance when you delete all observations with a particular factor/covariate pattern in
C.

XMATRIX M
Stores the design matrix in M.

XPWXINVERSE M
Stores the X'WX inverse matrix of the estimated coefficients in M.

Plot Factorial Design

FACPLOT: Session command for creating a factorial plot

FACPLOT C

Displays factorial plots for the model associated with the response variable in the specified column To create this
graph, you need to specify a model. To produce an interaction plot, you must have two or more variables.

These plots can illustrate how a response variable relates to one or more variables. You can produce two types
of factorial plots.

e Use a main effects plot to compare fitted means or data means across levels of one or more variables.
e Use an interactions plot to assess the effects of one variable at levels of another variable. An interactions plot
displays the fitted means for a level of a variable with the level of a second variable held constant.

Although you can use these plots to display the effects, be sure to evaluate significance by looking at the effects
in the analysis of variance table.
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FACTORS C...C
Specifies the variables to display in both the main effect and interaction plots. You must specify 2 or more
variables to generate an interaction plot.

GMAIN
GMAIN displays the main effect plot.

GINT
GINT displays the interactions plot.

FULL
Use FULL to display both interaction plots for each pair of categorical variables, such as Predictor 1 by
Predictor 2 and Predictor 2 by Predictor 1. Sometimes you can identify interactions more easily when
you examine both plots.

LOWER
Use LOWER to display one version of each interaction plot.

GMODEL (default)
GMODEL display plots for only terms that are in the model and listed in FACTORS. For purposes of a main
effect plot, a variable is in the model if the model includes any terms that involve only that variable, e.g. A,
A*A, or A*A*A. For purposes of an interaction plot, the interaction of two variables is in the model if the
model includes any terms that involve both variables, e.g. A*B, A*B*B.

GALL
GALL displays plots for all terms involving variables on the FACTORS subcommand.

TITLE "title"
Specifies a title for the graph. If you do not specify a title, Minitab uses a default title.

Factorial Designs

FDESIGN: Session command for creating a general full factorial
design

FDESIGN K...K
FDESIGN creates a general full factorial design. The values of K specify the number of levels of each factor. The
values of K must be integers that are greater than or equal to 2. The model generated is always full. To store your
design for additional analysis, use the DESIGN subcommand. (The DESIGN subcommand replaces the obsolete
subcommands SORDER, PTTYPE, and XMATRIX.)

FDESIGN is similar to FFDESIGN, but FDESIGN has arbitrary levels and no fractional designs.

REPS K
Replicates each point K times. Specifies up to 50 replicates of each point. REPS does not replicate center
points.
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The following example generates a full factorial that has 3 factors and 2 observations per cell. Thus, there
are a total of 48 runs in this experiment.

FDESIGN 4 3 2;
REPS 2.

BLOCK C
Specifies a blocking variable column (C). You can specify up to 64 blocks. The blocking variable column can
contain numeric data or text data, and can contain any value. The levels do not need to be in any special
order. When the blocking column is text, the first entry (row 1) is block 1, the next entry that is different is
block 2, and so on. When the blocking column is numeric, the smallest value is block 1, the second smallest
value is block 2, and so on. If you use BLOCK without REPS, Minitab stores a column of 1s.

RBLOCK
Specifies blocks on replicates. Each set of replicate points are placed in a separate block. No arguments are
taken.

LEVELS K K,..., K K

LEVELS C
Specifies factor levels for each factor.

Use LEVELS to specify values for the levels of each factor. The level values can be text or numeric. If you do
not use the subcommand, the levels are the integers 1, 2, 3, and so on.

With LEVELS K K, ..., KK, you can set levels to be text or numeric data. The arguments that define text data
must be enclosed in double quotation marks. List a pair of arguments for each factor. The first K is the low
level. The second K is the high level.

With LEVELS C, the level values must be numeric. Put the level values in a column, in the same order as if
they were listed on the subcommand. Then, specify the level column on the LEVELS subcommand.

RANDOMIZE [K]
Randomizes the runs in the design matrix. If you specify blocks, randomization is done separately within each
block and then the blocks are randomized. When you use RANDOMIZE, the standard order and the run order
are different and Minitab stores the design in run order.

The optional K is the base for the random number generator and can take any integer as an argument. To
get the same ordering of the rows, create the same design and randomize the runs with the same base. For
more information, go to BASE on page 86.

DESIGN
Names and stores the standard order, run order, point type, block assignment, and each factor in separate
columns. Unless you have only 1T empty worksheet in the project, Minitab stores the columns in a new
worksheet.

NAMES K K, ..., KK
Specifies names for the factors. Enclose names in quotation marks. If you do not use NAMES, then the
names of the factors are letters, skipping the letter I: A, B, C...

BRIEF K
Controls the amount of output. You can also use BRIEF as a main command. When you use BRIEF as a main
command, it affects all other commands that use BRIEF to control the amount of output.
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Value of K Output that is displayed

0 Minitab displays no output for the command, but performs all specified storage
and displays the following output: error messages, warnings, prompts, and notes.

1 Minitab displays a summary of the design.

2 (default) Same as K = 1 output.

3 Same as K = 2 output, but Minitab also displays the design table.

FFDESIGN: Session command for creating a full or fractional
factorial design

FFDESIGN K [K]
Creates a full or fractional factorial design with K factors and K number of runs. These designs are often referred
to as screening designs. If the second K is omitted and the first K is 7 or less, a full factorial design is generated.
To store your design for additional analysis, use the DESIGN subcommand. (The DESIGN subcommand replaces
the obsolete subcommands SORDER, CTPT, and XMATRIX.)

Minitab has a catalog of designs. For a summary of the catalog, go to Designs generated by FFDESIGN on page
1141. The two constants (K) on FFDESIGN specify a design from that catalog. The first K is the number of factors,
and the second K is the number of runs. You can then use REPS to replicate points, FOLD the design, and add
center points (CPBLOCK). You may also ADD additional factors, provided the total number is at most 15.

The design generators, resolution, and alias structure are displayed. The design matrix is displayed under BRIEF
3. The defining relation is displayed under BRIEF 4. Factors are denoted by the letters A, B, C, D, E, F, G, H, J, K, L,
M, N, O, P on the output and in the subcommands BLOCKS, ADD, and FOLD.

Note The letter | is not used.

The alias structure that is displayed by default depends on the number of factors. You can use ALIAS to change
what is displayed.

Number of factors What is displayed

2-6 All terms

7-10 Up to three-way interactions
11-15 Up to two-way interactions

Quotation marks around column names are required. If you use a subcommand more than one time, FFDESIGN
uses the last instance of the subcommand.

REPS K
Replicates each point K times. Specifies up to 50 replicates of each point. REPS does not replicate center
points.

The following example generates a full factorial design that has 4 factors and 2 observations per cell. Thus,
there are a total of 32 runs in this experiment.

FFDESIGN 4 16;
REPS 2.

BLOCKS
Specifies the number of blocks in K, or specifies the terms to use as block generators in termlist.
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If you use the subcommand ADD, you must also specify your own block generators. You cannot use an
integer with BLOCKS when you specify ADD. Minitab cannot determine good block generators in this case.
No extra text is allowed on the BLOCKS line, except after a #.

Blocking a design can reduce its resolution. Let ry = the resolution before blocking. Let r, = the length of the
shortest term that is confounded with blocks. Then the resolution after blocking is the smaller of ry and (r;
+1).

BLOCKS K

With BLOCKS K, you specify the number of blocks that you want, from 2 to 99. This number must evenly
divide the total number of runs, excluding center points (those given on FFDESIGN times those given
on REPS). Minitab then chooses an appropriate design.

If your design has replicates and you specify an integer on BLOCKS, then Minitab attempts to put
replicates in different blocks. The exact rule is a bit complicated.

BLOCKS termlist
With BLOCKS termlist, you specify terms to use as block generators.

The following example generates a 64 run design with 8 factors.

FFDESIGN 8 64;
BLOCKS ABC CDE.

The factors are labeled A, B, C, D, E, F, G, H. The block generators are ABC and CDE. This gives four blocks.
The blocks are numbered in standard order (also called Yates order). The blocks are as follows.

Block ABC CDE

1 - -

2 + -

3 - +

4 + +
CPBLOCK K

Adds center points to the design.
Note CPBLOCK supersedes the CENTER subcommand.

CPBLOCK adds center points as follows:

e When all factors are numeric, Minitab adds K center points as follows:
o If the design is not blocked, then Minitab adds K center points to the design.
o If the design is blocked, then Minitab adds K center points to each block.

e When all factors are text, you cannot use CPBLOCK to add center points.
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e When factors are both numeric and text, the design does not have a true center. In this case, center points
are called pseudo-center points, and Minitab adds K center points as follows:

o [f the design is not blocked, then Minitab adds K center points for each combination of the levels of
the text factors.

o If the design is blocked, then Minitab adds K center points for each combination of the levels of the
text factors to each block.

For example, consider an unblocked 2**3 design, factors A and C are numeric. Factor B is text that indicates
whether a catalyst is absent or present. The LEVELS subcommand assigns text data for the levels of factor
B.

FFDESIGN 3 8;

CPBLOCK 3;

BLOCKS 1;

LEVELS 0 10 "absent" "present" .2 .3
DESIGN.

Factor B has 2 levels: present or absent. With CPBLOCK 3, Minitab adds a total of 2 x 3 = 6 center points,
three points for the low level of factor B and 3 for the high level. The six points are as follows:
5 present .25

5 present .25
5 present .25
5 absent .25
5 absent .25
5 absent .25

Next, consider a blocked 2**5 design where 3 factors are text. There are 2 x 2 x 2 = 8 combinations of text
levels. If you use CPBLOCK 2 and BLOCKS 2, then Minitab adds 8 x 2 = 16 pseudo-center points to each
of the 2 blocks.

LEVELS

Use LEVELS to specify values for the levels of each factor. The level values can be text or numeric. The default
values are —1 for the low level, +1 for the high level, and 0 for a center point.

LEVELS K K, ..., KK
With LEVELS K K, ..., KK, you list one pair of arguments for each factor. The first K should be the low
level, and the second K should be the high level. When you add center points with CPBLOCK, Minitab
calculates the center points as the value that is half way between the low and high levels.

The following example stores O for the low level of A, 10 for the high level, and 5 for the center point;
100 for the low level of B, 102 for the high level, and 101 for the center point; .2 for the low level of C,
.3 for the high level, and 0.25 for the center point.

FFDESIGN 3 8;

CPBLOCK 2;

LEVELS 0 10 100 102 .2 .3;
BLOCKS 1;

DESIGN
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With LEVELS K K, ..., KK, you can set levels to be text data. The arguments that define text data must be
enclosed in double quotation marks. For example, if factor B is whether a catalyst is present or absent,
you can use the following:

FFDESIGN 3 8;

CPBLOCK 2;

LEVELS 0 10 "absent" "present" .2 .3;
BLOCKS 1;

DESIGN.

Because you use CPBLOCK 2 to add center points with a text factor, Minitab creates pseudo-center
points. For more information, see the CPBLOCK subcommand.

LEVELS C
With LEVELS C, the level values must be numeric. Put the level values in a column, in the same order as
if they were listed on the subcommand. Then, specify the level column on the LEVELS subcommand.

FOLD [factor...factor]
Folds the design on the specified factors. If you don't include factors, Minitab folds the design on all factors.

The signs on the factors that you specify are switched. The signs on the remaining factors are not switched.
These rows for the non-specified factors are then appended to the end of the design matrix, which doubles
the number of runs.

Consider the following example.
FFDESIGN 3 4;
FOLD A.

First, Minitab generates a 3 factor design in 4 runs. The first 4 rows of the data matrix below are these runs.
Then, Minitab folds on factor A. This adds 4 additional runs.

A B C
- - +
+ — —
- + -
+ + +
+ - +
+ + -
- + +

Folding is a way to reduce confounding. If you fold on one factor, say A, then A and all its two-factor
interactions are free from other main effects and two-factor interactions. If you fold on all factors, then all
main effects are free from all two-factor interactions.

When you fold, the defining relation is usually shortened. Specifically, any word in the defining relation that
has an odd number of the letters on which you folded the design is omitted. If you fold a design and the
defining relation is not shortened, then the folding adds replicates, but it does not reduce confounding. In
this case, Minitab displays an error message.

If you fold a design that is blocked, the same block generators are used for the folded design as for the
unfolded design.
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FRACTION K
Specifies which fraction of a fractional design to use. The default fraction is called the principal fraction. This
is the fraction where all signs are positive. Consider the following example.

FFDESIGN 5 8;
FRACTION 3.

A full design with 5 factors requires 32 runs. With just 8 runs, a one-fourth fraction is used. You can use any
of the four possible fractions of the design. Minitab numbers them in standard order (also called Yates' order)
using the design generators, as follows.

1 D =-AB E=-AC
2 D = AB E=-AC
3 D =-AB E=AC
4 D = AB E=AC

The default fraction is called the principal fraction. This is the fraction where all signs are positive. FRACTION
3 specifies the third fraction. This is the one with design generators D = -AB, E = AC.

FRACTION applies to all the factors: the ones specified on the command line and any you added with ADD.
If you use both FRACTION and ADD, you cannot use minus signs in the design generators that are listed on
ADD. Actually, in this case, minus signs on ADD are not useful.

Sometimes a design contains points that are impractical to run. Choosing an appropriate fraction can avoid
these points. For example, suppose you could not run the design in the example with all five factors set at
their high level. The principal fraction contains this point, but the third fraction does not.

RANDOMIZE [K]
Randomizes the runs in the design matrix. If you specify blocks, randomization is done separately within each
block, and then the blocks are randomized. When you use RANDOMIZE, the standard order and the run
order are different and Minitab stores the design in run order.

K is the base for the random number generator and can take any positive integer as an argument. To always
get the same ordering of the rows, create the same design and randomize the runs with the same base. For
more information, go to BASE on page 86.

DESIGN
Names and stores the standard order, run order, center point indicator, block assignment, and each factor
in separate columns. Unless you have only 1 empty worksheet in the project, Minitab stores the columns in
a new worksheet.

NAMES K K, ..., KK

Specifies names for the factors. Enclose names in quotation marks. If you do not use NAMES, then the
names of the factors are letters, skipping the letter I: A, B, C...

BRIEF K
Controls the amount of output.

You can also use BRIEF as a main command. When you use BRIEF as a main command, it affects all other
commands that use BRIEF to control the amount of output.

Value of K Output that Minitab displays
0 Minitab displays no output, but performs all specified storage.
1 Minitab displays a summary of the design.
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Value of K Output that Minitab displays

2 (default) In addition to the K = 1 output, Minitab displays the alias table.

3 In addition to the K = 2 output, Minitab displays the design table.

4 In addition to the K = 3 output, Minitab displays the defining relation. If the design

is a full factorial, there is no defining relation, so K = 4 is equivalent to K = 3.

ALIAS K

Specifies the highest-order interaction to print in the alias table. For example, ALIAS 3 displays single factors,
and two- and three-way interactions.
Important A large K with a large number of factors might take a very long time to calculate.

ADD factor = term...factor = term

ADD is used primarily when you want to create custom designs rather than use a design in Minitab's catalog.
With ADD, you can add factors to a design by specifying the appropriate generators.

Consider the following example.

FFDESIGN 3 8;
ADD D=AB E=AC.

The example starts with three factors labeled A, B, and C. Then, factors D and E are added. D is confounded
with the AB interaction. E is confounded with the AC interaction. This gives a 2672 design. You can also use
a minus interaction (for example, D = —AB). The added factors must be given in alphabetical order. The total
number of factors, those listed on FFDESIGN plus those listed on ADD, can be at most 15.

No extra text is allowed on the ADD line, except after a #.

If you use BLOCKS with ADD, you must specify your own block generators. You cannot use an integer with
BLOCKS when you specify ADD. Minitab cannot determine good block generators for a user-specified design.

SPDESIGN: Session command for creating a 2-level split-plot design

SPDESIGN K K

Creates 2-level split-plot designs, either full or fractional. In a split-plot experiment, levels of the hard-to-change
factor are held constant for several experimental runs. The experimental runs are collectively treated as a whole
plot. The easy-to-change factors are varied over these runs. Each combination of the factors is considered a
subplot. To store your design for additional analysis, use the DESIGN subcommand. (The DESIGN subcommand
replaces the obsolete subcommands SORDER, PTTYPE, and XMATRIX.)

You can have 2-7 factors in a split-plot experiment. The number of hard-to-change factors that you can have
depends on the number of factors. For 2 factors, you can have only 1 hard-to-change factor. For 3 factors, you
can have 1 or 2 hard-to-change factors. For 4, 5, 6, or 7 factors, you can have 1, 2, or 3 hard-to-change factors.

You specify a full or fractional design with the PLOTS subcommand.

PLOTS K K
Specifies K whole plots with K subplots.

WREPLICATES K
Replicates the base design by multiplying the number of whole plots by K.
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SREPLICATES K
Replicates the subplots within each whole plot K times.

RBLOCK

Specifies blocks on whole block replicates. Each replicate of the base design is placed in a separate block.
No arguments are taken.

LEVELS

Specifies the values for the levels of each factor. The level values can be text or numeric. The default values
are —1 for the low level and +1 for the high level.

The two ways to use LEVELS are as follows.

LEVELS KK, ..., KK

With LEVELS K K, ..., KK, you can set levels to be text or numeric data. The arguments that define text
data must be enclosed in double quotation marks. List a pair of arguments for each factor. The first K
should be the low level. The second K should be the high level.

In the following example, factor B is whether a catalyst is present or absent.

SPDESIGN 2 1;
PLOT 2 2;
WPREPLICATES 2;
RANDOMIZE;
ALIAS 2;
LEVELS O 10 "absent" "present";
DESIGN.

LEVELS C

With LEVELS C, the level values must be all numeric or all text. First, put the level values in a column, in
the same order as if they were listed on the subcommand. Then, specify this column on the LEVELS
subcommand.

FRACTION K
Specifies which fraction of a fractional design to use with K. K must be a positive integer.

A full design that has 5 factors requires 32 runs. A full factorial design has no fractions, so no value of K is
legal. The legal values for a "/2-fractional design are 1 and 2. The legal values for a Va-fraction are 1, 2, 3, and
4. The following example is a design with 2 whole plots and 8 subplots, which makes a "2-fraction.
SPDESIGN 5 1;

PLOT 2 8;
FRACTION 2.

As in FFDESIGN, the fractions are numbered according to the signs that are used in the defining relation.

Fraction number Defining relation

1 | — ABCD - CDE + ABE

2 | + ABCD - CDE — ABE

3 | — ABCD + CDE - ABE

4 | + ABCD + CDE + ABE

The default fraction is called the principal fraction. This is the fraction for which all signs are positive in the
defining relation.
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Sometimes a design contains points that are impractical to run. Choose an appropriate fraction to avoid
these points.

RANDOMIZE [K]

Randomizes the runs in the design matrix. If you specify blocks, randomization is done separately within each
block and then the blocks are randomized. When you use RANDOMIZE, the standard order and the run order
are different and Minitab stores the design in run order.

K is the base for the random number generator and can take any integer as an argument. To get the same
ordering of the rows, create the same design and randomize the runs with the same base. For more
information, go to BASE on page 86.

DESIGN
Names and stores the standard order, run order, point type, block assignment, and each factor in separate
columns. Unless you have only 1T empty worksheet in the project, Minitab stores the columns in a new
worksheet.

NAMES K K, ..., KK
Specifies names for the factors. Enclose names in quotation marks. If you do not use NAMES, then the
names of the factors are letters, skipping the letter I: A, B, C...

BRIEF K
Controls the amount of output. BRIEF can also be used as a main command. When you use BRIEF as a main
command, it affects all other commands that use BRIEF to control the amount of output.

Value of K Output that Minitab displays

0 Minitab does not display output, but does complete all specified storage.

1 Minitab displays a summary of the design.

2 (default) In addition to the K = 1 output, Minitab displays the alias table.

3 In addition to the K = 2 output, Minitab displays the design table.

4 In addition to the K = 3 output, Minitab displays the defining relation. If the design is

a full factorial, there is no defining relation, so K = 4 is equivalent to K = 3.

ALIAS K
Specifies the highest order interaction to display in the alias table. For example, ALIAS 3 displays single factors,
and 2- and 3-way interactions.
Important A large K along with a large number of factors might take a very long time to calculate.

PBDESIGN: Session command for creating a Plackett-Burman
design

PBDESIGN K [K]
Creates Plackett-Burman designs. Plackett-Burman designs are a class of resolution Ill, 2-level fractional factorial
designs that are often used to study main effects. In a resolution Ill design, main effects are aliased with 2-way
interactions.

The two constants on PBDESIGN specify a design. The first K is the number of factors. The second K is the number
of runs. Factor columns can be text or numeric.
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To see the designs that Minitab generates, go to Plackett-Burman designs on page 1176. A design is based on the
number of runs, from 8 to 48 and always a multiple of 4. Therefore, the second K on PBDESIGN must be a multiple
of 4. The number of factors must be less than the number of runs. If you don't include the second K, Minitab sets
the number of runs to the smallest possible value for the specified number of factors.

To store your design for additional analysis, use the DESIGN subcommand. (The DESIGN subcommand replaces
the obsolete subcommands SORDER, PTTPYE, and XMATRIX.)

CENTER K

Adds up to 50 center points to the design. If the design is blocked, the center points are divided equally
between the blocks. If K is not a multiple of the number of blocks, then each of the last few blocks has one
less point than the other blocks.

REPS K
Specifies up to 50 replicates of each point. REPS does not replicate center points.

The following example generates a Plackett-Burman design that has 2 factors and 8 base runs. Thus, there
are a total of 16 runs in this experiment.

PBDESIGN 2 8;
REPS 2.

RBLOCK

Specifies blocks on replicates. Each set of replicate points are placed in a separate block. No arguments are
taken.

LEVELS

Use LEVELS to specify values for the levels of each factor. The level values can be text or numeric. The default
values are -1 for the low level, +1 for the high level, and 0 for a center point.

The two ways to use LEVELS are as follows.

LEVELS KK, ..., KK
With LEVELS K K, ..., KK, you list one pair of arguments for each factor. The first K should be the low
level and the second K should be the high level. When you add center points with CPBLOCK, Minitab
calculates the center points as the value that is half way between the low and high levels. The following
example stores 0 for the low level of A, 10 for the high level, and 5 for the center point. 100 for the low
level of B, 102 for the high level, and 101 for the center point; .2 for the low level of C, .3 for the high
level, and 2.5 for the center point.

PBDESIGN 2 8;

CENTER 2;
LEVELS 0 10 100 102;
DESIGN.

With LEVELS K K, ..., KK, you can set levels to be text data. The arguments that define text data must be
enclosed in double quotation marks. In the following example, factor B is whether a catalyst is present
or absent. Because you use CENTER 2 to add center points with a text factor, Minitab creates pseudo
center points.

PBDESIGN 2 8;

CENTER 2;

RBLOCK;

LEVELS 0 10 "absent" "present";
DESIGN.
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LEVELS C

With LEVELS C, the level values must be numeric. Put the level values in a column, in the same order as
if they were listed on the subcommand. Then, specify the level column on the LEVELS subcommand.

RANDOMIZE [K]

Randomizes the runs in the design matrix. If you specify blocks, randomization is done separately within each
block and then the blocks are randomized. When you use RANDOMIZE, the standard order and the run order
are different and Minitab stores the design in run order.

K is the base for the random number generator and can take any integer as an argument. To get the same
ordering of the rows, create the same design and randomize the runs with the same base. For more
information, go to BASE on page 86.

DESIGN

Names and stores the standard order, run order, point type, block assignment, and each factor in separate
columns. Unless you have only 1T empty worksheet in the project, Minitab stores the columns in a new
worksheet.

NAMES K K, ..., KK

Specifies names for the factors. Enclose names in quotation marks. If you do not use NAMES, then the
names of the factors are letters, skipping the letter I: A, B, C...

BRIEF K

Controls the amount of output. You can also use BRIEF as a main command. When you use BRIEF as a main
command, it affects all other commands that use BRIEF to control the amount of output.

Value of K Output that is displayed

0 Minitab displays no output for the command, but performs all specified storage
and displays the following output: error messages, warnings, prompts, and notes.

1 Minitab displays a summary of the design.

2 (default) Same as K = 1 output.

3 Same as K = 2 output, but Minitab also displays the design table.

FFACTORIAL: Session command for analyzing a full or fractional
factorial design

Analyzes a factorial design with a continuous response. Fits full and fractional factorial models, including those produced
by FFDESIGN on page 279 and PBDESIGN on page 258. Each factor must have two levels. Also, you can have covariates
and a blocking factor. The design does not have to be orthogonal. You can specify a single response. Specify interactions
in the following way: C5*C6. For more information on specifying the model, go to How to specify the model for factorial
designs on page 1166.

The factor columns can be numeric or text, and can contain any values. The levels do not need to be in any special
order. When you include center points in the model, Minitab tests for curvature.

You can display effects plots and residual plots. You can store the residuals, fitted values, and many other diagnostics
for further analysis. You can use extra text on the command and subcommand lines only after a #. Quotation marks
around column names that are one word long are optional.

For information about how Minitab calculates the model, go to Calculations for FFACTORIAL on page 1136.
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For information about how Minitab handles missing data, go to Missing values in factorial, response surface, and
mixture designs on page 1171.

RESPONSE C
Specifies the column that contains the response variable in C. The column must be numeric or date/time.

FACTOR C...C (required)
Specifies the factors in columns C...C. The columns must have the same number of rows that the response column
has.

COVARIATES C...C

Specifies columns that include covariates in C...C. Include the covariate columns with terms to make a model that
considers the covariates. Covariates are fit first, the blocks second, and then all other terms. You can have up to
50 covariates.

BLOCKS C (optional)
Specifies the column that contains the blocking information in C. Include the blocking column together with
TERMS to make a model that considers blocks.

CTPT C
Specifies the column that identifies which design points are center points in C. Include the center point column
together with TERMS to make a model that tests for curvature.

TERMS termlist

Specifies the terms to include in the model. Only continuous predictors can repeat in a single term. Nested terms
are not allowed. The model can be nonhierarchical.

INUNIT K
Specifies whether the design is in coded form or uncoded form.

Value of K Form of design
0 Coded
1 Uncoded

LEVELS K K,..., K K

LEVELS C
Specifies the uncoded factor levels for each factor. In a pair of levels, the first K is the low level and the second K
is the high level. In a pair of column rows, the first row is the low level and the second row is the high level. For
each factor, the list or column must contain two values. Use LEVELS to change the default order of levels that
Minitab uses. You can use a column only when all of the levels are continuous or all of the levels are categorical.

Options

WEIGHTS C
Specifies a numeric column (C) that contains weights to use in weighted regression analysis. The same weights
are used for all responses. If different responses require different weights, then FFACTORIAL will need to be run
as many times as there are different weights.

Typically, the weights are the reciprocal of the variances of the responses. In this case, weights are based on the
fitted variances calculated and stored by VFACTORIAL. You can use other weight variables.

The leverages stored by HI are affected by weights.
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CONFIDENCE K

Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of K'is 95.

ITYPE K
Specifies the type of confidence interval.

Value of K Type of confidence interval
-1 Lower bound
0 (default) Two-sided
1 Upper bound
BOXCOX [K]

Transforms each variable or group to follow a normal distribution using the lambda value in K. K must be between
-5 and +5. If you do not specify K, then Minitab finds the optimal lambda. By default, Minitab rounds the optimal
value.

To use the exact lambda, change the setting in File > Options > Linear Models > Display of Results.

Minitab cannot calculate the optimal lambda for stepwise regression. So you must specify a lambda value for
BOXCOX if you use STEPWISE, FORWARD, or BACKWARD.

MEANS termlist

Calculates the least squares means for the terms that you specify in the termlist. You can use the following
commands to display and store the least squares means.

TMEANS
Displays the least squares means for the specified terms.

SMEANS
Stores the least squares means for the specified terms.

BSMEANS
If you transformed the data, stores the least squares means for the specified terms.

TOLERANCE K

Specifies the value in K above which Minitab removes highly correlated predictors and nearly constant predictors.
By default, K = 1E-12.

The tolerance value determines when Minitab retains a factor in the model that is either highly correlated with a
different factor or that is almost constant. Lowering tolerance by giving very small argument values can prevent
Minitab from eliminating problematic predictor columns from the model.

Collinearity 1-R? where R? is the value that results from regressing one predictor on the remaining
predictors. If (1 - R2) is < (K), then the predictor is removed from the equation.

Almost constant If the coefficient of variation of a predictor (the standard deviation / the mean) is <
square root (K), then the predictor is considered essentially constant and is removed
from the equation.
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Stepwise regression

FINFORMATION, STEPWISE, FORWARD, and BACKWARD perform a stepwise regression procedure to fit the model. No
arguments are needed for these subcommands.

FINFORMATION

Specifies a stepwise model selection procedure that uses forward information criteria selection. Use AICCORRECTED
or BICRITERION to specify which information criterion to use to select the final model. If you do not specify a
criterion, Minitab uses AICCORRECTED.

The forward information criteria procedure adds the term with the lowest p-value to the model at each step. If
you do not include subcommands about hierarchy, FINFORMATION adds 1 term at a step and maintains model
hierarchy, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

Minitab calculates the information criteria for each step.

In most cases, the procedure continues until one of the following conditions occurs:

e The procedure does not find a new minimum of the criterion for 8 consecutive steps.
e The procedure fits the full model.

e The procedure fits a model that leaves 1 degree of freedom for error.

If you specify settings for the procedure that require a hierarchical model at each step and allow only one term
to enter at a time, then the procedure continues until it either fits the full model or fits a model that leaves 1
degree of freedom for error. Minitab displays the results of the analysis for the model with the minimum value
of the selected information criterion, either the corrected Akaike's Information Criterion (AlCc) or the Bayesian
Information Criterion (BIC).

ATICCORRECTED
Specifies the use of the corrected Akaike's Information Criterion (AlCc) to select the final model.

BICRITERION
Specifies the use of the Bayesian Information Criterion (BIC) to select the final model.

STEPWISE

Specifies a stepwise model selection procedure that uses both forward selection and backward elimination. If you
do not include subcommands about hierarchy, STEPWISE and FORWARD add 1 term at a step and maintain model
hierarchy, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

FORWARD

Specifies a stepwise model selection procedure that uses forward selection. If you do not include subcommands
about hierarchy, STEPWISE and FORWARD add 1 term at a step and maintain model hierarchy, the equivalent of
the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

BACKWARD
Specifies a stepwise model selection procedure that uses backward elimination. Removes a single term at each
step and maintains a hierarchical model, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS.

AENTER K
Specifies the alpha level at which a term is entered into the model. The default is 0.15 for STEPWISE and 0.25
for FORWARD.
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AREMOVE K
Specifies the alpha level at which a term is removed from the model. The default is 0.15 for STEPWISE and
0.10 for BACKWARD. For STEPWISE, K must be greater than or equal to K for AENTER.

ENTER termlist
Specifies the terms that are contained in the starting model for STEPWISE. The ENTER termlist must be a
subset of the TERMS termlist or in the default term list in the design.

FORCE termlist
Specifies the terms to be forced in the model. The FORCE termlist must be a subset of the TERMS termlist
or in the default term list in the design.

NOHIERARCHICAL
Specifies that the model selection procedure does not consider hierarchy.

HIERARCHICAL
Maintains a hierarchical model in stepwise regression. In a hierarchical model, if a higher-order term is
included, all lower-order terms that comprise the higher-order term also appear in the model. For example,
a model that includes the interaction term A*B*C is hierarchical if it includes the following main effects and
lower-order interactions: A, B, C, A*B, A*C, and B*C.

CATONLY
Specifies that only the categorical terms in the model have to be hierarchical.

ALLTERMS
Specifies that both categorical and continuous terms have to be hierarchical.

ATEND
Specifies that the final step of the stepwise procedure adds terms to make the model hierarchical.

ALWAYS
Specifies that the model is hierarchical at every step.

SINGLE
Specifies that only one term can enter the model at each step. So a higher-order term can enter
the model only if the terms that comprise the term are already in the model. For example, the
algorithm does not consider the addition of A*B unless A and B are already in the model.

BACKWARDS does not use SINGLE or MULTIPLE because terms only exit the model.

MULTIPLE
Specifies that multiple terms can enter the model at each step. So a higher order term can enter
the model, and the terms that comprise the term enter the model at the same time. For example,
if A*B is the most statistically significant term, A*B enters the model. At the same time, A and B
enter the model if those terms are not in the model already.

BACKWARDS does not use SINGLE or MULTIPLE because terms only exit the model.

Graphs

GEFFECTS
Displays a normal probability plot of the effects or the standardized effects. Minitab labels the effects on the
probability plot that are considered significant. The alpha level is 1 —the confidence level that follows CONFIDENCE,
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unless you use stepwise selection that depends on an alpha level. For forward selection, the alpha level is the level
that follows AENTER. For backward and stepwise selection, the alpha level is the level that follows AREMOVE.

GHALF
Displays a half normal probability plot of the effects or standardized effects. Minitab labels the effects on the half
normal plot that are considered significant. The alpha level is 1 — the confidence level that follows CONFIDENCE,
unless you use stepwise selection that depends on an alpha level. For forward selection, the alpha level is the level
that follows AENTER. For backward and stepwise selection, the alpha level is the level that follows AREMOVE.

GPARETO

Displays a Pareto chart of the absolute effects. GPARETO draws a vertical reference line on the plot at the margin
of error. This plot lets you to look at both the magnitude and the importance of an effect at the same time. The
alpha level is 1 —the confidence level that follows CONFIDENCE, unless you use stepwise selection that depends
on an alpha level. For forward selection, the alpha level is the level that follows AENTER. For backward and stepwise
selection, the alpha level is the level that follows AREMOVE.

GALLEFFECTS K

Specifies to include the model terms and the terms that are not in the model up to order K on the plots. If you
specify a stepwise method, Minitab ignores K and shows the terms in the candidate list.

GMODEL
Specifies that only the terms that are in the model are on the plots.

RTYPE K
Specifies the type of residual to plot with the graph subcommands.

Value of K Type of residuals

1 (default) Regular or raw residuals (RESIDUALS)

2 Standardized residuals (SRESIDUALS)

3 Deleted Studentized residuals (TRESIDUALS)
GHISTOGRAM

Displays a histogram of the residuals.

GNORMAL
Displays a normal probability plot of the residuals.

GFITS
Plots the residuals versus the fitted values.

GORDER [C]
Plots the residuals versus the order of the data, or versus the order specified in C. The row number for each data
point is shown on the x-axis (for example, 12 3 4...n).

GFOURPACK [C]
Displays four residual plots—a histogram of the residuals, a normal probability plot of the residuals, the residuals
versus fitted the values, and the residuals versus the order of the data, or versus the order specified in C—in one

graph.

GVARIABLIE C...C
Plots the residuals versus variables. Displays a separate graph for the residuals versus each specified column.
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Results

The following subcommands specify what is displayed in the results.

NODEFAULT
Specifies that no default tables or graphs are displayed.

TEXPAND
Displays the expanded versions of the ANOVA table, the table of coefficients, the model summary table, and the
table of unusual observations.

TSIMPLE
Displays the simple versions of the ANOVA table, the table of coefficients, the model summary table, and the
table of unusual observations.

TMETHOD
Displays the method table.

TMSDETAILS
Displays the type of stepwise procedure and the alpha values to enter and/or remove a predictor from the model.
If you do not specify FULL or NOFULL, then Minitab uses the settings in File > Options > Linear Models >
Stepwise.

FULL
Displays the coefficients, the p-values, Mallows' Cp, and the model summary statistics for each step of the
procedure.

NOFULL
Does not display the coefficients, the p-values, Mallows' Cp, and the model summary statistics for each step
of the procedure.

TEQUATION
Displays the regression equation table. If the model is hierarchical, the equation is in uncoded units. If the model
is nonhierarchical, the equation is in coded units.

TCOEFFICIENT
Displays the table of coefficients. If you do not specify FULL or NOFULL, then Minitab uses the settings in File >
Options > Linear Models > Display of Results.

FULL
Displays the full set of coefficients for categorical predictors.

NOFULL
Displays only the linearly independent coefficients.

TSUMMARY
Displays the summary of model table, which includes the R statistics and S. The expanded version of the table
includes the prediction sum of squares (PRESS), the corrected Akaike's Information Criterion (AlCc) and the Bayesian
Information Criterion (BIC).

TANOVA
Displays the ANOVA table. The expanded version of the table includes the sequential sums of squares and the
percent contribution to the total sum of squares.

TDIAGNOSTICS [K]
Displays the table of diagnostics. The expanded version of the table includes the standard error of the fit, the
confidence interval for the fit, the deleted residual, the leverage, Cook's D, and DFITS.
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Value of K Diagnostics that are displayed
0 Only for unusual observations
1 For all observations

TALIAS [K]

Displays the alias table up to order K. One line is displayed for each term in the model, with a list of all terms, up
to order K, that are aliased with the model term. If K is omitted, then Minitab uses the default rule of FFDESIGN:
all interactions for 2 to 6 factors, up to three-way interaction for 7 to 10 factors, and two-way interactions for
more than 10.

TMEANS
Displays the table of least squares means for all combinations of the factor levels that you specify in MEANS.

Storage
The following subcommands specify what is stored in the worksheet.

FITS C
Stores the fitted values.

RESIDUALS C
Stores the residuals (response — fit) in C.

SRESIDUALS C
Stores the standardized residuals.

TRESIDUALS C
Stores the deleted Studentized residuals in C.

HI C
Stores the leverage values.

COCK C
Stores Cook's distance values, using one column for each response.

DFITS C
Stores DFITS (also called DFFITS), using one column for each response.

EFFECTS C
Stores the effects that are included in the output in C.
Note Effects are not displayed or stored for the constant, covariates, or blocks.

COEFFICIENTS C
Stores the coefficients that are included in the coefficients table in C.

The coefficients are based on coded levels (-1, 0, +1), not on the actual levels in the data set. A coefficient is
always half the value of the corresponding effect.

XMATRIX M

Stores the design matrix. The first column is a column of ones for the constant term. Next, there is one column
for each covariate. Next, if the design was blocked into k blocks, there are (k — 1) columns. Next, there is one
column for each factor, using -1 for the low level, O for a center point, and +1 for the high level. Next, there is
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one column for each interaction in the model. The column for an interaction is the product of all the columns that
correspond to the factors that are contained in that interaction.

If FFACTORIAL or VFACTORIAL removed some of the interactions that you specified in your model, the interactions
are not included in the stored design matrix. The columns in XMATRIX match the coefficients that are displayed
and stored.

BCRESP C
Stores the Box-Cox transformation of the response.

BFITS C
Stores the back-transformed fits after the Box-Cox transformation in C.

BSMEANS C
If you use a Box-Cox transformation, BSMEANS stores the means for the back-transformed response in C.

SMEANS C
Stores the least squares means from MEANS in C.

If you use a Box-Cox transformation, SMEANS stores the means for the transformed response in C.

BFFACTORIAL: Session command for analyzing a full or fractional
factorial design with a binary response

Required commands

To perform the analysis, use the main command and at least these accompanying subcommands.

BFFACTORIAL
Analyzes a factorial design with a binary response. Fits full and fractional factorial models, including those produced
by FFDESIGN on page 279 and PBDESIGN on page 258. Each factor must have two levels. Also, you can have
covariates and a blocking factor. The design does not have to be orthogonal. You can specify a single response.
Specify interactions in the following way: C5*C6. When you include center points in the model, Minitab tests for
curvature. For more information on specifying the model, go to How to specify the model for factorial designs
on page 1166.

This analysis provides diagnostic plots, goodness-of-fit tests, and other diagnostic measures so you can assess
the validity of your model. For more information, go to Generalized linear model diagnostics and residual analysis
on page 1177.

Minitab excludes all observations with missing values on either the response variable or any of the predictors
from all calculations.

RESPONSE C C
Enters the response data as a column that contains the number of events first and then a column that contains
the number of trials. The columns must have the same number of rows.For examples, go to Entering data
for response variables on page 1142.

FACTOR C...C
Specifies the factors in columns C...C. The columns must have the same number of rows as the response
columns.
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TERMS termlist
Specifies the terms to include in the model. Only continuous predictors can repeat in a single term. Nested
terms are not allowed. The model can be nonhierarchical.

LEVELS K K,..., K K or LEVELS C
Specifies the uncoded factor levels for each factor. In a pair of levels, the first K is the low level and the second
K'is the high level. In a pair of column rows, the first row is the low level and the second row is the high level.
For each factor, the list or column must contain two values. Use LEVELS to change the default order of levels
that Minitab uses. You can use a column only when all of the levels are continuous or all of the levels are
categorical.

INUNIT K
Specifies whether the design is in coded form or uncoded form.

Value of K Form of design
0 Coded
1 Uncoded

Optional subcommands

Use these subcommands and the subcommands in the following sections to change the default analysis.

EVNAME K
Specify the name of the event with K. Enclose text values in double quotation marks.

LOGIT
Use the logit link function.

NORMIT
Use the normit link function.

GOMPIT
Use the gompit link function. The gompit link function is also called the complementary log-log link function.

BLOCKS C
Specifies the column that contains the blocking information in C. Include the blocking column together with
TERMS to make a model that considers blocks.

COVARIATES C...C

Specifies columns that include covariates in C...C. Include the covariate columns with TERMS to make a model
that considers the covariates. Covariates are fit first, the blocks second, and then all other terms. You can have up
to 50 covariates.

CTPT C
Specifies the column that identifies which design points are center points in C. Include the center point column
together with TERMS to make a model that tests for curvature.
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Options subcommands

CONFIDENCE K

Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of K'is 95.

ITYPE K
Specifies the type of confidence interval.

Value of K Type of confidence interval
-1 Lower bound
0 (default) Two-sided
1 Upper bound
SEQDEVIANCE

Use sequential deviances for the tests of significance in the ANOVA table. The order of the terms in TERMS affects
the statistical significance. The default is to use adjusted deviances.

PEARSON
Specifies the use of Pearson residuals. The default is to use deviance residuals.

WEIGHT C

Performs a weighted regression. An n x n matrix W is formed with the column of weights as its diagonal and zeros
elsewhere. The regression coefficients are estimated by:

XWX ' (X'wWY)

HGROUP K
Specifies the number of groups for the Hosmer-Lemeshow goodness-of-fit test with K. The default is 10.

MEANS termlist

Calculates the fitted mean probability for the terms that you specify in the termlist. You can use the following
commands to display and store the probabilities.

TMEANS
Displays the fitted mean probability for the specified terms.

SMEANS C
Stores the fitted mean probability for the specified terms.

ITERATION K

Specifies the maximum number of iterations for the optimization algorithm that estimates the coefficients. The
default is 50.

TOLERANCE K

Specifies the value in K above which Minitab removes highly correlated predictors and nearly constant predictors.
By default, K = 1E-12.

The tolerance value determines when Minitab retains a factor in the model that is either highly correlated with a
different factor or that is almost constant. Lowering tolerance by giving very small argument values can prevent
Minitab from eliminating problematic predictor columns from the model.
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Collinearity 1-R? where R? is the value that results from regressing one predictor on the remaining
predictors. If (1 - R2) is < (K), then the predictor is removed from the equation.

Almost constant If the coefficient of variation of a predictor (the standard deviation / the mean) is <
square root (K), then the predictor is considered essentially constant and is removed
from the equation.

CTOLERANCE K
Specifies the convergence criterion for the algorithm that estimates the coefficients. By default, K = 1E-8.

START C
Specifies a column that contains starting values for the coefficients in the optimization algorithm. The column
begins with the estimate of the constant, then follows the order of the model after TERMS.

Stepwise regression subcommands

FINFORMATION, STEPWISE, FORWARD, and BACKWARD perform a stepwise regression procedure to fit the model. No
arguments are needed for these subcommands.

FINFORMATION
Specifies a stepwise model selection procedure that uses forward information criteria selection. Use AICCORRECTED
or BICRITERION to specify which information criterion to use to select the final model. If you do not specify a
criterion, Minitab uses AICCORRECTED.

The forward information criteria procedure adds the term with the lowest p-value to the model at each step. If
you do not include subcommands about hierarchy, FINFORMATION adds 1 term at a step and maintains model
hierarchy, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

Minitab calculates the information criteria for each step.

In most cases, the procedure continues until one of the following conditions occurs:

e The procedure does not find a new minimum of the criterion for 8 consecutive steps.
e The procedure fits the full model.

e The procedure fits a model that leaves 1 degree of freedom for error.

If you specify settings for the procedure that require a hierarchical model at each step and allow only one term
to enter at a time, then the procedure continues until it either fits the full model or fits a model that leaves 1
degree of freedom for error. Minitab displays the results of the analysis for the model with the minimum value
of the selected information criterion, either the corrected Akaike's Information Criterion (AlCc) or the Bayesian
Information Criterion (BIC).

ATICCORRECTED
Specifies the use of the corrected Akaike's Information Criterion (AlCc) to select the final model.

BICRITERION
Specifies the use of the Bayesian Information Criterion (BIC) to select the final model.

STEPWISE
Specifies a stepwise model selection procedure that uses both forward selection and backward elimination. If you
do not include subcommands about hierarchy, STEPWISE and FORWARD add 1 term at a step and maintain model
hierarchy, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.
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FORWARD
Specifies a stepwise model selection procedure that uses forward selection. If you do not include subcommands
about hierarchy, STEPWISE and FORWARD add 1 term at a step and maintain model hierarchy, the equivalent of
the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

BACKWARD
Specifies a stepwise model selection procedure that uses backward elimination. Removes a single term at each
step and maintains a hierarchical model, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS.

AENTER K
Specifies the alpha level at which a term is entered into the model. The default is 0.15 for STEPWISE and 0.25
for FORWARD.

AREMOVE K
Specifies the alpha level at which a term is removed from the model. The default is 0.15 for STEPWISE and
0.10 for BACKWARD. For STEPWISE, K must be greater than or equal to K for AENTER.

ENTER termlist
Specifies the terms that are contained in the starting model for STEPWISE. The ENTER termlist must be a
subset of the TERMS termlist or in the default term list in the design.

FORCE termlist
Specifies the terms to be forced in the model. The FORCE termlist must be a subset of the TERMS termlist
or in the default term list in the design.

NOHIERARCHICAL
Specifies that the model selection procedure does not consider hierarchy.

HIERARCHICAL
Maintains a hierarchical model in stepwise regression. In a hierarchical model, if a higher-order term is
included, all lower-order terms that comprise the higher-order term also appear in the model. For example,
a model that includes the interaction term A*B*C is hierarchical if it includes the following main effects and
lower-order interactions: A, B, C, A*B, A*C, and B*C.

CATONLY
Specifies that only the categorical terms in the model have to be hierarchical.

ALLTERMS
Specifies that both categorical and continuous terms have to be hierarchical.

ATEND
Specifies that the final step of the stepwise procedure adds terms to make the model hierarchical.

ALWAYS
Specifies that the model is hierarchical at every step.

SINGLE
Specifies that only one term can enter the model at each step. So a higher-order term can enter
the model only if the terms that comprise the term are already in the model. For example, the
algorithm does not consider the addition of A*B unless A and B are already in the model.

BACKWARDS does not use SINGLE or MULTIPLE because terms only exit the model.
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MULTIPLE

Specifies that multiple terms can enter the model at each step. So a higher order term can enter
the model, and the terms that comprise the term enter the model at the same time. For example,
if A*B is the most statistically significant term, A*B enters the model. At the same time, A and B
enter the model if those terms are not in the model already.

BACKWARDS does not use SINGLE or MULTIPLE because terms only exit the model.

Graphs subcommands

RTYPE K
Specifies the type of residual to plot with the graph subcommands.

Value of K Type of residuals

1 (default) Regular or raw residuals (RESIDUALS)

2 Standardized residuals (SRESIDUALS)

3 Deleted Studentized residuals (TRESIDUALS)
GEFFECTS

Displays a normal probability plot of the effects or the standardized effects. Minitab labels the effects on the
probability plot that are considered significant. The alpha level is (1 — the confidence level) that follows CONFIDENCE,
unless you use stepwise selection that depends on an alpha level. For forward selection, the alpha level is the level
that follows AENTER. For backward and stepwise selection, the alpha level is the level that follows AREMOVE.

GHALF

Displays a half normal probability plot of the effects or standardized effects. Minitab labels the effects on the half
normal plot that are considered significant. The alpha level is (1 — the confidence level) that follows CONFIDENCE,
unless you use stepwise selection that depends on an alpha level. For forward selection, the alpha level is the level
that follows AENTER. For backward and stepwise selection, the alpha level is the level that follows AREMOVE.

GPARETO

Displays a Pareto chart of the absolute effects. GPARETO draws a vertical reference line on the plot at the margin
of error. This plot lets you to look at both the magnitude and the importance of an effect at the same time. The
alpha level is (1 —the confidence level) that follows CONFIDENCE, unless you use stepwise selection that depends
on an alpha level. For forward selection, the alpha level is the level that follows AENTER. For backward and stepwise
selection, the alpha level is the level that follows AREMOVE.

GALLEFFECTS K

Specifies to include the model terms and the terms that are not in the model up to order K on the plots. If you
specify a stepwise method, Minitab ignores K and shows the terms in the candidate list.

GMODEL
Specifies that only the terms that are in the model are on the plots.

GHISTOGRAM
Displays a histogram of the residuals.

GNORMAL
Displays a normal probability plot of the residuals.
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GFITS
Displays residuals versus fitted values.

GORDER [C]
Plots the residuals versus the order of the data, or versus the order specified in C. The row number for each data
point is shown on the x-axis (for example, 12 3 4...n).

GFOURPACK [C]
Displays four residual plots—a histogram of the residuals, a normal probability plot of the residuals, the residuals
versus fitted the values, and the residuals versus the order of the data, or versus the order specified in C—in one
graph.

GVARIABLE C...C
Displays the residuals versus the variables in C. Typically, you enter the columns for the predictors.

Results subcommands

NODEFAULT
Hides default tables and graphs that you do not include the subcommand to display.

TEXPAND
Displays the expanded versions of the tables that have them. The expanded Analysis of Variance table adds the
sequential deviances and percent contributions for each term. The Coefficients table adds confidence intervals
for the coefficients. The Fits and Diagnostics table adds the standard error of the fit, the 95% confidence interval
for the fit, the deleted residual, the HI, the Cook's D, and the DFITS.

TSIMPLE
Displays the simple versions of the Analysis of Variance table, the Coefficients table, and the Fits and Diagnostics
table.

TMETHOD
Displays a table of information about the method and options.

TMSDETAILS
Displays the type of stepwise procedure and the alpha values to enter and/or remove a predictor from the model.

If you do not specify FULL or NOFULL, then Minitab uses the preferences that you set in File > Options > Linear
Models > Stepwise.

FULL
Specifies to display the coefficients, p-values, and model summary statistics for each step of the procedure.

NOFULL
Hides these statistics.

TRINFO
Displays the number of events, non-events, and the total. The table also indicates which response value is the
reference event.

TSTEP
Displays the deviance at each iteration of the coefficients.

TCOEFFICIENTS
Displays the coefficients and the p-values for the Wald normal approximation tests.
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If you do not specify FULL or NOFULL, Minitab uses the preferences that you set in File > Options > Linear
Models > Display of Results.

FULL
Specifies to show the coefficients for the reference level when you use (0, 1) coding for categorical predictors.

NOFULL
Hides these statistics.

TODDS

Displays odds ratios for each continuous predictor and each level of the categorical predictors. The output does
not show odds ratios for predictors with interactions in the model.

INCREMENT K. ..K

Specifies the increment for the odds ratio for the predictor with K. For example, if the predictor is mass in
grams, enter 1000 to see the change in the odds ratio for a kilogram. Enter a value for each numeric factor
in the same order that the factors follow the FACTOR subcommand. Then, enter a value for each covariate
in the order that the covariates follow the COVARIATE subcommand. Enter 1 for a factor or covariate to use
the same units as the data.

TSUMMARY
Displays the statistics that evaluate model fit, including deviance R%.

TGOODNESS

Displays the Pearson and deviance goodness-of-fit tests. For the binomial distribution models, also shows the
Hosmer-Lemeshow goodness-of-fit test.

TDEVIANCE
Displays the ANOVA table.

TEQUATION

Displays the regression equation table. If the model is hierarchical, the equation is in uncoded units. If the model
is nonhierarchical, the equation is in coded units.

TMEANS
Displays the table of fitted mean probabilities for all combinations of the factor levels that you specify in MEANS.

THOSMER
Displays the table of observed and expected values for the Hosmer-Lemeshow test.

TASSOCIATION

Displays the number of concordant and discordant pairs, the Somers' D, the Goodman-Kruskal Gamma, and
Kendall's Tau-a.

TDIAGNOSTICS [K]

Displays a table of diagnostics. K = 0 displays diagnostics for only observations with high leverage values or
standardized residuals greater than 2. K = 1 displays diagnostics for all observations.

TALIAS [K]
Displays the alias table up to order K. One line is displayed for each term in the model, with a list of all terms, up
to order K, that are aliased with the model term. If K is omitted, then Minitab uses the default rule of FFDESIGN:
all interactions for 2 to 6 factors, up to three-way interaction for 7 to 10 factors, and two-way interactions for
more than 10.
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Storage subcommands

FITS C
Stores the event probabilities in C.

RESIDUALS C
Stores the deviance residuals by default in C. Stores the Pearson residuals if you use the subcommand PEARSON.

SRESIDUALS C

Stores the standardized deviance residuals by default in C. Stores the standardized Pearson residuals if you use
the subcommand PEARSON.

TRESIDUALS C

Stores the deleted deviance residuals by default in C. Stores the deleted Pearson residuals if you use the
subcommand PEARSON.

COOK C
Stores the Cook's distances in C.

DFITS C
Stores the DFITS in C.

HI C
Stores the leverages in C.

SADJUSTEDRESP C
Stores the final adjusted response values in C.

SIWEIGHTS C
Stores the internal weights used to estimate the model parameters in C.

SECOEFFICIENTS C
Stores the standard errors of the estimated coefficients in C.

COEFFICIENTS C
Stores the estimated coefficients in C.

EFFECTS C
Stores the effects that are included in the output in C.
Note Effects are not displayed or stored for the constant, covariates, or blocks.

SMEANS C
Stores the fitted mean probability for the specified terms in C.

DBETA C
Stores the change in the estimated regression coefficients (delta b) when you delete all observations with a
particular factor/covariate pattern in C. Use the delta b values to detect observations with a strong influence on
the coefficients.

DSBETA C
Stores the change in the estimated regression coefficients when you delete all observations with a particular
factor/covariate pattern based on the standardized Pearson residual in C.
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DCHISQUARE C

Stores the change in the chi-square statistic when you delete all observations with a particular factor/covariate
pattern in C. Observations that are poorly fit by the model have high delta chi-square values.

DDEVIANCE C

Stores the change in the deviance when you delete all observations with a particular factor/covariate pattern in
C.

XMATRIX M
Stores the design matrix in M.

XPWXINVERSE M
Stores the X'WX inverse matrix of the estimated coefficients in M.

GFACTORIAL: Session command for fitting a general full factorial
design

GFACTORIAL

Analyzes a general factorial design that can have categorical predictors and continuous covariates using least
squares regression.

Fits general full factorial models, including those produced by FDESIGN on page 277. In addition, you can have
covariates and a blocking factor.

For general full factorial designs, you specify the number of factors and the levels of each factor. You can have
arbitrary levels but no fractional designs.

The design does not have to be orthogonal. You can specify up to 25 responses and have 2 to 15 factors. Each
factor must have at least 2 levels and at most 100 levels. The number of levels can be different for each factor.

Specify interactions in the following way: C5*C6. For more information on specifying the model, go to How to
specify the model for factorial designs on page 1166.

Optionally, you can store the residuals, fitted values, and many other diagnostics for further analysis.

You can use extra text on the command and subcommand lines only after a #. Quotation marks around column
names are optional.

For information about how Minitab calculates the model, go to Calculations for FFACTORIAL on page 1136.
For information on how Minitab handles missing data, go to Missing values in factorial, response surface, and

mixture designs on page 1171.

RESPONSE C
Specifies the column that contains the response variable. The column must be numeric or date/time.

BLOCKS C (optional)

Specifies the column that contains the blocking information. Include the blocking column together with
TERMS to make a model that considers blocks.

FACTOR C...C

Specifies the categorical factors, if you have any. The columns can be numeric, text, or date/time. The columns
must have the same number of rows as the response column.
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NLEVELS K...K

Use both NLEVELS and LEVELS when the factor levels in the worksheet are coded and you want to display
uncoded levels in the results.

NLEVELS specifies the number of levels for each factor. Each K must be an integer from 2 to 100. You must
specify the same number of K arguments as the number of columns that you specify in FACTOR.

LEVELS E...E

Use both NLEVELS and LEVELS when the factor levels in the worksheet are coded and you want to display
uncoded levels in the results.

LEVELS specifies the uncoded values for all the factor levels. You must specify the same number of values
for LEVELS as the number of arguments that you specify for NLEVELS. The group of values for each factor
must be of the same type.

COVARIATES C...C

Specifies which columns of variables are continuous. Include the covariate columns with terms to make a
model that considers the covariates. Covariates are fit first, then the blocks, then all other terms. You can
have up to 50 covariates.

TERMS termlist

Specifies the terms to include in the model. Terms can contain a maximum of two factors. Only continuous
predictors can be repeated. Nested terms are not allowed. If terms are to be fitted, they must contain the
blocks. The model can be nonhierarchical.

Options

WEIGHT C

Performs a weighted regression. An n x n matrix W is formed with the column of weights as its diagonal and zeros
elsewhere. The regression coefficients are estimated by the following:

XWX ' (XWY)
This is equivalent to minimizing the weighted SS Error as follows:
Zw; (Y- )2 where w; is the weight in row i

The prediction interval that is calculated by PREDICT assumes a weight of 1. If you use the WEIGHT subcommand
with values other than 1, you should adjust the prediction interval values manually.

CONFIDENCE K

Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of K is 95.

ITYPE K
Specifies the type of confidence interval.

Value of K Type of confidence interval
-1 Lower bound

0 (default) Two-sided

1 Upper bound
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TOLER K
Specifies the tolerance level for collinearity and constant check. By default, K = 1E-12.

Box-Cox

BOXCOX [K]

Transforms each variable or group to follow a normal distribution using the lambda value in K. K must be between

-5 and +5. If you do not specify K, then Minitab finds the optimal lambda. By default, Minitab rounds the optimal
value.

To use the exact lambda, change the setting in File > Options > Linear Models > Display of Results.

Minitab cannot calculate the optimal lambda for stepwise regression. So you must specify a lambda value for
BOXCOX if you use STEPWISE, FORWARD, or BACKWARD.

Means

MEANS termlist
Calculates least squares means for the specified terms. You can use the following commands to display and store
the least squares means.
TMEANS
Displays the calculated least squares means for the specified terms.

SMEANS
Stores the calculated least squares means for the specified terms.

BSMEANS
If you transformed the data, stores the calculated least squares means for the specified terms.

Stepwise

FINFORMATION, STEPWISE, FORWARD, and BACKWARD perform a stepwise regression procedure to fit the model. No
arguments are needed for these subcommands.
FINFORMATION

Specifies a stepwise model selection procedure that uses forward information criteria selection. Use AICCORRECTED
or BICRITERION to specify which information criterion to use to select the final model. If you do not specify a
criterion, Minitab uses AICCORRECTED.

The forward information criteria procedure adds the term with the lowest p-value to the model at each step. If
you do not include subcommands about hierarchy, FINFORMATION adds 1 term at a step and maintains model
hierarchy, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.
Minitab calculates the information criteria for each step.

In most cases, the procedure continues until one of the following conditions occurs:

e The procedure does not find a new minimum of the criterion for 8 consecutive steps.
e The procedure fits the full model.

e The procedure fits a model that leaves 1 degree of freedom for error.

If you specify settings for the procedure that require a hierarchical model at each step and allow only one term
to enter at a time, then the procedure continues until it either fits the full model or fits a model that leaves 1
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degree of freedom for error. Minitab displays the results of the analysis for the model with the minimum value
of the selected information criterion, either the corrected Akaike's Information Criterion (AlCc) or the Bayesian
Information Criterion (BIC).

ATICCORRECTED
Specifies the use of the corrected Akaike's Information Criterion (AlCc) to select the final model.

BICRITERION
Specifies the use of the Bayesian Information Criterion (BIC) to select the final model.

STEPWISE
Specifies a stepwise model selection procedure that uses both forward selection and backward elimination. If you
do not include subcommands about hierarchy, STEPWISE and FORWARD add 1 term at a step and maintain model
hierarchy, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

FORWARD
Specifies a stepwise model selection procedure that uses forward selection. If you do not include subcommands
about hierarchy, STEPWISE and FORWARD add 1 term at a step and maintain model hierarchy, the equivalent of
the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

BACKWARD
Specifies a stepwise model selection procedure that uses backward elimination. Removes a single term at each
step and maintains a hierarchical model, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS.

AENTER K
Specifies the alpha level at which a term is entered into the model. The default is 0.15 for STEPWISE and 0.25
for FORWARD.

AREMOVE K
Specifies the alpha level at which a term is removed from the model. The default is 0.15 for STEPWISE and
0.10 for BACKWARD. For STEPWISE, K must be greater than or equal to K for AENTER.

ENTER termlist
Specifies the terms that are contained in the starting model for STEPWISE. The ENTER termlist must be a
subset of the TERMS termlist or in the default term list in the design.

FORCE termlist
Specifies the terms to be forced in the model. The FORCE termlist must be a subset of the TERMS termlist
or in the default term list in the design.

NOHIERARCHICAL
Specifies that the model selection procedure does not consider hierarchy.

HIERARCHICAL
Maintains a hierarchical model in stepwise regression. In a hierarchical model, if a higher-order term is
included, all lower-order terms that comprise the higher-order term also appear in the model. For example,
a model that includes the interaction term A*B*C is hierarchical if it includes the following main effects and
lower-order interactions: A, B, C, A*B, A*C, and B*C.

CATONLY
Specifies that only the categorical terms in the model have to be hierarchical.
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ALLTERMS
Specifies that both categorical and continuous terms have to be hierarchical.

ATEND
Specifies that the final step of the stepwise procedure adds terms to make the model hierarchical.

ALWAYS
Specifies that the model is hierarchical at every step.

SINGLE

Specifies that only one term can enter the model at each step. So a higher-order term can enter
the model only if the terms that comprise the term are already in the model. For example, the
algorithm does not consider the addition of A*B unless A and B are already in the model.

BACKWARDS does not use SINGLE or MULTIPLE because terms only exit the model.

MULTIPLE

Specifies that multiple terms can enter the model at each step. So a higher order term can enter
the model, and the terms that comprise the term enter the model at the same time. For example,
if A*B is the most statistically significant term, A*B enters the model. At the same time, A and B
enter the model if those terms are not in the model already.

BACKWARDS does not use SINGLE or MULTIPLE because terms only exit the model.

Graphs

GPARETO

Displays a Pareto chart of the absolute effects. GPARETO draws a vertical reference line on the plot at the margin
of error. This plot lets you to look at both the magnitude and the importance of an effect at the same time. The
alpha level is 1 — the confidence level that follows CONFIDENCE, unless you use stepwise selection that depends
on an alpha level. For forward selection, the alpha level is the level that follows AENTER. For backward and stepwise
selection, the alpha level is the level that follows AREMOVE.

GALLEFFECTS K

Specifies to include the model terms and the terms that are not in the model up to order K on the plots. If you
specify a stepwise method, Minitab ignores K and shows the terms in the candidate list.

GMODEL
Specifies that only the terms that are in the model are on the plots.

RTYPE K
Specifies the type of residual to plot with the graph subcommands.

Value of K Type of residuals

1 (default) Regular or raw residuals (RESIDUALS)

2 Standardized residuals (SRESIDUALS)

3 Deleted Studentized residuals (TRESIDUALS)
GHISTOGRAM

Displays a histogram of the residuals.
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GNORMAL
Displays a normal probability plot of the residuals.

GFITS
Plots the residuals versus the fitted values.

GORDER [C]
Plots the residuals versus the order of the data, or versus the order specified in C. The row number for each data
point is shown on the x-axis (for example, 12 3 4...n).

GFOURPACK [C]
Displays four residual plots—a histogram of the residuals, a normal probability plot of the residuals, the residuals
versus fitted the values, and the residuals versus the order of the data, or versus the order specified in C—in one

graph.

GVARIABLE C...C
Plots the residuals versus variables. Displays a separate graph for the residuals versus each specified column.

Results
The following subcommands specify what is displayed in the results.

NODEFAULT
Specifies that no default tables or graphs are displayed.

TEXPAND
Displays the expanded versions of the ANOVA table, the table of coefficients, the model summary table, and the
table of unusual observations.

TSIMPLE
Displays the simple versions of the ANOVA table, the table of coefficients, the model summary table, and the
table of unusual observations.

TMETHOD
Displays the method table.

TMSDETAILS
Displays the type of stepwise procedure and the alpha values to enter and/or remove a predictor from the model.
If you do not specify FULL or NOFULL, then Minitab uses the settings in File > Options > Linear Models >
Stepwise.

FULL
Displays the coefficients, the p-values, Mallows' Cp, and the model summary statistics for each step of the
procedure.

NOFULL
Does not display the coefficients, the p-values, Mallows' Cp, and the model summary statistics for each step
of the procedure.

TFACTOR
Displays information about the factors.

TEQUATION
Displays the regression equation table.
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TCOEFFICIENT
Displays the table of coefficients. If you do not specify FULL or NOFULL, then Minitab uses the settings in File >
Options > Linear Models > Display of Results.

FULL
Displays the full set of coefficients for categorical predictors.

NOFULL
Displays only the linearly independent coefficients.

TSUMMARY
Displays the summary of model table, which includes the R statistics and S. The expanded version of the table
includes the prediction sum of squares (PRESS), the corrected Akaike's Information Criterion (AlCc) and the Bayesian
Information Criterion (BIC).

TANOVA
Displays the ANOVA table. The expanded version of the table includes the sequential sums of squares and the
percent contribution to the total sum of squares.

TDIAGNOSTICS [K]

Displays a table of diagnostics. The expanded version of the table includes the standard error of the fit, the
confidence interval for the fit, the deleted residual, the leverage, the Cook's D, and the DFITS.

Value of K Diagnostics that are displayed
0 Diagnostics only for unusual observations
1 Diagnostics for all observations

TMEANS

Displays the least squares means for all combinations of the factor levels that you specify in MEANS.

Storage
The following subcommands specify what is stored in the worksheet.

BCRESP C
Stores the Box-Cox transformation of the response.

BFITS C
Stores the fits for the original response.

FITS C
Stores the fitted values.

SMEANS C

Stores the least squares means for all combinations of factor levels that you specified in MEANS, in C.

BSMEANS C
Stores the least squares means for the original response, if the data were transformed. Stores all combinations
of factor levels that you specified in MEANS, in C.

RESIDUALS C
Stores the residuals (fitted values — observed values).
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SRESIDUALS C
Stores the standardized residuals.

TRESIDUALS C
Stores the deleted Studentized residuals in C.

HI C
Stores the leverage values.

COOK C
Stores the Cook's distance values, using one column for each response, in C.

DFITS C
Stores the DFITS (also called DFFITS), using one column for each response, in C.

COEFFICIENTS C
Stores the estimated coefficients.

XMATRIX M
Stores the design matrix for the regression model in M.

BGFACTORIAL: Session command for analyzing a general full
factorial design with a binary response.

Required commands

To perform the analysis, use the main command and at least these accompanying subcommands.

BGFACTORIAL
Analyzes a general factorial design that can have categorical predictors and continuous covariates with a binary
response.

Fits general full factorial models, including those produced by FDESIGN on page 277. In addition, you can have
covariates and a blocking factor.

For general full factorial designs, you specify the number of factors and the levels of each factor. You can have
arbitrary levels but no fractional designs.

The design does not have to be orthogonal. You can specify up to 25 responses and have 2 to 15 factors. Each
factor must have at least 2 levels and at most 100 levels. The number of levels can be different for each factor.

Specify interactions in the following way: C5*C6. For more information on specifying the model, go to How to
specify the model for factorial designs on page 1166.

This analysis provides diagnostic plots, goodness-of-fit tests, and other diagnostic measures so you can assess
the validity of your model. For more information, go to Generalized linear model diagnostics and residual analysis
on page 1177.

Minitab excludes all observations with missing values on either the response variable or any of the predictors
from all calculations.
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RESPONSE C C
Enters the response data as a column that contains the number of events first and then a column that contains
the number of trials. The columns must have the same number of rows.For examples, go to Entering data
for response variables on page 1142.

FACTOR C...C
Specifies the factors in columns C...C. The columns must have the same number of rows as the response
columns.

TERMS termlist
Specifies the terms to include in the model. Only continuous predictors can repeat in a single term. Nested
terms are not allowed. The model can be nonhierarchical.

Optional subcommands

Use these subcommands and the subcommands in the following sections to change the default analysis.

EVNAME K
Specify the name of the event with K. Enclose text values in double quotation marks.

LOGIT
Use the logit link function.

NORMIT
Use the normit link function.

GOMPIT
Use the gompit link function. The gompit link function is also called the complementary log-log link function.

BLOCKS C
Specifies the column that contains the blocking information in C. Include the blocking column together with
TERMS to make a model that considers blocks.

COVARIATES C...C

Specifies columns that include covariates in C...C. Include the covariate columns with TERMS to make a model
that considers the covariates. Covariates are fit first, the blocks second, and then all other terms. You can have up
to 50 covariates.

NLEVELS K...K
Use both NLEVELS and LEVELS when the factor levels in the worksheet are coded and you want to display uncoded
levels in the results.

NLEVELS specifies the number of levels for each factor. Each K must be an integer from 2 to 100. You must specify
the same number of K arguments as the number of columns that you specify in FACTOR.

LEVELS E...E
Use both NLEVELS and LEVELS when the factor levels in the worksheet are coded and you want to display uncoded
levels in the results.

LEVELS specifies the uncoded values for all the factor levels. You must specify the same number of values for
LEVELS as the number of arguments that you specify for NLEVELS. The group of values for each factor must be
of the same type.
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Options subcommands

CONFIDENCE K

Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of K'is 95.

ITYPE K
Specifies the type of confidence interval.

Value of K Type of confidence interval
-1 Lower bound
0 (default) Two-sided
1 Upper bound
SEQDEVIANCE

Use sequential deviances for the tests of significance in the ANOVA table. The order of the terms in TERMS affects
the statistical significance. The default is to use adjusted deviances.

PEARSON
Specifies the use of Pearson residuals. The default is to use deviance residuals.

WEIGHT C

Performs a weighted regression. An n x n matrix W is formed with the column of weights as its diagonal and zeros
elsewhere. The regression coefficients are estimated by:

XWX ' (X'wWY)

HGROUP K
Specifies the number of groups for the Hosmer-Lemeshow goodness-of-fit test with K. The default is 10.

MEANS termlist

Calculates the fitted mean probability for the terms that you specify in the termlist. You can use the following
commands to display and store the probabilities.

TMEANS
Displays the fitted mean probability for the specified terms.

SMEANS C
Stores the fitted mean probability for the specified terms.

ITERATION K

Specifies the maximum number of iterations for the optimization algorithm that estimates the coefficients. The
default is 50.

TOLERANCE K

Specifies the value in K above which Minitab removes highly correlated predictors and nearly constant predictors.
By default, K = 1E-12.

The tolerance value determines when Minitab retains a factor in the model that is either highly correlated with a
different factor or that is almost constant. Lowering tolerance by giving very small argument values can prevent
Minitab from eliminating problematic predictor columns from the model.
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Collinearity 1-R? where R? is the value that results from regressing one predictor on the remaining
predictors. If (1 - R2) is < (K), then the predictor is removed from the equation.

Almost constant If the coefficient of variation of a predictor (the standard deviation / the mean) is <
square root (K), then the predictor is considered essentially constant and is removed
from the equation.

CTOLERANCE K
Specifies the convergence criterion for the algorithm that estimates the coefficients. By default, K = 1E-8.

START C
Specifies a column that contains starting values for the coefficients in the optimization algorithm. The column
begins with the estimate of the constant, then follows the order of the model after TERMS.

Stepwise regression subcommands

FINFORMATION, STEPWISE, FORWARD, and BACKWARD perform a stepwise regression procedure to fit the model. No
arguments are needed for these subcommands.

FINFORMATION
Specifies a stepwise model selection procedure that uses forward information criteria selection. Use AICCORRECTED
or BICRITERION to specify which information criterion to use to select the final model. If you do not specify a
criterion, Minitab uses AICCORRECTED.

The forward information criteria procedure adds the term with the lowest p-value to the model at each step. If
you do not include subcommands about hierarchy, FINFORMATION adds 1 term at a step and maintains model
hierarchy, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

Minitab calculates the information criteria for each step.

In most cases, the procedure continues until one of the following conditions occurs:

e The procedure does not find a new minimum of the criterion for 8 consecutive steps.
e The procedure fits the full model.

e The procedure fits a model that leaves 1 degree of freedom for error.

If you specify settings for the procedure that require a hierarchical model at each step and allow only one term
to enter at a time, then the procedure continues until it either fits the full model or fits a model that leaves 1
degree of freedom for error. Minitab displays the results of the analysis for the model with the minimum value
of the selected information criterion, either the corrected Akaike's Information Criterion (AlCc) or the Bayesian
Information Criterion (BIC).

ATICCORRECTED
Specifies the use of the corrected Akaike's Information Criterion (AlCc) to select the final model.

BICRITERION
Specifies the use of the Bayesian Information Criterion (BIC) to select the final model.

STEPWISE
Specifies a stepwise model selection procedure that uses both forward selection and backward elimination. If you
do not include subcommands about hierarchy, STEPWISE and FORWARD add 1 term at a step and maintain model
hierarchy, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

Minitab =’ 315



Minitab Statistical Software DOE

FORWARD
Specifies a stepwise model selection procedure that uses forward selection. If you do not include subcommands
about hierarchy, STEPWISE and FORWARD add 1 term at a step and maintain model hierarchy, the equivalent of
the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

BACKWARD
Specifies a stepwise model selection procedure that uses backward elimination. Removes a single term at each
step and maintains a hierarchical model, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS.

AENTER K
Specifies the alpha level at which a term is entered into the model. The default is 0.15 for STEPWISE and 0.25
for FORWARD.

AREMOVE K
Specifies the alpha level at which a term is removed from the model. The default is 0.15 for STEPWISE and
0.10 for BACKWARD. For STEPWISE, K must be greater than or equal to K for AENTER.

ENTER termlist
Specifies the terms that are contained in the starting model for STEPWISE. The ENTER termlist must be a
subset of the TERMS termlist or in the default term list in the design.

FORCE termlist
Specifies the terms to be forced in the model. The FORCE termlist must be a subset of the TERMS termlist
or in the default term list in the design.

NOHIERARCHICAL
Specifies that the model selection procedure does not consider hierarchy.

HIERARCHICAL
Maintains a hierarchical model in stepwise regression. In a hierarchical model, if a higher-order term is
included, all lower-order terms that comprise the higher-order term also appear in the model. For example,
a model that includes the interaction term A*B*C is hierarchical if it includes the following main effects and
lower-order interactions: A, B, C, A*B, A*C, and B*C.

CATONLY
Specifies that only the categorical terms in the model have to be hierarchical.

ALLTERMS
Specifies that both categorical and continuous terms have to be hierarchical.

ATEND
Specifies that the final step of the stepwise procedure adds terms to make the model hierarchical.

ALWAYS
Specifies that the model is hierarchical at every step.

SINGLE
Specifies that only one term can enter the model at each step. So a higher-order term can enter
the model only if the terms that comprise the term are already in the model. For example, the
algorithm does not consider the addition of A*B unless A and B are already in the model.

BACKWARDS does not use SINGLE or MULTIPLE because terms only exit the model.
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MULTIPLE

Specifies that multiple terms can enter the model at each step. So a higher order term can enter
the model, and the terms that comprise the term enter the model at the same time. For example,
if A*B is the most statistically significant term, A*B enters the model. At the same time, A and B
enter the model if those terms are not in the model already.

BACKWARDS does not use SINGLE or MULTIPLE because terms only exit the model.

Graphs subcommands

RTYPE K
Specifies the type of residual to plot with the graph subcommands.

Value of K Type of residuals

1 (default) Regular or raw residuals (RESIDUALS)

2 Standardized residuals (SRESIDUALS)

3 Deleted Studentized residuals (TRESIDUALS)
GEFFECTS

Displays a normal probability plot of the effects or the standardized effects. Minitab labels the effects on the
probability plot that are considered significant. The alpha level is (1 — the confidence level) that follows CONFIDENCE,
unless you use stepwise selection that depends on an alpha level. For forward selection, the alpha level is the level
that follows AENTER. For backward and stepwise selection, the alpha level is the level that follows AREMOVE.

GHALF

Displays a half normal probability plot of the effects or standardized effects. Minitab labels the effects on the half
normal plot that are considered significant. The alpha level is (1 — the confidence level) that follows CONFIDENCE,
unless you use stepwise selection that depends on an alpha level. For forward selection, the alpha level is the level
that follows AENTER. For backward and stepwise selection, the alpha level is the level that follows AREMOVE.

GPARETO

Displays a Pareto chart of the absolute effects. GPARETO draws a vertical reference line on the plot at the margin
of error. This plot lets you to look at both the magnitude and the importance of an effect at the same time. The
alpha level is (1 —the confidence level) that follows CONFIDENCE, unless you use stepwise selection that depends
on an alpha level. For forward selection, the alpha level is the level that follows AENTER. For backward and stepwise
selection, the alpha level is the level that follows AREMOVE.

GALLEFFECTS K

Specifies to include the model terms and the terms that are not in the model up to order K on the plots. If you
specify a stepwise method, Minitab ignores K and shows the terms in the candidate list.

GMODEL
Specifies that only the terms that are in the model are on the plots.

GHISTOGRAM
Displays a histogram of the residuals.

GNORMAL
Displays a normal probability plot of the residuals.
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GFITS
Displays residuals versus fitted values.

GORDER [C]
Plots the residuals versus the order of the data, or versus the order specified in C. The row number for each data
point is shown on the x-axis (for example, 12 3 4...n).

GFOURPACK [C]
Displays four residual plots—a histogram of the residuals, a normal probability plot of the residuals, the residuals
versus fitted the values, and the residuals versus the order of the data, or versus the order specified in C—in one
graph.

GVARIABLE C...C
Displays the residuals versus the variables in C. Typically, you enter the columns for the predictors.

Results subcommands

NODEFAULT
Hides default tables and graphs that you do not include the subcommand to display.

TEXPAND
Displays the expanded versions of the tables that have them. The expanded Analysis of Variance table adds the
sequential deviances and percent contributions for each term. The Coefficients table adds confidence intervals
for the coefficients. The Fits and Diagnostics table adds the standard error of the fit, the 95% confidence interval
for the fit, the deleted residual, the HI, the Cook's D, and the DFITS.

TSIMPLE
Displays the simple versions of the Analysis of Variance table, the Coefficients table, and the Fits and Diagnostics
table.

TMETHOD
Displays a table of information about the method and options.

TMSDETAILS
Displays the type of stepwise procedure and the alpha values to enter and/or remove a predictor from the model.

If you do not specify FULL or NOFULL, then Minitab uses the preferences that you set in File > Options > Linear
Models > Stepwise.

FULL
Specifies to display the coefficients, p-values, and model summary statistics for each step of the procedure.

NOFULL
Hides these statistics.

TFACTOR
Displays information about the factors.

TRINFO
Displays the number of events, non-events, and the total. The table also indicates which response value is the
reference event.

TSTEP
Displays the deviance at each iteration of the coefficients.
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TCOEFFICIENTS
Displays the coefficients and the p-values for the Wald normal approximation tests.

If you do not specify FULL or NOFULL, Minitab uses the preferences that you set in File > Options > Linear
Models > Display of Results.

FULL
Specifies to show the coefficients for the reference level when you use (0, 1) coding for categorical predictors.

NOFULL
Hides these statistics.

TODDS
Displays odds ratios for each continuous predictor and each level of the categorical predictors. The output does
not show odds ratios for predictors with interactions in the model.

INCREMENT K. ..K
Specifies the increment for the odds ratio for a covariate with K. For example, if the covariate is mass in grams,
enter 1000 to see the change in the odds ratio for a kilogram. Enter a value for each covariate in the order
that the covariates follow the COVARIATE subcommand. Enter 1 for a covariate to use the same units as the
data.

TSUMMARY
Displays the statistics that evaluate model fit, including deviance R%.

TGOODNESS

Displays the Pearson and deviance goodness-of-fit tests. For the binomial distribution models, also shows the
Hosmer-Lemeshow goodness-of-fit test.

TDEVIANCE
Displays the ANOVA table.

TEQUATION
Displays the regression equation table. If the model is hierarchical, the equation is in uncoded units. If the model
is nonhierarchical, the equation is in coded units.

TMEANS
Displays the table of fitted mean probabilities for all combinations of the factor levels that you specify in MEANS.

THOSMER
Displays the table of observed and expected values for the Hosmer-Lemeshow test.

TASSOCIATION

Displays the number of concordant and discordant pairs, the Somers' D, the Goodman-Kruskal Gamma, and
Kendall's Tau-a.

TDIAGNOSTICS [K]
Displays a table of diagnostics. K = 0 displays diagnostics for only observations with high leverage values or
standardized residuals greater than 2. K = 1 displays diagnostics for all observations.

Storage subcommands

FITS C
Stores the event probabilities in C.
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RESIDUALS C
Stores the deviance residuals in C by default. Stores the Pearson residuals if you use the subcommand PEARSON.

SRESIDUALS C

Stores the standardized deviance residuals in C by default. Stores the standardized Pearson residuals if you use
the subcommand PEARSON.

TRESIDUALS C

Stores the deleted deviance residuals in C by default. Stores the deleted Pearson residuals if you use the
subcommand PEARSON.

COOK C
Stores the Cook's distances in C.

DFITS C
Stores the DFITS in C.

HI C
Stores the leverages in C.

SADJUSTEDRESP C
Stores the final adjusted response values in C.

SIWEIGHTS C
Stores the internal weights used to estimate the model parameters in C.

SECOEFFICIENTS C
Stores the standard errors of the estimated coefficients in C.

COEFFICIENTS C
Stores the estimated coefficients in C.

SMEANS C
Stores the fitted mean probability for the specified terms in C.

DBETA C
Stores the change in the estimated regression coefficients (delta b) when you delete all observations with a
particular factor/covariate pattern in C. Use the delta b values to detect observations with a strong influence on
the coefficients.

DSBETA C

Stores the change in the estimated regression coefficients when you delete all observations with a particular
factor/covariate pattern based on the standardized Pearson residual in C.

DCHISQUARE C
Stores the change in the chi-square statistic when you delete all observations with a particular factor/covariate
pattern in C. Observations that are poorly fit by the model have high delta chi-square values.

DDEVIANCE C

Stores the change in the deviance when you delete all observations with a particular factor/covariate pattern in
C.

XMATRIX M
Stores the design matrix in M.
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XPWXINVERSE M
Stores the X'WX inverse matrix of the estimated coefficients in M.

SPFACTORIAL: Session command for analyzing a 2-level split-plot
design

SPFACTORIAL
Analyzes a 2-level split-plot designs that is produced by SPDESIGN on page 284. In a split-plot experiment, levels
of the hard-to-change factor are held constant for several experimental runs, which are collectively treated as a
whole plot treatment. The easy-to-change factors are varied over these runs, each of which is considered a subplot
treatment.

Your split-plot design can include covariates and blocks. Specify interactions in the following way: C5*C6.

You can display effects plots (normal, half-normal, and Pareto) for either subplot effects only or subplot and whole
plot effects. You can also display residual plots. You can store the residuals, fitted values, and other diagnostics
for further analysis.

RESPONSE C
Specifies the column that contains the response variable. The column must be numeric or date/time.

FACTOR C...C (required)
Specifies the column that contains the response variable. The column must be numeric or date/time.

HTCHANGE C...C
Specifies factors C...C as hard-to-change. These columns are a subset of the columns that follow FACTOR.

WPID C
Specifies the whole plot that each experimental run belongs in.

TERMS termlist

Specifies the model terms. Only continuous predictors can repeat in a single term. Nested terms are not
allowed. The model can be nonhierarchical.

BLOCKS C

Specifies the column that contains the blocking information (optional). Include the blocking column with
TERMS to make a model that considers blocks.

COVARIATES C...C

Specifies columns that include covariates. Include the covariate columns with terms to make a model that
considers the covariates. Covariates are fit first, the blocks second, and then all other terms. You can have
up to 50 covariates.

INUNIT K
Specifies whether the design is in coded form or uncoded form.

Value of K Form of design
0 Coded
1 Uncoded
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LEVELS K K,..., K K

LEVELS C

Specifies the uncoded levels for the factors. For each factor, the list or column must contain two numerical
values. Use LEVELS to change the default order of levels that Minitab uses. You can use a column only when
all the levels are continuous or all of the levels are categorical.

Options

CONFIDENCE K
Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of K is 95.

ITYPE K
Specifies the type of confidence interval.

Value of K Type of confidence interval
-1 Lower bound
0 (default) Two-sided
1 Upper bound
BOXCOX [K]

Performs a Box-Cox transformation with a specified lambda. K is the value of lambda and must be between -5
and +5. If K'is not given, Minitab will find the optimal lambda. By default, Minitab rounds the optimal value. To
use the exact lambda, specify NOROUND.

Minitab cannot calculate the optimal lambda for stepwise regression. Consequently, you must specify a lambda
value for BOXCOX if you use STEPWISE, FORWARD, or BACKWARD.

NOROUND
Specifies to use the exact lambda.

MEANS termlist
Calculates least squares means for the specified terms. Use TMEANS to display these means. Use SMEANS to
store these means, or BSMEANS if you transformed the data.

TOLERANCE K
Requires that Minitab retain a factor in the model that is either highly correlated with a different factor or that is
almost constant. Lowering tolerance by giving very small argument values can prevent Minitab from eliminating
problematic predictor columns from the model.

Collinearity 1-R? where R? is the value that results from regressing one predictor on the remaining
predictors. If (1 - R2) is < (K), then the predictor is removed from the equation.

Almost constant If the coefficient of variation of a predictor (the standard deviation / the mean) is <
square root (K), then the predictor is considered essentially constant and is removed
from the equation.

K must be positive and less than 1. The default value is 8.88E-16.
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Graphs

GEFFECTS
Displays a normal probability plot of the effects or standardized effects. Minitab labels the effects on the probability
plot that are considered significant. The alpha level is 1 — the confidence level that follows CONFIDENCE, unless
you use stepwise selection. For forward selection, the alpha level is the level that follows AENTER. For backward
and stepwise selection, the alpha level is the level that follows AREMOVE.

GHALF
Displays a half normal probability plot of the effects or standardized effects. Minitab labels the effects on the half
normal plot that are considered significant. The alpha level is 1 — the confidence level that follows CONFIDENCE,
unless you use stepwise selection. For forward selection, the alpha level is the level that follows AENTER. For
backward and stepwise selection, the alpha level is the level that follows AREMOVE.

GPARETO
Displays a Pareto chart of the absolute effects. GPARETO draws a vertical reference line on the plot at the margin
of error. This plot lets you to look at both the magnitude and the importance of an effect at the same time. The
alpha level is 1 — the confidence level that follows CONFIDENCE, unless you use stepwise selection. For forward
selection, the alpha level is the level that follows AENTER. For backward and stepwise selection, the alpha level is
the level that follows AREMOVE.

GWHOLE
Specifies to show plots for whole plot effects that are in the model as well as subplot effects.

GALLEFFECTS K

Specifies to include the model terms and the terms that are not in the model up to order K on the plots. If you
specify a stepwise method, Minitab ignores K and displays the terms in the candidate list.

GMODEL
Specifies that only the terms that are in the model are on the plots.

RTYPE K
Specifies the type of residual to plot with the graph subcommands.

Value of K Type of residuals

1 (default) Regular or raw residuals (RESIDUALS)

2 Standardized residuals (SRESIDUALS)

3 Deleted Studentized residuals (TRESIDUALS)
GHISTOGRAM

Displays a histogram or an individual value plot of the residuals, depending on the sample size.

GNORMAL
Displays a normal probability plot of the residuals.

GFITS
Plots the residuals versus the fitted values.

GORDER [C]
Plots the residuals versus the order of the data, or versus the order specified in C. The row number for each data
point is shown on the x-axis (for example, 12 3 4...n).
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GFOURPACK [C]
Displays a layout of a histogram of the residuals, a normal probability plot of the residuals, residuals versus fitted
values, and residuals versus the order of the data, or versus the order specified in C.

GVARIABLE C...C
Displays a separate graph for the residuals versus each specified column that.

Results
The following subcommands specify what is displayed in the results.

NODEFAULT
Specifies that no default tables or graphs are displayed.

TEXPAND
Displays the expanded versions of the ANOVA table, the table of coefficients, the model summary table, and the
table of unusual observations.

TSIMPLE
Displays the simple versions of the ANOVA table, the table of coefficients, the model summary table, and the
table of unusual observations.

TMETHOD
Displays the method table.

TEQUATION
The regression equation table. If the model is hierarchical, the equation is in uncoded units. If the model is
nonhierarchical, the equation is in coded units.

TCOEFFICIENTS
Displays the table of coefficients.

FULL
Displays the full set of coefficients for categorical predictors.

NOFULL
Displays only the linearly independent coefficients.

TSUMMARY
The summary of model table, which includes the R® statistics and S. The expanded version of the table includes
the prediction sum of squares (PRESS).

TANOVA
The ANOVA table. The expanded version of the table includes the sequential sums of squares and the percent
contribution to the total sum of squares.

TDIAGNOSTICS [K]

A table of diagnostics. The expanded version of the table includes the standard error of the fit, the confidence
interval for the fit, the deleted residual, the leverage, the Cook's D, and the DFITS.

Value of K Diagnostics that are displayed
0 Diagnostics only for unusual observations
1 Diagnostics for all observations
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TALIAS [K]
Displays alias information. One line is displayed for each term in the model, with a list of all terms, up to order K,
that are aliased with the model term. If K is omitted, Minitab uses the default rule of FFDESIGN: all interactions
for 2 to 6 factors, up to three-way interaction for 7 to 10 factors, and two-way interactions for more than 10.

Note A value of K that is larger than the default can take a long time to calculate.

TMEANS
The least squares means for all combinations of the factor levels that you specify in MEANS.

Storage

The following subcommands specify what is stored in the worksheet.

FITS C
Stores the fitted values.

BFITS
Stores the back-transformed fits after the Box-Cox transformation.

BCRESP C
Stores the Box-Cox transformation of the response.

RESIDUALS C
Stores the residuals (response - fit)

SRESIDUALS C
Stores the standardized residuals.

TRESIDUALS C
Stores the deleted Studentized residuals.

WRESIDUALS C...C
Stores thole plot residuals.

EFFECTS C
Stores the effects that are included in the output.

Note Effects are not printed or stored for the constant, covariates, or blocks.

COEFFICIENTS C
Stores the coefficients that are included in the coefficients table.

The coefficients are based on coded levels (-1, 0, +1), not on the actual levels in the data set. A coefficient is
always half the value of the corresponding effect.

XMATRIX M
Stores the design matrix. The first column is a column of ones for the constant term. Next, there is one column
for each covariate. Next, if the design was blocked into k blocks, there are (k — 1) columns. Next, there is one
column for each factor, using -1 for the low level, O for a center point, and +1 for the high level. Next, there is
one column for each interaction in the model. The column for an interaction is the product of all the columns that
correspond to the factors that are contained in that interaction.

Minitab =’ 325



Minitab Statistical Software DOE

If SPFACTORIAL removed some of the interactions that you specified in your model, those interactions do not
appear in the stored design matrix. The columns in XMATRIX match the coefficients that are displayed and stored.

WXMATRIX M
WXMATRIX is like XMATRIX, but it includes the whole plot error terms.

WCOEFFICIENTS C...C
Stores coefficients in C...C (including whole plot error terms).

HI C
Stores the leverage values that you use to identify influential observations.

SMEANS C
Stores the least squares means from MEANS in the specified column.

If you use a Box-Cox transformation, SMEANS stores the means for the transformed response.

BSMEANS C
If you use a Box-Cox transformation, BSMEANS stores the means for the back-transformed response.

VPREPROCESS: Session command to preprocess responses for
analyze variability

Note VPREPROCESS replaces the obsolete session command PREPROCESS.

VPREPROCESS
Use VPREPROCESS to calculate and store standard deviations and counts of repeat or replicate measurements
before you use VFACTORIAL on page 327 to analyze the variability of responses. Use one of the following
subcommands: REPEATS, REPLICATES, or DEFINE. Then use the sub-subcommands to specify how to preprocess
the data.

REPEATS
Specifies that repeats of the measurement are in the same row of different columns.

RESPONSE C...C
Specifies which columns contain the repeated measurements of the response variable.

STDEV C
Specifies where to store the standard deviations of the repeated measurements for analysis.

COUNT C
Specifies where to store the number of repeated measurements for analysis.

RMEAN C
Specifies where to store the mean of the repeated measurements for analysis.

REPLICATES
Specifies that replicated measurements of a response variable are in the same column.

RESPONSE C...C
Specifies which columns contain the replicated measurements of a response variable. Each column is a
separate response variable.
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STDEV C...C

Specifies where to store the standard deviations of the replicate measurements for analysis. Enter a
column for each response variable.

COUNT C...C

Specifies where to store the number of replicated measurements for analysis. Enter a column for each
response variable.

COVARIATES C...C
Specifies covariates to adjust for in the calculation of the standard deviations.

DEFINE C...C

Specifies that standard deviations for analysis are already in the worksheet. Each column contains the standard
deviations for a different response variable.

COUNT E...E

Specifies the number of measurements for the standard deviation in each row. If the numbers of
measurements are all the same, enter the number or enter a column of constant values. If the numbers
of measurements vary, use a column to indicate the number for each row.

VFACTORIAL: Session command for analyzing variability in a 2-level
factorial design

VFACTORIAL

Analyzes variability in a 2-level factorial design, including those produced by FFDESIGN on page 279 and PBDESIGN
on page 258. You can specify covariates and a blocking factor. You can fit one response at a time. Before you use
VFACTORIAL, you must calculate and store standard deviations using PREPROCESS on page 326. Minitab uses
least squares estimation by default, but you can specify maximum likelihood estimation using MLE.

The factor columns can be numeric or text, and can contain any values. The levels do not need to be in any special
order. When the factor column is text, Minitab defines the low level as the level that is first using alphabetical
order. Change the order of the levels after the LEVELS subcommand to change this default ordering.

Optionally, you can display seven plots: a normal plot of the effects, a half normal plot of the effects, a Pareto
chart of the effects, and four different residual plots. In addition, you can store the residuals, fitted values, and
many other diagnostics for further analysis.

RESPONSE C
Specifies the column that contains the standard deviations.

COUNT E (required)
Specifies the constant or column that contains the number of repeat or replicate measurements. The columns
must have the same number of rows that the response column has.

FACTOR C (required)
Specifies the factors. The columns must have the same number of rows that the response column has.

BLOCKS C

Specifies the column that contains the blocking information (optional). A blocking variable column can be
numeric or text, and can contain any value. The levels do not need to be in any special order. When the
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blocking column is numeric, the smallest value is block 1, the second smallest value is block 2, and so on.
Include the blocking column with TERMS to make a model that considers blocks.

CTPT C
Specifies the column that identifies which design points are center points. Include the center point column
with TERMS to make a model that tests for curvature.

TERMS C
Specifies the model terms. Only continuous predictors can repeat in a single term. Nested terms are not
allowed. The model can be nonhierarchical.

INUNIT K
Specifies whether the design is in coded form or uncoded form.

Value of K Form of design

0 Coded

1 Uncoded
LEVELS

Specifies the uncoded levels for the factors. For each factor, the list or column must contain two numerical
values. Use LEVELS to change the default order of levels that Minitab uses. You can use a column only when
all the levels are continuous or when all the levels are categorical.

MLE
Specifies maximum likelihood estimation. By default, Minitab uses least squares estimation to fit the model.

Covariates

COVARIATES C...C
Lists the covariates to include in the model. You can have up to 50 covariates.

Options

MLE
Specifies using maximum likelihood estimation to analyze the model. The default method is least squares estimation.

CONFIDENCE K

Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of Kis 95.

ITYPE K
Specifies the type of confidence interval.

Value of K Type of confidence interval
-1 Lower bound

0 (default) Two-sided

1 Upper bound
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MEANS termlist
Calculates least squares means for the specified terms. You can use the following commands to display and store
the least squares means. If the design is orthogonal and there are no covariates, each mean is the average of all
the observations in the corresponding cell. Use the same syntax and abbreviations on MEANS as you use in
specifying a model.

TMEANS
Displays the calculated least squares means for the specified terms.

SMEANS
Stores the calculated least squares means for the specified terms.

BSMEANS
If you transformed the data, stores the calculated least squares means for the specified terms.

TOLERANCE K

Requires that Minitab retain a factor in the model that is either highly correlated with a different factor or that is
almost constant. Lowering tolerance by giving very small argument values can prevent Minitab from eliminating
problematic predictor columns from the model.

Collinearity 1-R? where R? is the value that results from regressing one predictor on the remaining
predictors. If (1 - R2) is < (K), then the predictor is removed from the equation.

Almost constant If the coefficient of variation of a predictor (the standard deviation / the mean) is <
square root (K), then the predictor is considered essentially constant and is removed
from the equation.

K must be positive and less than 1. The default value is 8.88E-16.

Stepwise

FINFORMATION, STEPWISE, FORWARD, and BACKWARD perform a stepwise regression procedure to fit the model. No
arguments are needed for these subcommands.

FINFORMATION

Specifies a stepwise model selection procedure that uses forward information criteria selection. Use AICCORRECTED
or BICRITERION to specify which information criterion to use to select the final model. If you do not specify a
criterion, Minitab uses AICCORRECTED.

The forward information criteria procedure adds the term with the lowest p-value to the model at each step. If
you do not include subcommands about hierarchy, FINFORMATION adds 1 term at a step and maintains model
hierarchy, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.
Minitab calculates the information criteria for each step.

Once Minitab fits the full model or a model that leaves 1 degree of freedom for error, the procedure stops. Minitab
displays the results of the analysis for the model with the minimum value of the selected information criterion,
either the corrected Akaike's Information Criterion (AICc) or the Bayesian Information Criterion (BIC).

AICCORRECTED
Specifies the use of the corrected Akaike's Information Criterion (AlCc) to select the final model.

BICRITERION
Specifies the use of the Bayesian Information Criterion (BIC) to select the final model.
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STEPWISE
Specifies a stepwise model selection procedure that uses both forward selection and backward elimination. If you
do not include subcommands about hierarchy, STEPWISE and FORWARD add 1 term at a step and maintain model
hierarchy, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

FORWARD
Specifies a stepwise model selection procedure that uses forward selection. If you do not include subcommands
about hierarchy, STEPWISE and FORWARD add 1 term at a step and maintain model hierarchy, the equivalent of
the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

BACKWARD
Specifies a stepwise model selection procedure that uses backward elimination. Removes a single term at each
step and maintains a hierarchical model, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS.

AENTER K
Specifies the alpha level at which a term is entered into the model. The default is 0.15 for STEPWISE and 0.25
for FORWARD.

AREMOVE K
Specifies the alpha level at which a term is removed from the model. The default is 0.15 for STEPWISE and
0.10 for BACKWARD. For STEPWISE, K must be greater than or equal to K for AENTER.

ENTER termlist
Specifies the terms that are contained in the starting model for STEPWISE. The ENTER termlist must be a
subset of the TERMS termlist or in the default term list in the design.

FORCE termlist
Specifies the terms to be forced in the model. The FORCE termlist must be a subset of the TERMS termlist
or in the default term list in the design.

NOHIERARCHICAL
Specifies that the model selection procedure does not consider hierarchy.

HIERARCHICAL
Maintains a hierarchical model in stepwise regression. In a hierarchical model, if a higher-order term is
included, all lower-order terms that comprise the higher-order term also appear in the model. For example,
a model that includes the interaction term A*B*C is hierarchical if it includes the following main effects and
lower-order interactions: A, B, C, A*B, A*C, and B*C.

CATONLY
Specifies that only the categorical terms in the model have to be hierarchical.

ALLTERMS
Specifies that both categorical and continuous terms have to be hierarchical.

ATEND
Specifies that the final step of the stepwise procedure adds terms to make the model hierarchical.

ALWAYS
Specifies that the model is hierarchical at every step.
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SINGLE

Specifies that only one term can enter the model at each step. So a higher-order term can enter
the model only if the terms that comprise the term are already in the model. For example, the
algorithm does not consider the addition of A*B unless A and B are already in the model.

BACKWARDS does not use SINGLE or MULTIPLE because terms only exit the model.

MULTIPLE

Specifies that multiple terms can enter the model at each step. So a higher order term can enter
the model, and the terms that comprise the term enter the model at the same time. For example,
if A*B is the most statistically significant term, A*B enters the model. At the same time, A and B
enter the model if those terms are not in the model already.

BACKWARDS does not use SINGLE or MULTIPLE because terms only exit the model.

Graphs

GEFFECTS

Displays a normal probability plot of the effects or standardized effects. Minitab labels the effects on the probability
plot that are considered significant. The alpha level is 1 — the confidence level that follows CONFIDENCE, unless
you use stepwise selection. For forward selection, the alpha level is the level that follows AENTER. For backward
and stepwise selection, the alpha level is the level that follows AREMOVE.

GHALF

Displays a half normal probability plot of the effects or standardized effects. Minitab labels the effects on the half
normal plot that are considered significant. The alpha level is 1 — the confidence level that follows CONFIDENCE,
unless you use stepwise selection. For forward selection, the alpha level is the level that follows AENTER. For
backward and stepwise selection, the alpha level is the level that follows AREMOVE.

GPARETO

Displays a Pareto chart of the absolute effects. GPARETO draws a vertical reference line on the plot at the margin
of error. This plot lets you to look at both the magnitude and the importance of an effect at the same time. The

alpha level is 1 — the confidence level that follows CONFIDENCE, unless you use stepwise selection. For forward

selection, the alpha level is the level that follows AENTER. For backward and stepwise selection, the alpha level is
the level that follows AREMOVE.

GALLEFFECTS K

Specifies to include the model terms and the terms that are not in the model up to order K on the plots. If you
specify a stepwise method, Minitab ignores K and shows the terms in the candidate list.

GMODEL
Specifies that only the terms that are in the model are on the plots.

RTYPE K
Specifies the type of residual to plot with the graph subcommands.

Value of K Type of residuals

1 (default) Regular or raw residuals (RESIDUALS)

2 Standardized residuals (SRESIDUALS)

3 Deleted Studentized residuals (TRESIDUALS)
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GHISTOGRAM
Displays a histogram of the residuals.

GNORMAL
Displays a normal probability plot of the residuals.

GFITS
Plots the residuals versus the fitted values.

GORDER [C]
Plots the residuals versus the order of the data, or versus the order specified in C. The row number for each data
point is shown on the x-axis (for example, 12 3 4...n).

GFOURPACK [C]
Displays four residual plots—a histogram of the residuals, a normal probability plot of the residuals, the residuals
versus fitted the values, and the residuals versus the order of the data, or versus the order specified in C—in one

graph.

GVARIABLIE C...C
Plots the residuals versus variables. Displays a separate graph for the residuals versus each specified column.

Results
The following subcommands specify what is displayed in the results.

NODEFAULT
Specifies that no default tables or graphs are displayed.

TEXPAND
Displays the expanded versions of the ANOVA table, the table of coefficients, the model summary table, and the
table of unusual observations.

TSIMPLE
Displays the simple versions of the ANOVA table, the table of coefficients, the model summary table, and the
table of unusual observations.

TMETHOD
Displays the method table.

TMSDETAILS
Displays the type of stepwise procedure and the alpha values to enter and/or remove a predictor from the model.
If you do not specify FULL or NOFULL, then Minitab uses the settings in File > Options > Linear Models >
Stepwise.

FULL
Displays the coefficients, the p-values, Mallows' Cp, and the model summary statistics for each step of the
procedure.

NOFULL
Does not display the coefficients, the p-values, Mallows' Cp, and the model summary statistics for each step
of the procedure.

TEQUATION

The regression equation table. If the model is hierarchical, the equation is in uncoded units. If the model is
nonhierarchical, the equation is in coded units.
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TCOEFFICIENT

Displays the table of coefficients. If you do not specify FULL or NOFULL, then Minitab uses the settings in File >
Options > Linear Models > Display of Results.

FULL
Displays the full set of coefficients for categorical predictors.

NOFULL
Displays only the linearly independent coefficients.

TSUMMARY

The summary of model table, which includes the R? statistics and S. The expanded version of the table includes
the prediction sum of squares (PRESS), the corrected Akaike's Information Criterion (AlCc) and the Bayesian
Information Criterion (BIC).

TANOVA

The ANOVA table. The expanded version of the table includes the sequential sums of squares and the percent
contribution to the total sum of squares.

TDIAGNOSTICS [K]
Displays a table of diagnostics.

Value of K Diagnostics that are displayed
0 Diagnostics only for unusual observations
1 Diagnostics for all observations

If you do not specify K, then Minitab uses the settings in File > Options > Linear Models > Display of Results.

TALIAS [K]

Alias information. One line is printed for each term in the model, with a list of all terms, up to order K, that are
aliased with the model term. If K is omitted, Minitab uses the default rule of FFDESIGN: all interactions for 2 to 6
factors, up to 3-way interaction for 7 to 10 factors, and 2-way interactions for more than 10.

TMEANS
The least squares means for all combinations of the factor levels that you specify in MEANS.

Storage
The following subcommands specify what is stored in the worksheet.

LFITS C
Stores the fitted values for the natural log of the standard deviation.

RRESIDUALS C
Stores the ratio residual, which is the ratio of the response standard deviation to the fitted standard deviation.

LRESIDUALS C

Stores the log residual, which is the difference between the natural log of the response standard deviation and
the natural log of the fitted standard deviation.

SLRESIDUALS C
Stores the standardized log residual, which is the log residual divided by its (asymptotic) standard error.

Minitab =’ 333



Minitab Statistical Software DOE

EFFECTS C
Stores the effects that are included in the output.

Note Effects are not printed or stored for the constant, the covariates, or the blocks.

REFFECTS C
Stores the ratio effects.

COEFFICIENTS C
Stores the coefficients that are included in the coefficients table.

The coefficients are based on coded levels (-1, 0, +1), not on the actual levels in the data set. A coefficient is
always half the value of the corresponding effect.

XMATRIX M
Stores the design matrix.

HI C
Stores the leverage values.

COOK C
Stores Cook's distance.

DFITS C
Stores the DFITS (also called DFFITS) values.

LNRESP C
Stores the log of the standard deviations. This column is the response for the model.

BFITS
Stores the back-transformed fitted values for the standard deviations.

SMEANS C
Stores the means for terms that are specified in the MEANS subcommand in the specified columns.

BSMEANS C
If you use a Box-Cox transformation, BSMEANS stores the back-transformed means.

SWEIGHTS C

Stores the unadjusted weights based on the fitted variances to use when you analyze location effects with
FFACTORIAL.

SADJUSTED C
If your data contain repeats with some replicated points, SADJUSTED stores the adjusted weights.

RMEANS C
Specifies the row means that are associated with the row standard deviations used as the response.

ACOVARIATES C...C
Accounts for covariates in C...C in calculating adjusted weights.
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Plot Factorial Design

FACPLOT: Session command for creating a factorial plot

FACPLOT C

Displays factorial plots for the model associated with the response variable in the specified column To create this
graph, you need to specify a model. To produce an interaction plot, you must have two or more variables.

These plots can illustrate how a response variable relates to one or more variables. You can produce two types
of factorial plots.

e Use a main effects plot to compare fitted means or data means across levels of one or more variables.

e Use an interactions plot to assess the effects of one variable at levels of another variable. An interactions plot
displays the fitted means for a level of a variable with the level of a second variable held constant.

Although you can use these plots to display the effects, be sure to evaluate significance by looking at the effects
in the analysis of variance table.

FACTORS C...C

Specifies the variables to display in both the main effect and interaction plots. You must specify 2 or more
variables to generate an interaction plot.

GMAIN
GMAIN displays the main effect plot.

GINT
GINT displays the interactions plot.

FULL

Use FULL to display both interaction plots for each pair of categorical variables, such as Predictor 1 by
Predictor 2 and Predictor 2 by Predictor 1. Sometimes you can identify interactions more easily when
you examine both plots.

LOWER
Use LOWER to display one version of each interaction plot.

GMODEL (default)
GMODEL display plots for only terms that are in the model and listed in FACTORS. For purposes of a main
effect plot, a variable is in the model if the model includes any terms that involve only that variable, e.g. A,
A*A, or A*A*A. For purposes of an interaction plot, the interaction of two variables is in the model if the
model includes any terms that involve both variables, e.g. A*B, A*B*B.

GALL
GALL displays plots for all terms involving variables on the FACTORS subcommand.

TITLE "title"
Specifies a title for the graph. If you do not specify a title, Minitab uses a default title.

MFFCUBE: Session command for creating a cube plot for fitted means

MFFCUBE C
Creates a cube plot of the fitted means for the response in C.
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You can draw a cube plot for a model from a 2-level factorial design. The factor columns can be numeric or text,
and can contain any values. When the factor column is text, the first entry (row 1) is level 1, the next entry that is
different is level 2. All factors must have 2 levels, and can have center points.

To draw a cube plot of the data means or a cube plot of the process variables in a mixtures design, use FFCUBE
on page 340.

FACTORS C...C
Specifies the factors to include on the cube plot in C...C. You can specify 2-8 factors.

TITLE "title"
Specifies a title for the graph. If you do not specify a title, Minitab uses a default title.

FFINT: Superseded by FACPLOT except for mixture designs

Note FFINT is superseded by FACPLOT on page 276, except for mixture designs.

FFINT C...C
Creates interaction plots for factors in C...C.

Creates an interaction plot for 2-level factorial designs. If you enter 2 factors on the command line, then Minitab
displays a single interaction plot. If you enter more than 2 factors, then Minitab displays a matrix of interaction
plots. You can use factors from designs that are generated by FFDESIGN and PBDESIGN.

You can specify up to 15 columns that contain the factors. The factor columns can be numeric or text, and can
contain any values. The levels do not need to be in any special order. When the factor column is text, the first
entry (row 1) is level 1, the next entry that is different is level 2, and so on. All factors must have 2 levels, and can
have center points.

RESPONSE C (required)
Plots the response data in C. If you specify RESPONSE without FMEANS, then Minitab plots the raw response
data. The interaction effects are calculated based on the means of the data. If you plot process variables from
a mixture design, then Minitab fits only the raw response data, not the fitted means.

You can specify up to 15 factors.

FMEANS C...C
Plots the least squares or fitted means in C...C. If you specify RESPONSE with FMEANS, then Minitab plots
the predicted values from the model. The interaction effects are calculated based on the fitted means. If you
plot process variables from a mixture design, Minitab fits only the raw response data, not the fitted means.

FULL
Displays the full interaction matrix when you enter more than 2 factors. By default, Minitab displays the half
matrix. The half matrix displays the plots in the upper right portion of the matrix. In the full matrix, the
transpose of each plot in the upper right is displayed in the lower left portion of the matrix. The full matrix
takes longer to display than the half matrix.

YMIN K

Specifies the minimum values on the y-axis of every plot that is displayed by the current command in K.
Making the minimum and maximum values the same is useful when you compare several plots of related
data.
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YMAX K

Specifies the maximum values on the y-axis of every plot that is displayed by the current command in K.
Making the minimum and maximum values the same is useful when you compare several plots of related
data.

INUNIT K
Specifies whether the design is in coded form or uncoded form.

Value of K Form of design
0 Coded
1 Uncoded

CTPT C

Specifies the center point column in C. Minitab considers a value of 0 as a center point.

LEVELS KK, ..., KK
Specifies the levels for the uncoded units for each factor in KK, ..., K K. Use LEVELS to change the default
order of levels that Minitab uses.

TITLE "title"
Specifies a title for the graph. If you do not specify a title, Minitab uses a default title.

GSAVE "file name"

GSAVE K
Saves the graph in a file.

The default file name is Minitab.PNG. You can specify a custom file name in double quotation marks
("file_name"), or as a stored text constant (K). You can also use any of the following subcommands to save
the graph in a different graphics format.

Some graph commands—for example, HISTOGRAM C1 C2 C3—generate more than one graph. If you include
the GSAVE subcommand with such a command, Minitab saves multiple files. Minitab gives each file a different
file name. Minitab uses the first five characters of the name you specify, then appends a number (001, 002,

and so on), for up to 300 files.

JPEG
JPEG color

PNGB
PNG grayscale

PNGC
PNG color

TIFB
TIF grayscale

TIF
TIF color

BMPB
BMP grayscale
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BMPC
BMP color

GIF
GIF

EMF
EMF

RESOLUTION K
Saves the graph at a resolution of K dots per inch.

MIXTURE
Specifies a mixture design, which indicates that the factors are process variables.

FFMAIN: Superseded by FACPLOT except for mixture designs

Note FFMAIN is superseded by FACPLOT on page 276, except for mixture designs.

FFMAIN C...C
Creates a main effects plot for 2-level factorial designs, for factors in C...C.

FFMAIN plots the means at the two levels of each factor and connects them with a line. FFMAIN plots any center
points you have, using a different symbol than that used for the factorial points. A reference line is drawn through
the plot to represent the overall mean (also called grand mean) of the response data.

Specify up to 50 factors. The factor columns can be numeric or text, and can contain any values. The levels do not
need to be in any special order. When the factor column is text, the first entry (row 1) is level 1. The next entry
that is different is level 2. All factors must have 2 levels, and can have center points.

RESPONSE C (required)
Plots the response data in C. If you specify RESPONSE without FMEANS, then Minitab plots the raw response
data. The main effects are calculated based on the means of the data. If you plot process variables from a
mixture design, Minitab fits only the raw response data, not the fitted means.

With RESPONSE, you can specify up to 50 factors.

FMEANS C...C
Plots the least squares or fitted means in C...C. If you specify RESPONSE with FMEANS, then Minitab plots
the predicted values from the model. The main effects are calculated based on the fitted means. If you plot
process variables from a mixture design, Minitab fits only the raw response data, not the fitted means.

With FMEANS, you can specify up to 10 factors.

YMIN K
Specifies the minimum values on the y-axis of every plot that is displayed by the current command in K.
Making the minimum and maximum values the same is useful when you compare several plots of related
data.

YMAX K
Specifies the maximum values on the y-axis of every plot that is displayed by the current command in K.
Making the minimum and maximum values the same is useful when you compare several plots of related
data.
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INUNIT K
Specifies whether the design is in coded form or uncoded form.

Value of K Form of design
0 Coded
1 Uncoded

CTPT K

Specifies the center point column in K. Minitab considers a value of 0 as a center point.

LEVELS KK, ..., KK
Specifies the levels for the uncoded units for each factor in KK, ..., K K. Use LEVELS to change the default
order of levels that Minitab uses.

TITLE "title"”
Specifies a title for the graph. If you do not specify a title, Minitab uses a default title.

GSAVE "file name"

GSAVE K
Saves the graph in a file.

The default file name is Minitab.PNG. You can specify a custom file name in double quotation marks
("file_name"), or as a stored text constant (K). You can also use any of the following subcommands to save
the graph in a different graphics format.

Some graph commands—for example, HISTOGRAM C1 C2 C3—generate more than one graph. If you include
the GSAVE subcommand with such a command, Minitab saves multiple files. Minitab gives each file a different
file name. Minitab uses the first five characters of the name you specify, then appends a number (001, 002,

and so on), for up to 300 files.

JPEG
JPEG color

PNGB
PNG grayscale

PNGC
PNG color

TIFB
TIF grayscale

TIF
TIF color

BMPB
BMP grayscale

BMPC
BMP color

Minitab =’ 339



Minitab Statistical Software DOE

GIF
GIF

EMF
EMF

RESOLUTION K
Saves the graph at a resolution of K dots per inch.

MIXTURE
Specifies a mixture design, which indicates that the factors are process variables.

FFCUBE: Session command for creating a cube plot

FFCUBE C...C
Use FFCUBE to draw a cube plot that does not show mean response values. With a mixture design, you can use
FFCUBE to draw a cube plot that shows mean response values. For all other models, such as the models from
FFAC or REGR, use MFFCUBE on page 335 to draw a cube plot that shows mean response values.

Displays a cube plot for factors in C...C. You can draw a cube plot with 2-8 factors for each response entered with
the RESPONSE subcommand with data means or 2—7 factors with fitted means. The factor columns can be numeric
or text, and can contain any values. The levels do not need to be in any special order. When the factor column is
text, the first entry (row 1) is level 1, the next entry that is different is level 2, and so on. All factors must have 2
levels, and can have center points.

When you use the RESPONSE subcommand, FFCUBE displays the means for the response at each point in the
cube where observations are measured. When you do not use the RESPONSE subcommand, FFCUBE draws points
on the cube for the effects that are in your model, which helps you visualize the design.

RESPONSE C...C
Plots the raw response data that is in columns C...C. The means for the cube points are calculated from the
data. You can specify 2-8 factors.

If you use FMEANS, RESPONSE is required.

FMEANS C...C
Plots the least squares or the fitted means that are in columns C...C. You can specify 2-7 factors. The column
must contain the fitted means in standard order for the cube points. The last row must be the overall mean
of the data.

If you use FMEANS, RESPONSE is required.

INUNIT K (required)
Specifies whether the design is in coded form or uncoded form.

Value of K Form of design

0 Coded form

1 Uncoded form
CTPT C

Specifies a center point column in C. Minitab considers a value of 0 to be a center point. A valid column
contains only values of 0 and 1.
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If you don't use MIXTURE, CTPT is required. You cannot use both MIXTURE and CTPT.

LEVELS K K, ..., K K (required)

Specifies the levels for the uncoded units for each factor in KK, .., K K. The order of the parameters must be
identical to the order of the factors that follow FFCUBE.

TITLE "title"
Specifies a title for the graph. If you do not specify a title, Minitab uses a default title.

GSAVE "file name"

GSAVE K
Saves the graph in a file.

The default file name is Minitab.PNG. You can specify a custom file name in double quotation marks
("file_name"), or as a stored text constant (K). You can also use any of the following subcommands to save
the graph in a different graphics format.

Some graph commands—for example, HISTOGRAM C1 C2 C3—generate more than one graph. If you include
the GSAVE subcommand with such a command, Minitab saves multiple files. Minitab gives each file a different
file name. Minitab uses the first five characters of the name you specify, then appends a number (001, 002,

and so on), for up to 300 files.

JPEG
JPEG color

PNGB
PNG grayscale

PNGC
PNG color

TIFB
TIF grayscale

TIF
TIF color

BMPB
BMP grayscale

BMPC
BMP color

GIF
GIF

EMF
EMF

RESOLUTION K
Saves the graph at a resolution of K dots per inch.

MIXTURE
Specifies a mixture design, indicating that the factors are process variables.
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Response Surface Designs

BBDESIGN: Session command for creating a Box-Behnken design

BBDESIGN K [K]
Generates Box-Behnken designs for 3, 4, 5, 6, 7, 9, or 10 continuous factors and optional categorical factors.

Enter the number of factors on BBDESIGN. For a summary of the designs generated by BBDESIGN, go to
Box-Behnken designs on page 1135. All the blocked designs have orthogonal blocks.

To store your design for additional analysis, use the DESIGN subcommand. (The DESIGN subcommand replaces
the obsolete subcommands SORDER, PTTYPE, and XMATRIX.)

CENTER K

Adds the number of center points to the design that you specify in K, up to 50. If you do not use this
subcommand, then Minitab uses a default number of center points, based on the design you specified.

If the design is blocked, the center points are divided equally (as much as possible) among the blocks.

REPS K
Replicates each point the number of times that you specify in K, up to 50 replicates of each point.

BLOCKS K

Specifies the number of blocks in K. The choices for K are limited. The "Optional number of blocks" column
in Box-Behnken designs on page 1135 shows which values of K you can use for different designs.

RBLOCK
Use to specify blocks on replicates. Each set of replicate points is placed in a separate block. No arguments
are taken.

LEVELS K K, ..., KK

LEVELS C

LEVELS allows you to override the default values normally assigned to the levels of each factor. The default
values use -1 for the low level of the corner point, +1 for the high level, and 0 for the center point.

With LEVELS K K, ..., KK, you list a pair of arguments for each factor. The first K should be the low level and
the second K should be the high level. Levels must be numeric.

With LEVELS C, put the level values in a column, in the same order as if they were listed on the subcommand.
Then specify the level column on the LEVELS subcommand.

CNUM K. ..K

Specifies the number of levels in categorical factors. The number of arguments must match the second
argument for the main command. Each K must be an integer from 2 to 100. The default number of levels in
categorical factors is 2.

CLEVEL K...K

CLEVEL C
Specifies the uncoded values of the categorical factor levels in K...K or stored in C. The number of arguments
K must equal the sum of arguments in CNUM. The group of arguments for each factor must be of the same
type. If stored in column C, the column can be numerical or text and must equal the sum of arguments in
CNUM. The default categorical factor levels are "1", "2", "3", and so on.
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RANDOMIZE [K]
Randomizes the run order and optionally uses base K. If you specify blocks, randomization is done separately
within each block and then the blocks are randomized. When you use RANDOMIZE, the standard order and
the run order are different and Minitab stores the design in run order.

K is the base for the random number generator and can take any integer as an argument. To get the same
ordering of the rows, create the same design and randomize the runs with the same base. For more
information, go to BASE on page 86.

DESIGN
Names and stores the standard order, run order, point type, block assignment, and each factor in separate
columns. Unless you have only 1T empty worksheet in the project, Minitab stores the columns in a new
worksheet.

NAMES K K, ..., KK
Specifies names for the factors. Enclose names in quotation marks. If you do not use NAMES, then the
names of the factors are letters, skipping the letter I: A, B, C...

BRIEF K
Controls the amount of output. You can also use BRIEF as a main command. When you use BRIEF as a main
command, it affects all other commands that use BRIEF to control the amount of output.

Value of K Output that is displayed

0 Minitab displays no output for the command, but performs all specified storage
and displays the following output: error messages, warnings, prompts, and notes.

1 Minitab displays a summary of the design.

2 (default) Same as K = 1 output.

3 Same as K = 2 output, but Minitab also displays the design table.

CCDESIGN: Session command for creating a central composite
design

CCDESIGN K
Creates a central composite design with K number of continuous factors and optional K categorical factors.

Generates central composite designs for 2 to 10 continuous factors and optional categorical factors.

Specify the number of factors on CCDESIGN. Designs for 1 to 7 factors can use either a full or fractional factorial
design. Designs with 5 to 8 factors can use a one-half fraction of the full factorial portion of the central composite
design. Use HALF to specify the one-half fraction. Designs with 8 or 9 factors can use a one-quarter fraction of
the full factorial portion of the central composite design. Use QUARTER to specify one-quarter fraction. Designs
with 10 factors can use a one-eighth quarter fraction of the full factorial portion of the central composite design.
Use EIGHTH to specify one-eighth fraction.

Central composite designs on page 1136 summarizes the designs generated by CCDESIGN. The default values of
alpha provide orthogonal blocking and, whenever possible, rotatability. To generate a face-centered design, use
ALPHA = 1. The cube portions of these designs are identical to those generated by FFDESIGN on page 279 with
the same number of center points and blocks. Thus, a design generated by FFDESIGN with the same number of
runs, center points, and blocks as shown below can be built up into an orthogonally blocked central composite
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design. Any FFDESIGN with the right number of runs and blocks can be built up into a blocked CCDESIGN. However,
to make the blocks orthogonal the FFDESIGN must use the number of center points shown in the table.

To store your design for additional analysis, use the DESIGN subcommand. (The DESIGN subcommand replaces
the obsolete subcommands SORDER, PTTYPE, and XMATRIX.).

HALF
Specifies the one-half fraction of a full factorial design. All the default designs generated by CCDESIGN use
a full factorial in the cube portion of the design. With five or six factors, you can optionally use a one-half
fraction of the full factorial. Use HALF to do so.

QUARTER
Specifies the one-quarter fraction of a full factorial design. Use QUARTER if you have eight or nine factors
and want to use a one-quarter fraction of the full factorial.

EIGHTH
Specifies the one-eighth fraction of a full factorial design. Use EIGHTH if you have ten factors and want to
use a one-eighth fraction of the full factorial.

CENTER K [K]

Adds K center points to cube and optionally, K center points to the axial block. If you do not give this
subcommand, Minitab uses a default number of center points, based on the design you specify.

If the design is blocked, you must give both Ks. The first gives the number of center points in the cube and
the second gives the number of center points in the axial block. If the cube is blocked, the number of center
points in the cube is split equally (as much as possible) among the blocks.

Central composite designs on page 1136 shows the defaults for blocked and unblocked designs. The defaults
for unblocked designs are in the "Total center points" column. For blocked designs, the defaults are in the
"Cube center points" and "Axial center points" columns.

ALPHA K
Specifies an alpha value in K. CCDESIGN has a default value for alpha, shown in Central composite designs
on page 1136, for each design. This subcommand allows you to change the default. The value must be positive.
A value of 1 results in a face-centered design. A value that is less than 1 places the axial points inside the
cube. A value that is greater than 1 places the axial points outside the cube.

REPS K
Replicates each point the number of times that you specify in K, up to 50 replicates of each point.

BLOCKS K
Specifies number of blocks in K. The choices for K are limited. The "Total blocks" column in Central composite
designs on page 1136 shows which values of K you can use for different designs.

RBLOCK
Blocks on replicates. Each set of replicate points is placed in a separate block. No arguments are taken.

LEVELS KK, ..., KK

LEVELS C
LEVELS allows you to override the default values normally assigned to the levels of each factor. The default
values use -1 for the low level of the corner point, +1 for the high level, 0 for the center point, and plus and
minus alpha for the axial points.

With LEVELS K K, ..., KK, you list one pair of arguments—giving first the low level and then the high level for
each factor. The center point and star points are scaled accordingly. Levels must be numeric.
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With LEVELS C, put the level values in a column, in the same order as if they were listed on the subcommand.
Then specify this level column on the LEVELS subcommand.

One important thing to note is that the values you enter in LEVELS are usually not the minimum and maximum
values in the design. They are the low and high settings for the cube portion of the design. The axial points
are usually outside the cube (unless you specify an alpha that is less than or equal to 1). If you are not careful,
this could lead to axial points that are not in the region of interest, or that may be impossible to run.

If you wish, you can use LEVELS to guarantee that all of the design points will fall within a predetermined
minimum and maximum value for the factors. What you need to determine are the appropriate low and high
settings for the cube, so you can enter these into LEVELS. All you need to do so are the desired minimum
and maximum and the value of alpha for the design. Default alpha values are shown in Central composite
designs on page 1136.

CNUM K. ..K
Specifies the number of levels in categorical factors. The number of arguments must match the second
argument for the main command. Each K must be an integer from 2 to 100. The default number of levels in
categorical factors is 2.

CLEVELS K...K

CLEVELS C

Specifies the uncoded values of the categorical factor levels in K...K or stored in C. The number of arguments
K must equal the sum of arguments in CNUM. The group of arguments for each factor must be of the same
type. If stored in column C, the column can be numerical or text and must equal the sum of arguments in
CNUM. The default categorical factor levels are "1", "2", "3", and so on.

INSCRIBE
Defines the low and high pairs in LEVELS as the axial points instead of the cube points.

RANDOMIZE [K]

Randomizes the run order and optionally uses base K. If you specify blocks, randomization is done separately
within each block and then the blocks are randomized. When you use RANDOMIZE, the standard order and
the run order are different and Minitab stores the design in run order.

K is the base for the random number generator and can take any integer as an argument. To get the same
ordering of the rows, create the same design and randomize the runs with the same base. For a discussion,
go to BASE on page 86.

DESIGN

Names and stores the standard order, run order, point type, block assignment, and each factor in separate
columns. Unless you have only 1 empty worksheet in the project, Minitab stores the columns in a new
worksheet.

NAMES K K, ..., KK
Specifies names for the factors. Enclose names in quotation marks. If you do not use NAMES, then the
names of the factors are letters, skipping the letter I: A, B, C...

BRIEF K

Controls the amount of output. You can also use BRIEF as a main command. When you use BRIEF as a main
command, it affects all other commands that use BRIEF to control the amount of output.

Value of K Output that is displayed

0 Minitab displays no output from the command, but performs all specified storage
and displays the following output: error messages, warnings, prompts, and notes.
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Value of K
1
2 (default)
3

DOE

Output that is displayed
Minitab displays a summary of the design.
Same as K = 1 output.

Same as K = 2 output, but Minitab also displays the design table.

RSREG: Session command for analyzing a response surface design
with least squares regression

RSREG

Analyzes a response surface design that can have continuous or categorical predictors using least squares

regression.

Fits a response surface model. Designs generated with BBDESIGN on page 342 and CCDESIGN on page 343 can be
analyzed using this command. Specify interactions in the following way: C5*C6. You can only use extra text on
the command and subcommand lines after a #. For more information on specifying the model, go to How to
specify the model for response surface designs on page 1168.

You can have up to 9 factors. To block the design, specify a blocking variable with the BLOCKS subcommand.
Optionally, you can display any of the five residual plots, and store the residuals, fitted values, and diagnostics

for further analysis.

XMATRIX is useful for storing the design matrix for use in other Minitab commands. It takes the factors, creates
the squares and cross-products, and stores all of these in a matrix. Copy the matrix into columns for use in other

commands.

You can store the residuals, fitted values, and many other diagnostics for further analysis.

For information on how Minitab handles missing data, go to Missing values in factorial, response surface, and
mixture designs on page 1171.

RESPONSE C

Specifies the column that contains the response variable. The column must be numeric or date/time.

BLOCK C

Specifies the column that contains the blocking information (optional). If you use BLOCK, you must also
include the blocking column in TERMS.

FACTOR C...C

Is mandatory and specifies the continuous factors. The columns must be numeric or date/time and must
match the length of the response column.

CFACTOR C...C

Specifies the categorical factors if you have any. The columns can be numeric, text, or date/time and must
match the length of the response column.

CNUM K. ..K

Use both CNUM and CLEVELS when the categorical factor levels in the worksheet are coded and you want
to display uncoded levels in the results.

CNUM specifies the number of levels for each categorical factor. Each K must be an integer from 2 to 100.
You must specify the number of K arguments as the number of columns that you specify in CFACTOR.
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CLEVELS E...E
Use both CNUM and CLEVELS when the categorical factor levels in the worksheet are coded and you want
to display uncoded levels in the results.

CLEVELS specifies the uncoded values for all the categorical factor levels. You must specify the same number
of arguments as the number of K arguments that you specify in CNUM. The group of arguments for each
factor must be of the same type.

LEVELS C

LEVELS K K, ..., KK
Specifies uncoded levels for all continuous factors in C or K...K. For each continuous factor, the list or column
must contain two numerical values. Use LEVELS to change the default order of levels that Minitab uses.

INUNIT K
Specifies whether the design is in coded form or uncoded form.

Value of K Form of design
0 Coded
1 Uncoded

TERMS termlist
Specifies the terms to include in the model. Terms can contain a maximum of two factors. Only continuous
predictors may be repeated. Nested terms are not allowed. Terms must contain the blocks if they are to be
fitted. The model can be nonhierarchical.

Options

WEIGHT C
Performs a weighted regression. An n x n matrix W is formed with the column of weights as its diagonal and zeros
elsewhere. The regression coefficients are estimated by:

XWX (XwWY)

This is equivalent to minimizing the weighted sum of squares for error:
n A2
Zi - 1Wi(yi_ yi)

The prediction interval computed by PREDICT assumes a weight of 1. If you used the WEIGHT subcommand with
values other than 1, you should adjust the prediction interval values manually.

CONFIDENCE K
Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of Kis 95.

ITYPE K
Specifies the type of confidence interval.

Value of K Type of confidence interval
-1 Lower bound
0 (default) Two-sided
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Value of K Type of confidence interval
1 Upper bound
TOLER K

Specifies tolerance level for collinearity and constant check. By default, K = 2.2204460492503131e-016.

Box-Cox transformation

BOXCOX [K]
Performs a Box-Cox transformation with a specified lambda. K is the value of lambda and must be between -5
and + 5. If K'is not given, Minitab will find the optimal lambda. By default, Minitab rounds the optimal value.

Minitab cannot calculate the optimal lambda for stepwise regression. Consequently, you must specify a lambda
value for BOXCOX if you use STEPWISE, FORWARD, or BACKWARD.

Stepwise regression

FINFORMATION, STEPWISE, FORWARD, and BACKWARD perform a stepwise regression procedure to fit the model. No
arguments are needed for these subcommands.

FINFORMATION
Specifies a stepwise model selection procedure that uses forward information criteria selection. Use AICCORRECTED
or BICRITERION to specify which information criterion to use to select the final model. If you do not specify a
criterion, Minitab uses AICCORRECTED.

The forward information criteria procedure adds the term with the lowest p-value to the model at each step. If
you do not include subcommands about hierarchy, INFORMATION adds 1 term at a step and maintains model
hierarchy, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.
Minitab calculates the information criteria for each step.

In most cases, the procedure continues until one of the following conditions occurs:

e The procedure does not find a new minimum of the criterion for 8 consecutive steps.

e The procedure fits the full model.

e The procedure fits a model that leaves 1 degree of freedom for error.

If you specify settings for the procedure that require a hierarchical model at each step and allow only one term
to enter at a time, then the procedure continues until it either fits the full model or fits a model that leaves 1
degree of freedom for error. Minitab displays the results of the analysis for the model with the minimum value

of the selected information criterion, either the corrected Akaike's Information Criterion (AlCc) or the Bayesian
Information Criterion (BIC).

AICCORRECTED
Specifies the use of the corrected Akaike's Information Criterion (AlCc) to select the final model.

BICRITERION
Specifies the use of the Bayesian Information Criterion (BIC) to select the final model.
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STEPWISE
Specifies a stepwise model selection procedure that uses both forward selection and backward elimination. If you
do not include subcommands about hierarchy, STEPWISE and FORWARD add 1 term at a step and maintain model
hierarchy, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

FORWARD
Specifies a stepwise model selection procedure that uses forward selection. If you do not include subcommands
about hierarchy, STEPWISE and FORWARD add 1 term at a step and maintain model hierarchy, the equivalent of
the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

BACKWARD
Specifies a stepwise model selection procedure that uses backward elimination. Removes a single term at each
step and maintains a hierarchical model, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS.

AENTER K
Specifies the alpha level at which a term is entered into the model. The default is 0.15 for STEPWISE and 0.25
for FORWARD.

AREMOVE K
Specifies the alpha level at which a term is removed from the model. The default is 0.15 for STEPWISE and
0.10 for BACKWARD. For STEPWISE, K must be greater than or equal to K for AENTER.

ENTER termlist
Specifies the terms that are contained in the starting model for STEPWISE. The ENTER termlist must be a
subset of the TERMS termlist or in the default term list in the design.

FORCE termlist
Specifies the terms to be forced in the model. The FORCE termlist must be a subset of the TERMS termlist
or in the default term list in the design.

NOHIERARCHICAL
Specifies that the model selection procedure does not consider hierarchy.

HIERARCHICAL
Maintains a hierarchical model in stepwise regression. In a hierarchical model, if a higher-order term is
included, all lower-order terms that comprise the higher-order term also appear in the model. For example,
a model that includes the interaction term A*B*C is hierarchical if it includes the following main effects and
lower-order interactions: A, B, C, A*B, A*C, and B*C.

CATONLY
Specifies that only the categorical terms in the model have to be hierarchical.

ALLTERMS
Specifies that both categorical and continuous terms have to be hierarchical.

ATEND
Specifies that the final step of the stepwise procedure adds terms to make the model hierarchical.

ALWAYS
Specifies that the model is hierarchical at every step.
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SINGLE

Specifies that only one term can enter the model at each step. So a higher-order term can enter
the model only if the terms that comprise the term are already in the model. For example, the
algorithm does not consider the addition of A*B unless A and B are already in the model.

BACKWARDS does not use SINGLE or MULTIPLE because terms only exit the model.

MULTIPLE

Specifies that multiple terms can enter the model at each step. So a higher order term can enter
the model, and the terms that comprise the term enter the model at the same time. For example,
if A*B is the most statistically significant term, A*B enters the model. At the same time, A and B
enter the model if those terms are not in the model already.

BACKWARDS does not use SINGLE or MULTIPLE because terms only exit the model.

Graphs

GEFFECTS

Displays a normal probability plot of the effects or the standardized effects. Minitab labels the effects on the
probability plot that are considered significant. The alpha level is 1 —the confidence level that follows CONFIDENCE,
unless you use stepwise selection that depends on an alpha level. For forward selection, the alpha level is the level
that follows AENTER. For backward and stepwise selection, the alpha level is the level that follows AREMOVE.

GHALF

Displays a half normal probability plot of the effects or standardized effects. Minitab labels the effects on the half
normal plot that are considered significant. The alpha level is 1 — the confidence level that follows CONFIDENCE,
unless you use stepwise selection that depends on an alpha level. For forward selection, the alpha level is the level
that follows AENTER. For backward and stepwise selection, the alpha level is the level that follows AREMOVE.

GPARETO

Displays a Pareto chart of the absolute effects. GPARETO draws a vertical reference line on the plot at the margin
of errors. This plot lets you look at both the magnitude and the importance of an effect at the same time. The
alpha level is 1- the confidence level that follows CONFIDENCE, unless you use stepwise selection. For forward
selection, the alpha level is the level that follows AENTER. For backward and stepwise selection, the alpha level is
the level that follows AREMOVE.

GALLEFFECTS K

Specifies to include the model terms and the terms that are not in the model up to order K on the plots. K can
be 1 or 2. If you specify a stepwise method, Minitab ignores K and shows the terms in the candidate list.

GMODEL
Specifies that only the terms that are in the model are on the plots.

RTYPE K
Specifies the type of residual to plot with the graph subcommands.

Value of K Type of residuals

1 (default) Regular or raw residuals (RESIDUALS)

2 Standardized residuals (SRESIDUALS)

3 Deleted Studentized residuals (TRESIDUALS)
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GHISTOGRAM
Displays a histogram of the residuals.

GNORMAL
Displays a normal probability plot of the residuals.

GFITS
Plots the residuals versus the fitted values.

GORDER
Plots the residuals versus the order of the data. The row number for each data point is shown on the x-axis (for
example, 12 3 4..n).

GFOURPACK
Displays a layout of a histogram of the residuals, a normal probability plot of the residuals, residuals versus fitted
values, and residuals versus order of the data.

GVARIABLIE C...C
Plots the residuals versus variables. Displays a separate graph for the residuals versus each specified column.

Results

NODEFAULT
Specifies that no default tables or graphs are displayed.

TMETHOD
Displays the method table.

TMSDETAILS
Displays the type of stepwise procedure and the alpha values to enter and/or remove a predictor from the model.
If you do not specify FULL or NOFULL, then Minitab uses the settings in File > Options > Linear Models >
Stepwise.

FULL
Displays the coefficients, the p-values, Mallows' Cp, and the model summary statistics for each step of the
procedure.

NOFULL
Does not display the coefficients, the p-values, Mallows' Cp, and the model summary statistics for each step
of the procedure.

TEQUATION
Displays the regression equation table. Minitab displays up to 50 equations. If you do not specify SINGLE or
SEPARATE, then Minitab uses the settings in File > Options > Linear Models > Display of Results.

SINGLE
Displays a single equation, rather than a separate equation for each factor level combination.

SEPARATE
Displays separate equations.

TCOEFFICIENT

Displays the table of coefficients. If you do not specify FULL or NOFULL, then Minitab uses the settings in File >
Options > Linear Models > Display of Results.
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FULL
Displays the full set of coefficients for categorical predictors.

NOFULL
Displays only the linearly independent coefficients.

TSUMMARY
Displays the model summary table.

TANOVA
Displays the ANOVA table.

TDIAGNOSTICS [K]
Displays a table of diagnostics.

Value of K Diagnostics that are displayed
0 Diagnostics only for unusual observations
1 Diagnostics for all observations

DOE

If you do not specify K, then Minitab uses the settings in File > Options > Linear Models > Display of Results.

TEXPAND

Displays the expanded versions of the ANOVA table, the table of coefficients, the model summary table, and the

table of unusual observations.

TSIMPLE

Displays the simple versions of the ANOVA table, the table of coefficients, the model summary table, and the

table of unusual observations.

Storage

BCRESP C
Stores the Box-Cox transformation of the response.

BFITS C
Stores the fits for the original response.

FITS C
Stores the fitted values.

RESIDUALS C
Stores the residuals (fitted values — observed values).

SRESIDUALS C
Stores the standardized residuals.

TRESIDUALS C
Stores the deleted Studentized residuals in C.

HI C
Stores the leverage values.
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COOK C
Stores Cook's distance.

DFITS C
Stores the DFITS (also called DFFITS) values.

COEFFICIENTS C
Stores the estimated coefficients.

XMATRIX M
Stores the design matrix for the regression model in M.

BRSREG: Session command for analyzing a response surface design
with a binary response

Required commands

To perform the analysis, use the main command and at least these accompanying subcommands.

BRSREG
Analyzes a response surface design that can have continuous or categorical predictors with a binary response.

Fits a response surface model. Designs generated with BBDESIGN on page 342 and CCDESIGN on page 343 can be
analyzed using this command. Specify interactions in the following way: C5*C6. For more information on specifying
the model, go to How to specify the model for response surface designs on page 1168.

You can have up to 9 factors. To block the design, specify a blocking variable with the BLOCKS subcommand.
Optionally, you can display any of the five residual plots, and store the residuals, fitted values, and diagnostics
for further analysis.

XMATRIX is useful for storing the design matrix for use in other Minitab commands. It takes the factors, creates
the squares and cross-products, and stores all of these in a matrix. Copy the matrix into columns for use in other
commands.

You can store the residuals, fitted values, and many other diagnostics for further analysis.

For information on how Minitab handles missing data, go to Missing values in factorial, response surface, and
mixture designs on page 1171.

RESPONSE C C

Enters the response data as a column that contains the number of events first and then a column that contains
the number of trials. The columns must have the same number of rows. For examples, go to Entering data
for response variables on page 1142.

FACTOR C...C

Specifies the continuous factors. The columns must be numeric or date/time and must have the same number
of rows as the response columns. Specify any categorical factors after CFACTOR instead of FACTOR.

TERMS termlist

Specifies the terms to include in the model. Terms can contain a maximum of two factors. Only continuous
predictors may be repeated. Nested terms are not allowed. Terms must contain the blocks if they are to be
fitted. The model can be nonhierarchical.
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LEVELS C or LEVELS KK, ..., KK
Specifies uncoded levels for all continuous factors in C or K...K. For each continuous factor, the list or column
must contain two numerical values. Use LEVELS to change the default order of levels that Minitab uses. Specify
levels for categorical factors after CLEVELS instead of LEVELS. Also specify the number of levels for categorical
factors after CNUM.

INUNIT K
Specifies whether the design is in coded form or uncoded form.

Value of K Form of design
0 Coded
1 Uncoded

Optional subcommands

Use these subcommands and the subcommands in the following sections to change the default analysis.

CFACTOR C...C
Specifies the categorical factors if you have any. The columns can be numeric, text, or date/time and must match
the length of the response column.

CNUM K...K
Use both CNUM and CLEVELS when the categorical factor levels in the worksheet are coded and you want to
display uncoded levels in the results.

CNUM specifies the number of levels for each categorical factor. Each K must be an integer from 2 to 100. You
must specify the number of K arguments as the number of columns that you specify in CFACTOR.

CLEVELS E...E
Use both CNUM and CLEVELS when the categorical factor levels in the worksheet are coded and you want to
display uncoded levels in the results.

CLEVELS specifies the uncoded values for all the categorical factor levels. You must specify the same number of
arguments as the number of K arguments that you specify in CNUM. The group of arguments for each factor
must be of the same type.

BLOCKS C
Specifies the column that contains the blocking information in C. Include the blocking column together with
TERMS to make a model that considers blocks.

EVNAME K
Specify the name of the event with K. Enclose text values in double quotation marks.

LOGIT
Use the logit link function.

NORMIT
Use the normit link function.

GOMPIT
Use the gompit link function. The gompit link function is also called the complementary log-log link function.
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Options subcommands

CONFIDENCE K

Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of K'is 95.

ITYPE K
Specifies the type of confidence interval.

Value of K Type of confidence interval
-1 Lower bound
0 (default) Two-sided
1 Upper bound
SEQDEVIANCE

Use sequential deviances for the tests of significance in the ANOVA table. The order of the terms in TERMS affects
the statistical significance. The default is to use adjusted deviances.

PEARSON
Specifies the use of Pearson residuals. The default is to use deviance residuals.

WEIGHT C

Performs a weighted regression. An n x n matrix W is formed with the column of weights as its diagonal and zeros
elsewhere. The regression coefficients are estimated by:

XWX ' (X'wWY)

HGROUP K
Specifies the number of groups for the Hosmer-Lemeshow goodness-of-fit test with K. The default is 10.

ITERATION K

Specifies the maximum number of iterations for the optimization algorithm that estimates the coefficients. The
default is 50.

TOLERANCE K

Specifies the value in K above which Minitab removes highly correlated predictors and nearly constant predictors.
By default, K = 1E-12.

The tolerance value determines when Minitab retains a factor in the model that is either highly correlated with a
different factor or that is almost constant. Lowering tolerance by giving very small argument values can prevent
Minitab from eliminating problematic predictor columns from the model.

Collinearity 1-R?, where R? is the value that results from regressing one predictor on the remaining
predictors. If (1 - Rz) is < (K), then the predictor is removed from the equation.

Almost constant If the coefficient of variation of a predictor (the standard deviation / the mean) is <
square root (K), then the predictor is considered essentially constant and is removed
from the equation.

CTOLERANCE K
Specifies the convergence criterion for the algorithm that estimates the coefficients. By default, K = 1E-8.
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START C

Specifies a column that contains starting values for the coefficients in the optimization algorithm. The column
begins with the estimate of the constant, then follows the order of the model after TERMS.

Stepwise regression subcommands

FINFORMATION, STEPWISE, FORWARD, and BACKWARD perform a stepwise regression procedure to fit the model. No
arguments are needed for these subcommands.

FINFORMATION
Specifies a stepwise model selection procedure that uses forward information criteria selection. Use AICCORRECTED
or BICRITERION to specify which information criterion to use to select the final model. If you do not specify a
criterion, Minitab uses AICCORRECTED.

The forward information criteria procedure adds the term with the lowest p-value to the model at each step. If
you do not include subcommands about hierarchy, FINFORMATION adds 1 term at a step and maintains model
hierarchy, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

Minitab calculates the information criteria for each step.

In most cases, the procedure continues until one of the following conditions occurs:

e The procedure does not find a new minimum of the criterion for 8 consecutive steps.
e The procedure fits the full model.

e The procedure fits a model that leaves 1 degree of freedom for error.

If you specify settings for the procedure that require a hierarchical model at each step and allow only one term
to enter at a time, then the procedure continues until it either fits the full model or fits a model that leaves 1
degree of freedom for error. Minitab displays the results of the analysis for the model with the minimum value
of the selected information criterion, either the corrected Akaike's Information Criterion (AlCc) or the Bayesian
Information Criterion (BIC).

AICCORRECTED
Specifies the use of the corrected Akaike's Information Criterion (AlCc) to select the final model.

BICRITERION
Specifies the use of the Bayesian Information Criterion (BIC) to select the final model.

STEPWISE
Specifies a stepwise model selection procedure that uses both forward selection and backward elimination. If you
do not include subcommands about hierarchy, STEPWISE and FORWARD add 1 term at a step and maintain model
hierarchy, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

FORWARD
Specifies a stepwise model selection procedure that uses forward selection. If you do not include subcommands
about hierarchy, STEPWISE and FORWARD add 1 term at a step and maintain model hierarchy, the equivalent of
the following:

HIERARCHICAL; ALLTERMS; ALWAYS; SINGLE.

BACKWARD
Specifies a stepwise model selection procedure that uses backward elimination. Removes a single term at each
step and maintains a hierarchical model, the equivalent of the following:

HIERARCHICAL; ALLTERMS; ALWAYS.
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AENTER K
Specifies the alpha level at which a term is entered into the model. The default is 0.15 for STEPWISE and 0.25
for FORWARD.

AREMOVE K
Specifies the alpha level at which a term is removed from the model. The default is 0.15 for STEPWISE and
0.10 for BACKWARD. For STEPWISE, K must be greater than or equal to K for AENTER.

ENTER termlist
Specifies the terms that are contained in the starting model for STEPWISE. The ENTER termlist must be a
subset of the TERMS termlist or in the default term list in the design.

FORCE termlist
Specifies the terms to be forced in the model. The FORCE termlist must be a subset of the TERMS termlist
or in the default term list in the design.

NOHIERARCHICAL
Specifies that the model selection procedure does not consider hierarchy.

HIERARCHICAL
Maintains a hierarchical model in stepwise regression. In a hierarchical model, if a higher-order term is
included, all lower-order terms that comprise the higher-order term also appear in the model. For example,
a model that includes the interaction term A*B*C is hierarchical if it includes the following main effects and
lower-order interactions: A, B, C, A*B, A*C, and B*C.

CATONLY
Specifies that only the categorical terms in the model have to be hierarchical.

ALLTERMS
Specifies that both categorical and continuous terms have to be hierarchical.

ATEND
Specifies that the final step of the stepwise procedure adds terms to make the model hierarchical.

ALWAYS
Specifies that the model is hierarchical at every step.

SINGLE
Specifies that only one term can enter the model at each step. So a higher-order term can enter
the model only if the terms that comprise the term are already in the model. For example, the
algorithm does not consider the addition of A*B unless A and B are already in the model.

BACKWARDS does not use SINGLE or MULTIPLE because terms only exit the model.

MULTIPLE
Specifies that multiple terms can enter the model at each step. So a higher order term can enter
the model, and the terms that comprise the term enter the model at the same time. For example,
if A*B is the most statistically significant term, A*B enters the model. At the same time, A and B
enter the model if those terms are not in the model already.

BACKWARDS does not use SINGLE or MULTIPLE because terms only exit the model.
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Graphs subcommands

RTYPE K
Specifies the type of residual to plot with the graph subcommands.

Value of K Type of residuals

1 (default) Regular or raw residuals (RESIDUALS)

2 Standardized residuals (SRESIDUALS)

3 Deleted Studentized residuals (TRESIDUALS)
GEFFECTS

Displays a normal probability plot of the effects or the standardized effects. Minitab labels the effects on the
probability plot that are considered significant. The alpha level is (1 —the confidence level) that follows CONFIDENCE,
unless you use stepwise selection that depends on an alpha level. For forward selection, the alpha level is the level
that follows AENTER. For backward and stepwise selection, the alpha level is the level that follows AREMOVE.

GHALF

Displays a half normal probability plot of the effects or standardized effects. Minitab labels the effects on the half
normal plot that are considered significant. The alpha level is (1 — the confidence level) that follows CONFIDENCE,
unless you use stepwise selection that depends on an alpha level. For forward selection, the alpha level is the level
that follows AENTER. For backward and stepwise selection, the alpha level is the level that follows AREMOVE.

GPARETO

Displays a Pareto chart of the absolute effects. GPARETO draws a vertical reference line on the plot at the margin
of error. This plot lets you to look at both the magnitude and the importance of an effect at the same time. The
alpha level is (1 — the confidence level) that follows CONFIDENCE, unless you use stepwise selection that depends
on an alpha level. For forward selection, the alpha level is the level that follows AENTER. For backward and stepwise
selection, the alpha level is the level that follows AREMOVE.

GALLEFFECTS K

Specifies to include the model terms and the terms that are not in the model up to order K on the plots. If you
specify a stepwise method, Minitab ignores K and shows the terms in the candidate list.

GMODEL
Specifies that only the terms that are in the model are on the plots.

GHISTOGRAM
Displays a histogram of the residuals.

GNORMAL
Displays a normal probability plot of the residuals.

GFITS
Displays residuals versus fitted values.

GORDER [C]

Plots the residuals versus the order of the data, or versus the order specified in C. The row number for each data
point is shown on the x-axis (for example, 12 3 4...n).

GFOURPACK [C]

Displays four residual plots—a histogram of the residuals, a normal probability plot of the residuals, the residuals
versus fitted the values, and the residuals versus the order of the data, or versus the order specified in C—in one

graph.
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GVARIABLE C...C
Displays the residuals versus the variables in C. Typically, you enter the columns for the predictors.

Results subcommands

NODEFAULT
Hides default tables and graphs that you do not include the subcommand to display.

TEXPAND
Displays the expanded versions of the tables that have them. The expanded Analysis of Variance table adds the
sequential deviances and percent contributions for each term. The Coefficients table adds confidence intervals
for the coefficients. The Fits and Diagnostics table adds the standard error of the fit, the 95% confidence interval
for the fit, the deleted residual, the HI, the Cook's D, and the DFITS.

TSIMPLE
Displays the simple versions of the Analysis of Variance table, the Coefficients table, and the Fits and Diagnostics
table.

TMETHOD
Displays a table of information about the method and options.

TMSDETAILS
Displays the type of stepwise procedure and the alpha values to enter and/or remove a predictor from the model.

If you do not specify FULL or NOFULL, then Minitab uses the preferences that you set in File > Options > Linear

Models > Stepwise.

FULL
Specifies to display the coefficients, p-values, and model summary statistics for each step of the procedure.

NOFULL
Hides these statistics.

TRINFO
Displays the number of events, non-events, and the total. The table also indicates which response value is the
reference event.

TSTEP
Displays the deviance at each iteration of the coefficients.

TCOEFFICIENTS
Displays the coefficients and the p-values for the Wald normal approximation tests.

If you do not specify FULL or NOFULL, Minitab uses the preferences that you set in File > Options > Linear
Models > Display of Results.

FULL
Specifies to show the coefficients for the reference level when you use (0, 1) coding for categorical predictors.

NOFULL
Hides these statistics.
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TODDS
Displays odds ratios for each continuous predictor and each level of the categorical predictors. The output does
not show odds ratios for predictors with interactions in the model.

INCREMENT K. ..K
Specifies the increment for the odds ratio for the predictor with K. For example, if the predictor is mass in
grams, enter 1000 to see the change in the odds ratio for a kilogram. Enter a value for each numeric factor
in the same order that the factors follow the FACTOR subcommand. Enter 1 for a factor to use the same units
as the data.

TSUMMARY
Displays the statistics that evaluate model fit, including deviance R%.

TGOODNESS
Displays the Pearson and deviance goodness-of-fit tests. For the binomial distribution models, also shows the
Hosmer-Lemeshow goodness-of-fit test.

TDEVIANCE
Displays the ANOVA table.

TEQUATION
Displays the model equation.

SINGLE

Specifies to show one equation instead of a separate equation for each combination of the levels of the
categorical predictors. The equation has a coefficient for each level of the categorical variables.

SEPARATE
Specifies to show separate equations for each combination of the levels of the categorical predictors. Each
equation has a different constant term.

THOSMER
Displays the table of observed and expected values for the Hosmer-Lemeshow test.

TASSOCIATION
Displays the number of concordant and discordant pairs, the Somers' D, the Goodman-Kruskal Gamma, and
Kendall's Tau-a.

TDIAGNOSTICS [K]
Displays a table of diagnostics. K = 0 displays diagnostics for only observations with high leverage values or
standardized residuals greater than 2. K = 1 displays diagnostics for all observations.

Storage subcommands

FITS C
Stores the event probabilities in C.

RESIDUALS C
Stores the deviance residuals by default in C. Stores the Pearson residuals if you use the subcommand PEARSON.

SRESIDUALS C

Stores the standardized deviance residuals by default in C. Stores the standardized Pearson residuals if you use
the subcommand PEARSON.
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TRESIDUALS C

Stores the deleted deviance residuals by default in C. Stores the deleted Pearson residuals if you use the
subcommand PEARSON.

COOK C
Stores the Cook's distances in C.

DFITS C
Stores the DFITS in C.

HI C
Stores the leverages in C.

SADJUSTEDRESP C
Stores the final adjusted response values in C.

SIWEIGHTS C
Stores the internal weights used to estimate the model parameters in C.

SECOEFFICIENTS C
Stores the standard errors of the estimated coefficients in C.

COEFFICIENTS C
Stores the estimated coefficients in C.

DBETA C
Stores the change in the estimated regression coefficients (delta b) when you delete all observations with a
particular factor/covariate pattern in C. Use the delta b values to detect observations with a strong influence on
the coefficients.

DSBETA C

Stores the change in the estimated regression coefficients when you delete all observations with a particular
factor/covariate pattern based on the standardized Pearson residual in C.

DCHISQUARE C
Stores the change in the chi-square statistic when you delete all observations with a particular factor/covariate
pattern in C. Observations that are poorly fit by the model have high delta chi-square values.

DDEVIANCE C

Stores the change in the deviance when you delete all observations with a particular factor/covariate pattern in
C.

XMATRIX M
Stores the design matrix in M.

XPWXINVERSE M
Stores the X'WX inverse matrix of the estimated coefficients in M.

OPTDES: Session command for selecting an optimal design

OPTDES K [C...C]
Select an optimal design by specifying the number of final design points in K and optionally, specifying candidate
design columns in C...C.
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The purpose of an optimal design is to select design points according to some criteria. Minitab's optimal design
capabilities can be used with response surface designs and mixture designs. You can use Select Optimal Design
to do the following:

e Select an optimal set of design points.
e Augment (add points to) an existing design.
e Improve the D-optimality of an existing design.

e Evaluate and compare designs.

OPTDES has the following forms:

e OPTDES K: Specifies the number of final design points to select based on D-optimality. For this command
form either a factorial model, mixture model, or response surface model must be specified by subcommands
FACMODEL, MIXMODEL, or RESMODEL. The constant K must be a positive integer or 0. If K = zero, you must
use either the AUGMENT or EVALUATE subcommand.

e OPTDESK, C...C: Specifies the number of final design points and the design columns that contain the candidate
set. Constant K must be a positive integer. You must specify at least 2 design columns. All columns must have
the same length and must be numeric. With this form of the main command you cannot have the following
subcommands: FACMODEL, RESMODEL, MIXMODEL, EVALUATE, BLOCK, GENERATE, EXCHANGE, FEDOROV,
SEQUENTIAL.

Note The subcommands DESIGN and COPY replace the obsolete subcommands XMATRIX and CARRY.

FACMODEL terms

Species the terms of a factorial model used in selecting D-optimal design. The legal term list is the same as
in GLM.

FACMODEL, RESMODEL, and MIXMODEL are mutually exclusive and one of them must be the first
subcommand.

MIXMODEL terms

Specifies the terms of a mixture model used in selecting D-optimal design. The legal term list is the same as
in MIXREG.

FACMODEL, RESMODEL, and MIXMODEL are mutually exclusive and one of them must be the first
subcommand.

RESMODEL terms

Specifies the terms of a response surface model used in selecting D-optimal design. The legal term list is the
same as in RSREG. When you use RESMODEL, also use INUNIT and LEVELS.

FACMODEL, RESMODEL, and MIXMODEL are mutually exclusive and one of them must be the first
subcommand.

INUNIT
Specifies whether the design is in coded form or uncoded form.

Value of K Form of design
0 Coded
1 Uncoded
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LEVELS K K, ..., KK
Specifies uncoded levels for all continuous factors K K, ..., K K. Enter the low level, then the high level,
for each continuous factor that follows RESMODEL. List the pairs of levels in the order of the factors that
follow RESMODEL.

AUGMENT C

Augments or improves an existing design indicated by row flags in C. Column C must be numeric and must
contain integers. The column length must match the length of the design columns.

Cannot be specified together with EVALUATE, GENERATE, or SEQUENTIAL.

EVALUATE C

Evaluates an existing design indicated by row flags in C. Column C must be numeric and must contain
non-negative integers. The column length must match the length of the design columns.

Cannot be specified with OPTDES K C...C, AUGMENT, EXCHANGE, FEDOROV, SEQUENTIAL, GENERATE,
INDICATOR.

BLOCK C

Specifies the blocking column. The column can be alpha or numeric with 2-64 distinct values. Column length
must match the length of the design columns. Must not be on the term list.

Cannot be specified with OPTDES K C...C.

PROCESS C...C
Specifies process variable columns. Columns must be either on the main line if OPTDES K C...C or on the term
list. Columns may be alpha or numeric with exactly 2 levels. With OPTDES K C...C, only numerical process
variable columns are allowed. The number of columns must be between 1 and 7. Column lengths must match
the length of design columns.

Cannot be specified with AMOUNT or with factorial or response surface models.

AMOUNT C

Specifies the mixture amount column. Column must be either on the main line if OPTDES K C...C or on the
term list. The column must be numeric with 2-5 distinct numerical values. The column length must match
the length of the design columns.

Cannot be specified with PROCESS or with factorial or response surface models.

PSEUDO
Specifies that calculations are performed using pseudo-components. PSEUDO is ignored in cases of factorial
or response surface designs.

GENERATE K [K [K]]
Generates K % of initial points randomly, and adds the rest of points by sequential method. The second K is
the number of random trials. The third K is the base for the random data generator. Legal values are as
follows: first and second K integer, third K any positive real. 0 < first K <=100, 1 <= second K <= 25.

Cannot be specified with OPTDES K C...C, AUGMENT, EVALUATE, SEQUENT.

SEQUENTIAL
Selects design points by the sequential algorithm for the initial design.
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Cannot be specified with OPTDES K C...C, AUGMENT, EVALUATE, GENERATE.

EXCHANGE K

Improves the initial design matrix by adding and dropping K design points one at a time. Legal values are
as follows: K'is an integer, 1 <= K <= 5.

Cannot be specified with OPTDES K C...C, EVALUATE, FEDOROV.

FEDOROV
Improves the initial design matrix using Fedorov's algorithm.

Cannot be specified with OPTDES K C...C, EVALUATE, EXCHANGE.

INDICATOR C
Stores selection indicators in the specified column.

Cannot be specified with EVALUATE.

DESIGN

Copies the standard order, run order, point type, blocks, and factors to a new worksheet for rows in the
optimal design.

COPY C...C

Copies rows in the optimal design to the new worksheet for columns that are not part of the design.
For example, you can use COPY to copy a column of covariate measurements.

BRIEF K
Controls the amount of output with a value in K.

Value of K Output that is displayed

0 Minitab displays no output, but performs all specified storage.

1 Minitab displays a summary table for the final design only.

2 (default) Minitab displays summary tables for the intermediate design and the final design.
3 Displays summary tables and the final design matrix.

DETZERO [K]

Overrides the lower limit for the determinant, which is E-30. Use when you receive the "rank deficient data"
error message, but still want to perform the analysis. K is an integer that is greater than or equal to 30. The
default value is 30.

Plot Response Surface Designs

FACPLQOT: Session command for creating a factorial plot

FACPLOT C

Displays factorial plots for the model associated with the response variable in the specified column To create this
graph, you need to specify a model. To produce an interaction plot, you must have two or more variables.
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These plots can illustrate how a response variable relates to one or more variables. You can produce two types
of factorial plots.

e Use a main effects plot to compare fitted means or data means across levels of one or more variables.

e Use an interactions plot to assess the effects of one variable at levels of another variable. An interactions plot
displays the fitted means for a level of a variable with the level of a second variable held constant.

Although you can use these plots to display the effects, be sure to evaluate significance by looking at the effects
in the analysis of variance table.

FACTORS C...C
Specifies the variables to display in both the main effect and interaction plots. You must specify 2 or more
variables to generate an interaction plot.

GMAIN
GMAIN displays the main effect plot.

GINT
GINT displays the interactions plot.

FULL
Use FULL to display both interaction plots for each pair of categorical variables, such as Predictor 1 by
Predictor 2 and Predictor 2 by Predictor 1. Sometimes you can identify interactions more easily when
you examine both plots.

LOWER
Use LOWER to display one version of each interaction plot.

GMODEL (default)
GMODEL display plots for only terms that are in the model and listed in FACTORS. For purposes of a main
effect plot, a variable is in the model if the model includes any terms that involve only that variable, e.g. A,
A*A, or A*A*A. For purposes of an interaction plot, the interaction of two variables is in the model if the
model includes any terms that involve both variables, e.g. A*B, A*B*B.

GALL
GALL displays plots for all terms involving variables on the FACTORS subcommand.

TITLE "title"
Specifies a title for the graph. If you do not specify a title, Minitab uses a default title.

Mixture Designs

EVDESIGN: Session command for creating an extreme vertices
design

EVDESIGN K
Creates an extreme vertices design for K components. In EVDESIGN, Minitab uses an algorithm that generates
extreme vertices and their blends up to the specified degrees. You must use these designs when your chosen
design space is not an L-simplex design. The presence of both lower and upper bound constraints on the
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components often create this condition. The goal of an extreme vertices design is to choose design points that
adequately cover the design space.

To store your design for additional analysis, use the DESIGN subcommand. (The DESIGN subcommand replaces
the obsolete subcommands SORDER, PTTYPE, and XMATRIX.).

Design

DEGREE K
Specifies the degree of the design in K. For lattice designs, 1 < K < 10. For extreme vertices designs, 1 < K <
number of components. The default K = 1.

AUGMENT
Augments (that is, adds points to) the design using axial points. Each axial point is added halfway between a
vertex and the center of the design.

By augmenting a design, you can better understand what occurs on the interior of the design, instead of relying
only on points on the edges.

AXIAL
Augments the design with axial points halfway between each vertex and centroid. The default is no axial points.

CENTER
Augments the design with center points if no center points exist in the design. The default is no center point.

ALLREP K
Replicates all points in the design K times. The default is K = 1.

REPS K, K...K, K
Specifies the number of replicates for design points of the selected type. In each constant pair (K, K), the first K
value indicates the point type (1, 2,..q, 0, 1), and the second K value indicates the number of replicates. The
default is no replicates.

Components

TOTAL K [K...K]

TOTAL C
Specifies the mixture design as actual measurements, not proportions, in K or C, with up to 5 different amounts.
For example, suppose you measure all the components of a mixture in liters. If the total mixture adds up to 5.2
liters, set TOTAL to 5.2. This generates the settings for components in the design in terms of liters. Or, suppose
you want to evaluate plant growth when one gram versus two grams of food are applied. You set TOTAL to 1 2.

K can be any positive number, with up to 5 values. The default value is 1. You can also enter the values in a column
(C) and use the column as the argument.

LOWER K...K

LOWER C
Specifies the lower bounds for the q components in K...K, one for each component. The first argument is for the
first component, the second for the second component, and so on. The default value is 0. If the sum of all the
lower bounds is less than the value of TOTAL, you can specify any non-negative values for LOWER. You can also
enter the values in a column (C) and use the column as the argument for LOWER.
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When you change the default lower bounds of one component, the achievable upper values on the other
components are also adjusted downward. Specifically, the achievable upper bound (U)) for component | is as
follows:

U| = TOTAL - [L1 + LZ + ..+ L(|_1) + L(|+1) + ..+ Lq]

Minitab displays both the specified lower bounds and the achievable upper bounds in the output. For example,
suppose you have 3 components: TOTAL = 10, L; = 0, L, = 2, and L3 = 1. In this case, the achievable upper bounds
areU; =7,U, =9,and U3 = 8.

UPPER K. ..K

UPPER C

Specifies upper bounds for the components in K...K or C. Must be a positive value for each component. The default
is 1 for each value if the units are proportions or pseudo-components. The default is the whole amount if the
units are amounts.

PSEUDO and PROPORTIONS

Specifies the scale in which data are represented, including: amounts, proportions, or pseudo-components.
Amounts are what you actually measure. By default, Minitab uses amounts to display and store your data. PSEUDO
specifies that the data is represented by pseudo-components. PROPORTIONS specifies that the data is represented
by proportions.

To get proportions, divide the measurement amounts by the value of TOTAL. When you use PROPORTIONS,
Minitab uses proportions to print and store the design. When you do not specify TOTAL, the amount scale and
the proportion scale are the same.

You generally use pseudo-components when you specify lower bounds. Pseudo-components, in effect, rescale
the constrained data area so that the least allowable amount (the lower bound) of each component is 0, and the
greatest allowable amount of a component is 1. This makes the pseudo-component terms of a constrained design
(that is, a design with lower bounds) the same as the proportional terms of an unconstrained design.

Mathematically, this translates to the following: Let X; be the settings expressed as proportions. Let L; be the lower
bounds expressed as proportions. Let Low = Ly + L, + ... + Lg. Then pseudo-component p; = (X; - L;) / (1 - Low).

When you use PSEUDO, then Minitab uses pseudo-components to print and store the design. When the design
has no LOWER bounds, pseudo-components and proportions are the same. When you do not use TOTAL or
LOWER, the PSEUDO, PROPORTIONS, and amount scales are the same.

You cannot use both PSEUDO and PROPORTIONS in the same command.

In the following example, 2 components show amounts, proportions, and pseudo-components. Suppose the total
mixture is 50 ml. Let X1 and X2 be the amount scale. Thus X1 + X2 = 50. Suppose X1 has a LOWER bound of 20.
(This means that the UPPER bound of X2 is 50 — 20, or 30.)

SCDESIGN 2;

TOTAL 50;
LOWER 20 O.

The following table shows some points on the three scales.

Amounts Proportions Pseudo-components
X1 X2 X1 X2 X1 X2
50 0 1.0 0.0 1.0 0.0
20 30 04 0.6 0.0 1.0
35 15 0.7 0.3 0.5 0.5
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LINEAR K...K

LINEAR C
Specifies linear constraints for the components in K..K or C. The number of values equals the number of components
+ 2. The first constant is the lower bound. The last constant is the upper bound. One of the bounds can be ' * .
All values must be numeric. The default is no linear constraint.

Process variables

PROC K1 [K2 [K3]]
Specifies the number of process variables, the factorial design, and the fraction id. The default is no process
variables. The Ks canequal: 1 < K1 <£7;K2=1,2,4,8,16; 1 < K3 < K2.

LEVELS K...K
Specifies level values for the process variables in K...K. The default is -1 and +1 for each variable. The number of
Ks equals twice the number of process variables. K can be numeric or text.

Options

RANDOMIZE [K]
Randomizes the runs in the design matrix. When you use RANDOMIZE, the standard order and the run order are
different and Minitab stores the design in run order.

K is the base for the random data generator and can take any integer as an argument. To always get the same
ordering of the rows, create the same design and randomize the runs with the same base. For more information,
go to BASE on page 86.

DESIGN
Names and stores the standard order, run order, point type, block assignment, and each factor in separate columns.
Unless you have only 1 empty worksheet in the project, Minitab stores the columns in a new worksheet.

NAMES K K, ..., KK
Specifies names for the mixture components. Enclose names in quotation marks. If you do not use NAMES,
then the names of the components are letters, skipping the letter I: A, B, C...

PNAMES K K, ..., KK
Specifies names for the process variables. Enclose names in quotation marks. If you do not use PNAMES,
then the names of the process variables are the letter X followed by sequential numbers: X1, X2, X3...

STOTAL C
Stores one or more totals in C. The default is no storage. STOTAL is incompatible with DESIGN.

SLOWER C
Stores the lower bounds of the components in C. The default is no storage. SLOWER is incompatible with DESIGN.

SUPPER C
Stores the upper bounds of the components in C. The default is no storage. SUPPER is incompatible with DESIGN.

SLINEAR C...C
Stores linear constraints in C...C, one per column. The default is no storage. SLINEAR is incompatible with DESIGN.
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Results

BRIEF K

Controls the amount of output. You can also use BRIEF as a main command. It then effects all commands that
are controlled by BRIEF.

Value of K Output that Minitab displays

0 Minitab displays no output, but performs all requested storage.
1 Minitab displays a summary of the design.

2 (default) Same as K = 1 output.

3 Same as K = 2 output, but Minitab also displays the data matrix.

SCDESIGN: Session command for creating a simplex centroid
design

SCDESIGN K
Creates a simplex centroid design for K components.

Generates a series of settings for the components in an experiment with a simplex centroid design. A simplex
centroid design consists of the following for a mixture with g components:

e All points (x1, x2, .., xq) where one component, xi = 1, and the other components are 0. These are called vertex
points.

e All points where one component, xi = 1/2, another component, xj = 1/2, and the other components are 0.

e All points where one component, xi = 1/3, another component, xj = 1/3, another component, xk = 1/3, and
the other components are 0.

e And so on, up to the stage where all components are 1/q. This last point (where all components are equal) is
called the center or centroid of the design.

Simplex centroid designs contain a total of 2q — 1 points.

The constant argument on the command line is an integer from 2 to 7 that specifies the number of components
or variables (which is generally called g).

To store your design for additional analysis, use the DESIGN subcommand. (The DESIGN subcommand replaces
the obsolete subcommands SORDER, PTTYPE, and XMATRIX.).

Design

AUGMENT

Augments (or adds points to) the design using the axial points shown below. Each added point is half way between
a vertex and the center of the design.

By augmenting a design, you can get a better picture of what happens on the interior of the design, instead of
just relying on points on the edges.

AXIAL
Augments the design with axial points half way between each vertex and centroid. The default is no axial points.
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ALLREP K
Replicates all points in the design K times. The default is K = 1.

REPS KK, ..., KK
Specifies the number of replicates for design points of selected type. In each constant pair K, K the first value
indicates the point type (1, 2, ..q, 0, —1), the second value specifies the number of replicates. The default is no
replicates.

Components

TOTAL K [K...K]

TOTAL C
Specifies the mixture design in terms of actual measurements, not proportions. For example, if you measure all
the components of your mixture in liters and the total mixture adds up to 5.2 liters, set TOTAL to 5.2 to generate
the settings for components in the design in terms of liters. Or, suppose you are testing plant food and would
like to evaluate plant growth when one gram versus two grams are applied. You would set TOTAL to 1 2.

The TOTAL argument can be any positive number, with up to five values for total. The default value is 1. You can
also enter the values in a column and use the column as the argument.

LOWER K. ..K

LOWER C
Specifies the lower bounds for the q components. The first argument is for the first component, the second for
the second component, and so on. The default is to set the lower bound for each component to 0. You may specify
any non-negative values for LOWER provided the sum of all the lower bounds is less than the value of TOTAL.
You can also enter the values in a column and use the column as the argument for LOWER.

When you change the default lower bounds of one component, the achievable upper values on the other
components are also adjusted downward. Specifically, the achievable upper bound (U i) for component i is

Ui =TOTAL - [Ly + Ly + . + Ligy + Ljuqy + - + Lyl

Minitab displays both the specified lower bounds and achievable upper bounds in the output. As an example,
suppose you have 3 components, TOTAL = 10, L; = 0, L, = 2 and L3 = 1. Then the achievable upper bounds are
U1 :7,U2=9andU3:8.

UPPER K. ..K

UPPER C

Specifies upper bounds for the components in K...K or C. Must be a positive value for each component. The default
is 1 for each value if the units are proportions or pseudo-components. The default is the whole amount if the
units are amounts.

PSEUDO and PROPORTIONS

Specifies the scale in which data is represented, including: amounts, proportions, or pseudo-components. Amounts
are what you actually measure. By default, Minitab uses amounts to print and store your data.

To get proportions, divide the measurement amounts by the value of TOTAL. When you use PROPORTIONS,
Minitab uses proportions to print and store the design. When you do not specify TOTAL, the amount scale and
the proportion scale are the same.

You generally use pseudo-components when you specify lower bounds. Pseudo-components, in effect, rescale
the constrained data area so the least allowable amount (the lower bound) of each component is 0, and the
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greatest allowable amount of a component is 1. This makes the pseudo-component terms of a constrained design
(that is, a design with lower bounds) the same as the proportional terms of an unconstrained design.

Mathematically, this translates to the following. Let x 1 be the settings expressed as proportions. Let Li be the
lower bounds expressed as proportions and let Low = Ly + L, + & + Lg. Then pseudo-component p; = (x - L) /
(1T - Low).

When you use PSEUDO, then Minitab uses pseudo-components to print and store the design. When the design
has no LOWER bounds, pseudo-components and proportions are the same. When you do not use TOTAL or
LOWER, the PSEUDO, PROPORTIONS, and amount scales are the same.

You cannot use both PSEUDO and PROPORTIONS in the same command.

Here is an example with 2 components that shows amounts, proportions, and pseudo-components. Suppose the
total mixture is 50 ml. Let X1 and X2 be the amount scale. Thus X1 + X2 = 50. Suppose X1 has a LOWER bound
of 20 (this means that the UPPER bound of X2 is 50 minus 20, or 30). The session commands for this are as follows.

SCDESIGN 2;
TOTAL 50;
LOWER 20 O.

The following table shows some points on the three scales.

Amounts Proportions Pseudo-components
X1 X2 X1 X2 X1 X2
50 0 1.0 0.0 1.0 0.0
20 30 04 0.6 0.0 1.0
35 15 0.7 0.3 0.5 0.5

Process variables

PROC K1 [K2 [K3]]

Specifies the number of process variables, the factorial design and fraction id. The default is no proc vars 1 <=
K1<=7,K2=1,248 161 <=K3 <=K2.

LEVELS K...K

Specifies level values for the process variables. The default is —1 and +1 for each variable. The number of Ks equals
twice the number of process variables. K may be numerical or text.

Options

RANDOMIZE [K]

Randomizes the runs in the design matrix. When you use RANDOMIZE, the standard order and the run order are
different and Minitab stores the design in run order.

K'is the base for the random data generator and can take any integer as an argument. To always get the same
ordering of the rows, create the same design and randomize the runs with the same base. See BASE on page 86
for a discussion.

DESIGN

Names and stores the standard order, run order, point type, block assignment, and each factor in separate columns.
Unless you have only 1 empty worksheet in the project, Minitab stores the columns in a new worksheet.
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NAMES KK, ..., KK
Specifies names for the mixture components. Enclose names in quotation marks. If you do not use NAMES,
then the names of the components are letters, skipping the letter I: A, B, C...

PNAMES K K, ..., KK

Specifies names for the process variables. Enclose names in quotation marks. If you do not use PNAMES,
then the names of the process variables are the letter X followed by sequential numbers: X1, X2, X3...

STOTAL C
Stores one or more totals in C. The default is no storage. STOTAL is incompatible with DESIGN.

SLOWER C
Stores the lower bounds of the components in C. The default is no storage. SLOWER is incompatible with DESIGN.

SUPPER C
Stores the upper bounds of the components in C. The default is no storage. SUPPER is incompatible with DESIGN.

Results

BRIEF K
Controls the amount of output. You can also use BRIEF as a main command. When you use BRIEF as a main
command, it affects all other commands that use BRIEF to control the amount of output.

Value of K Output that is displayed

0 Minitab displays no output from the command, but performs all specified storage and
displays the following output: error messages, warnings, prompts, and notes.

1 Minitab displays a summary of the design.

2 (default) Same as K = 1 output.

3 Same as K = 2 output, but Minitab also displays the design table.

SLDESIGN: Session command for creating a mixture design

SLDESIGN K [K]

Generates a series of settings for an experiment that uses a simplex lattice design with g components (variables),
of degree m. The degree m can be 1-10. For more information, go to Simplex lattice design descriptions on page
1180.

To store your design for additional analysis, use the DESIGN subcommand. (The DESIGN subcommand replaces
the obsolete subcommands SORDER, PTTYPE, and XMATRIX.).
Design

DEGREE K
Specifies the degree of the design in K. For lattice designs, 1 < K < 10. For extreme vertices designs, 1 < K <
number of components. The default K = 1.
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AUGMENT
Augments (that is, adds points to) the design using axial points. Each axial point is added halfway between a
vertex and the center of the design.

By augmenting a design, you can better understand what occurs on the interior of the design, instead of relying
only on points on the edges.

AXIAL
Augments the design with axial points halfway between each vertex and centroid. The default is no axial points.

CENTER
Augments the design with center points if no center points exist in the design. The default is no center point.

ALLREP K
Replicates all points in the design K times. The default is K = 1.

REPS K, K...K, K

Specifies the number of replicates for design points of the selected type. In each constant pair (K, K), the first K
value indicates the point type (1, 2,..q, 0, 1), and the second K value indicates the number of replicates. The
default is no replicates.

Components

TOTAL K [K...K]

TOTAL C
Specifies the total mixture amount in actual measurements in K or C. The TOTAL argument can be any positive
number, with up to five values for total. The default value is 1. You can also enter the values in a column and use
the column as the argument.

Specifies the mixture design in terms of actual measurements, not proportions. For example, if you measure all
the components of your mixture in liters and the total mixture adds up to 5.2 liters, set TOTAL to 5.2 to generate
the settings for components in the design in terms of liters. Or, suppose you are testing plant food and want to
evaluate plant growth when one gram versus two grams are applied. You would set TOTAL to 1 2.

LOWER K. ..K

LOWER C
Specifies the lower bounds for the q components in K...K, one for each component, or in C.

The first argument is for the first component, the second for the second component, and so on. The default is to
set the lower bound for each component to 0. You may specify any non-negative values for LOWER provided the
sum of all the lower bounds is less than the value of TOTAL. You can also enter the values in a column and use
the column as the argument for LOWER.

When you change the default lower bounds of one component, the achievable upper values on the other
components are also adjusted downward. Specifically, the achievable upper bound (U;) for component i is

Ui =TOTAL - [Ly + Ly + o + Ligy + Liaqy + - + L)

Minitab displays both the specified lower bounds and achievable upper bounds in the output. For example,
suppose you have 3 components, TOTAL = 10, L; = 0, L, = 2 and L3 = 1. Then the achievable upper bounds are
U1 :7,U2=9andU3:8.
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UPPER K. ..K

UPPER C
Specifies upper bounds for the components in K...K or C. Must be a positive value for each component. The default
is 1 for each value if the units are proportions or pseudo-components. The default is the whole amount if the
units are amounts.

PSEUDO and PROPORTIONS
Specifies the scale in which data are represented, including: amounts, proportions, or pseudo-components.
Amounts are what you actually measure. By default, Minitab uses amounts to display and store your data. PSEUDO
specifies that the data is represented by pseudo-components. PROPORTIONS specifies that the data is represented
by proportions.

To get proportions, divide the measurement amounts by the value of TOTAL. When you use PROPORTIONS,
Minitab uses proportions to print and store the design. When you do not specify TOTAL, the amount scale and
the proportion scale are the same.

You generally use pseudo-components when you specify lower bounds. Pseudo-components, in effect, rescale
the constrained data area so that the least allowable amount (the lower bound) of each component is 0, and the
greatest allowable amount of a component is 1. This makes the pseudo-component terms of a constrained design
(that is, a design with lower bounds) the same as the proportional terms of an unconstrained design.

Mathematically, this translates to the following: Let X; be the settings expressed as proportions. Let L; be the lower
bounds expressed as proportions. Let Low = L; + L, + ... + Ly. Then pseudo-component p; = (X; - L) / (1 - Low).

When you use PSEUDO, then Minitab uses pseudo-components to print and store the design. When the design
has no LOWER bounds, pseudo-components and proportions are the same. When you do not use TOTAL or
LOWER, the PSEUDO, PROPORTIONS, and amount scales are the same.

You cannot use both PSEUDO and PROPORTIONS in the same command.

In the following example, 2 components show amounts, proportions, and pseudo-components. Suppose the total
mixture is 50 ml. Let X1 and X2 be the amount scale. Thus X1 + X2 = 50. Suppose X1 has a LOWER bound of 20.
(This means that the UPPER bound of X2 is 50 — 20, or 30.)

SLDESIGN 2;

TOTAL 50;
LOWER 20 O.

The following table shows some points on the three scales.

Amounts Proportions Pseudo-components
X1 X2 X1 X2 X1 X2
50 0 1.0 0.0 1.0 0.0
20 30 0.4 0.6 0.0 1.0
35 15 0.7 0.3 0.5 0.5

Process variables

PROC K1 [K2 [K3]]

Specifies the number of process variables, the factorial design, and the fraction id. The default is no process
variables. The Ks can equal: 1 < K1 <7;K2=1,2,4,8,16; 1 < K3 < K2.

LEVELS K...K

Specifies level values for the process variables in K..K. The default is -1 and +1 for each variable. The number of
Ks equals twice the number of process variables. K can be numeric or text.
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Options

RANDOMIZE [K]
Randomizes the runs in the design matrix. When you use RANDOMIZE, the standard order and the run order are
different and Minitab stores the design in run order.

K'is the base for the random data generator and can take any integer as an argument. To always get the same
ordering of the rows, create the same design and randomize the runs with the same base. For more information,
go to BASE on page 86.

DESIGN
Names and stores the standard order, run order, point type, block assignment, and each factor in separate columns.
Unless you have only 1 empty worksheet in the project, Minitab stores the columns in a new worksheet.

NAMES K K, ..., KK
Specifies names for the mixture components. Enclose names in quotation marks. If you do not use NAMES,
then the names of the components are letters, skipping the letter I: A, B, C...

PNAMES K K, ..., KK
Specifies names for the process variables. Enclose names in quotation marks. If you do not use PNAMES,
then the names of the process variables are the letter X followed by sequential numbers: X1, X2, X3...

STOTAL C
Stores one or more totals in C. The default is no storage. STOTAL is incompatible with DESIGN.

SLOWER C
Stores the lower bounds of the components in C. The default is no storage. SLOWER is incompatible with DESIGN.

SUPPER C
Stores the upper bounds of the components in C. The default is no storage. SUPPER is incompatible with DESIGN.

Results

BRIEF K
Controls the amount of output. You can also use BRIEF as a main command. When you use BRIEF as a main
command, it affects all other commands that use BRIEF to control the amount of output.

Value of K Output that is displayed

0 Minitab displays no output from the command, but performs all specified storage and
displays the following output: error messages, warnings, prompts, and notes.

1 Minitab displays a summary of the design.

2 (default) Same as K = 1 output.

3 Same as K = 2 output, but Minitab also displays the design table.

MIXREG: Session command for analyzing a mixture design

MIXREG C...C = C...C
Analyzes (or fit) Scheffe mixture models, including simplex centroid and simplex lattice designs. You have a choice
of four standard models: linear, quadratic (default), special cubic, special quadratic, full cubic, and full quadratic.
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The main command contains a list of the response variables before the equal sign and a list of the components
after the equal sign. If the design is blocked, give the blocking variable with the BLOCKS subcommand.

You can have up to 25 responses before the equal sign. For information on how Minitab handles missing data,
go to Missing values in factorial, response surface, and mixture designs on page 1171.

To use commands on the Minitab menu that use model information, such as the response optimizer, use the
subcommand DESIGN.

PROC C...C

Specifies the columns that contain process variables. The number of columns must be from 1 to 7. The process
variables must be specified in term list.

AMOUNT C

Specifies the column that contains the mixture amounts. This column should not be specified in MIXREG on
the term list.

INUNIT K
Specifies the unit of the components.

Value of K Unit of the components
0 Pseudo-component units
1 Proportion units
2 Amount units

PSEUDO

Specifies that the analysis is performed in pseudo-components.

Stepwise

Specifies a model selection procedure. STEPWISE, FORWARD, BACKWARD are the three subcommands that correspond
to stepwise, forward, and backward model selection procedures.

You can specify one model selection procedure at a time.

STEPWISE
If you specify STEPWISE, then the FORCE, ENTER, AENTER, AREMOVE, and BEST subcommands are valid.

FORWARD
If you specify FORWARD, then the FORCE, AENTER, and BEST subcommands are valid.

BACKWARD
If you specify BACKWARD, then the FORCE, AREMOVE, and BEST subcommands are valid.

FORCE terms
Specifies the terms to be forced in the model. Main component terms are always present. Terms selected must
be a subset of the model terms given on MIXREG.

ENTER terms

Specifies the terms that are contained in a starting model for stepwise selection procedure. The term entered
here must be one of the model terms specified on MIXREG

Only the STEPWISE subcommand uses ENTER.
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AENTER K

Specifies the alpha level at which a term is entered to the model. K is a constant between 0 and 1 (including 0
and 1). The default value is 0.15 for STEPWISE, and 0.25 for FORWARD.

For stepwise selection, K for AREMOVE must be greater than or equal to K for AENTER. If only AREMOVE is specified
by a user, then AENTER = AREMOVE, vice versa.

AREMOVE K

Specifies the alpha level at which a term is removed from the model. K is a constant between 0 and 1 (including
0 and 1). The default value is 0.15 for STEPWISE, and 0.1 for BACKWARD. The FORWARD subcommand doesn't
use this input.

For stepwise selection, K for AREMOVE must be greater than or equal to K for AENTER. If only AREMOVE is specified
by a user, then AENTER = AREMOVE, vice versa.

BEST K
Specifies the best K alternative terms to show in the output. K is an integer from 1 to 10.

If BEST K is not entered, no alternative term will appear in the output. The default is no alternative term.

Terms

LOWER K. ..K

If you do not use LOWER, the lower bound of each component is the minimum value in the column of the
component. Specify as many bounds as you specify components. Specify 0 for components that do not have
lower bounds.

BLOCKS C

Specifies a blocking variable column when you specify your model explicitly on MIXREG. That is, you are not using
a model that you have stored with another command. The blocking variable column can be numeric or text, and
can contain any value. The levels do not need to be in any special order. When the blocking column is numeric,
the smallest value is block 1, the second smallest value is block 2, and so on.

Prediction

PREDICT E...E

Computes the fitted response values for given values of the components. PREDICT displays a table that contains
the fitted Ys, standard errors of the fitted Ys, a 95% confidence interval, and a 95% prediction interval. E...E can
be a list of constants or a list of columns, or a mixture of constants and columns. Component columns or constants
should be listed first, followed by process variables, if specified, and the amount variable, if specified.

PBLOCK E
Specifies the block of new design points if blocks are included in your design.

CONFIDENCE K

Specifies a confidence level. For example, for a 90% confidence level, enter CONFIDENCE 90. The default value
of K'is 95.

PSFITS C
Stores the fits in C.
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PSEFIT C
Stores the estimated standard errors of the fits in C.

CLIMITS C...C
Stores the lower and upper confidence limits in C...C.

PLIMITS C...C
Stores the lower and upper prediction limits in C...C.

Graphs

RTYPE K
Specifies the type of residual to plot with the graph subcommands.

Value of K Type of residuals

1 (default) Regular or raw residuals (RESIDUALS)

2 Standardized residuals (SRESIDUALS)

3 Deleted Studentized residuals (TRESIDUALS)
GHISTOGRAM

Displays a histogram of the residuals.

GNORMAL
Displays a normal probability plot of the residuals.

GFITS
Plots the residuals versus the fitted values.

GORDER [C]
Plots the residuals versus the order of the data, or versus the order specified in C. The row number for each data
point is shown on the x-axis (for example, 12 3 4...n).

GFOURPACK [C]
Displays four residual plots—a histogram of the residuals, a normal probability plot of the residuals, the residuals
versus fitted the values, and the residuals versus the order of the data, or versus the order specified in C—in one

graph.

GVARIABLE C...C
Plots the residuals versus variables. Displays a separate graph for the residuals versus each specified column.

Results

TOLERANCE K
Specifies the tolerance level for collinearity and constant check. By default, K = 4 * 2.22e-016

BRIEF K
Controls the amount of output. You can also use BRIEF as a main command. When you use BRIEF as a main
command, it affects all other commands that use BRIEF to control the amount of output.
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Value of K Output that is displayed

0 Minitab displays no output, but performs all specified storage.

1 Minitab displays the table of coefficients, s, R-sq, R-sq(ad]), the analysis of variance table,

the unusual values in the table of fits and residuals.

2 (default) Same as K = 1 output.

3 Same as K = 2 output, but also displays the full table of fits and residuals.
ORDER C

Specifies the row order of the table of fits and residuals that is displayed in the output. Specify the StdOrder

column in C.
Storage
FITS C...C

Stores the fitted values in C...C.

RESIDUALS C...C
Stores the residuals (response - fit) in C...C.

SRESIDUALS C...C
Stores the standardized residuals in C...C.

TRESIDUALS C...C
Stores the deleted Studentized residuals in C...C.

COEFFICIENTS C...C

Stores the coefficients, using one column for each response. These are the same coefficients that are displayed
in the output. If MIXREG removes some terms because the data cannot support them, then the removed terms
do not appear on the output.

MODEL C...C
Requests storage of model term codes. The number of columns matches the number of responses in C...C.

XMATRIX M

Stores the design matrix. If the design was blocked into k blocks, then there are (k — 1) columns for block dummy
variables. MIXREG uses the same method of coding blocks as GLM. The block dummy variables are followed by
one column for each component. When the model has 2-way interactions, the design matrix contains a column
for each interaction. The column for a 2-way interaction is the product of the corresponding two components.
When the model has 3-way interactions, the design matrix contains a column for each interaction. The column
for a 3-way interaction is the product of the corresponding three components. When the model has additional
terms for a full cubic, then the design matrix contains one column for each additional term. For example, the
column for a term such as X1 * X3 * (X1 - X3), with X1 in C1 and X3 in C3, is calculated using the equation C1 *
C3*(C1-C3).

Because MIXREG allows no constant in the model, the design matrix does not contain a column of 1s.
When MIXREG removes terms because the data cannot support them, the design matrix does not contain the

removed terms. The columns of the stored matrix match the coefficients that are displayed and/or stored.

HI C
Stores the leverage values.
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COOKD C...C
Stores Cook's distance values, using one column for each response.

DFITS C...C
Stores the DFITS (also called DFFITS), using one column for each response.

DESIGN

Stores model information to enable items on the menu that use the model, such as the response optimizer. To
use session commands to run the analyses that use the model, store the model information in a column with
MODEL.

OPTDES: Session command for selecting an optimal design

OPTDES K [C...C]

Select an optimal design by specifying the number of final design points in K and optionally, specifying candidate
design columns in C...C.

The purpose of an optimal design is to select design points according to some criteria. Minitab's optimal design
capabilities can be used with response surface designs and mixture designs. You can use Select Optimal Design
to do the following:

e Select an optimal set of design points.
e Augment (add points to) an existing design.
¢ Improve the D-optimality of an existing design.

e Evaluate and compare designs.

OPTDES has the following forms:

e OPTDES K: Specifies the number of final design points to select based on D-optimality. For this command
form either a factorial model, mixture model, or response surface model must be specified by subcommands
FACMODEL, MIXMODEL, or RESMODEL. The constant K must be a positive integer or 0. If K = zero, you must
use either the AUGMENT or EVALUATE subcommand.

e OPTDESK, C...C: Specifies the number of final design points and the design columns that contain the candidate
set. Constant K must be a positive integer. You must specify at least 2 design columns. All columns must have
the same length and must be numeric. With this form of the main command you cannot have the following
subcommands: FACMODEL, RESMODEL, MIXMODEL, EVALUATE, BLOCK, GENERATE, EXCHANGE, FEDOROQYV,
SEQUENTIAL.

Note The subcommands DESIGN and COPY replace the obsolete subcommands XMATRIX and CARRY.

FACMODEL terms

Species the terms of a factorial model used in selecting D-optimal design. The legal term list is the same as
in GLM.

FACMODEL, RESMODEL, and MIXMODEL are mutually exclusive and one of them must be the first
subcommand.

MIXMODEL terms

Specifies the terms of a mixture model used in selecting D-optimal design. The legal term list is the same as
in MIXREG.

FACMODEL, RESMODEL, and MIXMODEL are mutually exclusive and one of them must be the first
subcommand.
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RESMODEL terms

Specifies the terms of a response surface model used in selecting D-optimal design. The legal term list is the
same as in RSREG. When you use RESMODEL, also use INUNIT and LEVELS.

FACMODEL, RESMODEL, and MIXMODEL are mutually exclusive and one of them must be the first

subcommand.

INUNIT
Specifies whether the design is in coded form or uncoded form.

Value of K Form of design

0 Coded

1 Uncoded
LEVELS K K, ..., KK

Specifies uncoded levels for all continuous factors K K, .., K K. Enter the low level, then the high level,
for each continuous factor that follows RESMODEL. List the pairs of levels in the order of the factors that
follow RESMODEL.

AUGMENT C
Augments or improves an existing design indicated by row flags in C. Column C must be numeric and must
contain integers. The column length must match the length of the design columns.

Cannot be specified together with EVALUATE, GENERATE, or SEQUENTIAL.

EVALUATE C

Evaluates an existing design indicated by row flags in C. Column C must be numeric and must contain
non-negative integers. The column length must match the length of the design columns.

Cannot be specified with OPTDES K C...C, AUGMENT, EXCHANGE, FEDOROV, SEQUENTIAL, GENERATE,
INDICATOR.

BLOCK C
Specifies the blocking column. The column can be alpha or numeric with 2-64 distinct values. Column length
must match the length of the design columns. Must not be on the term list.

Cannot be specified with OPTDES K C...C.

PROCESS C...C
Specifies process variable columns. Columns must be either on the main line if OPTDES K C...C or on the term
list. Columns may be alpha or numeric with exactly 2 levels. With OPTDES K C...C, only numerical process
variable columns are allowed. The number of columns must be between 1 and 7. Column lengths must match
the length of design columns.

Cannot be specified with AMOUNT or with factorial or response surface models.

AMOUNT C
Specifies the mixture amount column. Column must be either on the main line if OPTDES K C...C or on the
term list. The column must be numeric with 2-5 distinct numerical values. The column length must match
the length of the design columns.

Cannot be specified with PROCESS or with factorial or response surface models.
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PSEUDO

Specifies that calculations are performed using pseudo-components. PSEUDO is ignored in cases of factorial
or response surface designs.

GENERATE K [K [K]]

Generates K % of initial points randomly, and adds the rest of points by sequential method. The second K is
the number of random trials. The third K is the base for the random data generator. Legal values are as
follows: first and second K integer, third K any positive real. 0 < first K <=100, 1 <= second K <= 25.

Cannot be specified with OPTDES K C...C, AUGMENT, EVALUATE, SEQUENT.

SEQUENTIAL
Selects design points by the sequential algorithm for the initial design.

Cannot be specified with OPTDES K C...C, AUGMENT, EVALUATE, GENERATE.

EXCHANGE K

Improves the initial design matrix by adding and dropping K design points one at a time. Legal values are
as follows: K'is an integer, 1 <= K <= 5.

Cannot be specified with OPTDES K C...C, EVALUATE, FEDOROV.

FEDOROV
Improves the initial design matrix using Fedorov's algorithm.

Cannot be specified with OPTDES K C...C, EVALUATE, EXCHANGE.

INDICATOR C
Stores selection indicators in the specified column.

Cannot be specified with EVALUATE.

DESIGN

Copies the standard order, run order, point type, blocks, and factors to a new worksheet for rows in the
optimal design.

COPY C...C

Copies rows in the optimal design to the new worksheet for columns that are not part of the design.
For example, you can use COPY to copy a column of covariate measurements.

BRIEF K
Controls the amount of output with a value in K.

Value of K Output that is displayed

0 Minitab displays no output, but performs all specified storage.

1 Minitab displays a summary table for the final design only.

2 (default) Minitab displays summary tables for the intermediate design and the final design.
3 Displays summary tables and the final design matrix.
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DETZERO [K]
Overrides the lower limit for the determinant, which is E-30. Use when you receive the "rank deficient data"
error message, but still want to perform the analysis. K is an integer that is greater than or equal to 30. The
default value is 30.

Plot Mixture Designs

SIMPLEX: Session command for creating a simplex design plot

SIMPLEX C...C
Creates a simplex design plot to visualize the mixture design space (or a slice of the design space, if you have
more than three components). Minitab plots the design points on triangular axes. You can plot components,
components and process variables, or components and an amount variable.

For information about graphics options for SIMPLEX, go to Graphics options for SIMPLEX on page 1154.

SINGLE C C C
Specifies three components for a single plot in C C C. Specified columns must be on the main command list.

ALLTRIPLETS
Requests multiple plots to show all component triplets (for only 3-5 components).

PANEL
Displays plots in one graph.

SEPARATE
Displays each graph in a separate graph.

TOTAL K [K...K]

TOTAL C

Specifies single or multiple total values. A single K must equal the common row sum of components. Multiple
Ks are accepted only if the Amount column is specified. The total subcommand must be specified if the
Amount column'’s specified either with a single K = 1 or with multiple K values that match the values in the
Amount column.

LOWER K. ..K

LOWER C

Specifies the lower bound of the components. The number of Ks must equal the number of components. All
Ks must be 0 <= K < TOTAL and SUM(K) < TOTAL. (TOTAL is the first value on Total.)

UPPER K. ..K

UPPER C

Specifies the upper bound of the components in K...K. The number of Ks must equal the number of
components. All Ks must be 0 < K <= TOTAL and SUM(K) > TOTAL. (TOTAL is the first value on Total.) Each
upper bound must be greater than the corresponding lower bound.
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CLINEAR K...K

CLINEAR C

Specifies the linear constraints on the components. The number of Ks must equal the number of components
+ 2. The first K, the lower bound, must be less than the last K, the upper bound. If one of the bounds is
missing, set it to the missing value ' * . You can use up to 10 CLINEAR subcommands.

PROPORTION
Specifies the proportion unit for the axes on the plot.

PSEUDO
Specifies the pseudo-component unit for the axes on the plot.

PROCESS C...C

Specifies process variable columns in C...C. The length of the columns must match component columns.
Columns may be numeric or alpha and must contain 2 levels. The maximum number of process variables is
7.

AMOUNT C

Specifies the mixture amount column in C. The length of the column must match the component columns.
The column must be numeric and must contain 2-5 distinct positive values. Must have a Total subcommand
with either K = 1, or multiple Ks must match the values in C.

LABEL [C]
Specifies the labels of the design points in C. If you omit C, then label points by number of replicates. The
length of the column must match component columns.

CLOW, CMIDDLE, and CHIGH

Sets the values of all the components that are not on the plot. Only design points that match these values
are plotted. By default, all components that are not on the plot are held at their lower bound. These commands
are not available for the process variable contour plot.

Command Bound or level
cLow Lowest bound
CMIDDLE Middle level
CHIGH Upper bound

CHOLD K...K

Holds components that are not on the plot to values that you specify in K...K. Each K must be between the
lower and upper bounds (inclusive) of the corresponding component. Only design points that match these
values are plotted. By default, all components that are not on the plot are held at their lower bound.

FLOW, FMIDDLE, and FHIGH
Sets the level of all the process variables that are not on plot. By default, all process variables are held at —1.

Command Level

FLOW Low level (-1)
FMIDDLE Middle level (0)
FHIGH High level (1)
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FHOLD K...K

FHOILD C
Holds process variables to values that you specify. Sets the levels of process variables at a combination of
-1 and 1. K must equal the number of process variables in the model. Only design points that match these
values are plotted. By default, all process variables are held at —1.

AHOLD K
Sets the mixture amount at the specified value in K. Only design points that match these values are plotted.
By default, the amount value is held at the first value in the Amount column.

CMIN K...K

CMIN C
Specifies the minimum axis values for all components, including those that are not on the plot. The number
of constants and the length of the column must match the number of components.

FMIN K...K

FMIN C
Specifies the minimum axis values for all process variables, including those that are not on the plot. The
number of constants or the length of the column must match the number of process variables.

FMAX K...K

FMAX C
Specifies the maximum axis values for all process variables, including those that are not on the plot. The
number of constants or the length of the column must match the number of process variables.

SGRID [K]
Displays grid lines at 0.1 intervals or at intervals specified in K.

SPSIMP: Session command for creating a simplex design plot

SPSIMP C...C
Creates three types of special simplex design plots:

e Simplex plot with four components

e Simplex plot with process variables

Simplex plot with amount variable

C...C must include all components in the design matrix.

Enables you to visualize the mixture design space (or a slice of the design space if you have more than three
components). Minitab plots the design points on triangular axes. You can plot components, components and
process variables, or components and an amount variable.

For information on graphics options for SPSIMP, go to Graphics options for SPSIMP on page 1157.

TYPE K
Determines which of the three simplex plots is created in K.

Value of K Plot that is created When to use

1 Four component matrix plot The model contains at least four components.
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Value of K Plot that is created When to use
2 Contour plot with process variables The model contains process variables.
3 Contour plot with mixture amounts The amount variable is specified in the model.

SINGLE C C C [C]
Specifies components in C C C [C] on the three or four axes of a single plot.

Three components must be specified if the plot type is 2 or 3. Four components must be specified if the plot
type is 1. Columns must be listed in the main command. If this command isn't specified, then Minitab uses
the first 3 or 4 components listed in SPSIMP according to the type of plot that you specify in TYPE.

ALLTRIPLETS
Displays multiple plots to show all component triplets (only for 3-5 components).

PANEL
Displays the plots in one graph.

SEPARATE
Displays the plots in separate graphs.

TOTAL K [K...K]

TOTAL C

Specifies 1 to 5 total values. Single K must equal the common row sum of components. Multiple Ks are
accepted only if Amount column specified. The total subcommand must be specified if the Amount columns
specified either with a single K = 1 or with multiple K values matching the values in column Amount.

LOWER K...K

LOWER C

Specifies the lower bound of the components. The number of Ks must equal the number of components. All
Ks must be 0 <= K < TOTAL and SUM(K) < TOTAL. (TOTAL is the first value on Total.)

UPPER K. . .K

UPPER C

Specifies the upper bound of the components in K...K. The number of Ks must equal the number of
components. All Ks must be 0 < K <= TOTAL and SUM(K) > TOTAL. (TOTAL is the first value on Total.) Each
upper bound must be greater than the corresponding lower bound.

CLINEAR K...K

CLINEAR C

Specifies the linear constraints on the components. The number of Ks must equal the number of components
+ 2. The first K, the lower bound, must be less than the last K, the upper bound. If one of the bounds is
missing, set it to the missing value ' * '. You can use up to 10 CLINEAR subcommands.

PROPORTION
Specifies the proportion unit for the axes on the plot.

PSEUDO
Specifies the pseudo-component unit for the axes on the plot.
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PROCESS C...C

Specifies that the process variables are in C...C. The length of the columns must match component columns.
Columns can be numeric or text and must contain 2 levels. The maximum number of process variables is 7.

AMOUNT C
Specifies the mixture amount in C. The length of the column must match the component columns. The column
must be numeric, and contain 2-5 distinct positive values. Must have Total subcommand with either K = 1,
or multiple Ks must match values in C.

LABEL [C]
Specifies labels for design points are in C. If you omit C, then you should label the points by the number of
replicates. The length of the column must match the component columns.

CLOW, CMIDDLE, and CHIGH

Sets the values of all the components that are not on the plot. Only design points that match these values
are plotted. By default, all components that are not on the plot are held at their lower bound. These commands
are not available for the process variable contour plot.

Command Bound or level
cLow Lowest bound
CMIDDLE Middle level
CHIGH Upper bound

CHOLD K...K

CHOLD C

Holds components that are not on the plot to values specified in K...K or C. The number of constants or the
length of the column must match the number of components. Each K must be between the lower and upper
bounds (inclusive) of the corresponding component. Only design points that match these values are plotted.
By default, all components that are not on the plot are held at their lower bound.

CMIN K...K

CMIN C

Specifies the minimum axis values for all components, including those that are not on the plot. The number
of constants and the length of the column must match the number of components.

FLOW, FMIDDLE, and FHIGH
Sets the level of all the process variables that are not on plot. By default, all process variables are held at —1.

Command Level

FLOW Low level (-1)
FMIDDLE Middle level (0)
FHIGH High level (1)

FHOLD K...K

FHOLD C

Holds process variables to values that you specify. Sets the levels of process variables at a combination of
-1 and 1. K must equal the number of process variables in the model. Only design points that match these
values are plotted. By default, all process variables are held at —1.
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FMIN K...K

FMIN C
Specifies the minimum axis values for all process variables, including those that are not on the plot. The
number of constants or the length of the column must match the number of process variables.

FMAX K...K

FMAX C
Specifies the maximum axis values for all process variables, including those that are not on the plot. The
number of constants or the length of the column must match the number of process variables.

AHOLD K
Sets the mixture amount at the specified value in K. Only design points that match these values are plotted.
By default, the amount value is held at the first value in the Amount column.

SGRID [K]
Displays grid lines at 0.2 intervals or at intervals specified in K. All K must be 0 < K < 1. The defaultis K = 0.2.

%SIMPROC: Session command for creating a simplex plot

$SIMPROC C...C
Creates a simplex plot of components in C...C. %SIMPROC is used for certain simplex plots when all level
combinations are plotted and there are process variables in the model. A simplex plot helps you visualize the
mixture design space. Minitab plots the design points on triangular axes.

SINGLE C C C
Specifies the three components on the three axes in C C C. Columns must be listed in main command.

TOTAL K
Specifies one total value in K. K must equal the common row sum of components.

LOWER K. ..K
Specifies the lower bound of components in K...K. The number of Ks must equal the number of components.
All Ks must be 0 <= K < TOTAL and SUM(K) < TOTAL.

UPPER K. ..K
Specifies the upper bound of components in K...K. The number of K's equals the number of components. All
Ks must be 0 < K <= TOTAL and SUM(K) > TOTAL.

INl1 K...K, ILN2 K...K, ... LN10 K...K
Specifies the linear constraints in K...K. The first linear constraint is in LN1, the second linear constraint is in
LN2, and so on. You can have a maximum of 10 linear constraints.

Each subcommand specifies a linear constraint on components in mixture models. The first K represents the
lower bound of a linear combination of the components, and the last K the upper bound of the linear
combination. The Ks in between represent the coefficients of the components.

For example, let A, B, and C be three components in a mixture design. A linear constraint on A, B, and C is
represented by:

0.5 <=3A+2B+C<=0.9

Then, the LN1 subcommand is specified as:
ILN1 0.5 3 2 1 0.9.
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PSEUDO
Specifies the pseudo-component unit for the axes on the plot.

PROPORTION
Specifies the proportion unit for the axes on the plot.

PROCESS C C C

Specifies process variable columns in C C C. The length of the columns must match component columns.
Columns may be numeric or text and must contain 2 levels. The number of process variables must equal 3.

CHOLD K. ..K
Specifies the hold values in K...K for components that are not on plot. Each K must be between the lower and
upper bounds (inclusive) of the corresponding component. Only design points that match these values are
plotted.

CMIN K...K
Specifies the minimum axis values of all components, including those not on the plot, in K...K. Values may
be in constants. The number of constants must match the number of components.

SGRID K
Specifies that grid lines are drawn on each axis at intervals specified in K.

TITLE "title"
Specifies a title for the graph. If you do not specify a title, Minitab uses a default title.

TRACE: Session command for creating a response trace plot

TRACE C C
Displays a response trace plot for the response in the first C and the model column in the second C, which is
stored using MIXREG and contains the model information.

A response trace plot (also called component effects plot) shows the effect of each component on the response.
Several response traces, which are a series of predictions from the fitted model, are plotted along a component
direction. The trace curves show the effect of changing the corresponding component along an imaginary line
(direction) connecting the reference blend to the vertex.

Each component in the mixture has a corresponding trace direction. The points along a trace direction of a
component are connected thereby producing as many curves as there are components in the mixture.

Specify a single response column, and the column where the model is stored. The model column contains the
number and ID of components, number and ID of process variables, ID of blocking column, ID of mixture amount
column, term codes and coefficients. The response column length must match the length of component columns.

TOTAL K [K...K]

TOTAL C
Specifies the total amount in K, or in C, from 1-5 values.

LOWER K. ..K

LOWER C
Specifies the lower bound of the components. The column must be numeric.

The number of values equals the number of components specified in the model column.
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All values must be 0 <= K < TOTAL and SUM(K) < TOTAL (TOTAL is row sum of components).

UPPER K. ..K

UPPER C
Specifies the upper bound of the components. The column must be numeric.

The number of values equals the number of components specified in the model column.

All values must be 0 < K <= TOTAL and SUM(K) > TOTAL (TOTAL is row sum of comps).

CLINEAR K...K

CLINEAR C

Specifies a linear constraint on the components. There can be up to 10 such subcommands. The column
must be numeric.

The number of values equals the number of components + 2. The first value, the lower bound, must be
smaller than last value, the upper bound. One of the bounds might be missing, i.e., setto ' *".

Note You can also use LINEAR to specify a linear constraint on the components.

PIEPEL
Specifies the plot uses Piepel directions.

REFERENCE K

REFERENCE K. ..K

Specifies the row ID of the reference blend or the coordinates of the reference blend. If you do not specify
XREFERENCE, then the default is to use the centroid of vertices.

XREFERENCE K specifies row id of the reference blend; 0 < K <= number of design points (length of design
columns).

XREFERENCE K...K specifies coordinates of the reference blend. The number of Ks equals the number of
components. Each K must be between the corresponding lower and upper bounds.

FLOW, FMIDDLE, and FHIGH
Sets the level of all the process variables that are not on plot. By default, all process variables are held at —1.

Command Level

FLOW Low level (-1)
FMIDDLE Middle level (0)
FHIGH High level (1)

FHOLD K...K
Sets process variable levels to specified values.

The number of Ks must equal the number of process variables. Constants must be between -1 and 1.

AHOLD K

Sets mixture amount to a specified value. The specified value must be between min and max of IPAMNT
column.
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MAXIMUM K K

Specifies the maximum value of an axis. The first K specifies the x- (use 1) or y- (use 2) axis and the second
K specifies the maximum value. You can also use MAX to specify the maximum value of an axis.

MINIMUM K K

Specifies the minimum value of an axis. The first K specifies the x- (use 1) or y- (use 2) axis and the second
K specifies the minimum value. You can also use MIN to specify the minimum value of an axis.

CURVE
Specifies different type and color for trace curves.

TYPE K. ..K
Use TYPE to specify the line type of trace curves. The default is solid lines.

COLOR K. ..K
Use COLOR to specify the line color of trace curves. The default is different colors.

TITLE "title"
Specifies a title for the graph. If you do not specify a title, Minitab uses a default title.

MIXCONTOUR: Session command for creating a contour plot

MIXCONTOUR C C

Displays a contour plot for the response in the first C and the model column in the second C, which is stored
using MIXREG and contains the model information.

The model column contains the number and the ID of the components, the number and the ID of the process
variables, the ID of the blocking column, the ID of the mixture amount column, the term codes, and the coefficients.
The response column and the component columns must have the same number of rows.

For more information about graphics options for MIXCONTOUR, go to Graphics options for MIXCONTOUR on
page 1148.

SINGLE C C [C]
Specifies three components in C C C or two numerical process variables in C C for a single plot. You must
specify the components or process variables that are on the list in the model column.

ALLTRIPLETS
Specifies that multiple plots show all component triplets (only for 3-5 components).

PANEL
Displays all the plots in one graph.

SEPARATE
Displays each plot on a separate page.

ALLPAIRS
Specifies that multiple plots show all pairs of numerical process variables.

PANEL
Displays all the plots in one graph.

SEPARATE
Displays each plot on a separate page.
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NLEVELS K
Specifies the number of contour levels in K. K must be 2-15.

LEVELS K...K
Specifies the values of contour levels in K. K must be 2-15.

NMESH K K
Specifies number of mesh points. The first constant specifies the direction for the number of mesh points:

e 1 = Horizontal

e 2 = Vertical

To specify both directions, issue NMESH twice.
The second constant specifies the number of mesh points. The second K must be 2-101.

TOTAL K [K...K]

TOTAL C
Specifies single or multiple total values. A single K must equal the common row sum of components. Multiple
Ks are accepted only if the Amount column is specified. The total subcommand must be specified if the
Amount column'’s specified either with a single K = 1 or with multiple K values that match the values in the
Amount column.

LOWER K. ..K

LOWER C

Specifies the lower bound of the components. The number of Ks must equal the number of components. All
Ks must be 0 <= K < TOTAL and SUM(K) < TOTAL. (TOTAL is the first value on Total.)

UPPER K. . .K

UPPER C

Specifies the upper bound of the components in K...K. The number of Ks must equal the number of
components. All Ks must be 0 < K <= TOTAL and SUM(K) > TOTAL. (TOTAL is the first value on Total.) Each
upper bound must be greater than the corresponding lower bound.

CLINEAR K...K

CLINEAR C

Specifies the linear constraints on the components. The number of Ks must equal the number of components
+ 2. The first K, the lower bound, must be less than the last K, the upper bound. If one of the bounds is
missing, set it to the missing value ' * '. You can use up to 10 CLINEAR subcommands.

PROPORTION
Specifies the proportion unit for the axes on the plot.

PSEUDO
Specifies the pseudo-component unit for the axes on the plot.

CLOW, CMIDDLE, and CHIGH
Sets the values of all the components that are not on the plot. Only design points that match these values
are plotted. By default, all components that are not on the plot are held at their lower bound. These commands
are not available for the process variable contour plot.
Command Bound or level

CLOW Lowest bound
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Command Bound or level
CMIDDLE Middle level
CHIGH Upper bound

CHOLD K...K

Holds components that are not on the plot to values that you specify in K...K. Each K must be between the
lower and upper bounds (inclusive) of the corresponding component. Only design points that match these
values are plotted. By default, all components that are not on the plot are held at their lower bound.

CMIN K...K

CMIN C

Specifies the minimum axis values for all components, including those that are not on the plot. The number
of constants and the length of the column must match the number of components.

FLOW, FMIDDLE, and FHIGH
Sets the level of all the process variables that are not on plot. By default, all process variables are held at -1.

Command Level

FLOW Low level (-1)
FMIDDLE Middle level (0)
FHIGH High level (1)

FHOLD K...K

FHOLD C

Holds process variables to values that you specify. Sets the levels of process variables at a combination of
-1 and 1. K must equal the number of process variables in the model. Only design points that match these
values are plotted. By default, all process variables are held at —1.

FMIN K. ..K

FMIN C

Specifies the minimum axis values for all process variables, including those that are not on the plot. The
number of constants or the length of the column must match the number of process variables.

FMAX K...K

FMAX C

Specifies the maximum axis values for all process variables, including those that are not on the plot. The
number of constants or the length of the column must match the number of process variables.

AHOLD K

Sets the mixture amount at the specified value in K. Only design points that match these values are plotted.
By default, the amount value is held at the first value in the Amount column.

SGRID [K]
Displays grid lines on each axis at intervals specified in K. All K must be 0 < K < 1. The default is K = 0.1.
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SPCONT: Session command for creating a contour design plot

SPCONT C C
Creates three types of special contour design plots:

e Contour plot with four components
e Contour plot with process variables

e Contour plot with an amount variable

The first C is the response, and the second C contains the model information.

Enables you to visualize the mixture design space (or a slice of the design space if you have more than three
components). Minitab plots the design points on triangular axes. You can plot components, components and
process variables, or components and an amount variable.

For information on graphics options that are available for SPCONT, go to Graphics options for SPCONT on page
1155.

TYPE K
Determines which of the three simplex plots is created in K.

Value of K Plot that is created When to use the plot

1 Four component matrix plot The model contains at least four components.
2 Contour plot with process variables The model contains process variables.

3 Contour plot with mixture amounts The amount variable is specified in the model.

SINGLE C C C [C]
Specifies components in C C C [C] on the three or four axes of a single plot.

Three components must be specified if plot type is 2 or 3. Four components must be specified if plot type
is 1. Columns must be listed in the model column. If this command isn't specified, Minitab uses the first 3 or
4 components listed in SPCONT according to the type of plot you specified in TYPE.

ALLTRIPLETS
Displays multiple plots to show all component triplets (only for 3-5 components).

PANEL
Displays the plots in one graph.

SEPARATE
Displays the plots in separate graphs.

NLEVELS K
Specifies the number of contour levels. K must be between 2 and 15.

LEVELS K...K
Specifies the values of contour levels in K...K. K must be between 2 and 15.

TOTAL K [K...K]

TOTAL C

Specifies single or multiple total values. A single K must equal the common row sum of components. Multiple
Ks are accepted only if the Amount column is specified. The total subcommand must be specified if the
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Amount column's specified either with a single K = 1 or with multiple K values that match the values in the
Amount column.

LOWER K. ..K

LOWER C

Specifies the lower bound of the components. The number of Ks must equal the number of components. All
Ks must be 0 <= K < TOTAL and SUM(K) < TOTAL. (TOTAL is the first value on Total.)

UPPER K. ..K

UPPER C

Specifies the upper bound of the components in K...K. The number of Ks must equal the number of
components. All Ks must be 0 < K <= TOTAL and SUM(K) > TOTAL. (TOTAL is the first value on Total.) Each
upper bound must be greater than the corresponding lower bound.

CLINEAR K...K

CLINEAR C

Specifies the linear constraints on the components. The number of Ks must equal the number of components
+ 2. The first K, the lower bound, must be less than the last K, the upper bound. If one of the bounds is
missing, set it to the missing value ' * . You can use up to 10 CLINEAR subcommands.

PROPORTION
Specifies the proportion unit for the axes on the plot.

PSEUDO
Specifies the pseudo-component unit for the axes on the plot.

PROCESS C...C

Specifies that the process variables are in C...C. The length of the columns must match component columns.
Columns can be numeric or alpha and must contain 2 levels. The maximum number of process variables is
7.

AMOUNT C

Specifies the mixture amount in C. The length of the column must match the component columns. The column
must be numeric, and contain 2-5 distinct positive values. Must have Total subcommand with either K = 1,
or multiple Ks must match values in C.

LABEL [C]
Specifies labels for design points are in C. If you omit C, then you should label the points by the number of
replicates. The length of the column must match the component columns.

CLOW, CMIDDLE, and CHIGH

Sets the values of all the components that are not on the plot. Only design points that match these values
are plotted. By default, all components that are not on the plot are held at their lower bound. These commands
are not available for the process variable contour plot.

Command Bound or level
cLow Lowest bound
CMIDDLE Middle level
CHIGH Upper bound
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CHOLD K...K

CHOLD C

Holds components that are not on the plot to values specified in K...K or C. The number of constants or the
length of the column must match the number of components. Each K must be between the lower and upper
bounds (inclusive) of the corresponding component. Only design points that match these values are plotted.
By default, all components that are not on the plot are held at their lower bound.

CMIN K...K

CMIN C

Specifies the minimum axis values for all components, including those that are not on the plot. The number
of constants and the length of the column must match the number of components.

FLOW, FMIDDLE, and FHIGH
Sets the level of all the process variables that are not on plot. By default, all process variables are held at -1.

Command Level

FLOW Low level (-1)
FMIDDLE Middle level (0)
FHIGH High level (1)

FHOLD K...K

FHOLD C

Holds process variables to values that you specify. Sets the levels of process variables at a combination of
-1 and 1. K must equal the number of process variables in the model. Only design points that match these
values are plotted. By default, all process variables are held at —1.

FMIN K. ..K

FMIN C

Specifies the minimum axis values for all process variables, including those that are not on the plot. The
number of constants or the length of the column must match the number of process variables.

FMAX K. ..K

FMAX C
Specifies the maximum axis values for all process variables, including those that are not on the plot. The
number of constants or the length of the column must match the number of process variables.

AHOLD K

Sets the mixture amount at the specified value in K. Only design points that match these values are plotted.
By default, the amount value is held at the first value in the Amount column.

SGRID [K]
Displays grid lines at 0.2 intervals or at intervals specified in K. All K must be 0 < K < 1. The default is K = 0.2.

TITLE "title"”
Specifies a title for the graph. If you do not specify a title, Minitab uses a default title.
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MIXSURFACE: Session command for creating a surface plot

MIXSURFACE C C
Displays surface plot for response in C and the model column in C, which is stored using MIXREG and contains
the model information.

Specifies a single response column and the column where the model is stored. The model column contains the
number and ID of components, number and ID of process variables, ID of blocking column, ID of mixture amount
column, term codes, and coefficients. The length of the response column must match that of component columns.

For information graphics options for MIXSURFACE, go to Graphics options for MIXSURFACE on page 1150.

SINGLE C C [C]
Specifies three components in CCC or two numerical process variables in C C for a single plot. The components
or process variables must be specified on the list in the model column.

ALLTRIPLETS
Displays multiple plots to show all component triplets (only for 3-5 components).

PANEL
Displays plots in one graph.

SEPARATE
Displays each graph on a separate page.

ALLPAIRS
Displays multiple plots to show all numerical process variable pairs.

PANEL
Displays plots in one graph.

SEPARATE
Displays each graph on a separate page.

NMESH K K
Specifies number of mesh points. The first constant specifies the direction for the number of mesh points:
e 1 = Horizontal

e 2 = Vertical

To specify both directions, issue NMESH twice.
The second constant specifies the number of mesh points. The second K must be from 2 to 101.

TOTAL K [K...K]

TOTAL C
Specifies single or multiple total values. A single K must equal the common row sum of components. Multiple
Ks are accepted only if the Amount column is specified. The total subcommand must be specified if the
Amount column'’s specified either with a single K = 1 or with multiple K values that match the values in the
Amount column.

LOWER K. ..K

LOWER C

Specifies the lower bound of the components. The number of Ks must equal the number of components. All
Ks must be 0 <= K < TOTAL and SUM(K) < TOTAL. (TOTAL is the first value on Total.)
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UPPER K. . .K

UPPER C

Specifies the upper bound of the components in K...K. The number of Ks must equal the number of
components. All Ks must be 0 < K <= TOTAL and SUM(K) > TOTAL. (TOTAL is the first value on Total.) Each
upper bound must be greater than the corresponding lower bound.

CLINEAR K...K

CLINEAR C

Specifies the linear constraints on the components. The number of Ks must equal the number of components
+ 2. The first K, the lower bound, must be less than the last K, the upper bound. If one of the bounds is
missing, set it to the missing value ' * '. You can use up to 10 CLINEAR subcommands.

PROPORTION
Specifies the proportion unit for the axes on the plot.

PSEUDO
Specifies the pseudo-component unit for the axes on the plot.

CLOW, CMIDDLE, and CHIGH

Sets the values of all the components that are not on the plot. Only design points that match these values
are plotted. By default, all components that are not on the plot are held at their lower bound. These commands
are not available for the process variable contour plot.

Command Bound or level
CLOW Lowest bound
CMIDDLE Middle level
CHIGH Upper bound

CHOLD K...K

Holds components that are not on the plot to values that you specify in K...K. Each K must be between the
lower and upper bounds (inclusive) of the corresponding component. Only design points that match these
values are plotted. By default, all components that are not on the plot are held at their lower bound.

CMIN K...K

CMIN C

Specifies the minimum axis values for all components, including those that are not on the plot. The number
of constants and the length of the column must match the number of components.

FLOW, FMIDDLE, and FHIGH
Sets the level of all the process variables that are not on plot. By default, all process variables are held at —1.

Command Level

FLOW Low level (-1)
FMIDDLE Middle level (0)
FHIGH High level (1)
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FHOLD K...K

FHOLD C

Holds process variables to values that you specify. Sets the levels of process variables at a combination of
-1 and 1. K must equal the number of process variables in the model. Only design points that match these
values are plotted. By default, all process variables are held at —1.

FMIN K...K

FMIN C

Specifies the minimum axis values for all process variables, including those that are not on the plot. The
number of constants or the length of the column must match the number of process variables.

FMAX K...K

FMAX C

Specifies the maximum axis values for all process variables, including those that are not on the plot. The
number of constants or the length of the column must match the number of process variables.

AHOLD K

Sets the mixture amount at the specified value in K. Only design points that match these values are plotted.
By default, the amount value is held at the first value in the Amount column.

SGRID [K]
Displays grid lines on each axis at specified intervals. All K must be 0 < K < 1. The default is K = 0.1.

MIXOVER: Session command for creating an overlaid contour plot

MIXOVER
Draws an overlaid contour plot for multiple (up to 10) responses of mixture models.

Contour plots for mixture designs show how response variables are related to three continuous design variables,
while holding the other variables in a model at certain settings. In a contour plot, the fitted response model is
viewed as a 2-dimensional surface where all points that have the same fitted value are connected to produce
contour lines of constants. Contour plots are useful for establishing operating conditions that produce desirable
response values.

Applications that involve multiple responses present a different challenge than single-response experiments.
Because each response is important in determining the quality of the product, you need to consider the responses
simultaneously. Optimal settings for input variables for one response might be far from optimal for another
response. Overlaid contour plots allow you to visually identify an area of compromise among the various responses.

For more information about graphics options for MIXOVER, go to Graphics options for MIXOVER on page 1150.

RESPONSE C...C
Specifies a set of up to 10 response variables for the experiment in C...C.

MODEL C...C

Specifies a set of model columns (one for each response), which contain design and model information in
C...C. Each model column is stored by the MODEL subcommand of MIXREG.

SINGLE C C [C]

Specifies three components or two numerical process variables for a single plot. You must specify the
components or process variables on the list in the model column.
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LEVELS K...K
Specifies the values of contour levels in K...K. K must be between 2 and 15.

TOTAL K [K...K]

TOTAL C

Specifies single or multiple total values. A single K must equal the common row sum of components. Multiple
Ks are accepted only if the Amount column is specified. The total subcommand must be specified if the
Amount column'’s specified either with a single K = 1 or with multiple K values that match the values in the
Amount column.

LOWER K...K

LOWER C

Specifies the lower bound of the components. The number of Ks must equal the number of components. All
Ks must be 0 <= K < TOTAL and SUM(K) < TOTAL. (TOTAL is the first value on Total.)

UPPER K. . .K

UPPER C

Specifies the upper bound of the components in K...K. The number of Ks must equal the number of
components. All Ks must be 0 < K <= TOTAL and SUM(K) > TOTAL. (TOTAL is the first value on Total.) Each
upper bound must be greater than the corresponding lower bound.

CLINEAR K...K

CLINEAR C

Specifies the linear constraints on the components. The number of Ks must equal the number of components
+ 2. The first K, the lower bound, must be less than the last K, the upper bound. If one of the bounds is
missing, set it to the missing value ' * '. You can use up to 10 CLINEAR subcommands.

PROPORTION
Specifies the proportion unit for the axes on the plot.

PSEUDO
Specifies the pseudo-component unit for the axes on the plot.

CLOW, CMIDDLE, and CHIGH
Sets the values of all the components that are not on the plot. Only design points that match these values
are plotted. By default, all components that are not on the plot are held at their lower bound. These commands
are not available for the process variable contour plot.

Command Bound or level
cLow Lowest bound
CMIDDLE Middle level
CHIGH Upper bound

CHOLD K...K

Holds components that are not on the plot to values that you specify in K...K. Each K must be between the
lower and upper bounds (inclusive) of the corresponding component. Only design points that match these
values are plotted. By default, all components that are not on the plot are held at their lower bound.

Minitab =’ 400



Minitab Statistical Software DOE

CMIN K...K

CMIN C
Specifies the minimum axis values for all components, including those that are not on the plot. The number
of constants and the length of the column must match the number of components.

FLOW, FMIDDLE, and FHIGH
Sets the level of all the process variables that are not on plot. By default, all process variables are held at -1.

Command Level
FLOW Low level (-1)
FMIDDLE Middle level (0)
FHIGH High level (1)
FMIN K. . .K
FMIN C

Specifies the minimum axis values for all process variables, including those that are not on the plot. The
number of constants or the length of the column must match the number of process variables.

FMAX C

Specifies the maximum axis values for all process variables, including those that are not on the plot. The
number of constants or the length of the column must match the number of process variables.

AHOLD K

Sets the mixture amount at the specified value in K. Only design points that match these values are plotted.
By default, the amount value is held at the first value in the Amount column.

SGRID [K]
Displays grid lines on each axis at specified intervals. All Ks must be 0 < K < 1. By default, K is 0.2.

TITLE "title"
Specifies a title for the graph. If you do not specify a title, Minitab uses a default title.

FFMAIN: Superseded by FACPLOT except for mixture designs

Note FFMAIN is superseded by FACPLOT on page 276, except for mixture designs.

FFMAIN C...C
Creates a main effects plot for 2-level factorial designs, for factors in C...C.

FFMAIN plots the means at the two levels of each factor and connects them with a line. FFMAIN plots any center
points you have, using a different symbol than that used for the factorial points. A reference line is drawn through
the plot to represent the overall mean (also called grand mean) of the response data.

Specify up to 50 factors. The factor columns can be numeric or text, and can contain any values. The levels do not
need to be in any special order. When the factor column is text, the first entry (row 1) is level 1. The next entry
that is different is level 2. All factors must have 2 levels, and can have center points.
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RESPONSE C (required)
Plots the response data in C. If you specify RESPONSE without FMEANS, then Minitab plots the raw response
data. The main effects are calculated based on the means of the data. If you plot process variables from a
mixture design, Minitab fits only the raw response data, not the fitted means.

With RESPONSE, you can specify up to 50 factors.

FMEANS C...C
Plots the least squares or fitted means in C...C. If you specify RESPONSE with FMEANS, then Minitab plots
the predicted values from the model. The main effects are calculated based on the fitted means. If you plot
process variables from a mixture design, Minitab fits only the raw response data, not the fitted means.

With FMEANS, you can specify up to 10 factors.

YMIN K

Specifies the minimum values on the y-axis of every plot that is displayed by the current command in K.
Making the minimum and maximum values the same is useful when you compare several plots of related
data.

YMAX K
Specifies the maximum values on the y-axis of every plot that is displayed by the current command in K.
Making the minimum and maximum values the same is useful when you compare several plots of related
data.

INUNIT K
Specifies whether the design is in coded form or uncoded form.

Value of K Form of design
0 Coded
1 Uncoded

CTPT K

Specifies the center point column in K. Minitab considers a value of 0 as a center point.

LEVELS K K, ..., K K
Specifies the levels for the uncoded units for each factor in KK, ..., K K. Use LEVELS to change the default
order of levels that Minitab uses.

TITLE "title"
Specifies a title for the graph. If you do not specify a title, Minitab uses a default title.

GSAVE "file name"

GSAVE K
Saves the graph in a file.

The default file name is Minitab.PNG. You can specify a custom file name in double quotation marks
("file_name"), or as a stored text constant (K). You can also use any of the following subcommands to save
the graph in a different graphics format.

Some graph commands—for example, HISTOGRAM C1 C2 C3—generate more than one graph. If you include
the GSAVE subcommand with such a command, Minitab saves multiple files. Minitab gives each file a different
file name. Minitab uses the first five characters of the name you specify, then appends a number (001, 002,

and so on), for up to 300 files.
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JPEG
JPEG color

PNGB
PNG grayscale

PNGC
PNG color

TIFB
TIF grayscale

TIF
TIF color

BMPB
BMP grayscale

BMPC
BMP color

GIF
GIF

EMF
EMF

RESOLUTION K
Saves the graph at a resolution of K dots per inch.

MIXTURE
Specifies a mixture design, which indicates that the factors are process variables.

FFINT: Superseded by FACPLOT except for mixture designs

Note FFINT is superseded by FACPLOT on page 276, except for mixture designs.

FFINT C...C
Creates interaction plots for factors in C...C.

Creates an interaction plot for 2-level factorial designs. If you enter 2 factors on the command line, then Minitab
displays a single interaction plot. If you enter more than 2 factors, then Minitab displays a matrix of interaction
plots. You can use factors from designs that are generated by FFDESIGN and PBDESIGN.

You can specify up to 15 columns that contain the factors. The factor columns can be numeric or text, and can
contain any values. The levels do not need to be in any special order. When the factor column is text, the first
entry (row 1) is level 1, the next entry that is different is level 2, and so on. All factors must have 2 levels, and can
have center points.

RESPONSE C (required)

Plots the response data in C. If you specify RESPONSE without FMEANS, then Minitab plots the raw response
data. The interaction effects are calculated based on the means of the data. If you plot process variables from
a mixture design, then Minitab fits only the raw response data, not the fitted means.
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You can specify up to 15 factors.

FMEANS C...C

Plots the least squares or fitted means in C...C. If you specify RESPONSE with FMEANS, then Minitab plots
the predicted values from the model. The interaction effects are calculated based on the fitted means. If you
plot process variables from a mixture design, Minitab fits only the raw response data, not the fitted means.

FULL
Displays the full interaction matrix when you enter more than 2 factors. By default, Minitab displays the half
matrix. The half matrix displays the plots in the upper right portion of the matrix. In the full matrix, the
transpose of each plot in the upper right is displayed in the lower left portion of the matrix. The full matrix
takes longer to display than the half matrix.

YMIN K
Specifies the minimum values on the y-axis of every plot that is displayed by the current command in K.
Making the minimum and maximum values the same is useful when you compare several plots of related
data.

YMAX K

Specifies the maximum values on the y-axis of every plot that is displayed by the current command in K.
Making the minimum and maximum values the same is useful when you compare several plots of related
data.

INUNIT K
Specifies whether the design is in coded form or uncoded form.

Value of K Form of design
0 Coded
1 Uncoded

CTPT C

Specifies the center point column in C. Minitab considers a value of 0 as a center point.

LEVELS KK, ..., KK
Specifies the levels for the uncoded units for each factor in KK, ..., K K. Use LEVELS to change the default
order of levels that Minitab uses.

TITLE "title"
Specifies a title for the graph. If you do not specify a title, Minitab uses a default title.

GSAVE "file name"

GSAVE K
Saves the graph in a file.

The default file name is Minitab.PNG. You can specify a custom file name in double quotation marks
(“file_name"), or as a stored text constant (K). You can also use any of the following subcommands to save
the graph in a different graphics format.

Some graph commands—for example, HISTOGRAM C1 C2 C3—generate more than one graph. If you include
the GSAVE subcommand with such a command, Minitab saves multiple files. Minitab gives each file a different
file name. Minitab uses the first five characters of the name you specify, then appends a number (001, 002,

and so on), for up to 300 files.
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JPEG
JPEG color

PNGB
PNG grayscale

PNGC
PNG color

TIFB
TIF grayscale

TIF
TIF color

BMPB
BMP grayscale

BMPC
BMP color

GIF
GIF

EMF
EMF

RESOLUTION K
Saves the graph at a resolution of K dots per inch.

MIXTURE
Specifies a mixture design, which indicates that the factors are process variables.

FFCUBE: Session command for creating a cube plot

FFCUBE C...C
Use FFCUBE to draw a cube plot that does not show mean response values. With a mixture design, you can use
FFCUBE to draw a cube plot that shows mean response values. For all other models, such as the models from
FFAC or REGR, use MFFCUBE on page 335 to draw a cube plot that shows mean response values.

Displays a cube plot for factors in C...C. You can draw a cube plot with 2-8 factors for each response entered with
the RESPONSE subcommand with data means or 27 factors with fitted means. The factor columns can be numeric
or text, and can contain any values. The levels do not need to be in any special order. When the factor column is
text, the first entry (row 1) is level 1, the next entry that is different is level 2, and so on. All factors must have 2
levels, and can have center points.

When you use the RESPONSE subcommand, FFCUBE displays the means for the response at each point in the
cube where observations are measured. When you do not use the RESPONSE subcommand, FFCUBE draws points
on the cube for the effects that are in your model, which helps you visualize the design.

RESPONSE C...C
Plots the raw response data that is in columns C...C. The means for the cube points are calculated from the
data. You can specify 2-8 factors.
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If you use FMEANS, RESPONSE is required.

FMEANS C...C

Plots the least squares or the fitted means that are in columns C...C. You can specify 2-7 factors. The column
must contain the fitted means in standard order for the cube points. The last row must be the overall mean
of the data.

If you use FMEANS, RESPONSE is required.

INUNIT K (required)
Specifies whether the design is in coded form or uncoded form.

Value of K Form of design

0 Coded form

1 Uncoded form
CTPT C

Specifies a center point column in C. Minitab considers a value of 0 to be a center point. A valid column
contains only values of 0 and 1.

If you don't use MIXTURE, CTPT is required. You cannot use both MIXTURE and CTPT.

LEVELS K K, ..., K K (required)

Specifies the levels for the uncoded units for each factor in KK, .., K K. The order of the parameters must be
identical to the order of the factors that follow FFCUBE.

TITLE "title"
Specifies a title for the graph. If you do not specify a title, Minitab uses a default title.

GSAVE "file name"

GSAVE K
Saves the graph in a file.

The default file name is Minitab.PNG. You can specify a custom file name in double quotation marks
("file_name"), or as a stored text constant (K). You can also use any of the following subcommands to save
the graph in a different graphics format.

Some graph commands—for example, HISTOGRAM C1 C2 C3—generate more than one graph. If you include
the GSAVE subcommand with such a command, Minitab saves multiple files. Minitab gives each file a different
file name. Minitab uses the first five characters of the name you specify, then appends a number (001, 002,

and so on), for up to 300 files.

JPEG
JPEG color

PNGB
PNG grayscale

PNGC
PNG color
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TIFB
TIF grayscale

TIF
TIF color

BMPB
BMP grayscale

BMPC
BMP color

GIF
GIF

EMF
EMF

RESOLUTION K
Saves the graph at a resolution of K dots per inch.

MIXTURE
Specifies a mixture design, indicating that the factors are process variables.

Response Optimization for Mixtures

MIXOVER: Session command for creating an overlaid contour plot

MIXOVER
Draws an overlaid contour plot for multiple (up to 10) responses of mixture models.

Contour plots for mixture designs show how response variables are related to three continuous design variables,
while holding the other variables in a model at certain settings. In a contour plot, the fitted response model is
viewed as a 2-dimensional surface where all points that have the same fitted value are connected to produce
contour lines of constants. Contour plots are useful for establishing operating conditions that produce desirable
response values.

Applications that involve multiple responses present a different challenge than single-response experiments.
Because each response is important in determining the quality of the product, you need to consider the responses
simultaneously. Optimal settings for input variables for one response might be far from optimal for another
response. Overlaid contour plots allow you to visually identify an area of compromise among the various responses.

For more information about graphics options for MIXOVER, go to Graphics options for MIXOVER on page 1150.
RESPONSE C...C

Specifies a set of up to 10 response variables for the experiment in C...C.

MODEL C...C

Specifies a set of model columns (one for each response), which contain design and model information in
C...C. Each model column is stored by the MODEL subcommand of MIXREG.
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SINGLE C C [C]

Specifies three components or two numerical process variables for a single plot. You must specify the
components or process variables on the list in the model column.

LEVELS K...K
Specifies the values of contour levels in K...K. K must be between 2 and 15.

TOTAL K [K...K]

TOTAL C

Specifies single or multiple total values. A single K must equal the common row sum of components. Multiple
Ks are accepted only if the Amount column is specified. The total subcommand must be specified if the
Amount column'’s specified either with a single K = 1 or with multiple K values that match the values in the
Amount column.

LOWER K. ..K

LOWER C

Specifies the lower bound of the components. The number of Ks must equal the number of components. All
Ks must be 0 <= K < TOTAL and SUM(K) < TOTAL. (TOTAL is the first value on Total.)

UPPER K. ..K

UPPER C

Specifies the upper bound of the components in K...K. The number of Ks must equal the number of
components. All Ks must be 0 < K <= TOTAL and SUM(K) > TOTAL. (TOTAL is the first value on Total.) Each
upper bound must be greater than the corresponding lower bound.

CLINEAR K...K

CLINEAR C

Specifies the linear constraints on the components. The number of Ks must equal the number of components
+ 2. The first K, the lower bound, must be less than the last K, the upper bound. If one of the bounds is
missing, set it to the missing value ' * '. You can use up to 10 CLINEAR subcommands.

PROPORTION
Specifies the proportion unit for the axes on the plot.

PSEUDO
Specifies the pseudo-component unit for the axes on the plot.

CLOW, CMIDDLE, and CHIGH
Sets the values of all the components that are not on the plot. Only design points that match these values
are plotted. By default, all components that are not on the plot are held at their lower bound. These commands
are not available for the process variable contour plot.

Command Bound or level
CLOW Lowest bound
CMIDDLE Middle level
CHIGH Upper bound
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CHOLD K. ..K
Holds components that are not on the plot to values that you specify in K...K. Each K must be between the
lower and upper bounds (inclusive) of the corresponding component. Only design points that match these
values are plotted. By default, all components that are not on the plot are held at their lower bound.

CMIN K...K

CMIN C
Specifies the minimum axis values for all components, including those that are not on the plot. The number
of constants and the length of the column must match the number of components.

FLOW, FMIDDLE, and FHIGH
Sets the level of all the process variables that are not on plot. By default, all process variables are held at —1.

Command Level
FLOW Low level (-1)
FMIDDLE Middle level (0)
FHIGH High level (1)
FMIN K...K
FMIN C

Specifies the minimum axis values for all process variables, including those that are not on the plot. The
number of constants or the length of the column must match the number of process variables.

FMAX K. ..K

FMAX C

Specifies the maximum axis values for all process variables, including those that are not on the plot. The
number of constants or the length of the column must match the number of process variables.

AHOLD K
Sets the mixture amount at the specified value in K. Only design points that match these values are plotted.
By default, the amount value is held at the first value in the Amount column.

SGRID [K]
Displays grid lines on each axis at specified intervals. All Ks must be 0 < K < 1. By default, K is 0.2.

TITLE "title"
Specifies a title for the graph. If you do not specify a title, Minitab uses a default title.

MROPT: Session command for the Response Optimizer

MROPT C...C
Use the Response Optimizer to identify the combination of input variable settings that optimize a single response
or that jointly optimize a set of responses. Joint optimization must satisfy the requirements for all the responses
in the set. The overall desirability (D) is a measure of how well you satisfied the combined goals for all the responses.
Overall desirability has a range of 0 to 1. A value of 1 represents the ideal case. A value of 0 indicates that one or
more responses are outside their acceptable limits.
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Minitab calculates an optimal solution and draws a plot. The optimal solution serves as the starting point for the
plot. With the optimization plot, you can interactively change the input variable settings to perform sensitivity
analyses and to possibly improve the initial solution.

Note Although numerical optimization, along with graphical analysis, can provide useful information, it is not a substitute for subject
matter expertise. Be sure to use relevant background information, theoretical principles, and knowledge from observation or previous
experimentation when you apply these methods.

Enter a set of response columns (up to 10) in the main command. You can use MIXTURE to match the responses
with their appropriate column. This column contains the model information that MROPT needs to find the optimum
solution and draw the trace plots.

For each response, you must do the following:

e Select a goal.

e Specify a minimum acceptable value, a maximum acceptable value, and a target value.
e Specify a utility transfer function value.

e Specify a weight or an importance level.

MODELS C...C

Specifies the model for the responses to be optimized. The arguments, one for each response, are the columns
stored by the MODEL subcommand of MIXREG. If you use session commands to optimize responses, you
must manually store the columns using MIXREG and MODEL.

LINEAR K. ..K
Specifies linear constraints for mixture components. You can use LINEAR up to 10 times.

For p mixture components, you must specify (p + 2) constant arguments. The first argument specifies
the lower bound for a linear inequality constraint. The next p arguments are the coefficients of the linear
function. The final argument is the upper bound on the linear function. Therefore, the subcommand
actually specifies two linear inequality constraints. If one of the bound arguments is ' * ' then there is
only one inequality, defined by the other bound. An inequality with an upper bound can be expressed
in terms of a lower bound by multiplying all coefficients and the bound by 1.

Used only as a subsubcommand with MIXTURE.
TOTAL K
Specifies the total mixture amount or amounts. K is 1-5.

INUNIT K
Specifies whether the design is in coded form or uncoded form.

Value of K Form of design

0 Coded

1 Uncoded
FLEVELS KK, ..., KK

Specifies values for the levels of each factor in K K,..., K K. The level values can be text or numeric.

GOAL K...K

GOAL C

Specifies a goal for each response. Enter the goal as a code from the following table in either a list of constants
(K...K) or a column (C).
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Code Goal Description

1 Smaller is better Set the response as small as possible.

2 Target is best Set the response as close to the target as possible.
3 Largest is best Set the response as large as possible.

UTWEIGHTS K. ..K

UTWEIGHTS C

Specifies the weights for each response. The weight defines the shape of the desirability function for each
response. For each response, you can select a weight (from 0.1 to 10) to emphasize or de-emphasize the

target.

Weight Emphasis

Less than 1 (minimum is 0.1) Less emphasis the target

Equal to 1 Equal emphasis on the target and the bounds
Greater than 1 (maximum is 10) More emphasis on the target

IMPORTANCE K. ..K

IMPORTANCE C

Specifies importance levels for each response. The levels are numbers between 0.1 and 10. If all responses
are equally desirable, use the default value of 1.0 for each response. Enter one argument (K) for each response,
or a column C) that contains the importance values.

The composite desirability is then the geometric mean of the individual desirabilities. However, if some
responses are more important than others, then you can include this information in the optimal solution by
setting unequal importance values.

Larger values correspond to more important responses. Smaller values correspond to less important responses.
You can also change the weights to perform sensitivity analyses on the optimal solution. For example, the
optimal solution when a response has a large weight might be very different from the optimal solution when
the same response has a small weight.

START K...K

Specifies a starting point for the search algorithm by giving a coordinate for each factor. Enter the coordinates
as constants. Each factor must have one value, and each value must be between the minimum and the
maximum for that factor.

DSTORE C

Stores the composite desirability values that are calculated at the points in the original design in a column.
You can use these values to produce wireframe plots or contour plots of the composite desirability surface
using CONTOURPLOT.

OPTIPLOT

Displays a table that shows the numerically optimal solution, the desirabilities for the responses, and the
interactive optimization plot.

Minimum, maximum, and target values

Specifies the minimum acceptable values, the maximum acceptable values, and the target values for the responses.
You must use all three subcommands. All three commands are needed to obtain the numerically optimum solution.
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You must also enter a value for each response in each of these subcommands. In other words, for each response, you
need a minimum acceptable value, a maximum acceptable value, and a target value. You can enter the values by using
a list of constants, or a column.

If you have a smaller-is-better goal for a response, your goal is to minimize the response. Identify the point of diminishing
returns. That is, you want to minimize the response, but going beyond a certain value makes a small difference or no
difference. If such a point exists, use it as the target value. If it does not exist, use a very small number, one that is
probably not achievable, as the target value. For a smaller-is-better response, the target and the minimum acceptable
value are also equal.

The same is true when the goal is larger-is-better. However, in the larger-is-better case, you need a value on the upper
end of the range instead of on the lower end.

When the goal is target-is-best, you probably have upper and lower specification limits for the response. You can use
these limits as minimum and maximum acceptable values. If not, you might want to use upper and lower points of
diminishing returns, or some other method.

MINACCEPT K...K

MINACCEPT C
Specifies the minimum acceptable values.

MAXACCEPT K. ..K

MAXACCEPT C
Specifies the maximum acceptable values.

TARGET K...K

TARGET C
Specifies the target values.

Taguchi Designs

OADESIGN: Session command for creating a Taguchi orthogonal
array design

OADESIGN K K K [K K]
Creates a Taguchi orthogonal array design, where the first K specifies the number of runs in the design and the
remaining Ks specify number of levels and number of factors, respectively.

Use OADESIGN to specify a Taguchi orthogonal array design. OADESIGN can take either 3 or 5 integer arguments,
which correspond to the standard Taguchi notation. For example, a commonly used orthogonal array is denoted
by L18 (2**1 3**7). This means that the design has 18 runs, with one two-level factor, and seven three-level factors.
The Minitab command that will specify this design is as follows:

OADESIGN 18 2 1 3 7.

Or, as follows:
OADESIGN 18 3 7 2 1.

If you want to use this array with one two-level factor and six three-level factors, the command is as follows:
OADESIGN 18 2 1 3 6.
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To store your design for additional analysis, use the DESIGN subcommand. (The DESIGN subcommand replaces
the obsolete subcommands XMATRIX and SIGNAL.)

LEVELS K K, ..., KK
Specifies the levels for each factor in KK, KK ... K K.

If you do not specify levels, Minitab uses the default levels given in the catalogue of arrays. For example, the
default levels of a 3-level column are 1, 2, and 3.

The following example shows how LEVELS is used:

OADESIGN 18 3 4 2 1;
DESIGN;
LEVELS 1 2 3 "red" "green" "blue" 2.7 2.9 3.4 3.9 4.2 6.8 -1 1.

This design will use five columns of the L18 (2**1 3**7) array. The first four factors, which will be stored in
columns C1-C4, will have 3 levels each. The fifth factor, which will be stored in column C5, will have 2 levels.
The levels of factor C1 will be 1, 2, and 3. The levels of C2 will be "red", "green", and "blue". The levels of
factor C3 are 2.7, 2.9, ad 3.4.

Note It is acceptable to repeat levels for the same factor, as long as there are at least two distinct levels. This allows the use of
"dummy treatments", an important technique for customizing Taguchi designs. For example, the 8-level column in the L16 (8**1
2**8) array can be used for a 7-level factor by specifying levels 1123456 7.

COLUMNS K...K
Specifies which columns of the full orthogonal array are used in the design in K...K.

Consider the following example:

OADESIGN 18 3 4 2 1;
DESIGN;
COLUMNS 2 3 5 7 1.

Worksheet column C1 will be the same as column 2 in the L18 (2**1 3**7) array. Column C2 will be the same
as column 3; C3 will be column 5; C4 will be column 7; and C5 will be column 1.

INTERACTIONS C C, ..., CC
Specifies which interactions among factors in C C you want to estimate. INTERACTIONS requests that Minitab
automatically assign factors to columns in such a way that the 2-way interactions listed are not confounded
with any of the main effects or with each other. If you want to remove an interaction from your model, you
should run the OADESIGN command to re-specify your model with the appropriate terms.

DESIGN

Names and stores the standard order, run order, point type, block assignment, and each factor in separate
columns. Unless you have only 1T empty worksheet in the project, Minitab stores the columns in a new
worksheet.

NAMES K K, ..., KK

Specifies names for the factors. Enclose names in quotation marks. If you do not use NAMES, then the
names of the factors are letters, skipping the letter I: A, B, C...

SNAME K

Use SNAME to add a signal factor to create a dynamic Tauchi design. Enter the name within double
quotation marks. When you specify SNAME, also specify SLEVEL.

SLEVEL K.K

Use SLEVEL specify the levels of the signal factor for a dynamic Taguchi design. Levels for a signal factor
must be numeric. Minitab replicates the orthogonal array part of the design at each level of the signal
factor.
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Consider the following example:
OADesign 4 2 3;

Design;

SNAME "Signal";
SLEVEL 1:5/2.

The design stored in the worksheet would be as follows:

c1 Cc2
A B

1 1

1 1

1 1

1 2

1 2

1 2

2 1

2 1

2 1

2 2

2 2

2 2

o W Ul W

Ul w

3
5

DOE

In general, the total number of runs will be the number of rows in the orthogonal array times the number

of levels in the signal variable.

ROBUST: Session command for analyzing a Taguchi design

ROBUST C = C...C

Analyzes a Taguchi design with responses in C and factors and interactions in C...C.

Calculates signal-to-noise ratios for an inner-outer array design and generates main effects and interactions plots
of the signal-to-noise ratios, means, slopes, or standard deviations versus the control factors in the inner array.
Use response tables and ANOVA results to determine what factors and interactions are important and which

factor settings minimize variability.

To use Predict Taguchi Results on the Minitab menu, use DESIGN and DOE to store the model information.

DESIGN C...C

Specifies all of the factors in your design in C...C if you have omitted some factors in the model specified in

ROBUST.

DOE

Stores model information to enable Predict Taguchi Results on the Taguchi menu. You can make
predictions with OAPREDICT whether or not you store the model information.
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DYNAMIC C

Specifies that the signal factor is in C. DYNAMIC cannot be used with any subcommands that apply only to
static response analysis: NOMONE, NOMTWO, LOWER, HIGHER, GMEANS, MEANS, CV, TMEANS.

Graphs

GSN

Displays main effects for s/n ratios. GSN plots the S/N ratio as the response variable. Choose the appropriate S/N
ratio with the NOMONE, NOMTWO, LOWER, or HIGHER subcommands (the default is NOMTWO).

GMEANS

Displays main effects for means. GMEANS cannot be used with DYNAMIC. You can use as many GMEANS as you
want. See LOGSTD if you want to use the log-transformed standard deviations as the response variable.

GSTDS

Displays main effects for standard deviations. You can use as many GSTDS as you want. See LOGSTD if you want
to use the log-transformed standard deviations as the response variable.

GSLOPES

Displays main effects for slopes. GSLOPES can only be used with DYNAMIC. You can use as many GSLOPES as
you want. See LOGSTD if you want to use the log-transformed standard deviations as the response variable.

GSCATTER

Displays scatterplots of data with fitted lines. Use GSCATTER to request scatterplots of the responses versus the
signal. GSCATTER can be used only with DYNAMIC.

INTROWS C...C

Specifies factors to be used as the grouping variable in the interaction plot matrix. The plots in the same row
share the factor that is used as the grouping variable.

INTCOLS C...C

Specifies factors to use for the horizontal scale of the interaction plot matrix. The plots in the same column share
the factor used for the horizontal scale.

INTSEP
Generates separate interaction plots for interactions specified in the model.

RTYPE K
Specifies the type of residual to plot with the graph subcommands.

Value of K Type of residuals

1 (default) Regular or raw residuals (RESIDUALS)

2 Standardized residuals (SRESIDUALS)

3 Deleted Studentized residuals (TRESIDUALS)
GHISTOGRAM

Displays a histogram of the residuals.

GNORMAL
Displays a normal probability plot of the residuals.
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GFITS
Plots the residuals versus the fitted values.

GORDER [C]
Plots the residuals versus the order of the data or vs the order specified in [C]. The row number for each data
point is shown on the x-axis (for example, 12 3 4... n).

GFOURPACK [C]
Displays a layout of a histogram of the residuals, a normal probability plot of the residuals, residuals vs fitted
values, and residuals vs order of the data or vs order specified in [C].

GVARIABLE C...C
Plots the residuals versus variables. Displays a separate graph for the residuals versus each specified column.

Analysis

TMEANS
Generates a response table for means. TMEANS cannot be used with DYNAMIC.

TSN
Generates a response table for s/n ratios.

TSTDS
Generates a response table for standard deviations.

TSLOPES
Generates a response table for slopes. TSLOPES can only be used with DYNAMIC.

AMEANS
Generates ANOVA results for means. AMEANS cannot be used with DYNAMIC.

ASN
Generates ANOVA results for s/n ratios.

ASTDS
Generates ANOVA results for standard deviations.

ASLOPES
Generates ANOVA results for slopes ratios. ASLOPES can only be used with DYNAMIC

Options

NOMONE
Specifies the s/n ratio based on standard deviations only.

Use NOMONE when the goal is to target the response. The formulais S /N = -10 (Iogm(sz)).

NOMTWO
Specifies the s/n ratio based on means and standard deviations (default).

Use NOMTWO when the goal is to target the response. The formulais S/ N = 10 (logqg (Xbar® / ).
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LOWER
Specifies the s/n ratio when the goal is to minimize the response.

Use LOWER when the goal is to minimize the response. The formulais S/ N = 10 (log4q (X Y2/ n)).

HIGHER
Specifies the s/n ratio when the goal is to maximize the response.

Use HIGHER when the goal is to maximize the response. The formula is
S/ N =-10 (log4o(x (1 /Y% /)

LOGSTD

Specifies the loge transformation for standard deviations. If you want to produce main effects and interactions
plots using the standard deviation as the response variable, consider using a loge transformation on the standard
deviations to stabilize their variability.

YREF K
Specifies the response reference value for dynamic designs.

Specifies the reference point through which the regression line must pass in a dynamic response model. If the
subcommand is not used, the reference value is taken to be zero by default. If neither YREF nor SREF are used,
the regression line passes through the origin.

YREF can only be used with DYNAMIC.

SREF K
Specifies the signal reference value for dynamic designs.

Specifies the reference point through which the regression line must pass in a dynamic response model. If the
subcommand is not used, the reference value is taken to be zero by default. If neither YREF nor SREF are used,
the regression line passes through the origin.

SREF can only be used with DYNAMIC.

NOREF
Specifies no reference values for the regression. Minitab estimates a separate regression intercept for each run.

Storage
You must use storage commands with one or more of the commands AMEANS, ASLOPES, ASNS, or ASTDS.

SNRATIO C
Stores s/n ratios in C.

MEANS C
Stores means in C. MEANS cannot be used with DYNAMIC.

SLOPES
Stores slopes in C. SLOPES can only be used with DYNAMIC.

INTERCEPTS
Stores intercepts in C. INTERCEPTS can only be used with DYNAMIC.
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STDEVS
Stores standard deviations in C.

LSTDEVS
Stores natural log of standard deviations in C.

cv

Stores coefficients of variation in C. CV cannot be used with DYNAMIC.

FITS C
Stores the fitted values.

RESIDUALS C
Stores the residuals (fitted values — observed values).

SRESIDUALS C
Stores the standardized residuals.

TRESIDUALS C
Stores the deleted Studentized residuals in C.

COEFFICIENTS C
Stores the estimated coefficients.

XMATRIX M

Stores the design matrix for the regression model in M.

HI C
Stores the leverage values.

COOK C
Stores Cook's distance.

DFITS C
Stores the DFITS (also called DFFITS) values.

DOE

OAPREDICT: Session command for calculating predicted response

values

OAPREDICT C...C = C...C

Predicts response values for statistics stored in C...C for factors and interactions in C...C.

Calculate predicted response values after you have analyzed a Taguchi design and examined the response tables,
ANOVA results, and plots to determine which factor settings should achieve a robust product design. OAPREDICT

allows you to predict S/N ratios and response characteristics for selected factor settings.

To use OAPREDICT, first store response characteristics (S/N ratios, means, slopes, standard deviations) you want
to predict with ROBUST. Specify stored response characteristic columns on left-side of model. Specify factors and

interactions on the right-side of the model.

For example, you might choose the best settings for the factors that have the greatest effect on the S/N, and then
wish to predict the S/N and mean response for several combinations of other factors. OAPREDICT provides the

expected responses for those settings. You should choose the results that come closest to the desired mean
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without significantly reducing the S/N ratio. You should then perform a follow-up experiment using the selected
levels, to determine how well the prediction matches the observed result.

If there are minimal interactions among the factors or if the interactions have been correctly accounted for by
the predictions, the observed results should be close to the prediction, and you will have succeeded in producing
a robust product. On the other hand, if there is substantial disagreement between the prediction and the observed
results, then there may be unaccounted for interactions or unforeseen noise effects, which may require further
investigation.

LABELS K...K
Specifies labels for the predicted values in the output. The arguments must be text constants.

LEVELS E...E

Specifies the factor levels for which you want to calculate predicted response values. The arguments may be
either constants or columns. The levels must agree with the levels in the factor columns.

PFITS C...C
Stores the predicted values in specified columns. The number of arguments should match the number of
response characteristics listed on the left-hand side of the model in the OAPREDICT command.

UNITS K K

Specifies the units of the inner array factors and the units for the new levels, 0 for coded and 1 for uncoded.
The first argument indicates the units of the inner array columns and the second argument indicates the
units of the levels given by the LEVELS subcommand.

NLEVELS K...K
Specifies the number of levels for each factor. Use when the two arguments of UNITS are different. It is used
in conjunction with FLEVELS to match coded levels with uncoded levels for each factor.

FLEVELS K...K

Specifies the uncoded levels of the factors listed in the model. Use FLEVELS if the two arguments of UNITS
are different. The number of arguments for FLEVELS should be the sum of the arguments of NLEVELS. NLEVELS
is used to determine which levels correspond to which factors.

Example:

OAPREDICT 'SNRA1' = Cl1 C3-C5;
LEVELS 2 1 1 1;
UNITS 1 0;

NLEVELS 2 3 3 3;
FLEVELS "low" "high" "low" "low" "